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Preface

In today’s competitive and diverse marketplace, effective collaboration is a critical component 
of organizational success. Lotus® Notes® and Domino®, the premier IBM® collaboration 
platform, helps organizations improve collaboration, increase productivity, and streamline 
business processes. The Lotus Notes 8 interface is intuitive and easy to use, and the Lotus 
Domino 8 server is secure, flexible, and reliable. Together, Lotus Notes and Domino 8 can 
help your organization to:

� Increase employee effectiveness and creativity through integrated messaging, 
collaboration, and office productivity applications.

� Reduce overall cost of ownership by deploying integrated offering with office productivity 
suite included at no additional charge.

� Protect IT infrastructure with a layered security model that reaches from server to 
individual field in a document.

� Increase mobile and offline productivity from secure, reliable replication.

� Increase individual responsiveness through customizable interface.

� Reduce application development and deployment costs through quick creation application 
component mash ups.

� Minimize downtime with high availability and simplified administration tools.

This IBM Redbooks® publication provides you with information about the new enhancements 
and features of Lotus Notes and Domino 8 and provides guidelines or directions on how to 
implement or utilize these. It also provides you with an approach to planning and deploying 
Lotus Notes and Domino 8 in new and existing environments. 

This publication is a valuable reference to all kinds of users. It will help CIOs, CTOs, 
administrators, developers, and users with:

� Understanding the capabilities and benefits of Notes and Domino 8
� Planning for the deployment of Notes and Domino 8
� Planning to leverage new features of Notes and Domino 8

The team that wrote this book

This book was produced by a team of specialists from around the world working at the 
International Technical Support Organization, Cambridge MA. Center.

Philip Monson is a Project Leader at the ITSO Lotus Center in Cambridge, MA. Phil has 
been with Lotus/IBM for 17 years, joining the company when the early versions of Notes were 
rolled out for internal use. He has served in management, technical, and consulting roles in 
the IT, Sales, and Development organizations.

Rishab Sharma is an IBM Accredited Senior IT Specialist (Lotus) with the IBM India 
Software Group team. He has been working with IBM India/SA for over six years and has 
worked closely with all major Lotus and WebSphere® Portal customers in India. He has been 
a contributor or influencer for all major sales of Lotus Software in India. He has over 11 years 
of experience with Lotus Domino and Extended products. He specializes in deployments and 
administration of Lotus and WebSphere Portal technologies. He currently runs the Lotus 
Health Assessments workshops and also works with large Lotus customer deployments in 
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India. He has presented at numerous road shows and participated all IBM India 
customer-facing events. He is a Certified System Administrator for Lotus Domino and 
WebSphere Portal. Rishab holds a bachelor's degree in Computer Science. He can be 
reached at rishabsharma@in.ibm.com.

Stacy Lieder is a Premium Support Manager working in the IBM Premium Support Program 
for Lotus Software. Stacy began her career in IT as a technical instructor, and has 12 years of 
experience with Notes and Domino, the last eight with IBM. In addition to holding an MSE in 
Engineering Management from the University of Texas and a Bachelor of Arts in English from 
Texas A&M University, Stacy is a member of the IEEE Computer Society. Stacy authored the 
Notes and Domino 7 Reviewer's Guide in 2005. 

Frank Nostrame is an IT Specialist with IBM Lotus Field Support Services, providing 
technical consultations, presentations, and general support for Lotus Premium Support 
customers. As a former project and technical lead supporting IBM Domino environment, 
Frank headed up Domino deployments, migrations, and automation projects, and has 
extensive experience in monitoring and early deployment of Lotus Domino products. Frank 
was also a member of the Domino Domain Monitoring IBM Redbooks team and holds a 
degree in Computer Science and Information Systems from Boston College. Frank's other 
professional areas of interest include SOA/Web services and open source Web development. 
He can be reached at nostrame@us.ibm.com.

Julie Castle has worked in the IT industry for 16 years in a range of consulting, project, and 
management roles in the software arena. Julie has been involved in many large Lotus Notes 
and Domino infrastructure planning and deployment projects in both a technical and project 
management capacity. She has been a previous author of two Redpaper projects: 
Understanding Lotus Notes Smart Upgrade, REDP-4180, and Domino 7 Server 
Consolidation, REDP-4181. Julie has been working for IBM Software Group in Melbourne 
Australia for seven years, the last six of which have been as a Premium Support Manager 
(PSM) working on IBM Premium Support Program accounts. Julie has a degree in Politics 
and Literature, and a Graduate Diploma in Computer Science.

Corey Davis is a Domino Administrator and Application Developer at Computer Sciences 
Corporation (CSC). He has been working with Notes and Domino since R3 and began 
programming at the age of 12. Corey has been involved in numerous large-scale migrations 
and Domino upgrades, in addition to developing numerous Domino applications and mail 
template enhancements for CSC customers. He served on IBM Software Design Review for 
Notes 8 and managed CSC's Notes 8 Beta Team. He can be reached at cdavis41@csc.com. 

Olanike Ogunbodede is a staff a Software Engineer with WPLC. She has been working for 
the Lotus Notes/Domino Support Team for four years, supporting Lotus Notes client software. 
She has become a key contributor to the team, and as a Product Area Expert has welcomed 
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Comments welcome

Your comments are important to us!

We want our books to be as helpful as possible. Send us your comments about this book or 
other IBM Redbooks in one of the following ways:

� Use the online Contact us review Redbooks form found at:

ibm.com/redbooks

� Send your comments in an e-mail to:

redbooks@us.ibm.com

� Mail your comments to:

IBM Corporation, International Technical Support Organization
Dept. HYTD Mail Station P099
2455 South Road
Poughkeepsie, NY 12601-5400
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Chapter 1. Introduction

The premier IBM collaboration platform is Lotus Notes and Domino. Lotus Notes and Domino 
have repeatedly delivered forward-looking capabilities to empower business people to be 
more effective, responsive, and innovative in their daily work. 

With Lotus Notes and Domino 8, world-class business e-mail and collaboration take an 
exciting step forward. They provide organizations around the world with new avenues to 
enhance efficiency and productivity. Lotus Notes and Domino 8 provide these capabilities 
while keeping existing investments in technology in mind. 

Lotus Notes and Domino 8 are not just about features, enhancements, or new functionality. 
Lotus Notes and Domino 8 represent the next stage in the evolution of collaborative software 
that demonstrates the commitment by IBM to provide productivity, efficiency, reliability, and 
scalability to users across the business spectrum.

This chapter discusses the business benefits of deploying a Lotus Notes and Domino 8 
environment that would impact both new and existing deployments. In addition, this chapter 
also discusses:

� The scope and focus of this IBM Redbooks publication

� The example environment of the fictitious ITSO Corp. This example environment is used 
throughout to explain the Lotus Notes and Domino 8 enhancements.

This book provides valuable information about Lotus Notes and Domino 8 for all kinds of 
organizations. The intended audience spans from a CIO to an administrator to a developer. It 
provides the audience with a structured and planned approach to deploying Lotus Notes and 
Domino 8. It also provides best practices with respect to co-existence and upgrade, and the 
steps required in order to enable and effectively utilize the new enhancements in Lotus Notes 
and Domino 8.

1
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1.1  Lotus Notes and Domino 8

With a fresh new intuitive look and feel, the Lotus Notes 8 client is a veritable powerhouse. It 
brings together information and tools to accomplish your daily jobs/tasks in an efficient and 
productive manner. Lotus Notes 8 client has been designed for the business user. Deploying 
the Lotus Notes 8 client can have a phenomenal impact on your business and help users to 
extract maximum return on investment. The new features of Lotus Notes 8 client can help 
users to transition from basic e-mail to more productive collaborative functions.

Lotus Notes and Domino 8 have been enhanced to help improve performance and efficiency. 
Lotus Notes and Domino 8 have the potential for less administrative overhead through the 
new features that allow a more granular control of your environment.

The Domino Web Access (DWA) interface in Lotus Notes and Domino 8 has been completely 
redesigned with enhanced functionality to bring DWA closer to parity with Lotus Notes 8 
client. These enhancements provide for a greatly improved and responsive user experience.

Application developers can use IBM Lotus Designer 8 to build reusable components that 
could be used by multiple applications. These reusable components can be combined with 
other functional components within a service-oriented architecture (SOA) to deliver what is 
now commonly referred as composite applications. Lotus Notes and Domino 8 applications 
now can consume Web services hosted on other systems. The open application 
infrastructure provided by Lotus Notes and Domino 8 supports business agility and extends 
your IT investments while improving user effectiveness and productivity.

1.2  Business benefits of upgrading or deploying Lotus Notes 
and Domino 8

IBM Lotus Notes and Domino 8 software delivers innovations in business collaboration. It 
continues to enhance its core capabilities while supporting your existing applications. Lotus 
software continues to be a leader in innovation, providing new capabilities that allow your 
employees to collaborate in the context of their day-to-day business.

1.2.1  Open application infrastructure

Using open standards-based Eclipse technology, Lotus Notes 8 client has been designed to:

� Let users work with people, information, and applications from a single page.
� Help users to reduce Inbox clutter.
� Allow users to bring together all related components of work into a common location.
� Provide an open platform for plugging in new capabilities driven by business needs.

The current release of Lotus Notes and Domino 8 provides enhanced support for 
service-oriented architecture through composite applications. Lotus Domino 8 also provides 
the ability to natively consume Web services. This allows users to weave contextual 
collaboration into your business applications. Lotus Notes and Domino 8 provides users the 
flexibility of leveraging your current investments by combining heterogeneous technologies.

Lotus Notes and Domino 8’s open application infrastructure provides for server-managed 
provisioning. This capability allows users to centrally manage and control the deployment of 
Notes client features and composite applications.
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1.2.2  Intuitive new interface for Lotus Notes and Domino Web Access client

Intuitive yet familiar seems to be the mantra for the Lotus Notes 8 client. The interface was 
designed in direct response to feedback from users. The Domino Web Access (DWA) Client 
has also been enhanced to provide close parity with the Lotus Notes 8 client.

Lotus Notes 8 client
Lotus Notes 8 is flexible. It offers the option to personalize the interface to accommodate your 
own ways of working and includes the ability to use plug-ins, allowing the interface to be 
extended to meet your business requirements.

Figure 1-1 illustrates some of the new innovations in the new Lotus Notes 8 client.

Figure 1-1   Lotus Notes 8 client layout with sidebar

Some user interface enhancements in Lotus Notes 8 client are:

� New vertical preview pane - In addition to the horizontal preview pane, Lotus Notes 8 has 
a new vertical preview pane option that offers users more flexibility when previewing mail, 
calendar, and contacts.

� Smaller and more appropriate inbox using conversations - Lotus Notes 8 provides the 
choice of viewing your inbox in the traditional way, as individual messages, or in an 
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innovative new way, as conversations. This reduces the time spent searching your inbox 
for responses, as all of the previous message threads are gathered together under the 
latest conversation.

� New customizable sidebar panel - The new sidebar panel on Lotus Notes 8 provides 
access to your Lotus Sametime contacts, calendar, activities, and an integrated RSS 
Feed reader. This sidebar panel can be customized to provide additional plug-ins that 
specifically meet your organization’s business requirements.

� Greater flexibility in business contacts - Users can now manage information about your 
business contacts more flexibly by allowing contacts to contain photographs, which can be 
displayed along with a business card view.

� Integrated Sametime 7.5 interface - Lotus Notes 8 supports an integrated Sametime 7.5 
interface that provides advanced functionality like presence awareness, emoticons, rich 
text, in-line spell check, instant messaging history, and much more. This allows users to 
quickly and easily collaborate with colleagues in real time side-by-side with your e-mail.

Note: For more information about Lotus Notes 8 client, refer to Chapter 4, “Deploying 
the Notes 8 client” on page 63, and Chapter 6, “Lotus Notes 8 client features” on 
page 113.
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Domino Web Access
DWA in Lotus Notes and Domino 8 has gone through a major redesign and now provides 
more enhancements and better performance. Figure 1-2 illustrates the new innovations in the 
new Domino Web Access 8 client.

Figure 1-2   Domino Web Access 8 Client

Some of these enhancements have been listed below:

� Improved interface - The look and feel in Domino Web Access has undergone a significant 
change to provide a uniform interface across different client and server platforms.

� Preview pane - Allows users to quickly scan the information in their inboxes or business 
contacts in Domino Web Access.

� Support for RSS or Atom Feed for inbox - Allows users to gain the flexibility to view their 
mail from Internet and non-Lotus clients when they are away from their usual work 
environment.

� Additional spell check dictionaries - DWA provides integration and support for additional 
LanguageWare® libraries and dictionaries. DWA also supports a multi-threaded server 
spell check engine for greater efficiency.

Note: For more information about DWA, refer to Chapter 8, “Domino Web Access” on 
page 215. 
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1.2.3  Improved organizational productivity and responsiveness

The rich set of enhanced functionality provided by Lotus Notes and Domino 8 helps improve 
organizational productivity and responsiveness. Some productivity enhancements are:

� Recent contacts - Builds a list of contacts based on recent activity like e-mails or chats, 
which allows users quick and easy access to the information even while offline.

� Message recall - Provides users the option to retract an e-mail message that has been 
sent to a recipient using a Lotus Domino 8 server.

� Thumbnail view with search center - Enables the user to view and work across all the 
open panels at given time. It also enables the usage of the unified search center with 
search history, which can be used to search Notes databases, the Web, or your desktop 
with the Google Desktop Search integration.

� Out-of-office enhancements - Allows users to gain greater flexibility and speed in letting 
your colleagues know that they are away from their desks.

� Single unified interface for preferences - Enables users to configure all preferences 
associated with the Lotus Notes client, including preferences associated with locations, 
instant messaging, activities, and productivity tools.

� Multilevel undo functionality - Enables users to retrace their steps through more than 50 
levels of edits while editing text in Lotus Notes and Domino 8. This enhances productivity 
by providing better editing support.

� Context sensitive help - Enables users to work in mail and look at Help simultaneously, 
fostering greater productivity.

1.2.4  Improved infrastructure flexibility

Lotus Notes and Domino software is well known for supporting a wide variety of operating 
system platforms. Lotus Notes and Domino 8 continue to provide hardware and software 
platform flexibility and choice. Lotus Notes and Domino 8 also offer more versatility for 
integration with complementary software.

The Lotus Notes 8 client offers a consistent installation process for both Microsoft® 
Windows® operating system users and Linux® desktop users. Enhancements in Lotus Notes 
8 for Linux include integrated instant messaging and presence awareness, the Lotus Notes 
smarticons toolbar and support for color printing.

In addition, Lotus Domino 8 brings greater similarity between Lotus Notes and Lotus Domino 
Web Access client options, for both the interface and the features. 

Note: The composite application editor feature of Lotus Notes 8 is supported on Microsoft 
Windows and Linux operating systems. However, Lotus Domino Designer is supported 
only for Microsoft Windows workstations. Refer to the latest release notes for the latest 
information:

http://www.ibm.com/developerworks/lotus/documentation/releasenotes/
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Lotus Domino 8 also offers new capabilities to allow easier interoperability with other 
software. These include:

� Full support for the option to use IBM DB2® software as a data store for Lotus Domino 8 
on select Microsoft Windows, IBM AIX®, and Linux platforms

� Full support for the DB2 access view and query view design elements of Lotus Domino 
Designer 8

� Incorporation of IBM Tivoli® Directory Integrator software capabilities into Lotus Domino 8

� Improved integration with IBM Tivoli Enterprise™ Console, IBM WebSphere Application 
Server, and WebSphere Portal software

1.2.5  Simplified administration and layered security

Lotus Notes and Domino 8 administration has been enhanced to provide control of your 
everyday administrative tasks. Improved security in Lotus Notes and Domino 8 helps to 
protect users from unauthorized attacks while keeping costs down.

Some of these enhancements and features of Lotus Notes and Domino 8 Administration are 
listed below:

� Out-of-office service - Implementing out of office as a mail router service instead of a 
scheduled agent can minimize the elapsed time before users receive absence 
notifications after sending e-mail to a colleague who is out of the office.

� Message recall - Users can control the use of message recall in their environment as per 
the business needs of their organization.

� Transfer and delay delivery reports - Automatically notify users when e-mails that they 
have sent are delayed.

� Server-based provisioning - Allows users to manage the deployment of Lotus Notes 8 
client features, Eclipse components, and composite applications from a Lotus Domino 8 
server.

� New policy settings - Productivity tools, Domino Web Access Security, and so on, are new 
policy settings that provide further granular control of a user’s desktop and mail files.

� Lotus Domino domain monitoring - Has new probes and probe subtypes in addition to 
other enhancements, thereby reducing the number of steps required to identify and 
resolve issues before they impact the business, potentially saving time and money.

� IBM support assistant - the integrated self-help application speeds the resolution of 
product challenges.

Note: For more details on DB2 Integration, refer to Chapter 9, “New administration 
features” on page 241.

Note: For more information about Lotus Notes and Domino 8 Administration 
enhancements, refer to Chapter 9, “New administration features” on page 241.
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Security
Some of the enhancements and features of Lotus Notes and Domino 8 related to security are:

� Internet password fields - protects against attempts to decipher hashed passwords using 
access restrictions

� Internet password lockout - protects against brute force and dictionary attacks on user 
Internet accounts

� Longer encryption keys - protects against attempts to decipher encryption keys

� Database redirect functionality - maximizes database availability while simplifying 
administration

1.2.6  Integrated productivity tools reduce cost of ownership

Lotus Notes and Domino 8 include a suite of open standards-based office productivity tools 
that support OASIS Open Document Format (ODF). Word processing documents, 
presentations, and spreadsheets created using IBM productivity tools can be shared with 
other organizations using ODF compatible tools. This eliminates the requirement and 
significantly lowers the cost of having to license, deploy, manage, and integrate multiple 
proprietary productivity tools or solutions. 

IBM productivity tools allow users to create, edit, and collaborate on a wide variety of 
document, presentation, and spreadsheet file types using the integrated Lotus Notes 8 client. 

Organizations can save costs by using the productivity tools integrated within the Lotus Notes 
8 client without having to license and deploy separate products that provide identical 
functionality.

IBM productivity tools provide interoperability and flexibility by offering support for multiple file 
formats. Users can read and save to Microsoft Office files and read from IBM Lotus 
SmartSuite® documents. Users can also save them to ODF format for sharing with 
ODF-compliant applications. 

All documents, spreadsheets, and presentations created using IBM productivity tools can 
also be exported to PDF format.

1.2.7  Improved efficiency and performance

Several enhancements to Lotus Notes and Domino 8 software provide an opportunity for 
enhanced system performance. These include streaming replication for Lotus Domino 
clusters and a variety of database and I/O improvements.

Note: For more details on IBM productivity tools, refer to Chapter 7, “Productivity tools” on 
page 199.
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Efficiency and performance improvements include:

� Inbox cleanup feature - Potentially can improve both Lotus Domino server and Lotus 
Notes client performance.

� Streaming cluster replication - Improves cluster replication performance and helps reduce 
the effect that this has on server I/O.

� User renames processing - Elapsed time required to complete user rename requests can 
be shortened by using the improved administration processing. 

� Design Note compression - Can potentially reduce the I/O and space utilization 
associated with database design information.

1.2.8  Support for activity-centric computing

Activities is an innovative approach to collaborative work management that facilitates new 
levels of productivity by bringing together all aspects of your work into a common view and 
enabling users to combine ad hoc collaboration techniques flexibly within a formalized 
processes.

Activities help users to consolidate work items to meet and produce a particular deliverable. It 
provides a lightweight mechanism that helps build best practices around personal tasks and 
projects in a more managed context, enabling users to more quickly complete activities and 
maintain an up-to-date view of their daily work.

Activities is a part of IBM Lotus Connections social software that is designed to empower 
people to be more effective and innovative by building professional networks of coworkers, 
partners, and customers. With this software, users can find and collaborate with experts; 
easily locate people and information; build closer partner and customer relationships; and 
foster bottom-up, community-based innovation.

Using Lotus Notes 8 one can create, manage, and integrate activities with mail or chat via the 
activities plug-in, which is provided in the Lotus Notes 8 client. So any document, message, 
bookmark, file, to do or related activity can be dragged and dropped from the Lotus Notes 8 
client into an activity or vice versa.

1.2.9  Improve responsiveness to manage emerging business requirements

IBM Lotus Notes and Domino 8 software is built on an open application infrastructure that can 
help users to respond quickly to emerging business needs requiring collaboration and 
integration using applications that are even easier to build.

Note: The activities server, which is a component of the Lotus Connections product suite, 
would need to be installed and configured to leverage this functionality. More information 
about Lotus Connections and activities can be found at:

http://www.ibm.com/lotus/connections

Note: For more details on activities, refer to 6.9, “Activities” on page 176.
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The following enhancements and features make it possible to respond quickly and cost 
effectively to emerging business requirements:

� Build reusable components - Components built using Eclipse, Lotus Component 
Designer, Lotus Expeditor, or Rational® Application developer can be integrated or 
coupled with other components to create role-based composite applications that can be 
accessed using the Lotus Notes 8 client. This can help improve user effectiveness and 
have a positive impact on your business.

� Consume Web services - The ability to consume Web services allows your applications to 
interact with other systems using open standards, enabling users to leverage more of your 
existing IT investments.

� Support for DB2 access views and query views - Allows developers to rapidly build 
applications that blend collaborative services and relational data. Lotus Domino data can 
also be accessed using industry-standard Structured Query Language (SQL).

1.2.10  Increased offline productivity

Lotus Notes and Domino have long provided offline functionality, which has been one of key 
differentiators between Lotus Notes and other vendor solutions.

Lotus Notes and Domino 8 include offline enhancements such as:

� Recent contacts.
� Make available offline, which is a single-click functionality for taking applications offline.
� Facility to take composite applications offline.
� The ability to create blogs or perform free-time search.

These enhancements help scale the offline innovations in Lotus Notes and Domino 8 to new 
heights.

1.3  Scope and focus of this IBM Redbooks publication

Lotus Notes and Domino 8 software is more flexible and extensible than ever before. The 
client has been enhanced with a fresh, intuitive user interface and new capabilities like 
composite applications, activity-centric computing, and productivity tools for creating and 
sharing documents, presentations, and spreadsheets. The scope of this IBM Redbooks 
publication is to primarly focus on the core functionality in terms of enhancements and new 
features in Lotus Notes and Domino 8. 

Our focus is to provide the following information:

� Insight into the new features and enhancements in Lotus Notes and Domino 8 from a 
usability and productivity stand point

� Best practices with respect to planning a new or upgrading an exisiting Domino 
environment

� Roadmap on what is required to implement the new features or enhancements in Lotus 
Notes and Domino 8
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1.4  Structure of this IBM Redbooks Publication

This IBM Redbooks publication discusses the new features and enhancements in Lotus 
Notes and Domino 8. It helps you plan the deployment and provides a roadmap of how to 
effectively utilize the new functionality in the product.

Chapter 1, “Introduction” on page 1, introduces the business benefits of deploying Lotus 
Notes and Domino 8. It also explains the example scenario, which is used throughout this 
book.

Chapter 2, “Planning the Notes and Domino 8 Deployment” on page 15, discusses planning 
considerations for deploying Lotus Notes and Domino 8, both for existing and new 
deployments.

Chapter 3, “Deploying the Domino 8 server” on page 45, provides guidelines and 
recommendations required to install and configure Lotus Domino 8 Server into your new or 
existing environment.

Chapter 4, “Deploying the Notes 8 client” on page 63, discusses the considerations a Lotus 
administrator must make when deploying the Lotus Notes 8 client.

Chapter 5, “Coexistence: Domino/Domino and Domino/Microsoft Exchange” on page 93, 
discusses the principles of coexistence between Domino 8 and Domino 6.5/7, as well as 
touching on coexistence between Domino 8 and Microsoft Exchange 2000/2003.

Chapter 6, “Lotus Notes 8 client features” on page 113, focusses on the enhancements in the 
Lotus Notes client's core and extended capabilities, such as e-mail, calendaring and 
scheduling, contact management, instant messaging, presence awareness, and support for 
activity-centric computing.

Chapter 7, “Productivity tools” on page 199, discusses the new productivity tools that ship 
with Notes 8, which include:

� IBM Lotus Documents, for creating and editing word processing documents
� IBM Lotus Presentations, for creating and running presentations
� IBM Lotus Spreadsheets, for creating and editing spreadsheets
� IBM Lotus Productivity Tools Toolkit

Chapter 8, “Domino Web Access” on page 215, discusses the new and improved features in 
the IBM Lotus Domino Web Access 8 client, the Web client alternative to the Lotus Notes 
client.

Chapter 9, “New administration features” on page 241, introduces the major new 
administration features in Notes and Domino 8. This chapter also provides information about 
the installation and configuration of the new administration enhancements in Lotus Notes and 
Domino 8. This chapter also describes the Lotus Domino and DB2 deployment features.

Chapter 10, “New concepts in administration: Eclipse, composite applications, and 
provisioning” on page 313, provides a primer to Lotus Domino Administrators and Architects 
for deploying composite applications and provisioning updates.

Chapter 11, “IBM WebSphere Portal integration” on page 349, provides an insight into the 
new enhancements in Notes and Domino 8 with respect to IBM WebSphere Portal. The focus 
of this chapter is how WebSphere Portal features can be leveraged along with Lotus Notes 
and Domino 8.
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Chapter 12, “New application development features” on page 399, provides information about 
the exciting new abilities for the application developer. New design elements, formula 
language commands, and LotusScript® commands, to the new worlds of composite 
applications and DB2 integration, are covered in depth in this chapter.

1.5  Example scenario - ITSO Corp

In order to facilitate and illustrate the discussions with respect to the enterprise deployment of 
Lotus Notes and Domino 8 within a reasonably large organization, we use the example of a 
fictitous organization called ITSO Corporation, which we reference throughout this IBM 
Redbooks publication.

ITSO Corporation is a large global management consulting, technology services, and 
multi-product organization. It is organized around four geographic regions: North America, 
Europe, Asia, and Australia. The geographical layout of the organization is shown in 
Figure 1-3.

Figure 1-3   ITSO Corp geographic layout
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ITSO Corp was initially only located in Los Angeles and Austin in the USA, with Richmond in 
Australia. The network layout diagram in Figure 1-4 illustrates this.

Figure 1-4   Initial network layout at ITSO Corp
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In the subsequent chapters, this book uses the ITSO Corp example to explain the following:

� What steps ITSO Corp took to upgrade the LA hub server to Lotus Notes and Domino 8

� What steps ITSO Corp took to set up Boston and Delhi on Lotus Notes and Domino 8

� What steps ITSO Corp took to set up London as a Lotus Domino Application Server and 
achieve DB2 integration

� What steps ITSO Corp took to integrate the activities plug-in with Notes 8

� What steps ITSO Corp took to integrate WebSphere Portal with Lotus Notes and Domino 
8 to provide federation administration and other WebSphere Portal enhancements

Figure 1-5 illustrates the final network layout at ITSO Corp that was accomplished. 

Figure 1-5   Final network layout at ITSO Corp
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Chapter 2. Planning the Notes and
Domino 8 Deployment

This chapter discusses planning considerations for deploying Lotus Notes and Domino 8 for 
both existing and new deployments. 

Any sort of deployment project requires some degree of planning. This chapter gives you a 
framework to help identify and address planning considerations in your environment. This 
IBM Redbooks Publication does not advocate any specific project planning methodology, but 
provides guidelines and an approach that can be incorporated into your planning 
methodology of choice.

Whatever that methodology, it is crucial to view your deployment holistically, beginning with 
understanding the stakeholders in your environment. 

2

Note: The audience for this chapter is the person or team designated to review Notes and 
Domino 8 and determine how and where they should be used to further your business 
goals.
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2.1  Preparing to Deploy Notes and Domino 8

Whether you are deploying Domino for the first time in your infrastructure or upgrading an 
infrastructure that has been in place for 15 years, the same approach should be taken. This 
section discusses the process of preparing to deploy Domino from a holistic perspective, 
providing a general approach to deployment. The end of this section also discusses the 
different considerations for an upgrade or a new deployment.

While deployments of Notes and Domino have always been deeply intertwined with other 
enterprise-wide systems and software, such as hardware, networks, operating systems, 
storage, and the internet, the complexity and importance of that relationship has grown over 
time. Because of this, changes to any enterprise system cannot happen in a vacuum, and 
must be taken in context. This chapter will help you fully understand the context in which your 
deployment will occur. In essence, you need to ask yourself three questions, and then answer 
yourself honestly. Those three questions are:

� Where do you want to be?
� Where are you now?
� What is it going to take to get you there?

These questions are perhaps in a different order than you expected, and there is a reason for 
that. The key to imagining where you want to be is to free yourself from the constraints of 
where you are. Only after you understand where you want to go can you fully understand and 
address any obstacles that may lie in your path. 

In this chapter, we walk through these steps together, as you begin to visualize where you 
want to take your Notes and Domino Deployment, then figure out what it will take to get from 
where you are to where you want to be.

2.1.1  Identifying team members

Whether you are upgrading an existing Domino environment or planning a new deployment of 
Notes and Domino 8, the very first step in your deployment planning is also one of the most 
crucial. Identifying all stakeholders and representing all interests on your team are very 
important for a successful deployment. Examples of stakeholders in a large enterprise 
include:

� The CIO or CTO, who provides guidance on business needs and direction

� Business analysts or line-of-business managers, to represent specific needs

� The architecture team, which is responsible for the overall architecture of the 
infrastructure

� The deployment team, which is responsible for implementing new deployments

� The operations team, which is responsible for steady-state operations of the deployment

� The client team, which handles distribution of client software

� The registration tream, which adds, removes, and modifies users

� The support team, which responds to problems as they arise

� The development team, which creates and maintains Domino applications

� The users, who use the tools to perform their job duties to further business goals
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In some organizations, two or more of these functions may be handled by the same team. 
Depending on the complexity and maturity of your deployment, other stakeholders may also 
include:

� The hardware team
� The operating system team
� The storage team
� The network team
� The security team including firewalls and so on
� The WebSphere Application Server team
� The WebSphere Portal team
� The IBM DB2 or relational database team
� The enterprise directory team

The important thing is to look at your organization and determine what teams or individuals 
would be required to understand your environment, your business needs, your user needs, 
your current capabilities, and any obstacles. The team members who you identify must be 
able to represent the needs and interests of all identified stakeholders.

2.1.2  Defining the goals and scope of your deployment project

When planning an upgrade of your existing Domino infrastructure, you should define clear 
goals and objectives. For example, if one of your goals is to take advantage of the new mail 
and calendar features in Lotus Notes and Domino 8, such as the out-of-office service and 
ghosted calendar entries, you may want to target your mail servers, mail files/templates, and 
Notes clients first, and consider application migration as a separate project. If your company 
has multiple mail domains, you may also consider a phased approach, focusing on one 
domain at a time, particularly if hardware upgrades or replacements are needed in a 
particular region.

The importance of a project sponsor
You have a great team, you have a good understanding of your business, you are about to 
immerse yourself in Lotus Notes and Domino 8 — do you really need a project sponsor? In 
more and more cases, having a project sponsor can mean the difference between success 
and failure. 

A project sponsor is usually someone from within the organization, such as a business 
manager or business executive. The project sponsor should have two specific attributes:

� The person understands the business benefits of the project and has a real business 
interest in ensuring that the project is a success and that the new software implementation 
fulfills a business need for the organization.

� The person is in a position to ensure that the project stays on track and is a success.

Your project sponsor is not just there to give you your charter and walk away. Your project 
sponsor will help get approvals, remove obstacles, and help you stay on track. Most 
importantly, your project sponsor will continue to provide you with business direction, to 
ensure that your work is not being done in a vacuum. Your project sponsor is the bridge 
between your team and the needs of the organization. 

Your project sponsor works with you on the high-level goals, and helps define your vision. 
Additionally, having a project sponsor signals the importance of your project to the rest of the 
organization. It is your job to keep the sponsor informed and engaged, so that your sponsor 
can fulfill her duties as champion. Having an engaged and committed project sponsor will 
help you meet or exceed the goals of your deployment project.
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2.1.3  Understanding Lotus Notes and Domino 8

The key concept here is getting a good understanding of where you want to be. Lotus Notes 
and Domino 8 offer many innovations for users, administrators, and designers. Your 
challenge is to answer the following questions:

� What business needs are you trying to meet?
� How do new features and functions benefit:

– Your users?
– Your administrators?
– Your developers?
– Your business?

� Which features and technologies you want to use? 
� How you want to use them?

In order to develop your goals and objectives, you need to understand the features, functions, 
and benefits available to you in Lotus Notes and Domino 8.

For an overview of the benefits of Notes and Domino 8, see 1.2, “Business benefits of 
upgrading or deploying Lotus Notes and Domino 8” on page 2.

Later chapters have more detailed information about the exciting new capabilities in Lotus 
Notes and Domino 8.

� New features in Notes 8 - Chapter 6, “Lotus Notes 8 client features” on page 113

� Notes 8 Productivity Tools - Chapter 7, “Productivity tools” on page 199

� WebSphere Portal integration - Chapter 11, “IBM WebSphere Portal integration” on 
page 349

� New features in Domino Web Access 8 - Chapter 8, “Domino Web Access” on page 215

� New features for administrators - 9.1, “Introduction to new administration features” on 
page 242

� New features for developers, including composite applications - Chapter 12, “New 
application development features” on page 399

The information in these sections provides you with the information you need to begin to 
imagine what your deployment could be.

Think big
Now that you have an idea of what Lotus Notes and Domino 8 does, it is time to get creative. 
What does creativity have to do with deploying Notes and Domino 8? Everything. Any 
software deployment has the potential to change the way you do things, but often those of us 
in the IT community tend do things in a step-wise fashion, taking advantage of incremental 
changes. Rarely do we take advantage of the opportunity to imagine what could be. While 
you may not be able to implement all of your big ideas immediately, you may be able to see 
your infrastructure in a different light if you begin by imagining what could be. 

Regardless of the nature of your organization, the IT infrastructure exists to support the 
business. At its heart, IT is a business tool, helping your organization to do its work, whatever 
that work is. To use an analogy from the transportation business, no matter how well 
designed or built, a bridge to nowhere is still a bridge to nowhere. For this reason, it is critical 
to keep your business needs and direction clearly in mind when considering any changes to 
your IT infrastructure. Any changes should ultimately drive business needs and solve 
business problems.
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Here are some questions that you may ask yourself and your team as you begin to consider 
how to make the best use of Lotus Notes and Domino 8 in your environment:

� What business problems do you have that need a solution?
� What one thing has your organization always wanted to do, but has not been able to?
� If you could change anything in your infrastructure, what would it be?
� How can Lotus Notes and Domino 8 solve those problems?
� What features and functions of Lotus Notes and Domino 8 caught your attention?
� How can you see these features in your environment?

Brainstorming as a planning tool
You and your project team have the knowledge and perspective to advise your project 
sponsor and CIO/CTO how best to leverage Notes and Domino in your environment. With 
business needs as your guiding principle, and your knowledge of Notes and Domino as your 
framework, you and your project team can synthesize new ways of solving old problems in 
your organization.

At this stage of the game, you want to think big. You want to allow the members of your team 
to use their imaginations, unfettered at the moment by the realities of your existing 
infrastructure. You want to encourage your team to think outside of the constraints with which 
they normally function. This is the best way to visualize your ideal deployment. 

The process best suited to fostering the latent creativity in your project team is brainstorming. 
Brainstorming is a process wherein groups of people with a diversity of perspectives come 
together to creatively address problems. Often, reframing the problem is one of the key goals 
of a brainstorming session. Brainstorming can be a very effective approach to problem 
definition.

The generally accepted rules of brainstorming include:

� Encourage wild and exaggerated ideas.

Throw out all assumptions and preconceived notions. Encourage wild, non-linear thinking. 

� Generate as many ideas as possible.

In a brainstorming session, the idea is quantity, not quality. Introduce as many ideas as 
possible. The more ideas you generate, the more creative your team will be.

� Use the ideas of others as a springboard.

Free-associate as much as possible. Add to the ideas of others. Combine ideas. Put 
things together in unexpected ways.

� Every person, and every idea, has equal worth.

Encourage everyone to participate. During brainstorming sessions, it is okay to say things 
out loud as you think of them, as long as everyone’s ideas are listened to and everyone 
gets the opportunity to talk.

� Write everything down.

Use a whiteboard, but have all participants use paper as well. Have them write things 
down while calling them out, too. Capture everyone’s notes. Photocopy all notes and give 
them to the entire team.
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� There are no silly ideas. 

This is the most important rule. Do not rate, evaluate, or criticize ideas during the 
brainstorming session. Prohibit the use of roadblock phrases. These are obstacles to 
creativity during a brainstorming session. Examples of roadblock phrases that should be 
prohibited during your brainstorming sessions are:

– That will never work.
– We cannot do that.
– That is not the way we do things.
– We will never get approval for that.
– We do not have the hardware for that.

These rules are critical to a successful brainstorming session. Everyone on the team and 
everyone in the brainstorming session must understand these rules, and everyone 
participating must agree to abide by the rules.

Facilitating a brainstorming session
You may also want to consider conducting brainstorming sessions with a subset of your 
stakeholder representatives. For example, if many of the team members are individual 
contributors, the creative process might be stifled by the presence of managers, particularly 
managers 2 or 3 levels above. In these cases, you might find your brainstorming session a 
little flat, because participants might not want to state a wild idea in the presence of 
management, either for fear of offending the manager, or worse, for fear of management 
latching on to the idea and pushing for immediate implementation. 

The team members have to feel equal in their contributions and worth, or they may not fully 
engage in the process. You may also find that you need to have one or two sessions with the 
team to allow them to relax enough to unleash their creativity.

Additionally, you should try to build in diversity of viewpoints into the team. If everyone has 
the same viewpoint, you may experience the phenomenon of groupthink, where ideas are 
accepted on the basis of consensus. Groupthink can lead perfectly competent people to 
agree on mediocre ideas, without fully exploring all relevant issues. Diversity of viewpoint can 
help to ensure that issues are considered more thoroughly, which should lead to better ideas.

Defining the problem
Start your brainstorming session with an open-ended question, or a short statement 
describing the facts of the situation you want your team to consider, but which may not 
explicitly state a problem. Imposing a predefined problem on the team may restrain the 
team’s creativity. Instead, let the team formulate the problem based on their perception of the 
facts. 

It is often the case that using a narrowly construed problem definition limits the solutions that 
may be proposed. Broader problem statements tend to lead to more innovative approaches 
to problem solving. Some approaches to creative problem solving advocate discussing the 
facts of a situation, and using brainstorming as part of the problem definition process, not just 
the solution development process.

Example: reframing the problem provides a broader set of solutions
Problem definition is the most important part of solving any problem. How you define the 
problem has a direct impact on what solutions you will consider.

Situation: Your organization is receiving many calls to the help desk regarding perceived 
sluggish performance of a particular application, which is hosted in Los Angeles. Most of the 
reports come from users in Delhi. 
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Consider how framing the problem influences the solution.

Problem definition 1: We do not have enough bandwidth on our WAN to support application 
X, so our users in Delhi are complaining.

Solution: The solution is to increase bandwidth. 

Analysis: This problem statement is so narrowly construed that the solution is actually 
included in the problem statement. The problem is not actually a statement of the problem 
users are reporting, but it is a conclusion based on the facts. 

Now, consider how reframing the problem changes the potential solutions.

Problem definition 2: Users are reporting that they are having to sit and wait a long time to 
get responses from application X.

Solution: Perhaps the WAN connection is the problem. If so, replicating the application to a 
server in Delhi would be a solution, and perhaps users could have local replicas of the 
database on their workstations, thereby eliminating the need for synchronous access to the 
database in Los Angeles, and taking the WAN connection out of the picture. 

Perhaps the database design is the problem. If so, the database design could be modified to 
improve performance.

Perhaps the size of the database is the issue. If so, the database could be broken down into 
smaller databases, or dormant documents could be archived to an active archive database.

Analysis: In this case, the problem is defined from the perspective of facts, rather than 
conclusions. This leads to many more solutions, and increasing bandwidth is not necessarily 
one of them.

Documenting your results
After completing your brainstorming exercise, where you wrote every idea down, it is time to 
document what you came up with. What is your ideal architecture? Express this in a way that 
is meaningful to you and your team. This may include diagrams, descriptions, high-level 
overviews, strategies, specifications, even presentations. Document your results in a way that 
makes sense and captures the essence of your aspirations for your environment. 

You will be using your results at a later time to help you make decisions about what activities 
you will need to complete to deploy Notes and Domino. Do not worry if this is very ambitious 
at this stage. You will compare ideal to real soon enough. Remember that this is an 
aspiration, and that it is meant as a guide to help you plan for a successful Notes and 
Domino 8 deployment.

2.2  Evaluating your existing deployment

To have a successful upgrade, you must first understand your starting point and where you 
expect to be in the next six months to two years. Many deployments of Lotus Notes and 
Domino have grown organically over the years, with upgrades and additions occurring in an 
incremental fashion. Mergers and acquisitions often simply combine existing infrastructures 
together. New features are deployed by adding in additional servers. Bandwidth is added as 
needed. Generally, this incremental upgrade approach tends to be a tactical maneuver, and 
the speed of change does not often afford the opportunity to take a step back, understand 
what you have, and imagine what could be from a strategic perspective. 
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The project team, as described in 2.1.1, “Identifying team members” on page 16, should 
consider each of the areas on concern described in this section. The information gained in 
the exercise, while it does consider future needs, forms the starting point from where you will 
begin to plan your deployment.

Best practices suggest that a periodic review of needs should be undertaken, and the existing 
infrastructure assessed on the basis of how well it meets those needs. Ultimately, a best of 
breed deployment should be designed and used as an aspiration for improving the existing 
infrastructure. Planning for an enterprise-wide software upgrade is a good time to take that 
step back, and imagine how you might better meet the needs of your business by 
empowering your workforce with more efficient, better-targeted tools, allowing them to use 
the correct tool for each job. It is also a good time to consider taking advantage of technology 
improvements and understanding what it would take to implement those improvements. This 
section is intended to guide you through the process of evaluating where you are, the first 
step in planning a deployment.

A word about best practices
In the IT community, the term best practice is used widely and broadly. In general, a best 
practice is an accepted method of performing a particular task. In general, best practices may 
encompass actions or approaches that improve efficiency, fault tolerance, capacity, or 
availability. However, for one reason or another, best practices may not always be 
implemented in an enterprise, even if they are recognized and acknowledged by the 
resources supporting that enterprise.

When reviewing your environment, you should strive for accuracy above all. If you assume 
that a stated and accepted best practice is in use in your enterprise, be sure to test that 
assumption before documenting your results. For example, suppose your CIO has a stated 
policy that your organization clusters all mail servers. When constructing your infrastructure 
diagrams, it is advisable to confirm the clustermate for each mail server by reviewing the 
Domino directory. You may find some exceptions to your own organizations best practices, 
and those should be documented without bias as you evaluate your environment.

2.2.1  Organizational concerns

Every organization is different and has different needs and approaches. The first step in 
evaluating your existing deployment is understanding your organizational structure and how it 
affects your needs. The following checklist has questions you should answer about your 
organization, including plans for the immediate future.

� In how many countries do you do business?
� How many locations?
� How many employees?

2.2.2  User population

The types of users in your organization, as well as the distribution of each type, should be 
considered when evaluating your existing deployment. Examples of types of users you may 
have in your organization include:

� Executives
� Desktop users
� Laptop users
� Kiosk users

– Domino Web Access
– Notes multi-user
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� Other mobile users
– Telecommuters
– Mobile device users

The types of users you have in your organization will impact your decisions about which 
clients you deploy and how you distribute your software.

2.2.3  Network/infrastructure

When evaluating the readiness of your infrastructure for a Notes and Domino upgrade, you 
should consider the following areas. Again, planning should consider expected 
changes/increases/decreases over the next two years or so. Areas of concern when 
evaluating your network/infrastructure include:

� Geographic distribution of users and servers
� Network topology
� Current network bandwidth usage

– Within each geographic location
– Between locations

� Network bandwidth availability and cost for each geographic location
� Storage subsystems

Depending on the history of your organization and deployment, there may be other areas of 
concern as well.

When reviewing your network infrastructure readiness, it is also important to understand how 
well your infrastructure meets your current needs. For example, if you are currently at 
capacity on your networks or on your WAN connections, you may already be at the point 
where you need to add capacity just to keep up with current needs. 

Tip: The information you collect during your infrastructure review should be used to update 
existing diagrams of your environment or to create diagrams if they do not yet exist.

Documentation should also include:

� OS and software versions
� Mail routing topology
� Replication topology
� Customizations
� Standard deployments (client and server)
� Network links (LAN/WAN, plus capacity)
� Backup and storage topology
� Other data stores, such as WebSphere Portal Servers, DB2 servers, and WAS servers
� VPNs, DMZs, firewalls
� Anything else you deem relevant

Note: The last two to three years have seen explosive growth in Telecom infrastructure in 
many regions around the world, providing increased bandwidth, reliability, and competition. 
Organizations with offices in high-growth areas may want to review their existing telecom 
infrastructures in light of this growth.
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2.2.4  Anticipating future needs

While no one can see the future, planned changes should be considered, and certain things 
can be expected to increase. For instance, some companies regularly acquire new 
companies, or are expanding operations in certain regions. These changes should be 
considered when evaluating the current environment. Additionally, experience has shown us 
that as users become familiar with newer technology, their usage increases. When planning a 
new deployment, again, it is important to consider what your needs will be, not just what they 
are today.

Things to be considered:

� Planned mergers, acquisitions, divestitures
� Planned or expected hiring
� Increased usage of products due to new features
� Increased traffic on network/servers
� Increased mailfile or application size
� Planned changes in corporate strategy

Anticipating future needs is a very important part of understanding where you are now. They 
become part of the foundation for where you want to be. In other words, you cannot build for 
where you are now, because you will fail to meet the needs of the foreseeable future. You 
have to build for where you expect to be down the road if you want your deployment to be 
successful.

Again, in order to ensure that you have the correct insight, it is critical to ensure that all 
stakeholders are represented on the project team. Leaving out representation from the part of 
your organization that does resource planning may lead to a deployment that is unable to fully 
meet the needs of your organization.

2.2.5  Other concerns

There may be other things at play external to your environment, such as business pressures 
or government regulations, which may impact your deployment choices. These are unique for 
every organization, but some examples of these types of items include:

� Changes to Daylight Saving Time observance in 2006 and 2007
� Italian privacy regulations in 2005
� U.S. Federal Information Processing Standards (FIPS) compliance
� Canadian laws requiring software to be in French as well as English

There may be other externally imposed types of considerations as well. When evaluating your 
enterprise, you should include resources that are cognizant of these external forces, such as 
the office of your chief information officer (CIO), chief technology officer (CTO), or equivalent.

2.2.6  Considerations for upgrading an existing Domino infrastructure

In addition to the general areas of concern listed in this section, when you are evaluating an 
existing Domino infrastructure, there are some additional areas to be reviewed and 
evaluated. You should evaluate your current Domino environment thoroughly when planning 
your upgrade. Some things you should consider include:

� Domain and directory configuration
– The number of domains you have
– The types of domains you have
– The types of directories in use
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� Mail routing topology
� Replication topology
� Application topology
� User and server registration process used in your organization

– Naming standards for users and servers
– Domino certificates for organization and organizational units

� Domino software upgrade procedures currently used in your organization
� Hardware age and capacity
� Usage patterns on each server
� Template customization
� Third-party software

– Virus scanning
– Spam scanning
– Backup
– Monitoring
– Mobile device support

The goal of the review of your existing Domino environment is to understand whether it is 
meeting your needs and how close to capacity your environment is. Typically, older 
enterprise deployments have grown organically and incrementally, as the needs of the 
organization have changed. Growth in the size and maturity of an organization, mergers, 
acquisitions, and divestitures all have an effect on deployments, with changes typically being 
tactical and incremental, rather than strategic. 

When reviewing your Domino environment, you may find a need for some new hardware or 
added capacity. You may also see an opportunity for server consolidation. For information 
about consolidating your Domino environment, see Domino 7 Server Consolidation: Best 
Practices to Get the Most Out of Your Domino Infrastructure, REDP-4181-00, which can be 
found at the following URL:

http://redbooks.ibm.com/Redbooks.nsf/RedbookAbstracts/redp4181.html

For more information about deploying Domino 8 on new hardware, see 2.3.3, “Planning a new 
deployment of Notes and Domino 8” on page 38.

For a checklist to use when sizing a new Domino server, see Techpaper 7008851, 
“Notes/Domino Best Practices: Sizing,” available at this URL:

http://www.ibm.com/support/docview.wss?rs=203&uid=swg27008851

Considerations for mail servers
For many organizations, e-mail is considered a mission-critical application. For this reason, 
special attention should be given to the evaluation of your mail infrastructure. When 
assessing your Domino mail servers, you should consider each of the following areas:

� General server performance
– Responsiveness
– Average and peak CPU utilization
– Average and peak memory utilization
– Average and peak transactions per minute
– Average and peak disk utilization

� Total disk usage for mail files
� Average mail file size
� Largest mail files
� Current quota practices
� Current archiving practices
� Average number of messages processed each day
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� Average number of concurrent users
� Peak usage times
� Usage of local replica model
� Inbox size
� Attachment compression
� Standard settings and configurations
� Use of Web-based mail

– HTTP
– IMAP
– SSL
– RSS

You are probably already monitoring many of these things, and you may have historical data 
to show you how disk space usage and CPU utilization has increased over time. You may 
also track your top 10 largest mail files, and track the overall disk footprint of mail files on your 
servers. You may even have implemented an archiving and quota strategy to keep your mail 
files at or below a specified size, as well as a local replica model to improve user experience 
and decrease user impact in the event of network or server issues. 

Wherever you are today, understanding the work that your mail servers do is a very important 
part of assessing your overall Domino environment. 

Considerations for application servers
From a similar perspective, you should consider your application servers carefully. In some 
ways, your application servers are more difficult to assess than your mail servers because of 
different usage patterns and differences in application design. However, many of the same 
things should be assessed in your review.

Information to collect while assessing your application environment includes:

� List of all application servers in your environment
� List of any mixed-use servers (mail and application)
� Locations of critical and enterprise-wide applications
� List of servers dedicated to a specific application
� Inventory of all non-mail applications
� Usage patterns

– Critical and enterprise-wide applications
– Application servers

� Use of Web applications
– HTTP
– SSL
– RSS

� Replication topology
� Attachment handling
� Any specialized functions or features used by applications
� Backup methodology
� Dependencies between databases in complex applications (such as lookups)
� Use of applications to send mail

Using the database catalog on your application servers, or on any server on which you allow 
users to create databases, is a good way to develop your application inventory. The catalog 
also provides information such as ACL listings and information about reads and writes on the 
database. Additionally, you can redirect the output of a directory list command on the 
operating system to develop a list of all databases and applications on your servers.
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Because of the varied nature of applications, there may well be other concerns as well. It is 
important to work closely with your development teams to gain a full understanding of your 
application environment. 

Third-party applications
Like many organizations, you may have third-party applications in place in your environment, 
such as anti-spam, anti-virus, backup, and monitoring. When reviewing your Domino 
environment, it is important to fully understand the third-party applications you have in your 
environment.

Things to consider while assessing the use of third-party applications in your environment 
include:

� Which third-party applications you have in place
� Versions of each third-party application
� Dependencies for each third-party application
� Interaction between Domino and third-party applications

There may well be other concerns, depending on the nature of the third-party applications 
you have in place. Because of the variety of applications and vendors, it is important to work 
closely with the teams supporting these applications to fully understand their usage in your 
environment.

Template customization
When evaluating your environment, you should also consider any customizations that you 
have made to templates. It is possible that customizations have been made to mail templates, 
directory templates, and application templates that ship with Notes and Domino, such as 
teamroom and discussion. You need to consider any customizations that have been made, 
and determine whether any customizations need to be carried forward into the templates that 
ship with Notes and Domino 8.

If you do have template customizations, best practices suggest that you create a new custom 
template based on the template that ships with the version of code you deploy. This may 
involve re-coding certain changes to ensure full compatibility.

For more information about considerations for template management, see 3.3.4, “Review 
your template strategy” on page 47.

Evaluation questionnaire: existing Domino environment
Table 2-1 provides a checklist of things to consider based on the areas listed in this section. 

Table 2-1   Existing Domino environment evaluation questionnaire

Area of concern Things to consider

Stakeholders CTO/CIO
Users
Client/desktop software team
Deployment team
Domino admin/operations team
Help desk/support team
Network admin
Storage admin
Other admins (Portal, WAS, DB2, Web servers)
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Organizational 
concerns

Countries in which you do business
Number of locations/facilities
Number of users

Domino environment - 
general

Domain and directory configurations
The number of domains you have
The types of domains you have
The types of directories in use
Replication topology
Naming standards
Domino certificates in use (O, OUs)
User registration process used in your organization
Domino software upgrade procedures currently used in your 
organization
Hardware age and capacity
Template customization

Domino environment - 
mail

Locations of key mail files (executives)
Average mail file size per server
Largest mail files per server
Archive strategy
Quota strategy
Mail routing topology
Usage patterns on each server
Average number of messages processed each day
Average concurrency rate
Peak usage times
Usage of local replica model
Inbox size
Attachment compression
Standard settings and configurations
Use of IMAP/HTTP/SSL/RSS for mail

Domino environment - 
applications

Location of critical applications
Location of enterprise-wide applications
Usage patterns on each server
Any servers dedicated to a specific application
Use of HTTP/SSL/RSS for applications
Replication topology
Attachment handling
Specialized functions or features used by applications
Backup methodology
Dependencies between databases in complex applications (such as 
lookups)
Use of applications to send mail

User types Executives
Desktop
Laptop
Kiosk: DWA
Kiosk: Notes multi-user
Roaming users
Telecommuters
Mobile device users

Area of concern Things to consider
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2.2.7  Considerations for a new Domino deployment

When evaluating your existing environment in order to plan a new deployment of Domino, the 
process is essentially the same as for an existing Domino infrastructure upgrade. The 
additional concerns include:

� Designing your Domino architecture
– Planning your hierarchy
– Determining your organizational structure

� Setting your naming standards
� Defining your topologies

– Mail routing
– Replication

� Planning your administration strategy
– Centralized or regional
– User management
– Server management
– Application management

Network/Infrastructure Geographic distribution of users and servers
Network topology
Current network bandwidth usage in each geographic location and 
between locations
Network bandwidth availability and cost for each geographic location
Storage subsystems

Documentation Infrastructure diagrams
Standard configurations (client and server)
Lists of customizations
Procedure documents
Organizational best practices

Other concern Governmental regulations
Business pressures
Other data stores you may want to utilize

Future needs Planned mergers, acquisitions, divestitures
Planned or expected hiring
Increased usage of products due to new features
Increased traffic on network/servers
Increases in mail file or application size
Planned changes in corporate strategy

Third-party applications
(such as backup, 
anti-virus, anti-spam, 
monitoring, mobile)

Third-party applications you have in place
Versions of each third-party application
Dependencies for each third-party application
Interaction between Domino and third-party applications

Area of concern Things to consider
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Environment evaluation questionnaire: new Domino deployment
Table 2-2 is an environment evaluation questionnaire for new Domino deployment.

Table 2-2   Existing Domino environment evaluation questionnaire

Area of concern Things to consider

Stakeholders CTO/CIO
Users
Client/desktop software team
Deployment team
Domino admin/operations team
Help desk/support team
Network admin
Storage admin
Other admins (Portal, WAS, DB2, Web servers)

Organizational 
concerns

Countries in which you do business
Number of locations/facilities
Number of users

User types Executives
Desktop users
Laptop users
Kiosk: DWA
Kiosk: Notes multi-user
Roaming users
Telecommuters
Mobile device users

Network/infrastructure Geographic distribution of users and servers
Network topology
Current network bandwidth usage in each geographic location and 
between locations
Network bandwidth availability and cost for each geographic location
Storage subsystems

Documentation Infrastructure diagrams
OS and software versions
Standard configurations (client and server)
Lists of customizations
Procedure documents
Organizational best practices

Other concerns Governmental regulations
Business pressures
Other data stores you may want to utilize

Future needs Planned mergers, acquisitions, divestitures
Planned or expected hiring
Increased usage of products due to new features
Increased traffic on network/servers
Increases in mail file or application size
Planned changes in corporate strategy

Third-party applications Backup
Spam
Virus scanning
Monitoring
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2.3  Plotting your course

By working through the checklists earlier in this chapter, you have now answered the first two 
questions:

� Where do you want to be?
� Where are you now?

Now, you are ready to answer the final question: What is it going to take to get you there?

In essence, this part of the process is the easiest. You have all of your background 
information, you know what you need to accomplish, and essentially you just need to apply 
this to getting to where you want to be. This section will be your map.

2.3.1  Planning to upgrade your existing Domino servers

When planning to upgrade your existing Domino infrastructure, it is important to understand 
what is needed to get your environment ready to accept Domino 8. 

Understanding prerequisites
Preparing for an upgrade includes understanding and meeting all prerequisites for the 
upgrade, all the things that need to be in place before you begin the upgrade.

Things to consider at this stage include:

� Does your operating system meet the minimum requirements?
� Does your hardware meet the minimum requirements?
� Do you need to upgrade existing server hardware?
� Do you need to add or replace server hardware?
� Do you need to add more network bandwidth?
� Do you need to add more storage capacity?
� Does it make sense to consolidate?

The information that you have gathered in the infrastructure assessment should be used to 
help determine what actions will be required to meet the prerequisites to deploy Notes and 
Domino 8.

Evaluating server readiness
The tables below compare system requirements from Domino 7 to Domino 8 for all supported 
platforms, to allow you to determine if your hardware needs to be upgraded or replaced. The 
Domino 7 requirements are based on system requirements for Domino 7.0.2, as listed in the 
release notes for Notes and Domino 7.0.2. 

Note that with Domino 7.0.2, additional platform support was added to enable you to prepare 
your systems for Domino 8 prior to its release. This allows you to bridge any gaps you find in 
your preparedness now, in advance of deploying 8, and removes the need to perform 
hardware, operating system, and Domino upgrades all at once, allowing you to segment your 
upgrade activities in the most appropriate manner for your environment.

Tables 2-3, 2-4, 2-5, 2-6, 2-7, 2-8, and 2-9 compare the system requirements of Domino 7.0.2 
and 8 on all supported platforms.

Important: Note that with Domino 8, support has been discontinued for older versions of 
some operating systems that are out of vendor support. In most cases, these are replaced 
by supported versions, as shown in the following tables.
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Table 2-3   Comparison of system requirements from Domino 7 to Domino 8 on Windows  

Table 2-4   Comparison of system requirements from Domino 7 to Domino 8 on AIX

Table 2-5   Comparison of system requirements from Domino 7 to Domino 8 on Solaris™

Domino 7.0.2 Domino 8

Operating
system

Windows 2000 
Windows 2003

Windows 2003

Memory 256 MB minimum
512 MB or more recommended per CPU

512 MB minimum
512 MB or more recommended per CPU

Disk space 1.5 GB minimum per partition, more 
recommended

1.5 GB minimum per partition, more 
recommended

Processor Pentium® or better Pentium or better

Note: Windows 2000 is not supported for Domino 8.

Domino 7.0.2 Domino 8

Operating 
system

AIX 5.2
AIX 5.3

AIX 5.3

Memory 512 MB minimum
512 MB or more recommended per CPU

512 MB minimum
512 MB or more recommended per CPU

Disk space 1.5 GB minimum per partition, more 
recommended

1.5 GB minimum per partition, more 
recommended

Processor PowerPC® PowerPC

Note: AIX 5.2 is not supported for Domino 8.

Domino 7.0.2 Domino 8

Operating 
system

Solaris 9
Solaris 10

Solaris 10

Memory 512 MB minimum
512 MB or more recommended per CPU

512 MB minimum
512 MB or more recommended per CPU

Disk space 1.5 GB minimum per partition, more 
recommended

1.5 GB minimum per partition, more 
recommended

Processor UltraSPARC UltraSPARC III or better

Note: Solaris 9 is not supported for Domino 8.
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Table 2-6   Comparison of System Requirements from Domino 7 to Domino 8 on Linux

Table 2-7   Comparison of system requirements from Domino 7 to Domino 8 on System i™ 

Table 2-8   Comparison of system requirements from Domino 7 to Domino 8 on System z™

Domino 7.0.2 Domino 8

Operating 
System

Novell SLES 8
Novell SLES 9
Novell SLES 10 (32-bit)
Novell SLES 10 (64-bit)
Red Hat RHEL 4 (32-bit)
Red Hat RHEL 4 (64-bit)

Novell SLES 10 (32-bit)
Novell SLES 10 (64-bit)
Red Hat RHEL 5 (32-bit)
Red Hat RHEL 5 (64-bit)

Memory 512 MB minimum
512 MB or more recommended per CPU

512 MB minimum
512 MB or more recommended per CPU

Disk Space 1.5 GB minimum per partition, more 
recommended

1.5 GB minimum per partition, more 
recommended

Processor Pentium or better Pentium or better

Note: SUSE Linux Enterprise Server 8 and 9, and Red Hat RHEL 4 are not supported for 
Domino 8.

Domino 7.0.2 Domino 8

Operating 
system

i5/OS® V5R3
i5/OS V5R4

i5/OS V5R4

Memory 288 MB minimum
512 MB or more recommended per 
Domino server

512 MB minimum
512 MB or more recommended per 
Domino server

Disk space 1.6 GB minimum
2 GB or more recommended

2 GB minimum
4 or more drives recommended

Processor eServer™ i5 model 520 and later iSeries® 270 and 8XX
eServer i5 model 520-901 and later

iSeries 270, 800-2464, 810-2465, and 
eServer i5 520-0901 recommended for 
Notes-based mail or light applications 
only

eServer i5 520-902 or later 
recommended for CPU-intensive 
workloads

Note: iSeries 800-2463 and eServer i5 520-0900 are not supported for Domino 8. i5/OS 
V5R3 is no longer supported for Domino 8.

Domino 7.0.2 Domino 8

Operating 
system

z/OS® Version 1, Release 5 or later
z/OSe Version 1, Release 5 or later

z/OS Version 1, Release 7 or later;
z/OSe Version 1, Release 7 or later
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Table 2-9   Comparison of system requirements from Domino 7 to Domino 8 on Linux for System z

Consolidation
When reviewing your Domino environment, you may have found your environment in need of 
some level of consolidation, such as domain consolidation or server consolidation. If you are 
considering consolidation, it would be wise to conduct the consolidation as part of your 
prerequisite activities. While consolidation is not a prerequisite, best practices suggest that, 
should you want to consolidate, you should do so before upgrading, to avoid making multiple 
changes at once. Then upgrade those servers to Domino 8 only after the consolidation has 
been successful.

For more information about consolidation, see Domino 7 Server Consolidation: Best 
Practices to Get the Most Out of Your Domino Infrastructure, REDP-4181, available at the 
following URL:

http://www.redbooks.com/Redbooks.nsf/RedbookAbstracts/redp4181.html

Memory 1 GB Minimum
2 GB or more recommended

1 GB Minimum
2 GB or more recommended

Disk space Three 3390-3 volumes minimum Three 3390-3 volumes minimum

Processor Any processor that supports your 
release of z/OS

Any processor that supports your 
release of z/OS

Note: z/OS Version 1, Release 5 is no longer supported for Domino 8.

Domino 7 Domino 8

Operating 
system

Novell SLES 8 on System z (31-bit)
Novell SLES 9 on System z (64-bit)
Novell SLES 10 on System z (64-bit)
Red Hat RHEL 4 on System z (64-bit)

Novell SLES 10 on System z (64-bit)
Red Hat RHEL 5 on System z (64-bit)

Memory 1 GB minimum
2 GB or more recommended

1 GB minimum
2 GB or more recommended

Disk space 2.5 GB minimum, more recommended 2.5 GB minimum, more recommended

Processor Any processor that supports your 
release of Linux of System z

Any processor that supports your 
release of Linux of System z

Note: Novell SLES 8 on System z (31-bit), Novell SLES 9 on System z (64-bit), and Red 
Hat RHEL 4 on System z (64-bit) are no longer supported for Domino 8.

Domino 7.0.2 Domino 8
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Mail file management
When reviewing your mail servers, you may have found some things you would like to 
change. Are there things that you would like to implement that you have not yet 
implemented? Some things you may want to consider include:

� Managing user mail file size
– Implementing quotas
– Implementing archiving
– Managing template size
– Managing the size of user inboxes

� Implementing a local replica model

For more information about management of large mail files, see the developerWorks® article 
“Best Practices for large Lotus Notes mail files,” which discusses the impact of mail file size 
on performance, as well as the impact of inbox size on server performance. The article can 
be found at this URL:

http://www.ibm.com/developerworks/lotus/library/notes-mail-files/

This article suggests that smaller inboxes may improve server performance, and it also 
suggests the use of archiving and quotas to assist in addressing mail file growth. While 
archiving and quotas have been around for a while, Domino 8 has introduced functionality to 
assist in maintaining smaller inboxes. For more information see 9.4, “Inbox maintenance” on 
page 249.

Another consideration for mail servers is the impact of the mail template on mail file size and 
total disk utilization. Table 2-10 shows the size of the out-of-the-box mail template in 7 and 8. 
The third column shows the impact of using the design note compression that ODS 48 makes 
available. 

Table 2-10   Out-of-the-Box Mail Template size comparison

As the table clearly illustrates, on a server with 1,000 mail files, upgrading the Domino 8 could 
increase total disk usage by 8 GB. However, enabling design note compression could 
actually save you 6 GB over what you would be using today, significantly decreasing your disk 
overhead on a per-mailfile basis. For more details on design note compression, see “Design 
compression” on page 279.

For a comparison of local and server-based mail, see the developerWorks article “Lotus 
Notes Mail: comparing Server-based mail and local replica mail” at the this URL:

http://www.ibm.com/developerworks/lotus/library/serverlocalmail/

This article discusses the advantages and disadvantages of using local mail replicas, and 
suggests that in many situations, a local replica model is a better choice.

Mail 7 template Mail 8 template 
(ODS 43)

Mail 8 template 
(ODS 48 with design 
note compression)

Template only 17 MB 25 MB 11 MB

Template in 
1,000 mail files

17 GB 25 GB 11 GB

Net change per 
1,000 mail files

--- +8 GB -6 GB
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Application considerations
From an application perspective, there a few things to consider when planning to upgrade 
your application servers. While it is not necessary to rewrite your pre-existing applications, we 
strongly recommend testing your applications on Domino 8 before upgrading your production 
application servers. 

In previous steps, you collected the information about your applications. Using this 
information, you can target your testing appropriately. Additionally, once your application has 
been tested and the application server upgraded, you can consider modifying the application 
to take advantage of new application development functionality in Domino 8.

Leveraging new application development functionality
While it is not necessary to upgrade your applications to run them in a Lotus Notes and 
Domino 8 environment, you may want to leverage the new application development 
functionality available with Domino 8. 

At this stage, you may want to identify the new application development features you would 
like to leverage in your Domino applications. For more information about this, see Chapter 12, 
“New application development features” on page 399.

Third-party applications
Your third-party applications also have prerequisites, and server readiness includes making 
sure that your environment meets the prerequisites for supported versions of your third-party 
applications. In some cases, you may need to upgrade to a later version of a third-party 
application to support Domino 8. Understanding the version and patch requirements for your 
third-party applications is critical to your successful deployment.

2.3.2  Planning to deploy Lotus Notes 8

The first thing to consider when planning to deploy Lotus Notes 8 is whether your client base 
meets the minimum requirements. While Lotus Notes and Domino 7 was a server-centric 
release, Lotus Notes and Domino 8 are client-centric releases. Many new capabilities have 
been added, and the system requirements for Lotus Notes 8 are significantly greater than 
what was required to run Lotus Notes 7. 

Understanding prerequisites
When planning to upgrade existing clients, whether they are Notes clients or Domino Web 
Access clients, you need to understand the system requirements for deploying the new 
versions. The tables that follow provide guidance in understanding your hardware and 
software prerequisites.

Important: We advise following the recommended upgrade path, which suggests 
upgrading your application servers last, after you have upgraded your mail servers and 
Notes clients.

For more information about the recommended upgrade path, see 3.4, “Defining the 
deployment sequence” on page 49.

Note: Note that many base model notebook and desktop computers available from leading 
PC makers today meet the minimum requirements for Lotus Notes 8.
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Evaluating workstation readiness: Lotus Notes 8
Table 2-11 compares system requirements for Lotus Notes 7 and Lotus Notes 8.

Table 2-11   Comparison of system requirements on Notes 7 and Notes 8

Evaluating workstation readiness: Domino Web Access 8
The following tables provide comparisons of system requirements for Domino Web Access 7 
and 8 on Windows, Linux, and Macintosh.

Table 2-12 compares system requirements for Domino Web Access 7 and 8 on Windows.

Table 2-12   Comparison of system requirements for Domino Web Access 7 and 8 on Windows 

Notes 7 Notes 8

Memory 128 MB minimum
256 MB or more recommended
(Windows 2000 and Windows XP)

Windows XP: 512 MB minimum,
1 GB or more recommended

Windows Vista®: 1 GB minimum,
1.5 GB or more recommended

Linux: 512 MB minimum,
1 GB or more recommended

Disk Space 275 MB required Windows: 900 MB required, more 
recommended 

Linux: 1.5 GB minimum, more 
recommended

Processor Pentium or better Pentium or better

Attention: A basic configuration of Notes 8 is available for low-memory client machines. 
Workstations running the basic configuration of Notes 8 are unable to take advantage of 
components built on the Eclipse framework, such as composite applications, productivity 
tools, the sidebar, vertical preview pane, and mail improvements related to recent 
contacts, such as drop-down addressing. 

For more information about what Notes 8 features are available with this configuration, see 
“Features not available in "basic" configuration of Notes 8” in the Notes and Domino 8 
release notes.

DWA 7 DWA 8

Client 
operating 
system

Windows 2000
Windows XP Professional 

Windows XP
Windows Vista

Browser Internet Explorer® 6.0

Mozilla Firefox 1.0.x and 1.5.0.2 or later
Note: Does not support Lotus Sametime 
awareness

Internet Explorer 6
Internet Explorer 7
Mozilla Firefox 2.0 or later

Memory 128 MB minimum
512 MB or more recommended

128 MB minimum
512 MB or more recommended

Processor Pentium III 400 MHz minimum, Pentium 
IV 1.0 GHz or better recommended

Pentium III 400 MHz minimum, Pentium 
IV 1.0 GHz or better recommended
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Table 2-13 compares system requirements for Domino Web Access 7 and 8 on Linux.

Table 2-13   Comparison of system requirements or Domino Web Access 7 and 8 on Linux 

Table 2-14 compares system requirements for Domino Web Access 7 and 8 on Macintosh.

Table 2-14   Comparison of system requirements for Domino Web Access 7 and 8 on Macintosh 

2.3.3  Planning a new deployment of Notes and Domino 8

For a new deployment, you need to consider many of the same things as when planning to 
upgrade an existing infrastructure:

� Organizational structure
� Network/infrastructure
� User types

But you also need to plan your Domino environment, considering:

� Architecture
� Naming Standards for users and servers
� Domain structure
� Domino server platform
� Third-party products you may need:

DWA 7 DWA 8

Client 
operating 
system

Novell SuSE Linux Desktop (SLD) 8
Novell Linux Desktop (NLD) 9
Novell Red Hat Enterprise Linux 
Desktop (RHELD) 4

Novell Linux Desktop (NLD) 10
Linux RedHat RHEL 5.0

Browser Mozilla Firefox 1.0.x and 1.5.0.2 or later
Mozilla 1.7.x, but without Domino 
Off-Line Services (DOLS) and local 
archiving

Mozilla Firefox 2.0 or later

Memory 192 MB minimum
512 MB or more recommended

192 MB minimum
512 MB or more recommended

Processor Pentium III 500 MHz minimum, Pentium 
IV 1.0 GHz or better recommended

Pentium III 500 MHz minimum, Pentium 
IV 1.0 GHz or better recommended

DWA 7 DWA 8

Memory 256 MB minimum
512 MB or more recommended

256 MB minimum
512 MB or more recommended

Client 
operating 
system

OS 10.4.x OS 10.4.x

Browser Mozilla 1.7x
Mozilla Firefox 1.0.x and 1.5.0.2 or later
Note: Does not support Domino Off-Line 
Services (DOLS), local archiving, or 
Lotus Sametime awareness

Mozilla Firefox 2.0 or later 
Note: Does not support Domino Off-Line 
Services (DOLS), local archiving, or 
Lotus Sametime awareness

Processor G4 1.0 GHz minimum, 1.25 GHz or 
better recommended

G4 1.0 GHz minimum, 1.25 GHz or 
better recommended
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– Backup
– Anti-virus
– Anti-spam
– Monitoring
– Mobile device support

2.3.4  A word about pilot deployment

When working with new software, whether a new version or a completely new product, many 
companies include a pilot phase in their project plans. In a pilot, a smaller, representative 
group of servers and users are upgraded. Often, pilot projects are used to improve 
deployment procedures and practices before deploying to the enterprise, and they allow the 
project team the opportunity to test assumptions and fine-tune procedures.

The knowledge and experience gained during a pilot deployment can dramatically improve 
results of a production deployment, because it can uncover unanticipated problems in the 
environment, and allow them to be resolved during the pilot phase, rather than after the 
product has gone into wide production. Additionally, pilot projects typically have a specified 
duration, and at the end of the specified time period, the success of the pilot is evaluated, and 
lessons-learned are captured and documented.

Some organizations choose to conduct their pilot deployment using the dot zero release of 
new software, but standardize their wide-scale deployment on later point releases of the 
software. This approach may work for you, as it has the benefit of allowing your organization 
to take advantage of any fixes for problems that may be discovered after the initial release of 
the product.

2.3.5  Creating a communication and training plan

When making any changes to your environment that could impact users, it is advisable to 
communicate the nature of the changes to the community, particularly if user action is 
required either before or after the changes occur.

If you are planning to implement a new product or take advantage of new features, some 
level of training may be needed for some or all of the stakeholder community.

The following sections discuss some of the groups that may be impacted by your Domino 8 
deployment.

Users
Users will be affected because they will be using a new interface, with new features available 
to them. User needs should be considered when determining your training and 
communication needs, particularly if any action will be required on the users’ part. 
Additionally, users with a more complete understanding of the product may open fewer help 
desk tickets, decreasing the burden on your help desk personnel, and potentially lowering 
your help desk costs.

For more information about Lotus Notes 8, see Chapter 6, “Lotus Notes 8 client features” on 
page 113.

Client/desktop software team
The team tasked with deploying Notes 8 should definitely be considered for your 
communication and training plan. This team will be responsible for implementing the software 
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based on the needs you identify, such as type of user (as discussed in 2.2.2, “User 
population” on page 22), and which client features you plan to implement.

For more information about deploying Lotus Notes 8, see Chapter 4, “Deploying the Notes 8 
client” on page 63.

Domino Administrators/operations staff
Your administrators and operations staff will also be affected. They will be responsible for 
actually installing the Domino server software onto your servers, and they will be managing 
steady-state operations and problem response. They need to understand what is new in 
Domino 8, and whether any changes will affect their job duties.

For form information about new features for administrators, see Chapter 9, “New 
administration features” on page 241.

For information about the tasks required to upgrade your Domino servers, see Chapter 3, 
“Deploying the Domino 8 server” on page 45.

Help desk
The people who respond to problems reported in your environment need to be considered 
when developing your communications and training plan. From the people in the call center 
who answer the phone to the people who have to perform problem determination and 
interface with Lotus technical support, all will be affected, and will have to understand how to 
perform their job duties when addressing issues with the deployment.

Developers
Developers should also be considered, as you may have plans to take advantage of some of 
the new application development capabilities in Domino 8, such as composite applications. In 
order to leverage these new capabilities, your developers must understand these functions.

For more information about the new features for developers, see Chapter 12, “New 
application development features” on page 399.

Network/operating system administrators
Communicating with ancillary team members is particularly important, because Domino is 
completely dependent on the network infrastructure. Network administrators need to be 
aware of any prerequisites that must be met before you begin deploying Domino 8. In this 
context, prerequisites may include anything from operating system patch levels to additional 
bandwidth, based on your assessed needs.

Storage team
In the enterprise, most organizations have some sort of external or remote storage, such as a 
Storage Area Network (SAN) or Network Attached Storage (NAS). If your Domino 8 
deployment will take advantage of external storage, your storage team will need to be 
included in the communications plan.

2.4  System requirements

This section includes the supported platforms for Lotus Notes and Domino 8, as well as the 
minimum system requirements.
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2.4.1  Lotus Notes 8 supported platforms

This section contains the supported platforms for Lotus Notes 8.

Microsoft Windows
The following are supported platforms for Lotus Notes 8:

� Microsoft Windows XP Professional, Service Pack 2
� Microsoft Windows XP Tablet Edition
� Microsoft Windows Vista Ultimate with Aero™
� Microsoft Windows Vista Ultimate Tablet Edition

On Windows XP, 512 MB RAM is required at minimum, with 1 GB RAM or higher 
recommended.

On Windows Vista, 1 GB RAM is required at minimum, with 1.5 GB RAM or higher 
recommended.

Linux
The supported Linux platforms for Lotus Notes 8 are:

� Novell SUSE Linux Enterprise Desktop (SLED) 10 XGL™.
� RedHat Enterprise Linux (RHEL) 5 Desktop. XGL and SELinux must be disabled

For Linux, 512 MB RAM is required at minimum, with 1 GB RAM or higher recommended.

2.4.2  Domino Designer 8, Domino Administrator 8 supported platforms

The supported platforms for Domino 8 Designer and Domino 8 administrator are:

� Microsoft Windows XP Professional, Service Pack 2
� Microsoft Windows Vista Ultimate with Aero

On Windows XP, 512 MB RAM is required at minimum, with 1 GB RAM or higher 
recommended.

On Windows Vista, 1 GB RAM is required at minimum, with 1.5 GB RAM or higher 
recommended.

2.4.3  Domino Web Administrator 8 supported platforms

The supported platforms for Domino Web Administrator 8 are:

� Microsoft Windows

– Internet Explorer 6 and 7

– Mozilla Firefox 1.4.x, 1.5.x, 2.0.x, or later

� Linux

Mozilla Firefox 1.4.x, 1.5.x, 2.0.x, or later

Tip: For comparisons of system requirements in Lotus Notes 7 and 8, refer to “Evaluating 
workstation readiness: Lotus Notes 8” on page 37.
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2.4.4  Domino Web Access 8 supported platforms

The requirements for Domino Web Access 8 are listed below.

Client hardware requirements
Recommended for better performance:

� Windows - Pentium IV 1 GHz with 512 MB of memory
� Linux - Pentium IV 1 GHz with 512 MB of memory 
� Macintosh - G4 1.25 GHz with 512 MB of memory

Minimum requirements:

� Windows - Pentium III 400 MHz with 128 MB of memory
� Linux - Pentium III 500 MHz with 192 MB of memory 
� Macintosh - G4 1 GHz 256 MB of memory

Client operating systems and supported browsers
This section lists the operating system and browser requirements for Domino Web Access.

Windows XP and Vista using the following browsers:

� Internet Explorer 6 and 7
� Mozilla Firefox 2.0 or later
� Novell Linux Desktop (NLD) 10 using Mozilla Firefox 2.0 or later
� Linux RedHat RHEL 5.0 using Mozilla Firefox 2.0 or later
� Macintosh OS 10.4.x, using Mozilla Firefox 2.0 or later

2.4.5  Lotus Domino 8 supported platforms

The platforms that are supported by Lotus Domino 8 are listed in the sections that follow. See 
the release notes for patch and service pack requirements.

Important: Domino Web Access does not work if JavaScript™ or session cookies are 
disabled.

Attention: Attempting to access Domino Web Access through unsupported browsers 
results in the display of an unsupported browser notice. Netscape 4.x users may see 
hangs or crashes when encountering the Domino Web Access unsupported browser page. 
If you are a Netscape 4.x user and you encounter these problems, you should open your 
mail file using the WebMail UI directly through the &ui=webmail switch. This is documented 
in the topic Switching to WebMail in the Domino Web Access help.

Note: This configuration does not support Domino Off-Line Services (DOLS), local 
archiving, or Lotus Sametime awareness.

Restriction: For all operating systems, Mozilla Firefox is supported by the DWA7 and 
DWA8 mail templates only. It is not supported by iNotes6 templates.

Tip: For a comparison of system requirements for Domino Web Access 7 and 8, refer to 
“Evaluating workstation readiness: Domino Web Access 8” on page 37.
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Note that Domino 8 support has been dropped for older versions of some operating systems 
that are now obsolete. 

Microsoft Windows
The supported Microsoft Windows platforms are:

� Windows 2003 Server Standard Edition, Service Pack 1
� Windows 2003 Server Enterprise Edition, Service Pack 1
� Windows 2003 Server x64 Edition

UNIX
The supported UNIX® platforms are:

� IBM AIX 5.3
� Sun™ Solaris 10

Note that for both operating systems, the 64-bit kernel is required.

iSeries
The supported iSeries platform is IBM i5/OS V5R4.

Linux
The supported Linux platforms are:

� Novell SUSE Linux Enterprise Server (SLES) 10 with 32-bit kernel
� Novell SUSE Linux Enterprise Server 10 with 64-bit kernel
� Novell SUSE Linux Enterprise Server 10 for zSeries® with 64-bit kernel
� Red Hat Enterprise Linux (RHEL) 5 with 32-bit kernel
� Red Hat Enterprise Linux 5 with 64-bit kernel

zSeries
The supported platforms for zSeries are:

� IBM z/OS Version 1, Release 7 and later
� IBM z/OSe Version 1, Release 7 and later

Tip: For a comparison of system requirements for Domino 7 and 8, refer to “Evaluating 
server readiness” on page 31.
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Chapter 3. Deploying the Domino 8 server

This chapter provides recommendations and best practices for planning, installing, and 
testing Domino 8 into your new or existing Domino server infrastructure. While your upgrade 
plan must be tailored to your own environment, this chapter provides a high-level outline of a 
typical enterprise deployment that can be used as a base reference.

Additionally, this chapter covers the optional steps of upgrading to the Domino 8 On-Disk 
Structure (ODS) of your Notes databases the extended capabilities available with Notes and 
Domino 8 that require additional server deployment, including activities, composite 
applications, and the Domino and DB2 feature.

In this chapter the following topics are discussed:

� Planning for the Lotus Domino 8 deployment
� Defining the Lotus Domino 8 deployment sequence
� Deploying the Lotus Domino 8 servers
� Upgrading to the Lotus Domino 8 ODS
� Extending the Lotus Domino 8 capabilities

3
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3.1  Introduction to deploying Domino 8

Now that we covered the high-level planning for Notes and Domino 8 in Chapter 2, “Planning 
the Notes and Domino 8 Deployment” on page 15, we are ready to tackle the deployment of 
the Domino 8 servers into our infrastructure. 

The good news is that since Notes and Domino 8 is a client-centric release, the Domino 
deployment considerations, sequence, and installation have, for the most part, remained 
unchanged from prior Lotus Domino releases. This allows us to focus our efforts on planning 
for and enabling the new Domino 8 administration features, which are described in detail in 
Chapter 9, “New administration features” on page 241.

In 3.3, “Planning lays the foundation for deployment” on page 46, we cover some additional 
planning steps that are Domino 8-specific. Section 3.4, “Defining the deployment sequence” 
on page 49, lays out the upgrade path, and we then progress to the actual Domino code 
installation in 3.5.4, “Installing the Domino 8 code across your Domino domain” on page 55. 
Finally, we discuss the optional ODS upgrade and extended capabilities of Notes and 
Domino 8.

3.2  Domino upgrade versus new installation

As mentioned in 2.2.7, “Considerations for a new Domino deployment” on page 29, the 
process of deploying new Domino servers is similar to upgrading existing Domino servers. 
Given this fact, this chapter assumes a Domino upgrade, but will call out anything that is 
required or unique to a new Domino deployment.

3.3  Planning lays the foundation for deployment

As detailed in Chapter 2, “Planning the Notes and Domino 8 Deployment” on page 15, 
planning is essential to a successful deployment of Notes and Domino 8. This section covers 
the Domino server specific planning steps that are required when deploying Domino 8.

3.3.1  Pilot deployment of Notes and Domino 8

As discussed in 2.3.4, “A word about pilot deployment” on page 39, leverage your pilot or 
pre-production environment not only to test your procedures that directly relate to the Domino 
code installation itself, but also for testing your implementation of your template strategy, 
control of Domino directory design, new Domino 8 features, and other mechanisms that 
maintain administrative control over your Domino environment. The goal is to create a 
miniature production environment, mirroring the hardware, software, network, and other 
elements as much as possible.

3.3.2  Isolate the Domino 8 deployment from other system changes

For existing Domino deployments, best practices recommend performing any non-Domino 
server code upgrades or consolidation work prior to beginning the deployment of Domino 8. 
While it may save time and money in the short term, piggy-backing system changes like a 
consolidation or operating system upgrade on a Domino upgrade is risky. Introducing 
changes to high availability applications like IBM Lotus Domino should be performed in a 
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systematic step-by-step approach in order to isolate the root cause and resolve potential 
problems.

3.3.3  Planning for Domino coexistence

The issue of Domino version and product coexistence has not been very problematic given 
the backwards compatibility that IBM Lotus builds into the Notes and Domino products. With 
that said, there are certain elements of risk that should be examined and approached with 
caution. A full examination of the considerations and recommendations of Domino version 
and Domino and Microsoft Exchange coexistence is available in Chapter 5, “Coexistence: 
Domino/Domino and Domino/Microsoft Exchange” on page 93.

3.3.4  Review your template strategy

An essential planning step for deploying Domino 8, as was the case for prior versions of IBM 
Lotus Notes and Domino, is to review your template deployment and maintenance strategy. 
Managing your templates is important because a lot of the new functionality in a new major 
release of Domino is due to new design elements that are pushed from template to system 
databases.

Here are some of the more common methods of Domino template management:

� Centrally managing templates from one Domino server or a subset of servers

� Modifying the ACL to grant limited rights to the servers and potential users

� Modifying the template name inheritance, replica ID, and template file name

� Disabling the replication of all the templates

� Removing all templates from the Domino server and removing the nightly run of the 
design task

You should use one or more of the above methods to manage your templates. For more 
information about template strategy, including details on how to create your own template 
package, reference the Lotus Notes and Domino 7 Enterprise Upgrade Best Practices 
Redpaper at the following URL:

http://www.redbooks.ibm.com/abstracts/redp4120.html?Open

The method used to manage your templates depends on what you and your Domino 
administration team have found to work in the past in your environment and how tightly you 
want to manage and protect your templates in the future.

3.3.5  Controlling and managing your Domino directory design

The Domino directory is the heart of your Domino infrastructure, and access to the database, 
including the design, should be tightly controlled. Any erroneous or ill-timed changes to the 
design or contents of the directory could result in Domino server unresponsiveness or other 

Note: If you have customized any of the pre-Domino 8 templates, such as the mail 
template, make sure to thoroughly test your modifications on the new Domino 8 templates 
before deploying the updated templates to your Notes mail files or database applications. 
In order to take advantage of the new design features in Domino 8, we recommend making 
customizations to the new Domino 8 templates, rather than using back-leveled templates.
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unexpected behavior. Therefore, an essential planning step is to devise or design a method 
of locking down your Domino directory design or reviewing your existing method.

You should set your ACLs to only allow administrator access to the Domino directory 
configuration documents. The replication flow of both data and design of the Domino directory 
from a high-level hub, most likely your administration hub, to your other hub and spoke 
servers should be managed through ACL settings.

In addition to ACL settings, there are other means of controlling the design of the Domino 
directory, including modifying the Domino directory template inheritance and selecting the 
Replace Design on Admin Server Only database property. These methods, as well as the 
ACL settings, are documented in the Lotus Notes and Domino 7 Enterprise Upgrade Best 
Practices Redpaper at the following URL:

http://www.redbooks.ibm.com/abstracts/redp4120.html?Open

If your organization has customized the Domino directory, you should compare your custom 
design elements to the default Domino 8 directory design elements to see if the 
customizations are still needed. If they are still needed, add the customizations to the new 
Domino directory design. Remember, customized templates are not supported by IBM Lotus, 
so if your customizations provide similar functionality to the Domino 8 template, we 
recommend using the out-of-the-box template.

The ultimate goal is to protect the new Domino directory design during the Domino 8 
deployment and beyond, whether it contains customizations or not.

3.3.6  Additional Domino 8 planning considerations 

Prior to upgrading to Domino 8 you need to decide which of the new features to implement 
and when to implement them. In some cases, new Domino features are enabled by default, 
while in other cases they are disabled, with the latter usually being the case. This section 
focuses on the features that are enabled by default, for example, the new message recall 
feature.

As a best practice, upgrade the server and verify stability at the new code level in your 
production environment. Only then should you enable new features. Achieving a steady state 
after upgrading will help you isolate any potential issues that may arise during the 
enablement of new Domino 8 features.

Note: One of the major new Domino 8 Domino directory design enhancements is the 
inclusion of a By Client Version view, which is a Person view sorted by the Notes client 
build users have listed in the Notes client build field in the Administration tab. Note that 
users will be listed multiple times if they have more than one Notes client version listed in 
the Notes client build field.

Attention: Chapter 9, “New administration features” on page 241, provides a thorough 
description of the major new Lotus Domino 8 administration features, including features 
enabled and disabled by default, and functionality that is not configurable, like streaming 
cluster replication.
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Message recall
The message recall feature is enabled by default with Domino 8. Therefore, you need to 
decide whether you want message recall enabled or disabled prior to rolling out the Domino 
directory in your production environment. 

Direct deposit of administration requests onto the target server
In Domino 8, certain administration requests are now deposited directly into the target 
server’s administration request database replica, which can potentially result in faster 
administration request processing. By default, this new feature is enabled, but can be 
disabled with the ADMINP_DONT_ATTEMPT_DIRECT_DEPOSIT=1 notes.ini parameter.

Activity trends in Domino 8
The billing feature is only included in Domino 8 for older system support. This means that no 
bug fixes or feature enhancements are planned for the billing feature, and we recommend 
that you migrate to activity logging for the equivalent functionality.

Third-party support for Domino 8
As discussed in Chapter 2, “Planning the Notes and Domino 8 Deployment” on page 15, it is 
essential that you plan and test for Domino 8 interoperability with any third-party products.

Domino 7 features, if upgrading from Domino 6.5.x
If you are upgrading from Domino 6.5.x, you also need to plan for the enablement of the 
Domino 7 features. Review Appendix A, “Considerations for upgrading from Notes and 
Domino 6.5.x to 8” on page 447, for the Domino 6.5.x to Domino 8 upgrade considerations.

3.4  Defining the deployment sequence

As mentioned in 3.1, “Introduction to deploying Domino 8” on page 46, the high-level Domino 
8 deployment sequence has not changed from prior releases, except for the addition of two 
optional steps. We recommend that you leverage your existing Domino upgrade processes 
and procedures to avoid repeating what has already been done when deploying Notes and 
Domino 8.

The two optional steps that have been added to the end of the recommended upgrade 
sequence from pre-Domino 8 releases are: 

� Upgrade ODS to take advantage of the new database properties and optimizations.

� Install the extended capabilities like activities, composite applications, and the Domino 
and DB2 feature.

Recommended deployment sequence
We recommend the following upgrade sequence, which is depicted in Figure 3-1 on page 50:

1. Upgrade your Domino Administrator clients to Notes 8.

2. Upgrade the design of your Domino directory across your domain.

3. Upgrade your administration server.

Important: If you decide to disable the feature, do not forget that you need to take action 
to disable the feature from a configuration document in the Domino directory. More 
information regarding message recall is provided in 9.3, “Message recall” on page 245.
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4. Upgrade your hubs and directory servers.

5. Upgrade your mail and application servers.

6. Upgrade your Notes clients.

7. Upgrade the design of your mail databases and new applications to enable new Notes 
and Domino 8 features. 

8. (Optional) Upgrade the ODS of your mail and applications.

9. Install additional server components to extend Domino capabilities.

Figure 3-1   Recommended upgrade sequence

This is not the only sequence that can be used to deploy Domino. There could be reasons 
that are specific to your Domino infrastructure that prevent you from following these exact 
steps. The key is to ensure that the sequence makes sense for your environment, has been 

Note: While the extended capability is not new to Domino 8, IBM Lotus Sametime is also 
represented in step 9 in Figure 3-1. The IBM Lotus Notes client provided integrated 
capabilities with IBM Lotus Sametime since Notes 6.5.

1. Upgrade/install the Domino Administrator Clients

2. Upgrade the Domino directory design

3. Upgrade Admin server and system databases

4. Upgrade Hub and Directory servers

5. Upgrade the Mail Application and Web servers

6. Upgrade the Notes clients

7. Upgrade the design of mail and application
databases to enable new Domino 8 features

Optional

8. ODS upgrade 9. Install additional server
components to extend
Domino capabilities

Feature 
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tested in your pilot environment, and minimizes Domino service disruption as much as 
possible. 

3.5  Performing the Domino 8 deployment

With all of the prerequisites from “Understanding prerequisites” on page 31 in place and 
planning and pilot testing complete, you are ready to deploy Lotus Domino 8.

3.5.1  Install the Notes 8 Domino Administrator client

In order to become familiar with the new Notes 8 client, the Domino administration team 
should install the Notes 8 All Client version, making sure to install both the Domino 
Administrator and Domino Designer client options. Install additional client features as 
required.

Figure 3-2   Remote server setup option in Notes 8 All Client installation

The Domino Administrator and Domino Designer clients are also available with the basic 
client configuration. Therefore, if the system you are installing the Notes 8 All Client version 
onto does not meet the minimum system requirements, as documented in 2.3.2, “Planning to 
deploy Lotus Notes 8” on page 36, install the basic configuration during this step. More 
information about the basic client configuration can be found in 4.8, “Notes 8 - basic 
configuration” on page 91.

Tip: As shown in Figure 3-2, install the remote server setup feature in order to remotely 
connect to and configure your first Domino server for new Domino deployments or 
subsequent servers for existing Domino deployments.
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3.5.2  Upgrade the Directory design across your domain

Given that the Domino directory is backwards compatible, you should upgrade your Domino 8 
Domino directory design prior to upgrading your servers to Domino 8. Deploying the directory 
design first allows you to get this major system database work out of the way, and pave the 
way for the Domino 8 code upgrade. 

While we recommend that you use the latest design for the Domino directory (and also the 
administration requests database), this is not the case with all databases. In particular, for the 
mail template or more widely used application templates, we recommend that you do not use 
a later release than the version used by both the Notes client and the Domino server. 

Prior to upgrading the design, make sure to review 3.3.5, “Controlling and managing your 
Domino directory design” on page 47 to ensure that you are effectively managing your 
Domino directory. As mentioned in that section, there are various ways in which you can 
control the design of the Domino directory, and you should use the method that is appropriate 
for your environment.

The following list provides some of the options for upgrading the design in your Domino 
environment:

� Manually upgrade the Domino directory design on the administration server prior to 
upgrading any servers to Domino 8, and let the design replicate out to the Domino domain 
servers via standard replication.

� Upgrade your administration server to Domino 8 and upgrade the design of your Domino 
directory at the same time. Let the design replicate out to the Domino domain servers via 
standard replication.

� Prevent the Domino directory design from replicating out from the administration hub (via 
ACL settings), and manually upgrade the Domino directory design on the administration 
server prior to upgrading any servers. Make an operating system level copy of the Domino 
directory, which will still have the same replica ID, of the new Domino directory from the 
administration server and copy it to your Domino systems, scheduling down time to swap 
in the new replica.

The last option has traditionally been employed by Domino enterprises that have large 
Domino directories. Large Domino directories can result in replication delays or long view 
indexing if a new directory design is pushed onto the high-level hub and replicated out to the 
spoke Domino servers. This activity could interfere with Notes client access during peak 
usage hours.

Attention: For more information regarding template version and design interoperability, 
see 5.1, “Domino/Domino coexistence” on page 94.

Important: The message recall feature is enabled by default with Domino 8. Therefore, 
you need to decide whether you want message recall enabled or disabled prior to rolling 
out the Domino directory in your production environment. If you decide to disable the 
feature, do not forget that you need to take action to disable the feature from a 
configuration document in the Domino directory. More information regarding message 
recall is provided in 9.3, “Message recall” on page 245.
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Detailed instructions on how to upgrade the design of the Domino directory, from either the 
Domino Administrator client or the Domino server console, are provided in the Lotus Notes 
and Domino 7 Enterprise Upgrade Best Practices Redpaper at the following URL:

http://www.redbooks.ibm.com/abstracts/redp4120.html?Open

3.5.3  Pre-installation steps

Prior to performing the Domino code installation, the following steps should be performed:

� Clean up system files.
� Review Notes.ini settings.
� Back up system files.
� Complete the pre-upgrade checklist.

Clean up system files
Upgrading your Domino server provides a good opportunity to clean up all unused program 
documents, server connection documents, and even databases that are no longer used. If 
upgrading from Domino 7, utilize the Scheduled Checks Database DDM probe to find inactive 
mail files or applications on your servers. 

Also, you should consider removing and archiving old files present in your Domino data 
directory, such as old NSD files and temporary files.

Review notes.ini settings
Consider removing notes.ini settings that are no longer supported in Domino 8. In addition to 
obsolete parameters, you should also review the debug notes.ini settings you have in place to 
ensure that they are still required. Most debug settings should only be utilized on a temporary 
basis for debugging and troubleshooting purposes. Look in both the notes.ini files and server 
configuration documents when cleaning up obsolete or debug notes.ini parameters.

Note: If you employ this last method, ensure that the master Domino directory replica has 
completed all view rebuilds prior to making the copy to use across other servers, as is 
mentioned in “Pre-upgrade checklist” on page 55.

Furthermore, as of this writing, the IBM Lotus Notes/Domino 8 Beta 3 Release Notes state 
that if you upgrade to Domino 8 and your Domino directory contains 10,000 users or more, 
plan ahead for view updating. This information is provided in reference to the Unicode 
standard collation, and two views are called out specifically, the $Users and 
$ServerAccess views. In a large enterprise deployment of ND, these two views are usually 
the largest, and great care should be taken to ensure that they do no become corrupt or 
need to be rebuilt after upgrading your servers to Domino 8.

Note: The steps in this section apply to all server types: administration, hub, directory, 
mail, application, and Web servers. If there are specific steps or recommendations that are 
specific to one particular server type, they will be mentioned separately.

Tip: If upgrading from Domino 6, utilize a database event generator to find inactive mail 
files or applications on your servers.

Note: Review the IBM Lotus Notes/Domino 8 Release Notes for any obsolete notes.ini 
parameters in Domino 8.
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In addition to removing notes.ini parameters for cleanup purposes, the following parameters 
should be considered for addition:

� Server_Upgrade_No_Directory_ReDesign=1

Add this setting if you have already upgraded the design of your Domino directory and do 
not want to be prompted to upgrade your design when the Domino server starts up on 
Domino 8.

� CREATE_R8_DATABASES=1

While we do not suggest upgrading the ODS during the upgrade process itself, you can 
add this notes.ini parameter prior to upgrading to Domino 8. As described in 9.10.2, “How 
to enable the new On Disk Structure on Domino servers” on page 280, pre-Domino 8 
servers ignore this setting, so it is safe to set this parameter even in a mixed version 
environment.

� If you utilize the native Domino console logging and do not explicitly enable console 
logging with the console_log_enabled=1 notes.ini setting or specify a default console 
logging limit size with the console_log_max_kbytes=<desired size> notes.ini setting, 
upgrading the Domino server to Domino 8 sets the console logging limit to 1 K. The new 
default setting of 1 K was introduced to improve product serviceability and is enabled 
without user intervention or notification.

Therefore, we strongly recommend that, if you utilize console logging for crash reporting to 
Lotus support, troubleshooting, document retention, or whatever other purpose, you 
enable one of the following notes.ini parameters:

– console_log_enabled=1
– console_log_max_kbytes=<desired size>

Stopping and restarting console logging with the stop consolelog and start consolelog 
commands is required for these setting to take effect.

Backup system files
Performing a backup prior to upgrading is strongly recommended in the rare case you will 
need to backout an upgrade or you experience any database corruption or data loss.

We recommend performing a full backup of your Domino server before starting the server 
upgrade process. If you are unable to perform a full backup of all your Domino servers, we 
suggest backing up at least the following elements:

� Server ID and all other IDs present on your system

� Notes.ini files

� Domino directory

� Log.nsf, to provide a record of your previous server activities

� All other directory databases such as the directory assistance, extended directory catalog, 
condensed directory catalog, and schema database

� Any customized templates

� Any third-party add-ins binaries or executables and extension managers

Tip: The following IBM Lotus Web site provides a great reference for common Notes.ini 
parameters:

http://www.ibm.com/developerworks/lotus/documentation/notes-ini/index.html
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Pre-upgrade checklist
Complete the following pre-upgrade checklist just prior to upgrading your Domino servers. 
The exact steps for your environment v vary based on your Domino server configuration and 
other factors.

1. Verify the Domino directory design on your server (Application → Properties → Design 
information). It should inherent from the Domino directory 8 design, which was pushed 
out prior to the first upgrade in 3.5.2, “Upgrade the Directory design across your domain” 
on page 52, unless you are going to upgrade the Domino design during the Domino code 
install. 

If you are swapping in an operating system level copy of names.nsf, run the updall -R 
command to rebuild the views.

2. Back up any files that have been updated or were not backed up during the full or partial 
backup completed in “Clean up system files” on page 53.

3. (Optional) Disable Domino directory replication.

4. (Optional) Disable other connection documents (replication and routing information).

5. Restrict server usage using the server_restricted=1 dynamic Notes.ini parameter and drop 
all users from server sessions. 

This notes.ini parameter does not stay in effect after Domino is restarted. To maintain the 
setting after a Domino server restart use server_restricted=2.

6. Force routing of all mail still waiting for delivery, and then stop the router and SMTP tasks. 
To force mail that is pending to a destination server, issue the route <destination server 
address> Domino console command.

7. (Optional) Purge all administrative requests.

8. If running Domino as a service on Windows, change the startup type to manual.

9. Disable any cron jobs on UNIX platforms that automatically restart Dominos and clean up 
shared memory segments. 

10.Stop the Domino server.

3.5.4  Installing the Domino 8 code across your Domino domain

This section details the steps required to perform the actual Domino 8 code installation.

Install the Domino 8 code
IBM Lotus provides several different installation types, including full, silent, and express 
installations.

For the purposes of this IBM Redbooks publication, we focus on the full setup installation, 
which we performed on the Windows 2003 operating system in our ITSO lab environment. 
For details on the silent and express installations or other operating systems installations, see 
the Lotus Domino Administrator 8 help documentation.

Note: The steps in this section apply to all server types: administration, hub, directory, 
mail, application, and Web servers. If there are specific steps or recommendations that are 
specific to one particular server type, they will be mentioned separately.
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For a Domino full setup installation, perform the following steps:

1. After invoking the setup.exe file to launch the Domino 8 installation program, the 
Java™-based InstallShield Wizard dialog box opens, as shown in Figure 3-3.

Figure 3-3   Domino Java-based installer 

2. After accepting the license agreement, you will be prompted to select a folder for the 
Domino executable and data files, as shown in Figure 3-4.

Figure 3-4   Select a folder for the Domino data and executable files

By default, the installation program installs the new files to the same location where your 
current Domino server is installed.

You will also be asked whether you want to install a partitioned server, which means that 
the same binaries folder and directory are used by several Domino servers on the same 
physical machine or on the same logical OS partition, known as an LPAR on UNIX-based 
machines. We do not install partitioned servers, so we leave this setting unchecked.

Attention: On UNIX-based systems, Domino 8 still supports the installation of running 
multiple versions of Domino code across two or more Domino servers, which was 
introduced with Domino 6.
56 IBM Lotus Notes and Domino 8 Deployment Guide



3. After specifying a location for the Domino 7 installation, the dialog box shown in Figure 3-5 
opens, offering selections for the server types and features to install.

Figure 3-5   Available choices during the Domino upgrade

4. After verifying the installation settings, shown in Figure 3-6, click Next to launch the 
Domino 8 server installation.

Figure 3-6   Verify the installation settings
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5. After the installation completes, click Finish, as shown in Figure 3-7. 

Figure 3-7   Final Windows installation panel

While this install was performed on a Windows 2003 server, the installation on the UNIX 
platform has not changed drastically from pre-Domino 8 releases.

Post-upgrade checklist
Perform the following steps prior to starting the Domino 8 servers for the first time:

1. Verify your template management, as discussed in 3.3.4, “Review your template strategy” 
on page 47. Replace the out-of-the-box templates and remove unused templates, as 
necessary.

2. Edit the server Notes.ini file, per the recommendations in “Review notes.ini settings” on 
page 53.

3. (Optional) Perform maintenance operations, like compact, on the names.nsf and 
admin4.nsf files. 

Note that if the Create_R8_Databases=1 notes.ini parameter was put into place and a 
copy style compact is run on names.nsf or admin4.nsf, the ODS is upgraded to ODS 48.

4. Rebuild view of names.nsf offline, using the updall -R command. 

If working with a large names.nsf, it is ideal to replace the names.nsf database with a 
replica that already has the new Domino 8 design with updated views. See 3.5.2, 
“Upgrade the Directory design across your domain” on page 52, for more information. If 

Important: Before starting the Domino 8 server, refer to “Pre-upgrade checklist” on 
page 55 for additional steps and considerations.

Tip: You can now customize the IBM Lotus Domino server installation on UNIX platforms. 
Installing all templates is now optional, whereas with previous releases you only had the 
option to install all or none of the template files. If you choose the Customize Domino 
server option, you can now choose which template options to install under Data Files. Note 
that all templates are installed by default with utility, messaging, and enterprise server 
types.
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you are swapping in an operating system level copy of names.nsf, move out the old file to 
a names.nsf.<date>.<time> name and move in the new copy.

5. Delete busytime.nsf and move out the log.nsf file and mailXX.box files. 

6. Restart your server. 

As mentioned in “Review notes.ini settings” on page 53, if you do not have the 
Server_Upgrade_No_Directory_ReDesign=1 Notes.ini setting in place prior to starting 
your server after the Domino 8 upgrade, you will be prompted to upgrade the design of 
your Domino directory. 

As with prior releases of the Domino server, after starting the server for the first time on 
Domino 8, the design of many of the system databases is automatically upgraded as well, 
including events4.nsf and ddm.nsf.

7. For Windows servers, reset your Domino server as a Windows service.

8. For UNIX servers, reenable any cron jobs that automatically restart Domino.

9. If disabled in “Pre-upgrade checklist” on page 55, turn on replication and connection 
documents. 

10.If server_restricted=2 was enabled in “Pre-upgrade checklist” on page 55, reenable Notes 
client access by issuing the Domino console command set config server_restricted=0.

11.Test your Domino server:

a. Access the Domino server from a remote Notes client.

b. Access a database on the Domino server from a Web browser if http is enabled.

c. Ensure that the major Domino server functions like replication, mail routing, and any 
third-party applications are running successfully.

12.After upgrading the administration server, make sure that you upgrade the design of your 
administration requests database (admin4.nsf) based on the new admin4.ntf template.

13.Prepare the next Domino sever for upgrade.

Repeat the upgrade steps in this section for each of your Domino servers: administration, 
hub, directory, mail, application, and Web servers. Once all Domino servers are upgraded, 
your Domino server deployment is complete. 

You are now ready to perform the optional ODS upgrade and deploy the extended Domino 
capabilities.

3.5.5  Upgrade the Notes clients

With your Lotus Domino 8 deployment complete, you are now ready to deploy the new Notes 
8 client to your user population. 

Section 2.3.2, “Planning to deploy Lotus Notes 8” on page 36, provides prerequisites, 
recommendations, and best practices that should be used when planning for the Notes 8 
client deployment. 

The considerations that should be made when actually deploying the Notes client, as well as 
upgrade options and information about the Linux and basic configuration, can be found in 
Chapter 4, “Deploying the Notes 8 client” on page 63.
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3.5.6  Upgrade the Notes mail file and application design

After both Lotus Domino 8 and Lotus Notes 8 are deployed, upgrade the design of your user 
mail files and applications. Detailed information regarding upgrading the design of mail or 
applications using the convert Domino task can be found in the Lotus Domino Administrator 8 
help documentation. If using Upgrade-by-Mail to upgrade your Notes clients, you also have 
the option to upgrade the mail template after the Notes client install or upgrade. More 
information about Upgrade-by-Mail can be found in 4.5, “Upgrade by mail” on page 76.

3.5.7  Upgrading the ODS (optional)

The full details of how and why to upgrade to ODS 48, the new Domino 8 ODS, are provided 
in Chapter 9, “New administration features” on page 241. To summarize, the new ODS 
provides potential improvements for I/O and folder optimization. It is also a requirement for the 
implementation of the following new features:

� Database names list for user renames
� Design compression

The ODS 48 upgrade steps are provided in 9.10.2, “How to enable the new On Disk Structure 
on Domino servers” on page 280. To summarize, the following two steps are required to 
enabled the new ODS:

� Add the Create_R8_Databases=1 parameter to the server notes.ini files.
� Run a compact -c, or other copy-style compact, against your databases.

We highly recommend that, if and when you decide to upgrade the ODS of your databases, 
you ensure that the Domino server is stable at the new Domino 8 code level. This includes 
the testing of all the basic Domino server functionality, as outlined in “Post-upgrade checklist” 
on page 58. Once you are confident that the Domino 8 upgrade was a success, you can 
proceed to upgrading the ODS. 

With that said, if you decide that you would like to upgrade to ODS48 immediately or shortly 
after you upgrade to Domino 8, you can add the Create_R8_Databases=1 notes.ini 
parameter to a Lotus Domino 7 server in preparation for the Domino 8 upgrade, as mentioned 
in 9.10.2, “How to enable the new On Disk Structure on Domino servers” on page 280.

Important: As discussed in “Design compression” on page 279, design note compression 
is enabled in the standard Notes 8 mail template (Mail8.ntf). Therefore, once you enable 
the new Domino 8 ODS with the Create_R8_Databases=1 Notes.ini variable, any new mail 
files created with the Notes 8 mail template or any mail files converted to the Notes 8 mail 
template will have design note compression enabled. 

If you do not want to automatically enable design note compression for mail files, deselect 
the option in the Notes 8 mail template (mail8.ntf) before using it for new and existing mail 
files.

Note that mail8.ntf is the only standard system template that has design note compression 
selected by default. All other templates have the option deselected.

Important: If you add the Create_R8_Databases=1 notes.ini parameter and do not run a 
copy-style compact, any new databases that are created on the server will be created with 
ODS 48, but the existing databases will remain at ODS43.
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3.5.8  Extending the capabilities of Domino 8 (optional)

This section provides links to sections within this IBM Redbooks publication and other 
documentation where you can find more information about how to extend the capabilities of 
IBM Lotus Notes and Domino 8. The capabilities include:

� Activities through the Notes 8 side-bar with an activities server
� Composite application support with WebSphere Portal
� Domino and DB2 integration
� IBM Lotus Sametime for awareness and chat

Activities through the Notes 8 side-bar with an activities server
Notes 8 has an activities plug-in in the Side Bar panel, which allows users to work with 
activities that have been hosted on an IBM Lotus Connections server. Activities help users to 
consolidate work items to meet and produce a particular deliverable. 

Activities provides a lightweight mechanism that helps build best practices around personal 
tasks and projects in a more managed context, enabling users to more quickly complete 
activities and maintain an up-to-date view of their daily work.

More detailed information about activities can be found in 6.9, “Activities” on page 176.

Composite application support with WebSphere Portal
Notes 8 provides support for composite applications, a key element of IBM service-oriented 
architecture and contextual collaboration strategy. Composite applications combine 
components from multiple applications into a single, role-based work environment. 

Composite applications are a loose coupling of Eclipse components, Lotus Component 
Designer components, and Notes applications (known within composite applications as NSF 
components) encompassed within a single panel to create a unified view of disparate data.

For more information about the following Domino and WebSphere Portal integration topics, 
visit Chapter 11, “IBM WebSphere Portal integration” on page 349:

� Domino Portal Integration (DPI®) Wizard
� Domino Portal Federated Administration
� Web Administrator Server Bookmarks
� WebSphere Portal Home Portal Account
� Lotus server client installer (SCI)

Domino and DB2 integration
Notes and Domino 8 now fully support utilizing a DB2 backend for data storage and retrieval. 
In additional to DB2-enabling a Notes application, the feature allows for data federation from 
a Notes view, which means that you can query non-Notes SQL data from within a Notes view.

Utilizing the Domino and DB2 feature means that you can take advantage of the strengths of 
both data storage systems, including the security and user interface of Domino and the 
scalability and flexibility of DB2. This new features breaks down traditional barriers that 
prevented Notes applications from directly running SQL queries against Notes data or 
non-Notes SQL data.

Domino and DB2 installation and configuration information can be found in 9.11, “Domino and 
DB2 deployment” on page 286.
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IBM Lotus Sametime for Awareness and Chat
Presence awareness and instant messaging were first introduced into the IBM Lotus 
Notes 6.5 Client. The IBM Lotus Notes 8 client provides an instant message experience 
based on the IBM Lotus Sametime Connect 7.5.1 client, which, just like the IBM Lotus Notes 
8 client itself, is also based on Eclipse client technology.

Some of the Sametime client features provided with the IBM Lotus Notes 8 client include 
tabbed chats, video chats, enhanced contact list, chat history, and Web conferencing. More 
information about the IBM Lotus Notes 8 Sametime features can be found in 6.8, “Sametime 
contacts” on page 167. 

For best practices on deploying a Sametime 7.5.1 infrastructure, visit the Sametime 7.5.1 - 
Best Practices for Enterprise Scale Deployment IBM Redbooks publication at:

http://www.redbooks.ibm.com/redpieces/abstracts/sg247410.html?Open
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Chapter 4. Deploying the Notes 8 client

This chapter discusses the considerations a Lotus administrator must make when deploying 
Notes 8. The goal is to assist you when considering different upgrade options for the client in 
conjunction with how it will impact you from an administrative perspective and the client from 
a user perspective.

In this chapter we discuss:

� Manual installation of Notes 8
� Upgrade options, including: 

– Smart Upgrade 
– Upgrade by mail
– Seamless mail upgrade

� Installing the client on Linux 
� Notes 8 - basic configuration

4
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4.1  Introduction

IBM Lotus Notes and Domino have three major clients:

� The Lotus Notes client allows you to send and receive mail, schedule appointments, work 
in custom-built applications, browse the Web, use instant messaging, and much more.

� The Lotus Domino Designer Client allows you to develop collaborative Lotus Notes, Web, 
and mobile device applications that are required for your business needs.

� The Lotus Domino Administrator client allows you to manage your Domino servers and 
perform most Notes and Domino specific administrative tasks.

You need to decide which Lotus Notes and Domino Client to deploy based on user type. You 
may want to install all three clients — the Notes client, Domino Administrator client, and 
Domino Designer for your Domino Administrator or Designer — or you may choose to install 
only two of the clients, based on your users’ job functions. If you decide to install only the 
Notes client for your users, you also need to decide whether this is a multi-user or single-user 
installation.

Depending on the size of your enterprise, you may also need to provide an installation 
method for only a few users or for thousands of users. In addition, you may need to customize 
the installation process so that users install only the features that they need.

Section 4.2, “Client installation choices” on page 64, discusses some installation choices that 
you can make available to the users in your enterprise.

4.2  Client installation choices

Notes 8 provides the following choices for deploying the client:

� Manual installation: This is usually done from the CD or from files placed in the network.

� Smart Upgrade: This is a feature that uses policy and settings documents to help push out 
upgrade to users who would then get a notification to upgrade their Lotus Notes client.

� Upgrade by mail: This is a feature that sends an e-mail notification to specified users to 
upgrade their Notes clients and, optionally, their mail file templates.

� Administrative installation: This is a feature of the Microsoft Windows Installer that copies 
the installation kit to a file server that users access through a network connection. Users 
launch the installation program from the file server to install Lotus Notes client locally on 
their client machines.

Note: 

Single-user client installation: This installation is usually done from the CD or from files 
placed in the network.

Multi-user installation: This option is available only for Notes client installation. Multi-user 
installation is not available for installing the Domino Administrator client or Domino 
Designer.

Important: Before deploying Notes 8, review 2.3.3, “Planning a new deployment of Notes 
and Domino 8” on page 38, and 2.4, “System requirements” on page 40.
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Table 4-1 compares these choices.

Table 4-1   Notes client deployment choices

Note: You can use administrative installation to copy the installation files to a network 
file server, then use upgrade-by-mail or Lotus Notes Smart Upgrade to notify users

Deployment options Advantages Disadvantages

Manual installation/upgrade � Easily back up files before 
upgrading

� Time consuming
� Administrator might have to 

visit each workstation

Smart Upgrade � Can establish a deadline in 
which users must upgrade 
their Notes client

� Can be customized with 
transforms to create a 
silent, automated 
installation, a shared 
installation, and so on

� Not capable of upgrading 
pre-Release 6 clients

Upgrade by mail � Capable of upgrading 
pre-Release 6 clients.

� Can be customized with 
transforms to create a 
silent, automated 
installation, a shared 
installation, and so on

� Mail template can also be 
upgraded at the time of 
client upgrade

� Administrator cannot 
determine when upgrade 
occurs

Administrative 
Installation/Upgrade

� Uses the command line 
option /A to create an 
administrative image of the 
Lotus Notes 8 installation 
on a network file server 

� Can be customized with 
transforms to create a 
silent, automated 
installation, a shared 
installation, and so on

� Requires the Windows 
Installer service, which is 
part of the Windows XP and 
2000 operating systems 
and is available for, but not 
part of, Windows 95, 98, 
and NT 4.0 
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4.3  Manual installation/upgrade

The manual installation process has not changed from Release 7. This section briefly 
describes what to expect from a manual installation of Notes 8, with emphasis on the new 
available features. The steps below walk you through the all client installation.

1. You are prompted with the welcome panel shown in Figure 4-1. Click Next.

Figure 4-1   Welcome panel

Note: The all client installation allows you to install the Domino Administrator and Domino 
Designer clients. It is, however, not supported with a multi-user installation.
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2. Read and accept the license agreement, as shown in Figure 4-2.

Figure 4-2   License agreement

3. You are prompted for customer information, as shown in Figure 4-3. If this is an upgrade, 
Notes retrieves the information from the client currently installed. You can modify it as 
needed. Click Next.

Figure 4-3   Customer Information
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4. Select the installation path, as shown in Figure 4-4. 

– If this is an upgrade, go to step 4a. 
– For a new install, go to step 4b.

a. If this is an upgrade, the installation path would default to where the Notes client is 
currently installed, and the change button might be unavailable. 

b. If this is a new installation, select the installation path or leave the default and click 
Next.

Figure 4-4   Installation Path Selection

Important: During an upgrade, the current install path is pulled from the registry 
key\HKEY_LOCAL_MACHINE\SOFTWARE\Lotus\Notes. If you want to install the 
Notes client to a different path, we recommend that you uninstall the previous client 
before installing the new version.
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5. Select which features to install, as shown in Figure 4-5 and Figure 4-6 on page 70. By 
default, the installation selects the minimum recommended files for the Notes client 
installation. Activities, composite application editor, IBM productivity tools, and Sametime 
(integrated) features are newly introduced in Notes 8.

– Activities - Select this to install the activities feature. An activities server is required to 
use this feature. For complete details see 6.9, “Activities” on page 176.

– Sametime (integrated) - Select to install basic Sametime capabilities such as chat and 
presence awareness. A Sametime server is required to use this feature. For complete 
details see 6.8, “Sametime contacts” on page 167.

– IBM Lotus Productivity Tools - Select this to install IBM Lotus Documents, IBM Lotus 
Presentations, and IBM Lotus Spreadsheets. For more information about productivity 
tools, see Chapter 7, “Productivity tools” on page 199.

– Composite Applications Editor - Select this to install the composite applications editor 
for use with composite applications. For complete details see Chapter 12, “New 
application development features” on page 399.

You can highlight some features for a description. You can also select each client to check 
how much hard drive space it requires. Click Next.

Figure 4-5   New features added in Notes 8
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Figure 4-6   Custom Setup

6. You are now ready to install the program. Click the Install button as shown in Figure 4-7 or 
use the Back button to change to any of the previous options without canceling the 
installation.

Figure 4-7   Ready to Install the Program
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7. While the Notes client is being installed, a panel with a progress bar is displayed. See 
Figure 4-8.

Figure 4-8   Installing Lotus Notes - progress bar

8. Once installation completes, you should see the dialog box shown in Figure 4-9. Click 
Finish. You can now launch the Notes client with the desktop icon.

Figure 4-9   Install completed

4.3.1  Multi-user installation

Multi-user install enables multiple users to sequentially log in to the same machine and use 
the same shared IBM Lotus Notes install directory, but with their own Notes data directory. 
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Use the multi-user installation if your enterprise has multiple users who share a single 
workstation. 

In a multi-user installation, the installer installs the Notes program files to a central location on 
the local system. When users log onto the system and run the Lotus Notes client setup, their 
own personal data files (that is, BOOKMARK.NSF, NAMES.NSF, and other files) are created. 
It allows each user to store her personal desktop, address books, local databases, 
preferences, and so forth. In essence, each user has her own data directory located in the 
system's application data directory for the current user. The actual location varies according 
to operating system.

The multi-user installation differs from a shared installation in that program files are located 
on the local system in a multi-user install, which can be an advantage. This allows for access 
to the Notes client regardless of which network drives are available. In a shared installation, 
users are dependent on the availability of shared network drives.

When installing for multi-user, you must be logged in as an administrative user. Once 
installed, users can open and use Lotus Notes 8.

Windows supports both single-user and multi-user installs of Lotus Notes 8. However, the 
AllClient kit, which includes the Domino Administrator and Domino Designer clients, does not 
support the multi-user installation.

Section 4.3, “Manual installation/upgrade” on page 66, walked you through the installation of 
the AllClient. At no point was the installation specified as a multi-user installation. 

Note: Individual location documents are no longer needed for each user who uses the 
Notes client on the same workstation, as was required in previous releases.

Note: When installing Lotus Notes 8 for single user, you must be logged in as an 
administrative user or as a non-administrative user with elevated privileges.

Note: You can install Lotus Notes on Windows as single or multi-user installation. 
However, Lotus Notes installation on Linux supports multi-user only. Be aware that you 
can still install Lotus Notes as multi-user for just one user.
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Installing the Notes-only client gives you the option to install as a single user or multi-user, 
and Figure 4-10 would replace Figure 4-3 on page 67 in the manual installation process.

Figure 4-10   Option to install as multi-user

4.3.2  Automating your deployment

Depending on the size of your enterprise, you may need to provide an deployment method for 
hundreds or even thousands of users. In this instance being able to automate the deployment 
saves you both time and resources. Below are a few resources to help with automating your 
deployment: 

� IBM Redpaper, Distributing Notes Clients Automatically, REDP-3693

http://publib-b.boulder.ibm.com/Redbooks.nsf/RedbookAbstracts/redp3693.html?Open

� Lotus Domino Administrator 8 Help topic, Automating client installation using a silent 
install

� Lotus Domino Administrator 8 Help topic, Setting up client installation and installation 
methods

� Lotus Domino Administrator 8 Help topic, Providing a batch file for installing the clients

4.4  Smart Upgrade

Lotus Smart Upgrade enables administrators to push out a Notes client upgrade with ease to 
an entire company or selected users using policy and settings documents. Users would get a 
Smart Upgrade notification to update their Notes clients to later releases, with the option to 
delay the upgrade if the time is inconvenient.

Important: You may choose to use a third-party tool in automating your deployment. 
However, be aware that IBM Lotus would assist you as much as possible to make your 
deployment successful, but does not support the third-party tool.
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Lotus Smart Upgrade was introduced in Release 6.x to assist Lotus Domino Administrators in 
upgrading the Notes client. Smart Upgrade can be used to upgrade the Notes clients from 
Release 6.x or later to Release 8. Using Smart Upgrade has three important benefits:

� Prevents administrators and support staff from having to visit each desktop
� Reduces the dependency on third-party tools
� Reduces the total cost of upgrading

This section discusses what you should know before you proceed with setting up Smart 
Upgrade, and what has changed in Notes 8 with respect to setting up the Smart Upgrade kit.

What you need to know before setting up Smart Upgrade
You must know:

� If you are running a version of Lotus Notes that was released prior to Notes 6.5, you need 
to upgrade to at least Lotus Notes 6.5 before upgrading to the Lotus Notes 8 release. You 
can choose to have multiple upgrade kits: one to upgrade the client to 6.5.x and the other 
to upgrade from Lotus Notes release 6.5.x or 7.x to Lotus Notes 8 release.

� Smart Upgrade is not supported in Lotus Notes 8 Beta, and neither is any form of 
upgrading from a beta version to a gold version. If you have installed a previous beta 
version of Lotus Notes 8, you must uninstall it before installing Lotus Notes 8.
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Changes in the Smart Upgrade kit document
In Notes and Domino 8, the Smart Upgrade kit document now has a new Configuration field 
(Figure 4-11), where you can choose to install the standard installation or basic configuration 
(see 4.8, “Notes 8 - basic configuration” on page 91) of the Notes client.

Figure 4-11   Sample Smart Upgrade kit document

Smart Upgrade “run as admin” utility (SURunAs)
The runs as admin utility was introduced in the Lotus Notes 7.0.2 release, enabling users to 
install the Notes client using different permissions from what the user’s current logon 
provides.

The feature is especially designed for Notes client users who do not have administrator 
privileges but who still need to update their Notes client software periodically. SURunAs can 
be used in Smart Upgrade or through any existing deployment method. It can be used to 
create a single executable file that can be attached to the Smart Upgrade kit document or it 
can be used to create a setup.exe file that can be placed on a network drive and referenced in 
the Smart Upgrade kit document.

For details on how Smart Upgrade and SURunAs works, its features, and steps to deploying 
the Notes client using Smart Upgrade, refer to the IBM Redpaper, Understanding Lotus Notes 
Smart Upgrade, REDP-4180: 

http://www.redbooks.ibm.com/abstracts/redp4180.html?Open
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4.5  Upgrade by mail

Upgrade by mail is a feature that sends an e-mail to users and gives them the option to 
upgrade their Notes client and the design of their mail template. You might want to use 
upgrade by mail for users who are already familiar and comfortable with this form of upgrade 
from a previous release. Upgrade by mail also has no time limit, allowing users to upgrade 
their Notes client at a convenient time. This works well for users out of the office (during the 
upgrade) for a extended period of time. 

Below are steps for a basic upgrade by mail process:

1. Launch the Domino Administrator client.

2. Confirm that you are administering the server on which the user’s mail file resides. If not, 
from the File menu, choose Open server and select the proper server.

3. Click the Messaging tab, then click the Mail Users view on the left navigator pane. See 
Figure 4-12.

4. Select one or more users who you want to send the notification to upgrade just the Notes 
client or the Notes client and mail file design. Click the Send Upgrade Notification action 
button, as shown in Figure 4-12.

Figure 4-12   Select users

Restriction: Be aware that upgrade from a release prior to Notes 6.5 is not supported. If 
you are running a version of Lotus Notes that was released prior to Notes 6.5, upgrade to 
at least Lotus Notes 6.5 before installing and upgrading to this Lotus Notes 8.
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5. The upgrade notification document will now display, as shown in Figure 4-13.

Figure 4-13   Upgrade Notification - Basics tab

6. On the Basics tab, select Upgrade Notes Client & Mail Template to Notes 6 or higher 
for the type of upgrade notification to send. If you want to be notified once the user 
upgrades his or her mail template, select Yes for the option, "Notify me when users 
complete mail conversion."
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7. Switch to the Client Versions tab of the upgrade notification document. The "Do not 
upgrade Notes if workstation uses build xxx or later" option reflects the build number 
corresponding to the client used to send the upgrade notification. The build number for 
Lotus Notes Version 8.0 is 306. See Figure 4-14.

Figure 4-14   Upgrade Notification - client versions

Note: If you do not know or are not sure of the build number, set the option "Do not 
upgrade Notes if workstation uses build xxx or later" to 999. This ensures that the 
recipient of the upgrade notification is able to upgrade his client.
78 IBM Lotus Notes and Domino 8 Deployment Guide



8. Switch to the Software Distribution tab and enter the "Root path for install kits" to point to 
the server and shared folder name, making sure to end the line with a backslash (\). See 
Figure 4-15.

9. In the Path for Windows 95, 98, NT, 2000 field enter the path to setup.exe. Be sure to put 
a backslash in front of the path to setup.exe if it is relative to the root path specified in step 
8. See Figure 4-15.

Figure 4-15   Upgrade Notification - Software Distribution tab

10.In the Old design template name for your mail files field (see Figure 4-15) enter the current 
template name for the mail file or use an asterisk (*) for any template.

11.In the New mail template file name field enter the new template name for upgrading the 
design of the mail files.

12.Click Send. The recipient will receive an e-mail with the subject Upgrading to the latest 
version of Notes.

Note: The Subject field is not editable on the upgrade notification document.
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13.In the "Upgrading to the latest version of Notes" e-mail are two buttons, as shown in 
Figure 4-16, Install New Notes Software and Upgrade My Mail File, to upgrade the user's 
mail file. When the user clicks the first button, the Notes client currently running will shut 
down and the upgrade will begin.

Figure 4-16   Upgrade Notification - e-mail message

14.Once the install is complete, the user can open the message again and click the second 
button to upgrade the design of the mail file.

Using optional arguments
Upgrade by mail allows you to control user interaction with the upgrade process. This can be 
configured in the Arguments Option for W32 field, shown in Figure 4-15 on page 79.

Optional arguments are commonly used to run a silent installation requiring no user input 
during the upgrade, or to launch an upgrade that is almost silent, requiring almost no input 
from users.

Important: The new mail template must be in each user’s data directory for the user to 
properly upgrade his mail file using the Upgrade My Mail File button sent in the upgrade 
notification message. Therefore, it is important that your users click the Upgrade My Mail 
File button after they click the Install New Notes Software button.

The user must have Designer access in the ACL to upgrade his own mail file using the 
upgrade by mail feature.

Tip: If you would rather not have the users upgrade their mail files using the upgrade by 
mail process, leave the New mail template file name option in step 12 empty.
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Samples of the optional command-line arguments and their descriptions are shown in 
Table 4-2.

Table 4-2   Optional command line arguments

Arguments Description and use

/a Administrative installation.

/s

Note: Always place a blank space immediately 
after the /s.

Instructs setup.exe to run in silent mode (does 
not display the install shield initialization box).

/v Passes arguments to MSIexec. All arguments 
entered to the right of the argument /v apply to 
MSIexec (for example, /v”qb+” would pass the 
qb+ command to the MSI installer). The 
commands are surrounded by quotation marks. 
There is no space between the /v and the 
quotation marks.

/qn+ No user interface displayed during the installation 
of the client except for a modal dialog box 
displayed at the end to notify that the installation 
is completed.

/qb+ User sees progress bar showing status of the 
installation of the client with a modal dialog box 
displayed at the end to notify that the installation 
was completed.
The modal box is not displayed if the user cancels 
the installation.
Use qb+! or qb!+ to hide the Cancel button.

Tip: For instructions on how you can perform a silent upgrade by mail for Windows, see 
the Lotus Software Knowledge Base Document, “How to perform a silent upgrade by mail” 
at:

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21164125

Note: The transform file created by a third-party tool, such as InstallShield Tuner OEM 
Edition, can be used to customize the installation process by adding resources, changing 
defaults, or hiding features present in the Lotus Notes installation kit.

The transform file can be used with upgrade by mail. Use the "TRANSFORMS=" 
parameter and specify the transform file path in the Arguments Option for W32 field (for 
example, /s /v"TRANSFORMS=file.mst").

There is an excellent IBM Redpaper, Distributing Notes Clients Automatically, REDP-3693, 
with detailed instructions on using the InstallShield Tuner to create a transform file:

http://publib-b.boulder.ibm.com/Redbooks.nsf/RedbookAbstracts/redp3693.html?Open

Domino Administrator help also includes help topics, such as customizing client 
installations using the tuner.
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4.6  Seamless mail upgrade

Seamless mail upgrade is a method of upgrading client templates when upgrading the Lotus 
Notes client. It is configured in a desktop settings document and is assigned to a master 
policy document. It only works at the time of the client upgrade. 

From the user’s perspective, after the Notes setup is complete, the user can be asked (or 
forced) to upgrade his mail file to the new template design. 

Configuring seamless mail upgrade
Perform the following steps:

1. From the Domino Administrator, select the People & Groups tab, and select the Settings 
view.

2. If there is already a desktop policy setting document, you can edit the current one or 
create a new desktop settings document by clicking Add Settings → Desktop.

3. If the desktop settings document is new, fill in a name on the Basics tab.

Figure 4-17   Desktop settings document - section to configure seamless mail upgrade

Tip: To avoid potential incompatibility issues, use seamless mail upgrade in conjunction 
with Smart Upgrade. This upgrades the template immediately following the upgrade of the 
client to avoid potential incompatibility.
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4. Scroll down to the mail template information section and complete the fields shown in 
Table 4-3. Figure 4-17 on page 82 shows the mail template information section.

Table 4-3   Seamless mail upgrade fields

5. Click Save & Close.

6. Include the desktop settings document in the master policy.

Field Action

Prompt user before upgrading mail file Do one:
� Select Yes to inform users before upgrading 

their mail files. This enables users to defer the 
upgrade.

� Clear the Yes option (default) to upgrade 
without notification.

Old design template name for your mail files The default asterisk (*) uses any mail template.
(Optional) Enter the name of the current template 
you are using. 

If Running This Version of Notes Enter the build version of the Notes client in the 
format Release Vnn Month dd, yyyy (for example, 
Release 7.0.1 January 21, 2006). To upgrade all 
versions, use an asterisk (*). 
Tip: To find the build version, select Help → About 
Domino Administrator.

Use This Mail Template Enter the new mail template file name, Mail8.ntf.

Ignore 200 category limit By default, the number of folders created during 
conversion is limited to 200 folders. Do one of the 
following actions:
� Select Yes to override that limit and create as 

many folders as necessary (default).
� Clear the Yes option to enforce the limit.

Mail file to be used by IMAP mail clients Do one:
� Select Yes if mail file will be used by an IMAP 

mail client.
� Clear the Yes option if IMAP will not be used 

(default).

Upgrade the design of custom folders The conversion does not upgrade private folders 
automatically. Do one:
� Select Yes to include custom folders in the 

design upgrade (default).
� Clear the Yes option to exclude custom folders 

in the design upgrade.

Prompt before upgrading folder design Do one:
� Select Yes to inform users before upgrading 

their mail folder design. This enables users to 
defer the upgrade.

� Clear the Yes option (default) to upgrade folder 
design without notifying users.

Notify these administrators of mail upgrade 
status

If you chose to notify users before updating mail 
template or folders, enter the names of 
administrators who should receive status 
information.
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7. Assign to users if it is an explicit policy.

4.7  Installing Lotus Notes 8 client on Linux

This section provides you with helpful information for installing Notes 8 on a Linux client.

4.7.1  Considerations before installing the client

In this section we discuss the considerations before installing the client.

Requirements:

� Lotus Notes 8 installation on Linux supports SLED 10 (XGL enabled or disabled) and 
RHEL 5 (AIGLX and SELinux disabled).

� Before installing Lotus Notes 8 on a Linux client, you must have Mozilla Firefox, Version 
1.5+ GTK2 build, Mozilla Seamonkey, or the Mozilla Runtime Environment, Version 1.8+ 
GTK2 build, installed on your system. The client does not support the earlier beta 
requirement of Mozilla 1.7.12. See the "Linux system requirements" release note for 
details.

� If you have installed a previous beta version of Lotus Notes 8, you must uninstall it before 
installing Lotus Notes 8. Upgrade from a beta version of this release is not supported.

� You must install Lotus Notes 8 on Linux in a multi-user environment. Single user install is 
not supported.

� You must be logged in as a root user or switch the user to root before installing Lotus 
Notes. Once installed, non-root users can open and use Lotus Notes.

Recommendations:

� While a minimum of 512 MB of memory is required, 1GB or more of memory is 
recommended. See the "Software requirements" section of the release notes for details. 

� A summary panel displays the disk space footprint for what is being installed. Install also 
needs additional temporary disk space. The temporary disk space required is almost as 
large as the footprint. If you do not have enough space for the footprint and temporary 
space, the installer will stop you from continuing.

Note: See your Domino Administrator help for more information about policies.

Important: Before deploying Notes 8 on Linux, review 2.3.2, “Planning to deploy Lotus 
Notes 8” on page 36, and 2.4.1, “Lotus Notes 8 supported platforms” on page 41.

Note: See the requirements section of the release notes for the latest information about 
supported hardware and software.
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Unsupported/supported configurations:

� Roaming user is not supported in Lotus Notes 8. Roaming user in Lotus Notes 8 basic 
configuration remains available.

� The installation path cannot contain special characters such as # or $.

� Only one instance of Lotus Notes 8 should be installed on a client workstation at any given 
time.

4.7.2  Installing the client

Read 4.7.1, “Considerations before installing the client” on page 84, before starting Notes 8 

installation.

1. Exit out of any existing versions of Lotus Notes and Lotus Sametime Connect Client.

2. If you have installed a previous beta version of this Lotus Notes release, uninstall it before 
continuing. For information about uninstall, see the "Uninstalling Notes on Linux" release 
note.

3. As the root user, open a new terminal panel or file browser. If you are obtaining the 
installation kit from a Web downloads page, open your Mozilla GTK2 browser and 
navigate to the Web page from which to obtain the download. 

4. Locate the Lotus Notes installation media kit CD or download it from your Passport 
Advantage® site and save it to a local folder, for example, to your /root folder.

5. Navigate to the folder in which you saved the installation kit and unpack the tar file.

6. Change to the directory that contains the unpacked setup.sh installation executable.

Note: Verify that the directory also contains the deploy directory, setup.sh, and 
updateSite.zip. These contain the needed install manifest, feature, and plug-in JAR 
files.
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7. Run the setup.sh installation executable by double-clicking setup.sh or by running 
./setup.sh in a shell. see Figure 4-18.

Figure 4-18   Run installation executable from shell

8. Read the Welcome window, shown in Figure 4-19, and click Next.

Figure 4-19   Welcome panel - Linux Installation

Note: You must be logged in as root user to install.
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9. Read and accept the license agreement terms, shown in Figure 4-20, and click Next.

Figure 4-20   License agreement - Linux installation

10.Accept the default install directory (/opt/ibm/lotus/notes, shown in Figure 4-21) or choose 
a different install directory. You must install to a directory that is readable, but not 
writeable, by all users. Click Next.

Figure 4-21   Specify the install location

Note: Upgrade from a Notes 7.x installation is not supported. Install to a different 
directory or uninstall Notes before installing.
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11.Select the features to install, as shown in Figure 4-22, and click Next. These options 
include the following:

– Activities - Select this to install the activities feature. An activities server is required to 
use this feature. For complete details, see 6.9, “Activities” on page 176.

– Sametime (integrated) - Select to install basic Sametime capabilities such as chat and 
presence awareness. A Sametime server is required to use this feature. For complete 
details, see 6.8, “Sametime contacts” on page 167.

– IBM Lotus Productivity Tools - Select this to install IBM Lotus Documents, IBM Lotus 
Presentations, and IBM Lotus Spreadsheets. For more information about Productivity 
tools, see Chapter 7, “Productivity tools” on page 199.

– Composite Applications Editor - Select this to install the Composite Applications editor 
for use with composite applications. For complete details see Chapter 12, “New 
application development features” on page 399.

Figure 4-22   Select features to install
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12.Review the preview window for installation directory, features, and size, and click Cancel 
to cancel installation, Back to go back and make changes to the configuration, or Install 
to install the client. See Figure 4-23.

Figure 4-23   Installation summary

A progress bar displays while the installer copies files to the install directory and 
provisions the installed features.

13.Read the installation summary window and click Finish to exit the installation wizard.

Note: This process may take several minutes. You may be prompted by an acceptance 
window from any firewalls you have installed, asking for confirmation, even if the 
installation is being done locally.

Note: If installation is unsuccessful, you can open the install log file at 
<install_dir>/framework/rcp/installer_logs/framework_install.log. 
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4.7.3  After install

The following information describes what you just installed. 

� After install, application icons should be visible for all users by clicking Computer → More 
Applications → Office and residing in /usr/share/applications. See Figure 4-24.

Figure 4-24   Lotus Notes icons

� The Notes installer does not create desktop shortcut icons. 

� The directories created are:

– /opt/ibm/lotus/notes - Lotus Notes 8 product and binary files installation directory

– /root/lotus/notes/data - Lotus Notes 8 data files installation directory

– /root/lotus/notes/data/workspace - Lotus Notes 8 workspace directory 

–  /opt/ibm/lotus/notes/framework - Lotus Notes 8 Java code installation directory 

– /etc/lotus/notes/data - Shared data directory

– /{$HOME}/lotus/notes/data - Lotus Notes 8 data files directory for each user
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– /{$HOME}/lotus/notes/data/workspace - Lotus Notes 8 workspace directory for each 
user

Running the client as a user after root user install

Once the administrator has installed the Notes client, users can log in and run Notes. 

1. Log in as a non-root user.

2. Start Lotus Notes by clicking Computer → More Applications → New Applications → 
Lotus Notes 8.

3. Respond to Notes setup prompts as they appear.

4.8  Notes 8 - basic configuration

The system memory requirements for running the Lotus Notes 8 client with the Eclipse 
interface are higher than those required for running previous versions of the Lotus Notes 
client. You may find that some percentage of your workstations do not yet meet the 
requirements to run Lotus Notes 8.

However, this does not mean that you cannot deploy Notes 8. A basic configuration of Lotus 
Notes 8 is available that requires no more resources than Lotus Notes 6.5/7.x client. Although 
some features will not be available, the basic configuration may be a good option for your 
deployment.

Certain functions and features will not be available with the Basic Lotus Notes 8. See 
Appendix B, “Lotus Notes and Domino client feature comparison” on page 457, for details.

Note: You can install the Lotus Notes 8 client with the Eclipse interface but still run the 
basic portion of the Lotus Notes 8 client by adding the -sa command-line parameter until 
the workstation has been upgraded to the required specification.
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Chapter 5. Coexistence: Domino/Domino 
and Domino/Microsoft Exchange

This chapter discusses the principles of coexistence between Domino 8 and Domino 6.5/7, as 
well as touching on coexistence between Domino 8 and Microsoft Exchange 2000/2003. We 
layout the phases of coexistence followed by a highlight of key issues.

Coexistence is a time of change in your Domino environment that should be handled with 
care and attention to detail. In this chapter we discuss the following implications of 
coexistence:

� Domino/Domino coexistence
– Templates and design elements
– System databases
– Clusters
– Out of office
– Message recall
– Smart Upgrade
– Client
– On-Disk Structure
– ID files

� Coexisting with Domino 6.5
� Domino/Exchange coexistence

5
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5.1  Domino/Domino coexistence

Coexistence between two versions of Notes and Domino has generally not been very 
problematic. Design of Notes and Domino has always been approached with careful 
consideration to backward compatibility. But, as with any deployment project, there are 
elements of unavoidable risk that must be examined and approached with caution.

5.1.1  The phases of coexistence

The process of upgrading an existing Lotus Notes and Domino environment to Notes and 
Domino 8 will require a period of coexistence between Notes and Domino 8 and pre-Notes 
and Domino 8 servers, clients, and applications. Coexistence is not purely the realm of large 
enterprise infrastructures. Even a single-server environment will experience some level of 
coexistence with clients, templates, and design elements. The time period in which your 
environment is in coexistence can be broken up into phases. Regardless to how long these 
phases of coexistence last, keep in mind that during coexistence your environment is in a 
continuous cycle of change with server installs and upgrades, client installs and upgrades, 
and application design upgrades. All the while, this shiny new code is communicating with 
older servers, clients, and applications. This period of change must be handled with thought 
and devotion to quality. Planning and testing are wonderful tools, so give them due 
consideration.

The following list of coexistence phases is intended to provide a higher level of understanding 
into the change that your Domino application and messaging environment will be 
experiencing. The phases of coexistence go hand-in-hand with the migration steps outlined in 
3.4, “Defining the deployment sequence” on page 49.

Initial phase
The first step in any Domino upgrade is to deploy the new Notes client to the Domino 
administration team. As soon as the first upgraded client connects to your existing Domino 
servers, you have entered the initial phase of coexistence. Because the time-lapse between 
installing the administrator’s client and installing the first server can be separated by days, 
weeks, or even months, the initial phase of coexistence can last for quite some time.

The next step in the upgrade is to replace the Domino directory design with the Domino 8 
design template. Upgrading the Domino directory design can take place several days or 
weeks prior to upgrading the Domino code on the administration server, or it can be done just 
prior to the administration server upgrade. For more information see 3.5.2, “Upgrade the 
Directory design across your domain” on page 52.

The initial phase of coexistence ends when you upgrade or install your first Domino 8 server.

Things to be aware of during this initial phase of coexistence include:

� Some of the features in the Domino Administrator 8 client may not be functional on 
pre-Domino 8 servers.

� Developers need to keep in mind that newly added Formula, LotusScript, and Java 
functionality will not work with pre-Notes and Domino 8 clients and servers.

Tip: A Domino directory based on the Domino 8 design can run on Domino 6.5 and 
Domino 7 servers.
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� Domino 8 specific features added to the Domino directory design, especially in the server 
and configuration documents, will not function on pre-Domino 8 servers even if they are 
configured.

Mixed-environment phase
Whether or not you stay in the initial phase of coexistence for a short or long time span, the 
next step is to upgrade your first server to Domino 8. This is usually the administration server, 
as discussed in 3.4, “Defining the deployment sequence” on page 49.

Once your first server is upgraded, you have entered the second phase of coexistence and 
can begin upgrading other servers in your environment. This is also referred to as a 
mixed-environment due to the fact that you have Domino 8 servers running in the same 
environment alongside pre-Domino 8 servers and clients. This phase introduces several 
potential challenges to the administrator as the struggle between implementing new features 
while coexisting with old server code is being managed.

Typically, upgrading the On-Disk Structure (ODS) version of databases on Domino servers is 
the next step in the process. This step is optional with Domino 8. However, there are some 
features that do not work unless the databases are upgraded to ODS48.

� For more information about how to upgrade your databases to ODS48, refer to 3.5.7, 
“Upgrading the ODS (optional)” on page 60.

� To understand the advantages of upgrading the ODS, refer to 9.10, “The new optional On 
Disk Structure (ODS48)” on page 278.

� Step-by-step instructions for the server upgrade process can be found in 3.5, “Performing 
the Domino 8 deployment” on page 51.

The next step in the mixed-environment phase is client deployment. Even though the Notes 8 
client is backward compatible with pre-Domino 8 servers, users may see features that are not 
available when on a pre-Domino 8 server. Therefore, we recommend upgrading the clients 
soon after the servers have been upgraded to avoid user confusion.

Refer to Chapter 4, “Deploying the Notes 8 client” on page 63, for more information about the 
client upgrade procedure.

Design upgrade phase
Finally, the last phase of coexistence is started. This phase entails upgrading your mail 
database and application design.

To simplify your mail database design deployment strategy, familiarize yourself with all facets 
of the design and convert tasks, and use the task that is appropriate for your given situation. 
These tasks allow you to upgrade the design of all databases, specific databases, even 
non-mail databases. In-depth information about design and convert can be found in the Lotus 
Domino Administrator 8 Help.

Applications should be tested prior to this phase in your proof-of-concept or similar 
environment to ensure full compatibility with Domino 8. If any changes need to be made to 
existing applications, they should be rolled-out as soon as possible with consideration of their 
functionality with pre-Notes 8 clients.

Tip: Thoroughly test your deployment strategy by creating a proof-of-concept environment 
were you can test various server, client, and application deployment strategies. Although 
Domino is designed to be backward compatible, this does not lessen the need for testing. 
Test your back-out strategy. Test it multiple times.
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From a support standpoint, you want coexistence to last for as short a period as possible. 
Though great strides have been made by IBM to ensure backward compatibility between 
servers, clients, and templates, there are simply too many factors involved with coexistence 
that can lead to undesirable results. There are unavoidable situations in which environments 
must stay in coexistence. However, every component that can be upgraded in these ongoing 
mixed-environments should be upgraded in order to ensure the highest level of compatibility 
and satisfaction with Notes and Domino.

5.1.2  Templates and design elements

One of the very first items you need to consider when managing your coexistence with 
pre-Domino 8 servers involves templates and design elements. Specifically, you need to 
decide whether to allow Notes and Domino 8 design elements to replicate to pre-Domino 8 
servers, and whether to replicate the new Notes and Domino 8 templates to the older 
pre-Domino 8 servers.

Templates and design element replication
Generally speaking, replicating Notes and Domino 8 templates and design elements to 
pre-Domino 8 servers does not cause issues. In most cases, the new design element feature 
simply does not work. However, there may be situations in which you do not want a 
pre-Domino 8 server to have the Notes and Domino 8 design elements. If this situation were 
to arise, not only would you want to prevent the new design elements from replicating to the 
pre-Domino 8 server, you would also need to prevent the old design elements from 
replicating back to the Domino 8 server. The same holds true for templates in situations 
where separation of Domino 8 and pre-Domino 8 templates is required.

Before we go further, let us quickly define the difference between template and design 
element, as the two terms are frequently used interchangeably.

� Templates: When we refer to templates in this chapter, we specifically refer to the physical 
.NTF file. This file does not contain data, only database design elements.

� Design elements: When we refer to design elements in this chapter, we specifically refer 
to only the design elements of a .NSF file, not the data. Design elements are forms, views, 
framesets, pages, agents, script libraries, and so on. Keep in mind that, in Notes and 
Domino, data is separated from design. Therefore, forms are not the same as documents. 
Forms make up a document’s user interface and programming, while documents simply 
contain data.

Template replication
During the coexistence phases of an upgrade you should keep in mind that template 
replication is no different than replication of any other Notes and Domino application. In fact, 
in order to ensure that this replication takes place, many of the system templates have 
reserved replica IDs that do not change from release to release. Therefore, if your 
environment is architected in a manner that allows templates to replicate between servers 
(that is, you allow replication of all databases via connection documents between servers), 

Note: Did you know that the attention to backward compatibility in Notes allows 
applications built in Notes Release 1, prior to the advent of LotusScript, to still work in 
Notes 8? Notes Release 1 shipped in 1989.

Note: Documents with stored forms are slightly different, but you can simply think of the 
stored form as data because it has, in essence, ceased to be a detached design 
element and has become merged with the data.
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you will need to keep in mind that once you upgrade your first Domino 8 server, many of the 
Notes and Domino 8 templates may replicate to other servers.

If you prefer to keep templates server-version specific (that is, keep Domino 8 templates on 
Domino 8 servers, and Domino 7 templates on Domino 7 servers), then you may need to 
change your procedures to prevent template replication.

Below are some examples of how you might prevent templates from replicating:

� Limit pre-Domino 8 server ACL rights to prevent access.
� Create new copies of the templates so that they have different replica IDs.

Design element replication
Once you begin upgrading the design of your Notes and Domino 8 databases, you may also 
need to consider whether to allow upgraded database design elements to replicate to 
pre-Domino 8 servers. This is not the same as allowing templates to replicate. Here we are 
referring to the ability to filter the replication of a database’s design elements from replication 
to other replicas. In essence, this is the same as saying that the database replication will only 
replicate data, not design.

Example: Domino directory person form
We use the Domino directory as an example. In Domino 8, the person document has a new 
field named Photo URL on the Miscellaneous tab. Perhaps you do not want users on 
pre-Domino 8 servers to see this field. To achieve this, you decide to keep the Domino 
directory from replicating new design elements to old servers.

There are a number of ways to handle this scenario:

� Restrict ACL access. 
� Disable design element replication.

Restrict ACL access
Designer access or above is required to replicate design elements. You could accomplish this 
simply by creating two new groups in your Domino directory, one for Domino 8 servers and 
one for pre-Domino 8 servers. The group of Domino 8 servers is allowed Designer or above 
access, while the pre-Domino 8 group is assigned less than Designer access. As each server 
is upgraded you move it out of the pre-Domino 8 group and into the Domino 8 group.

If possible, administrator and developer access should also be restricted to the database in 
order to prevent accidental replication to the server from a local replica.

Note: Replication works by comparing the documents within a database on one server to 
the documents in a matching replica of the same database on a different server. There are 
many facets to understanding replication, but at the high level it is simply a comparison 
that checks for changes and ensures that all replicas are synchronized and contain the 
same data.

To really understand replication and how it actually compares documents by using 
sequence numbers, revision history, and so on, read the developerWorks article Notes 
from Support: Domino Replication found at:

http://www.ibm.com/developerworks/lotus/library/ls-Domino_Replication
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Disable design element replication
Another option is to disable design element replication for non-clustered servers only. To 
achieve this, follow these steps:

1. Open the template or application.
2. Select File → Replication → Options for this application.
3. Select the Advanced tab.
4. Uncheck the Design Elements box, as shown in Figure 5-1.

Figure 5-1   Disabling design element replication

Tip: The configuration documents, found in the Servers/Configurations view of the Domino 
directory, can be assigned to either a single server or a group. If you decide to utilize a new 
configuration document for your Domino 8 servers, you can use these same groups to 
assign one configuration document to pre-Domino 8 servers, and another configuration 
document to the Domino 8 servers.

Note: If you have agents in your domain signed by the server ID that require Designer or 
above access to the directory, this option may cause issues for those agents. If this is the 
case, consider allowing those agents to run with full access administration or try disabling 
design element replication as outlined below. For more information about allowing agents 
to run with full access administration, see the Lotus Domino Designer 8 Help.

Important: To fully prevent design elements from replicating using this method, we 
recommend that design element replication be disabled on all servers on which the 
template exists.

Note: Communicate this temporary change to all administrators and developers. One 
out-of-the-loop individual can easily change this back and ruin your entire plan.
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Unless you have a particular need to keep the templates and design elements server version 
specific, you may prefer to keep your upgrade, and your environment, simple by allowing 
replication to take place naturally.

Customized templates
Customizing mail and directory templates is very common and must be taken into 
consideration when upgrading. Unless you have specifically implemented some scheme to 
ensure that your customized templates remain independent of the out-of-the-box system 
templates, you may encounter usability issues or lose your customizations when replicating 
newer and older design elements.

Considerations for databases with Notes and Domino 8 design elements
No matter the scheme or mechanism by which you plan to replicate Notes and Domino 8 
design elements, keep in mind that any application based on a Notes and Domino 8 design 
running on a pre-Domino 8 server may exhibit undesirable effects if you attempt to access the 
Notes and Domino 8 features. In most situations, these newer features simply do not function 
on older servers, but this cannot be assumed to be true in all cases. It is therefore important 
to test any business-critical applications.

5.1.3  System databases

Domino system databases such as the Domino directory, resource reservations, and 
administrations request require special consideration when upgrading your Domino 
environment.

Domino directory
Best practices suggest that you upgrade your Domino directory before upgrading any 
servers. Keep in mind, however, that many server features are implemented via design 
elements in the Domino directory. For example, many features can be turned on/off or 
configured via the server and configuration documents. With that in mind, remember that just 
because a feature is configurable via these documents does not mean that the feature is 
actually available. If the server is a pre-Domino 8 server, any Domino 8 specific features, 
though visible in these documents, will not actually run until the server is upgraded to Domino 
8 as well.

Note: Remember to re-enable design element replication as you upgrade each server so 
that you can take full advantage of the benefits of the new design elements.

Important: If you are in a clustered environment, keep in mind that the cluster replicator 
will not abide by this setting and will replicate design elements to other servers in the 
cluster. If you want to keep design elements at the same version as the server, do not put 
Domino 7 and Domino 8 servers in the same cluster.

Tip: To understand how replication conflicts are created during replication, read “A review 
of the Notes ID” on page 150 in the Lotus Notes and Domino 7 Enterprise Upgrade Best 
Practices, REDP-4120, at:

http://www.redbooks.ibm.com/abstracts/redp4120.html
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Administration requests and monitoring configuration
The administration requests database, based on the ADMIN4.NTF template, and the 
monitoring configuration database, based on EVENTS4.NTF, automatically upgrade after 
your server has been upgraded to Domino 8. Allowing these databases to replicate the 
Domino 8 design to pre-Domino 8 servers should not cause any issues in your environment. 
If you do not want the Domino 8 design to replicate to pre-Domino 8 servers, follow the steps 
for disabling design element replication in “Templates and design element replication” on 
page 96. However, as mentioned in that section, you should re-enable replication as each 
server is upgraded to Domino 8.

Domino Domain Monitoring
Domino Domain Monitoring (DDM) was introduced in Domino 7. Though most DDM probes 
are only available on Domino 7 and later servers, there are probes that can be used on 
pre-Domino 7 servers. For instance, a Domino 8 server can probe Domino 6.5 configurations 
from the Domino directory if that directory exists on a Domino 7 or 8 server. The best practice 
probes for security and the Web can also be used.

For additional information about the Domino Domain Monitor database (DDM.NSF), refer to 
the Lotus Domino 8 Administrator Help. or the Redpaper Lotus Domino Domain Monitoring, 
REDP-4089, located at:

http://www.redbooks.ibm.com/abstracts/redp-4089.html

Also refer to 9.9, “New Domino domain monitoring features” on page 265, for information 
about changes to DDM in Domino 8.

Resource reservations
Resource reservations have seen significant changes since Domino 6.5. Prior to Domino 7, 
the resource reservation functionality was distributed amongst the resource template, the 
router task, and the schedule manager task. Beginning with Domino 7, this functionality was 
combined into a single server task: rooms and resource manager, or RnRMgr.

If you will be upgrading directly from Domino 6.5 or earlier, read “Resource Reservations 
database” in the Lotus Notes and Domino 7 Enterprise Upgrade Best Practices, REDP-4120, 
for a full overview of managing resource reservation coexistence, as these points apply to 
Domino 8 just as they did for Domino 7.

Preventing system databases from reverting back to pre-Domino 8
design
The design task is responsible for refreshing the design of all databases on the server with 
their associated master template. Unless configured otherwise, the design task runs every 

Tip: Another upgrade best practice is to freeze all modifications to the environment until all 
servers have been upgraded. Not only will this help avoid confusion over which features 
are available on which servers, but it can drastically improve time-to-resolution on 
server-related issues by not obscuring a problem with both an upgrade and configuration 
change. Many organizations freeze changes during predetermined times of the year, such 
as during quarterly or annual reporting periods.

Tip: Pre-Domino 7 event generators can report to the DDM database. Note that by default, 
only the failure and fatal event types and severities are logged. If you need a specific event 
generator to report to DDM, be sure to adjust the filter or event severity accordingly.
100 IBM Lotus Notes and Domino 8 Deployment Guide

http://www.redbooks.ibm.com/abstracts/redp-4089.html


morning at 1 a.m. From each database, it gets the name of the template from the Inherit 
Design From field and then finds the master template with the same name. Assuming that 
one is found, design then refreshes the database design based on the master template 
design. In most cases, this is a powerful and time-saving feature that not only ensures that 
any design elements inadvertently lost during the day are restored, but also keeps the 
database design up-to-date in case the design template has been modified or upgraded.

During the mixed release phase of coexistence, this feature can be a burden on all servers by 
constantly overwriting the Domino 8 design with the pre-Domino 8 templates if the Domino 8 
templates are not replicated to all servers. This may seem contradictory to our statement 
above regarding system database templates replicating from newly upgraded Domino 8 
servers, but keep in mind that this statement encompassed those specific system database 
templates that have reserved replica IDs that remain the same from release to release. Also, 
these templates only replicate if your connection documents allow it. For instance, if the ITSO 
Corp domain had a single connection document between LA/ITSO and Delhi/ITSO for the 
replication of names.nsf and no other connection documents, then only the names.nsf 
database would replicate between those two servers during scheduled replication, and 
therefore templates, along with all other databases, would not replicate.

Example: design reversion loop
For this example, we use two servers from the ITSO Corp environment: Boston/ITSO and 
Richmond/ITSO. Both servers replicate the Domino directory every 60 minutes via scheduled 
replication. Boston is a Domino 8 server with all Domino 8 templates installed. Richmond is a 
Domino 7 server with the Domino 7 templates installed. The templates do not replicate 
between the two servers. Both servers run the design task every morning at 1 a.m. To 
simplify this example, we also assume that both servers are in the same time zone. Table 5-1 
explains what happens.

Table 5-1   Database design reversion loop

Note: There are many more aspects to consider when discussing replication. ACL, manual 
replication (pull, push, or repl commands issued from the Domino console), database 
replication settings, and so on all affect replication.

Time Boston (Domino 8) Richmond (Domino 7)

Day one:
1 a.m.

Design task launches. As it processes 
the Domino directory it compares it to 
the master template PUBNAMES.NTF. 
There are no differences between the 
designs, so design moves on to the 
next database.

Design task launches. As it processes 
the Domino directory it compares it to 
the master template PUBNAMES.NTF. 
Because PUBNAMES.NTF is the 
Domino 7 template and the Domino 
directory is based on the Domino 8 
design, the design task sees them as 
being different and overwrites all 
Domino 8 design elements with the 
Domino 7 elements.
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The scenario outlined in Table 5-1 on page 101 does not address additional effects, such as:

� Re-indexing of all views that would take place when the update task runs at 2 a.m.

� What would happen if the replicator was replicating the Domino directory at 1 a.m. while 
the design task was replacing the design on Richmond

� The impact on directory performance with so many deletion stubs being created and 
replicated daily

� Time zone differences in a globally diverse environment

It is clear that this design reversion loop may cause an unnecessary drain on server 
resources. Worse yet, this design reversion loop would happen every day.

Day one:
2 a.m.

The replicator kicks off and as it 
compares the Domino directory with 
the replica on Richmond it sees 
hundreds of design elements that are 
newer in Richmond because the 
design has just been refreshed from 
the Domino 7 template. Replicator 
replaces all Domino directory design 
elements on Boston with the Domino 7 
design elements from Richmond, 
effectively overwriting the Domino 8 
design. This is equivalent to deleting 
several hundred documents on 
Boston. Therefore, several hundred 
deletion stubs are pushed from Boston 
to Richmond.

Day two:
1 a.m.

The design task launches. As it 
processes the Domino directory it 
compares it to the master template 
PUBNAMES.NTF. Because 
PUBNAMES.NTF is the Domino 8 
template and the Domino directory is 
based on the Domino 7 design after the 
day one reversion, the design task 
sees the elements as being different 
and overwrites all Domino 7 design 
elements with the Domino 8 elements.

The design task launches. As it 
processes the Domino directory it 
compares it to the master template 
PUBNAMES.NTF. There are no 
differences between the designs, so 
design moves on the to next database.

Day two:
2 a.m.

The replicator kicks off, and as it 
compares the Domino directory with 
the replica on Richmond it sees 
hundreds of design elements that are 
newer in Boston because the design 
has just been refreshed from the 
Domino 8 template. The replicator 
replaces all design elements on 
Richmond with the Domino 8 design 
elements, effectively overwriting the 
Domino 7 design. Again, this is 
equivalent to deleting several hundred 
documents on Richmond. Therefore, 
several hundred deletion stubs are 
pushed from Richmond to Boston.

Time Boston (Domino 8) Richmond (Domino 7)
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If you have the design task running on any of your servers, you may find it beneficial to 
ensure that the new Domino 8 system database templates replicate with the older 
pre-Domino 8 servers in order to prevent the old design from being reapplied, or see “Design 
element replication” on page 97 for more information about preventing replication of design 
elements.

5.1.4  Clusters

Clustering Domino servers is one of the single most powerful features in Domino for 
maintaining high availability for your mail and applications. Both Domino 7 and Domino 8 
introduced clustering enhancements that improve manageability and speed.

Domino 7 saw manageability improvements in the form of the cluster administrator 
(CLADMIN) task. As of Domino 7, the cluster administrator is now a server thread. It still 
performs the same tasks as it did before, such as starting the cluster database manager 
(CLDBDIR) and cluster replicator (CLREPL) tasks at server startup. Previously, the CLDBDIR 
and CLREPL tasks were required to be in the ServerTasks= line, but this is no longer 
necessary. If these tasks still exist in the NOTES.INI, the process of upgrading to Domino 8 
removes any CLDBDIR and CLREPL lines from ServerTasks= and adds CLADMIN.

Domino 8 further improves on clustering with the advent of streaming replication. You can 
read more about what streaming replication is and how it works in 9.12, “Other administrative 
enhancements” on page 309. The important thing to know about streaming replication is that 
during coexistence, Domino 8 does not preform streaming replication with pre-Domino 8 
servers in the same cluster. Instead, Domino attempts to initiate streaming replication, and 
upon failure to do so reverts back to standard cluster replication. Therefore, while this new 
feature is not used with older Domino releases, clustering continues to function as it did 
pre-Domino 8. As soon as there are two or more Domino 8 servers within a cluster, the 
Domino 8 servers automatically begin utilizing streaming replication amongst themselves and 
fall back to standard cluster replication with the remaining pre-Domino 8 servers in the 
cluster.

Finally, while modifications have been made to the cluster database directory template 
(CLDBDIR.NTF), these changes are all backward compatible with pre-Domino 8 servers.

5.1.5  Out of office

New to Domino 8 is the option for the out of office process to run as a service rather than an 
agent. During the upgrade of your environment, when a Domino 8 server is in a cluster with 
one or more pre-Domino 8 servers, out of office must run as an agent.

For more information about running out of office as a service refer to 9.12, “Other 
administrative enhancements” on page 309.

Tip: Allowing the design of system databases to replicate throughout your domain 
alleviates these types of concerns.

Note: Even though changes to the cluster database directory database are backward 
compatible and the new streaming replication will gracefully revert back to standard cluster 
replication when attempted with a pre-Domino 8 server, we recommend that all servers in 
a cluster be upgraded to the same Domino release in relatively quick succession.
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5.1.6  Message recall

A new feature to Domino 8, message recall, provides the ability for users to recall a message 
that has been sent. This feature utilizes the router task of the Domino server to perform the 
recall, while in a mixed environment, users on a Domino 8 server are not able to recall 
messages from users on pre-Domino 8 servers.

5.1.7  Smart Upgrade

Smart Upgrade was introduced in Notes 6 to alleviate much of the burden involved with 
upgrading Notes clients across the enterprise. Table 5-2 presents the features of Smart 
Upgrade and notes which features are dependent on specific client versions, server versions, 
or template versions. Take this table into consideration when planning your client upgrades.

Table 5-2   Smart Upgrade feature and server, client, or a specific template version dependency

Tip: Message recall is enabled by default on Domino 8 servers, so it is a good idea to 
decide whether your organization will allow message recall prior to beginning the upgrade 
procedure. Refer to 9.3, “Message recall” on page 245, for more information.

Tip: For more information about SmartUpgrade, refer to the IBM Redpaper Understanding 
Lotus Notes Smart Upgrade, REDP-4180, at:

http://www.redbooks.ibm.com/abstracts/redp-4180.html

Smart Upgrade feature Notes client
dependency

Domino server
dependency

Template
dependency

Multiple source versions. 6.0.3/6.5 or later 6.0.5/6.5 or later 6.5.1 Smart Upgrade kits 
(SMUPGRADE.NTF)

Pattern matching for source version. 6.5.1 or later 6.5.1 or later N/A

Upgrade deadline (and “remind me every 
hour”).

6.0 or later 6.5.1 or later 6.5.1 Domino directory 
(PUBNAMES.NTF)

Automatic prompting occurs when 
authenticating to user’s home server is 
down, but a server in the cluster contains a 
Smart Upgrade database.

6.0 or later 6.5.1 or later N/A

Notes client fails over when attempting to 
find Smart Upgrade database and the user's 
home server is down, but a server in the 
cluster is up containing a replica of the 
Smart Upgrade database.

6.5.1 or later 6.0 or later N/A

Administrator can specify both a shared 
path and an attached kit.

6.5.1 or later 6.5.1 or later 6.5.1 Smart Upgrade kits 
(SMUPGRADE.NTF)

Background thread initiates Smart Upgrade.  6.5.3 or later 6.0 or later N/A

Attached kits detach in the background.  6.5.3 or later 6.0 or later N/A
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For more information about Smart Upgrade changes in Notes 8, refer to 4.4, “Smart Upgrade” 
on page 73.

5.1.8  Client

Just as Domino 8 can communicate with older Domino server releases, the Notes 8 client can 
also communicate with older server releases. It is considered a best practice to upgrade 
clients after the server has been upgraded, but there are cases, such as with administrators 
and developers, were certain users may need the newer client prior to their server being 
upgraded. If this happens you should communicate to these users that there may be features 
available in the client that require a Domino 8 back-end in order to operate, and that those 
features may not be available until Domino is upgraded. As long as you keep this in mind, 
upgrading the client on select users prior to upgrading the server should pose no significant 
issues.

For more information about communication, refer to 2.3.5, “Creating a communication and 
training plan” on page 39.

Client/template interoperability
After upgrading both the server and client, you can begin the process of upgrading user mail 
files to the Notes 8 template. Using the latest template enables the user to take advantage of 
all the latest features in Notes and Domino 8. Table 5-3 lists best practices for client/template 
coexistence.

Table 5-3   Supported client/template coexistence

Smart Upgrade tracking.  6.5.3 or later 6.0 or later 6.5.3 Domino directory 
(PUBNAMES.NTF)

6.5.3 Smart Upgrade Kits 
(SMUPGRADE.NTF)

Smart Upgrade console commands:
SUCACHE SHOW and SUCACHE 
REFRESH.

6.0 or later 6.0.5/6.5.4 or later N/A

Smart Upgrade governors. 6.0.5/6.5.4 or later 6.0.5/6.5.4 or later 6.0.5/6.5.4 Domino 
directory 
(PUBNAMES.NTF)

All clients versus Notes client only 
differentiation.

6.5.5 or later 6.0 or later 6.5.5 Smart Upgrade kits 
(SMUPGRADE.NTF)

Prompt when detaching kits in background 
complete.

7.0 or later 6.0 or later N/A

Smart Upgrade feature Notes client
dependency

Domino server
dependency

Template
dependency

Lotus Notes 8.x Lotus Notes 7.x Lotus Notes 6.5.x

Notes 8 template Supported Supporteda

a. Although this configuration is supported, it is not considered a best practice because there is
limited functionality available to the user.

Unsupported

Notes 7 template Supported Supported Supporteda

Notes 6 template Supported Supported Supported
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Refer to Chapter 6, “Lotus Notes 8 client features” on page 113, for a more in-depth review of 
Notes client features.

Calendar and scheduling
Many of the new calendar and scheduling features rely on a Domino 8 back-end, Notes 8 
interface, and Notes 8 mail template design. Therefore much of the new functionality is 
missing until the server, client, and finally mail template are upgraded.

Table 5-4 lists the new calendar features available in Notes 8.

Table 5-4   New calendar features in Notes 8

Calendar delegation
Users who manage other users’ calendars, also known as calendar delegates, are a special 
case requiring some forethought before upgrading their client or template. Undesirable side 
effects can occur if the calendar owner and calendar delegate are running different versions 
of the Notes client. For example, if the calendar owner were to be upgraded to both the 
Notes 8 client and template prior to the delegate, the delegate could encounter difficulty 
managing the calendar based on the Notes 8 template while they are still using a pre-Notes 8 
client. Furthermore, the calendar owner will have features available that the calendar 
delegate does not.

To alleviate this situation, we recommend coordinating the upgrade process so that both 
calendar owner and calendar delegate are upgraded to the Notes 8 client at the same time. 

Tip: For the most up-to-date information about supported templates, refer to Technote 
1264690 at:

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21264690

Feature Description Benefit

More consistent and intuitive 
navigation

� Ability to access views from the left 
navigator

� Action bar enhanced for consistency 
with mail

Get your work done more quickly and 
easily.

Unprocessed calendar entries Option to display unprocessed 
invitations side-by-side with accepted 
calendar entries

See overlaps in your schedule at a 
glance before deciding which meetings 
to accept.

Improved display of events Modified display of all day events to 
visually span the entire day

See at a glance that every time slot in the 
day is already scheduled.

Ability to check your calendar 
while you are scheduling a 
meeting

Option to show your schedule for the 
target meeting date while you are 
creating a meeting notice

More easily reduce the likelihood of 
inadvertent scheduling conflicts.

Options to manage meeting 
cancellations

Option to have canceled meetings 
identified with visual cues on your 
calendar

Choose the way you prefer to work. 

Can use in conjunction with 
unprocessed calendar entries to help 
you make scheduling decisions about 
which meetings to accept.

More flexible free time search Ability to locate a mutually free time for a 
dynamic subset of the invitee list

Check free time for different groupings of 
invitees when there is no mutually 
convenient time for everyone.
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We also recommend upgrading their mail templates at the same time, mostly to avoid user 
confusion rather than for any technical reason.

Autoprocess meeting invitations
Notes/Domino 7 introduced the ability to autoprocess incoming meeting invitations based on 
preference settings. If you are upgrading from a pre-Domino 7 environment, see the Lotus 
Notes and Domino 7 Enterprise Upgrade Best Practices, REDP-4120-00, at 
http://www.redbooks.ibm.com/abstracts/redp4120.html for coexistence issues, as they 
apply to Domino 8 as well.

5.1.9  Domino Web Access

Domino Web Access 8 (DWA) has several new features that require a Domino 8 server and 
the FORMS8.NSF file, which resides on the server. If you upgrade a mail file to the Notes 8 
design on a Domino 7 server, or if you replicate a Notes 8 mail file to a Domino 7 server, you 
will not have access to these new features or the new look of DWA. However, because 
Domino 8 servers do contain FORMS6.NSF and FORMS7.NSF, these prior releases of DWA 
will work on a Domino 8 server.

In order to run Sametime connect through DWA7 with new mail files on a Domino 8 server, 
refer to Domino Administrator 8 Help for information about how to use the Sametime 7.0 
connect client for browsers. The help entry “Setting up Domino Web Access with Sametime” 
provides step-by-step instructions. This can be skipped if all new mail files on your Domino 8 
server will be created with the DWA8 design.

If you will be housing DWA6.5 users on your Domino 8 server, you should also note that the 
instant messaging settings and local archive settings in the configuration document of the 
Domino directory are intended only for users using the DWA8 template. In order to configure 
these option for DWA6.5 users you will need to utilize the appropriate INI parameters, as 
defined in Table 5-5.

Table 5-5   Sametime and local archiving NOTES.INI parameters for DWA6.5 users

Tip: Keeping confusion to a minimum for your users during a migration will see a drastic 
improvement in both user satisfaction and user-perceived migration success.

Note: As of Domino 8 there are no longer two separate templates for mail and Domino 
Web Access. The MAIL8.NTF includes DWA. There is no separate DWA template.

Attention: If you currently have DWA5 deployed, note that FORMS5.NSF is not 
distributed with Domino 8. However, if upgrading a server that contains FORMS5.NSF to 
Domino 8, the install process does not remove this file and DWA5 continues to work. In 
order to get DWA5 to work on a new Domino 8 install you must replicate FORMS5.NSF to 
this server.

Notes.ini parameter Configuration Settings document field

iNotes_WA_Chat Instant Messaging features

iNotes_WA_LiveNames Online awareness

iNotes_WA_SametimeJavaConnect Prefer Sametime Java Connect for browsers
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For more information about Domino Web Access 8, see Chapter 8, “Domino Web Access” on 
page 215.

5.1.10  On-Disk Structure 

The On-Disk Structure, more commonly referred to as ODS, has been upgraded in Domino 8 
to ODS 48. Domino 8 is fully backward compatible with all prior ODS versions including ODS 
16 used in Notes Release 1. However, you are not able to open an ODS 48 database locally 
in Notes 7 or prior. If you require an ODS 48 database on a Domino 7 or prior server, you 
must either create a new replica or a new copy. Do not make an operating system-level copy, 
as the ODS is part of the database structure and is copied if done from the OS. Replicas and 
Notes copies automatically convert the ODS to the appropriate version depending on the 
Notes or Domino version being replicated/copied to.

For more information about ODS see 9.10, “The new optional On Disk Structure (ODS48)” on 
page 278.

5.1.11  ID files

Many changes were made to encryption key length between Notes and Domino 6.5 and 
Notes and Domino 7. Therefore, if you are upgrading to Notes and Domino 8 directly from 
Notes and Domino 6.5, refer to the Lotus Notes and Domino 7 Enterprise Upgrade Best 
Practices, REDP-4120-00, available at:

http://www.redbooks.ibm.com/abstracts/redp4120.html

5.1.12  Coexisting with Domino 6.5

While many new features have been added to Domino 8, it is Notes 8 that received most of 
the attention in this release. Though we tried to keep Domino 6.5 in mind throughout this 
chapter, we recommend that if you are considering upgrading to Domino 8 directly from 
Domino 6.5 you also consult the Lotus Notes and Domino 7 Enterprise Upgrade Best 
Practices, REDP-4120-00, as much of the information in it applies to Domino 8 as well. The 
Redpaper can be found at:

http://www.redbooks.ibm.com/abstracts/redp4120.html

5.2  Domino/Exchange coexistence

Coexistence between the Exchange and Domino environments plays one of the most critical 
roles in ensuring a seamless migration process for both administrators and users. Unless you 
can accomplish instantaneous migration of users from Exchange to Domino, users will likely 

iNotes_WA_SametimeServer Set instant messaging server host name for all 
Domino Web Access users

iNotes_WA_SametimeToken Allows secrets and tokens authentication

iNotes_WA_STLinksLocal Loads \stlinks from Domino application server

iNotes_WA_NoLocalArchive Local Archiving

Notes.ini parameter Configuration Settings document field
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be migrating gradually over a period of time. During that time, users in both environments 
must be able to continue communicating with one another as well as with users who are 
external to both environments. Failure to provide this ability to users can have an adverse 
effect on any migration project.

5.2.1  Levels of coexistence

Several levels of coexistence between Exchange and Domino are possible. The functionality 
that is provided by the selected coexistence approach normally depends on the functionality 
presently utilized by Exchange users and existing Domino users. The following list describes 
coexistence options from the simplest to the most complex. Refer to the technical sections 
later in this book for comparison of the different coexistence and migration tools.

The levels of coexistence are:

� No coexistence

� Messaging only

� Messaging with directory synchronization

� Messaging with directory synchronization and cross-platform calendar and scheduling 
support

� Messaging with directory synchronization, cross-platform calendar and scheduling 
support, and uninterrupted application access

No coexistence
Users are migrated instantaneously, for example, during the weekend. At no point are there 
Domino and Exchange servers existing side-by-side.

Messaging only
This coexistence method uses SMTP to exchange mail messages between Exchange, 
Domino, and the Internet, and requires manual entry of addressing information for some or all 
recipients. 

This method is fairly easy to establish, however, it imposes a burden on users to know the 
exact addresses of all recipients, some of whom they had previously been able to select from 
the directory. Addressing questions subsequently increase the load on the user support 
personnel, dramatically increasing the overall cost and decreasing satisfaction with the 
coexistence solution. This method is only recommended for brief coexistence periods.

Messaging with directory synchronization
This coexistence method uses SMTP or other protocols for sending mail messages between 
Exchange, Domino, and the Internet, and allows selection of all Exchange and Domino 
recipients from the appropriate mail directory. Depending on the mail exchange approach 
selected, directory synchronization can be performed manually or automatically.

Manual directory synchronization requires periodic updates to Domino and Exchange 
directories initiated by an authorized individual. The process can consist of executing custom 
programs, performing manual data entry, or a combination of the two.

Automated directory synchronization is a process that automatically performs directory 
updates either instantly or based on a predefined schedule. Automated directory 
synchronization can be achieved by using IBM Tivoli Directory Integrator, Microsoft’s Domino 
Connector for Exchange, Microsoft’s Identity Integration Server, TenFour’s TFS Gateway, or 
by creating automatically invoked custom programs.
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While automated directory synchronization requires a fair amount of effort to establish, it 
enables users to continue e-mail communication in a familiar way regardless of the sender’s 
or recipient’s migration status. Because of this, this method is recommended for extended 
coexistence periods.

Messaging with directory synchronization and cross-platform calendar
and scheduling support
This coexistence option uses SMTP or other protocols for exchanging mail messages 
between Exchange, Domino, and the Internet, and allows selection of all Exchange and 
Domino recipients from the appropriate mail directory. Depending on the mail exchange 
approach selected, directory synchronization can be performed manually or automatically. 
Also, depending on the mail exchange approach selected, cross-platform calendar and 
scheduling support can be provided in a transparent or manual fashion.

In the manual approach to cross-platform calendar and scheduling, Domino and Exchange 
users include users of the opposite platform in the scheduling notices, which are translated 
into simple mail messages when delivered to such recipients. Recipients have to manually 
add scheduling notices to their calendars and manually respond to invitations. Cross-platform 
schedule check is not possible with this approach.

In the transparent approach to cross-platform calendar and scheduling, Domino and 
Exchange users are able to perform all calendar and scheduling functions, such as sending 
scheduling notices, accepting invitations, checking schedules, and so forth, regardless of the 
recipient’s platform. Transparent cross-platform calendar and scheduling support can only be 
achieved by using the calendar connector portion of Microsoft’s Domino Connector for 
Exchange.

This method requires a great deal of effort to establish. However, it enables users to continue 
all of their e-mail and calendar and scheduling communication in a familiar way regardless of 
the sender’s or recipient’s migration status. This method is recommended for extended 
coexistence periods.

Messaging with directory synchronization, cross-platform calendar and
scheduling support, and uninterrupted application access
This coexistence method uses SMTP or other protocols for exchanging mail messages 
between Exchange, Domino, and the Internet, and allows selection of all Exchange and 
Domino recipients from the appropriate mail directory. Depending on the mail exchange 
approach selected, directory synchronization can be performed manually or automatically. 
Also, depending on the mail exchange approach selected, cross-platform calendar and 
scheduling support can be provided in a transparent or manual fashion. Finally, depending on 
the nature of applications, application access can be achieved through universal application 
access, or manual or automatic application synchronization.

Universal application access is achieved for applications that are Outlook® 
client-independent, for example, Web-enabled applications accessed through a Web 
browser. Users continue to access such applications regardless of their migration status. For 
Outlook client-dependent applications, continuous application access can be achieved by 
retaining the Outlook mail client on users’ workstations, possibly along with the Notes client, 
and continuing to access applications that so require it using Outlook client.

Manual application synchronization requires that periodic updates to applications be 
performed by an authorized individual. The process can consist of executing custom 
programs, performing manual data entry, or a combination of the two.

Automated application synchronization is a process that automatically performs application 
updates, either instantly or based on a predefined schedule. Depending on the nature of an 
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application, automated application synchronization can be achieved by using a third-party 
product or by creating automatically invoked custom programs.

Depending on the nature of applications, this method can require a great deal of effort to 
establish. However, it enables users to continue accessing applications regardless of their 
migration status. This method is recommended for extended coexistence periods were 
seamless application access is important. 

Note: For an in-depth overview of migrating from Exchange 2000/2003 to Domino, see 
Migrating from Microsoft Exchange 2000/2003 to Lotus Notes and Domino 7, SG24-7777.
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Chapter 6. Lotus Notes 8 client features

World-class collaboration gets even better with new features and capabilities in Lotus Notes 8 
client. This chapter focuses on the enhancements in the Lotus Notes client's core capabilities, 
such as e-mail, calendaring and scheduling, and contact management. 

This chapter also provides insights into the enhanced instant messaging and presence 
awareness support and support for activity-centric collaboration, which can increase user 
productivity and efficiency.

This chapter would be of great value for all kind of users who would like to understand in 
detail the new features in the Lotus Notes 8 client and how does it impacts productivity and 
efficiency. This chapter also provides tips on how to utilize these new features in order to 
derive maximum benefit.

This chapter contains the following sections:

� Enhanced user interface
� Mail enhancements
� Calendar enhancements
� Contacts
� Document editing
� Sidebar plug-ins
� Sametime contacts
� Activities
� Reading feed content in Lotus Notes 8 client

6
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6.1  Enhanced user interface

The Lotus Notes 8 client has a fresh but familiar look and feel and is designed to be intuitive 
to use. The interface was designed in direct response to feedback from users. Notes 8 
software offers a number of new features to assist in improving employee efficiency and 
effectiveness.

Notes 8 software is flexible. Not only does it offer the option to personalize the interface to 
accommodate your own ways of working, it also includes the ability to use plug-ins, allowing 
the interface to be extended to meet your business requirements.

6.1.1  Welcome page

While the home setup page (previously known as welcome setup page) has a new look, as 
shown in Figure 6-1, there are still the familiar options, where you can choose to create your 
own home page, use the default, or learn more on what is new in this release. 

Figure 6-1   Home Setup page

Note: If you are upgrading from a previous version of Lotus Notes client, then, by default, 
you will retain your existing welcome page.
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Choosing to use the default page takes you to the Getting Started page. See Figure 6-2. 

Figure 6-2   Getting Started page

Once the Getting Started page is close, the Notes client opens to the home page or an 
application that you have specified. 
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The Notes 8 client has a new default welcome page, now called Home page, as shown in 
Figure 6-3. 

Figure 6-3   Default Home page

As with previous versions of the Lotus Notes client, there are links on the Home page to mail, 
calendar, contacts (previously called personal address book), to do, and personal journal. 
Additionally, with the Notes 8 client, you now have links to a set of productivity tools, which 
you might have installed with the Notes client. For more details, see Chapter 7, “Productivity 
tools” on page 199.
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6.1.2  Open list

Your Lotus Notes applications and documents are now accessible from a new Open list 
menu, which is displayed by clicking the Open button in the top-left corner of the panel 
(Figure 6-4). 

Figure 6-4   Open list

If you are upgrading from a previous release of the Lotus Notes client, you would realize that 
the Open menu has replaced what you knew as the bookmark bar, and your bookmarks are 
migrated into the Open list. In addition to what was on the bookmark bar, the Open list also 
has links to the IBM productivity tools (see Chapter 7, “Productivity tools” on page 199 for 
more information), as well as the Web browser. One of the advantages of the Open list is that 
it displays icons as well as a brief description for each item without having to hover over the 
icons.
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Dock the Open list
You can chose to dock the Open list to display only icons in a thin list along the edge of your 
panel (or for the look and feel of a bookmark bar). See Figure 6-5. To do this, right-click Open 
and then click Dock the Open List. To view it as a full list once again, right-click an open area 
of the thin list and uncheck the docking option. This option is available on the View tab. 

Figure 6-5   Docked Open list

Type to find
Another advantage of the Open list menu is that you have the ability to search your Open list. 
Use the type-ahead feature by entering the first letter or two of the application that you want 
to open at the Type to find prompt (Figure 6-4 on page 117). As you type, only applications 
that contain text matching the typed text will remain in the list.
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Note that there is a still a File menu from where you can open Lotus Notes databases that 
you have not bookmarked. If you have used a previous version of Lotus Notes, you will notice 
that the term database has been replaced with application (Figure 6-6).

Figure 6-6   File menu

This change in terminology reflects the fact that the Lotus Notes 8 client is embracing 
additional types of applications and is no longer limited to just databases. See Chapter 12, 
“New application development features” on page 399.

6.1.3  Toolbars

Contextual toolbars now appear within each individual Lotus Notes tab rather than directly 
below the menu, bringing the toolbars closer to the activity to which they relate and allowing a 
smoother transition when switching between tabs that require different toolbars. Figure 6-7 
shows an example.

Figure 6-7   Toolbar appears within the mail tab

Tip: To quickly display a menu that allows you to hide toolbars, display additional toolbars, 
or access toolbar preferences, right-click the toolbar.
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6.1.4  Window management and navigation

Notes 8 offers several features to help you manage your open windows, making it possible for 
you to navigate easily to the required view, document, or page, even when there are several 
Lotus Notes panels open. To set a preference on how documents or applications are opened, 
click File → Preferences → Windows and Themes and make you changes.

Open each document in its own tab
As with Lotus Notes 7, this default option has each document and application open a new 
window tab in your active Lotus Notes panel.

Group document tabs
With Notes 8, you now have the option to group window tabs. This means that when you have 
several documents open from the same database view, they are grouped together under a 
single tab. Clicking the arrow on the right side of the tab displays a list of all of the open 
windows from this view. Simply click an entry in the list to navigate to the required window. 
See Figure 6-8 for an example. 

This feature can improve your ability to manage multiple windows. Fewer tabs across the top 
of the page make it easier to read the tab names. And, because the tab contents are listed in 
the drop-down list, it is possible to see the complete panel titles.

Figure 6-8   Group document tabs
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Open each document in its own panel
Another option for panel management is to have all documents in their own panel. This is 
useful if you want to display more than one document on the page at one time, as shown in 
Figure 6-9.

Figure 6-9   Open each document in a separate panel

6.1.5  Thumbnails

Window tabs make it convenient for you to switch from one open document or application to 
another. However, the number of tabs in the panel can grow very quickly. In addition to the 
options listed in 6.1.4, “Window management and navigation” on page 120, you are also able 
to view thumbnails of all open panel tabs. Click the Show Thumbnails icon on the right side of 
the Open button, as shown in Figure 6-10, to view the tabs as thumbnails.

Figure 6-10   Show Thumbnails icon
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Figure 6-11 is an example of a view with all open window tabs showing as thumbnails. You 
can click one of the thumbnails to quickly navigate to the associated Lotus Notes window tab.

Figure 6-11   Thumbnails

You can also use the type-ahead feature by entering the first letter or two of the document or 
application that you want to open in the Find field (see Figure 6-11). This acts as a filter, 
displaying only the tabs with the titles that contain the typed text, and therefore reduces the 
number of tabs displayed and makes it easier to locate the tab that you need.
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6.1.6  Unified preferences

With Notes 8, the File → Preferences menu is a single location from which you can configure 
all preferences associated with the Lotus Notes client, including preferences associated with 
locations, instant messaging, activities, and the productivity tools. See Figure 6-12.

Figure 6-12   Preferences

To offer users the flexibility to customize the client interface to meet their specific needs and 
ways of working, there are many preferences that can be configured. However, a filter 
function at the top of the list of preferences enables you to quickly locate the required 
preference by showing only those preferences that match the text that is entered. See the 
example in Figure 6-13.

Figure 6-13   Filtering the preferences
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Note that the original methods for accessing the mail/calendar preferences and locations are 
still available in addition to the unified preferences menu, allowing backward compatibility for 
users familiar with the original methods.

6.1.7  Advanced menus option

In order to simplify the menus for users, the Notes 8 client has an option to suppress the 
advanced menus, as shown in Figure 6-14. Options on advanced menus are targeted more 
for system administrators or designers, and include menus for tasks such as archiving or 
deleting Lotus Notes applications, creating an embedded element, or viewing agents. The 
Advanced Menus option is deselected by default, and users requiring these advanced menu 
entries need to select this option using View → Advanced Menus.

Figure 6-14   Configuring advanced menus
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Figure 6-15 is an example showing the difference between the tools menu with the advanced 
menus option selected and the tools menu without the advanced menus option.

Figure 6-15   Difference in the tools menu options with and without the advanced menus option

The options listed in Table 6-1 display only when advanced menus are enabled.

Table 6-1   Additional options with advanced menus enabled

6.1.8  Making applications available offline

To simplify the process of creating a local replica of an application that is hosted on a Lotus 
Domino server, the Notes 8 client has a Make Available Offline option. Through a single 

Menu Option

File → Application Archive
Delete
Design synopsis
New Copy 
Publish
Refresh Design
Replace Design

File → Replication Find Replica
History
New Replica

View Agents
Design
Image Resources
Switch Form

View → Show Hidden from Notes
Java Applets Running
Page Source
Pass-Thru HTML

Create Computed Text
Design
Embedded Element
Java Applet
View

Actions Edit HTML Attributes
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window, users can supply all the information necessary to enable them to access applications 
when they are disconnected from their network. See Figure 6-16 for an example.

Figure 6-16   Make the application available offline

The Make Available Offline option is also available by right-clicking the application icon on the 
workspace or in the Open list.

6.1.9  Search enhancements

The Notes 8 client has a new search center interface and also a new search syntax that 
allows the user to find information more seamlessly.
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Search center
The search center in the Notes 8 client enables you to go to a single location to search your 
mail, calendar, directories, catalogs, and even the Web. Figure 6-17 illustrates some of the 
enhancements. For example, there are options for Yahoo! and Google Web searches. If you 
select one of these options, your Web search is carried out by the associated search engine. 
If you have Google Desktop Search installed on your workstation, this option also appears in 
the search scope drop-down menu.

Figure 6-17   Search center enhancements

Now you do not have to leave your Lotus Notes client to perform common search tasks even 
if the targets of the search are not in the Lotus Notes environment itself.

New search syntax
The Lotus Notes 8 client now supports a new Web-style syntax when performing search. If 
your search query now has several words, the documents returned will contain those words, 
but not necessarily in the order that you specified. 

For example, “ibm redbooks publications” or “publications redbooks ibm” might give the same 
search results. 

This is a change from the current Notes syntax. To search exact terms and to force the order, 
quotation marks are now needed.
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6.1.10  Web browser

In order to view a Web page from the Lotus Notes client, earlier releases of the client 
provided you with the option of using either Notes browser, Microsoft Internet Explorer 
Netscape Navigator, or manually selecting a different browser path.

With the Notes 8 client, you can either choose to use the embedded browser, which lets you 
navigate Web pages directly from within Lotus Notes or your operating system default 
browser, allowing you to use the browser familiar to you, without having to know its installed 
path.

You can specify which browser to use from your Web browser preferences, as shown in 
Figure 6-18.

Figure 6-18   Web browser preferences

Attention: To use the old Notes-style (pre-Lotus Notes 8) search for a particular query, 
you can prepend a forward slash (/) to the beginning of the query to switch off Web-style 
syntax for that search.

Note: Refer to the Lotus Domino 8 Administrator’s Guide for more information. All Lotus 
Notes and Domino documentation can be found at:

http://www.ibm.com/ldd/doc
128 IBM Lotus Notes and Domino 8 Deployment Guide

http://www.ibm.com/ldd/doc


6.1.11  Dynamic help

In the Notes 8 client, help has a new user interface that lets you display context-sensitive help, 
specific to the task you are performing, in a side panel while you work (Figure 6-19). 

Figure 6-19   Context-sensitive help

In addition to help for the Lotus Notes client, this help system includes sections about 
Sametime contacts, activities, the composite application editor, and the IBM productivity 
tools, each of which you can choose to install during the Notes 8 client installation.

6.1.12  IBM Support Assistant

IBM has integrated the IBM Support Assistant with the Lotus Notes client. You can access the 
IBM Support Assistant from the Notes 8 client help menu by selecting Help → Support → 
IBM Support Assistant.

IBM Support Assistant is a software application offered at no additional charge. It is intended 
to help clients be more productive with IBM products by resolving product challenges faster. 
Clients are encouraged to consult IBM Support Assistant when experiencing a product 
challenge. IBM Support Assistant offers resources for self-help that can enable customers to 
identify, assess, and overcome product difficulties without needing to contact IBM. When it is 

Tip: Context-sensitive help is available when you press F1.
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necessary to contact IBM, IBM Support Assistant offers resources for rapid submission of 
problem reports and immediate, automated collection of diagnostic data that can accelerate 
problem resolution. See Figure 6-20.

Figure 6-20   IBM Support Assistant Welcome page

For more information about IBM Support Assistant, see the Lotus Notes 8 client online help or 
the following Web site:

http://www.ibm.com/software/support/isa/

6.2  Mail enhancements

The fresh new interface in the Lotus Notes 8 mail file is a direct result of considerable 
feedback from the Lotus Notes community. It is intuitive to use, as well as having new and 
improved features, which include a new preview option, in-line spell checking, message 
recall, intelligent e-mail addressing, enhanced out of office, and improved threaded e-mail 
capabilities. We look at these new mail features in detail.
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6.2.1  Action bar

Each window tab optionally includes an action bar, specific to the application or document 
open in the window tab. The mail file inbox action bar uses both icons and text. There are 
icons with no text for common and easily distinguishable actions. However, you can hover 
over the icon to remind you of its action. Figure 6-21 displays the mail action bar with the 
folder icon selected.

Figure 6-21   Inbox Action bar

In most cases, common actions can be carried out with a single click, leaving easily 
accessible, two-click actions for less frequent tasks. For example, if you are in your mail file, it 
is likely that the type of document you create most often is a new e-mail. Therefore, if you click 
the New icon in the action bar, a new message form opens. However, if you click the arrow 
beside the New icon, you get a drop-down list allowing you to select a new calendar entry, to 
do entry, or contacts entry instead.

Also, reply and reply to all are single-click actions, and these now default to including the mail 
history and attachments.

Note: Items on the action bar are also available from the action menu.
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6.2.2  Mail preferences

Notes 8 has all preferences pertaining to your mail file in one location as part of the unified 
preferences. Mail preference (Figure 6-22) has been simplified so that it is easier for users to 
manage their mail file.

Figure 6-22   Mail preferences
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New in Notes 8 is the Image Security option with the ability for you to prevent the display of 
unwanted images, especially from unsolicited mail. See Figure 6-23.

Figure 6-23   Mail preferences - image security

6.2.3  Message preview

In this section we discuss the message preview.
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Vertical preview
The preview pane displays a preview of a selected document in an application, such as a mail 
message or calendar entry. In Notes 8, you now have the option of displaying the preview 
pane vertically, beside the view pane, as well as horizontally, underneath the view pane. The 
vertical preview pane is shown in Figure 6-24.

Figure 6-24   Vertical preview pane

Note that, with the vertical preview pane on the right, your mail view is automatically 
reformatted to show the mail subject on a second line, underneath the sender and the date. 
This allows you to see the pertinent information for each mail message even though the width 
of the view has been made smaller. The option to switch between the preview panes or to 
hide the preview pane altogether is selected from the Show menu at the top-right corner of 
the page.

6.3  Mail threads and conversations

Lotus Notes 7 introduced the ability to see the mail thread to which an e-mail belonged from 
within the header of an e-mail. In addition, with Notes 8, there are two methods of viewing 
mail threads directly from the inbox (or any folder whose design is based on the inbox).
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Individual message view
By default, the inbox view will show you whether there is a thread associated with an e-mail 
when you highlight the e-mail. Note the twisty in front of the mail subject. This tells you that 
this e-mail is part of a mail conversation (Figure 6-25).

Figure 6-25   Individual mail

Clicking the twisty at the front of the subject opens up the conversation and allows you to see 
the contents of the conversation, as shown in Figure 6-26.

Figure 6-26   Click twisty to see conversation

Replies to an e-mail often have the same title as the original e-mail, simply prefixed with Re:. 
In order to allow more useful information to be shown in the conversation, the first line of the 
e-mail, rather than the title, is used in the conversation. This might make it easier for you to 
identify the e-mail that you need. It might even allow you to find all the information you require 
without actually having to open any of the e-mails in the conversation.

Note that the conversation shows all associated e-mails regardless of where they are in your 
mail file and also shows you the folders in which they are located.

The mail conversations are resilient. This means that if an intermediate response is deleted 
from the mail file, any replies to the deleted response still appear in the conversation. Also, 
conversations can now include mails that originated from e-mail systems other than Lotus 
Notes, meaning that responses to and from people outside of your company also appear in 
your conversations.
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Conversation view
With Lotus Notes 8, you can also organize mail messages in your inbox view so that they are 
grouped in conversations with only one view entry per conversation. This can make searching 
the inbox much easier. This is because there are fewer conversations than there are e-mails. 
You can now have all the e-mails in a topic grouped together in your inbox under the latest 
entry in the mail thread.

You can switch between the individual messages mode (where messages and replies are 
displayed and sorted individually) and the conversations mode (where messages and replies 
are grouped together) from the Show menu at the top-right corner of the page. 

When you are in conversations mode, you only see the latest response in each mail thread 
displayed in the view. The number in parentheses at the end of the subject indicates how 
many e-mails are in the conversation, as shown in Figure 6-27. As with the default inbox view, 
if you click the twisty beside the view entry, you can open the thread to see all the mails in the 
conversation.

Figure 6-27   Conversation view

When in conversation mode, you are also able to perform actions, such as filing in a folder or 
deletion, on an entire mail thread. To help prevent accidental deletion, a dialog box shown in 
Figure 6-28 warns you of the action. You can suppress this dialog box if wanted.

Figure 6-28   Warning that you are about to delete a conversation and not a message
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6.3.1  Collaboration history

When you are searching for information, you might remember the people with whom you were 
collaborating rather than the tool in which the collaboration was taking place. With Lotus 
Notes 8, a right-click menu option (Figure 6-29) for names fields allows you to see a list of 
other collaborations that you had with that person. These collaborations can be e-mails from 
your inbox, meetings from your calendar, instant messages stored in your history, or activities 
displayed in your sidebar.

Figure 6-29   Right-click menu option to view collaboration history
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All of these are displayed together in the collaboration history, as shown in Figure 6-30. You 
can select an entry from the list to open it directly from your mail file, calendar, instant 
message history, or activities list.

Figure 6-30   Collaboration history

6.3.2  Mail header

With Notes 8, you can customize your mail header to display only information and options 
that are useful to you.

New message
As shown in Figure 6-31, a new Display drop-down lets you customize the header of your new 
message by checking or unchecking the options from the drop-down menu.

Figure 6-31   Customize display of mail header

Tip: The right-click View Collaboration History option extends to name fields in other 
databases such as contacts, team room, and discussion databases, as well as in the mail, 
calendar, and instant contacts list.
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Also new in Notes 8 is an additional mail option, Mark Subject Confidential. Check the Mark 
Subject Confidential box to add a *Confidential: prefix to the subject (Figure 6-32). This 
makes it simple for you to mark confidential e-mail in a consistent and easily recognized 
format.

Figure 6-32   Additional mail option - mark subject confidential

Received message
Received messages in Notes 8, by default, display a simple mail header, which is cleaner and 
also hides information you may not be interested in. However, you have the option to display 
a more detailed header by clicking Show Details link. See Figure 6-33 for an example of a 
simple and detailed mail header.

Figure 6-33   Mail header - received message

Simple Header

Detailed Header
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With the detailed header, you are able view a sorted name list of the recipients of the 
message. Click the Sort List link and a dialog similar to the one shown in Figure 6-34 is 
displayed.

Figure 6-34   Sorted Name List

6.3.3  Mail addressing

You can address a message either by selecting recipient names from an address book or by 
entering names or addresses directly into an address field of the message. If you enter 
names directly, you can set Notes to use a type-ahead feature that completes names based 
on the first few letters you type. 

The address type-ahead feature available in prior versions of Lotus Notes has been 
enhanced and converted to a type-down feature in Notes 8, to make it quicker for you to find 
the people you collaborate with most often. As you type into an address field, names that 
match your typed text appear in a drop-down list below. The list of names is not sorted 
alphabetically but according to frequency of use. Therefore, your most common contacts 
appear at the top of the address list, as shown in Figure 6-35. 

Figure 6-35   Type-ahead

Note: The sorted name list is only available for the SendTo and CopyTo fields.
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When you see the name you want, you can click it in the list to populate the address field with 
the full name.

6.3.4  Message recall

The new Notes 8 message recall feature provides Lotus Notes client users with the ability to 
recall mail messages from other Lotus Notes users. This feature is useful when a Lotus Notes 
client user has accidentally clicked Send and then needs to retract the message, because it 
was sent to the wrong recipient or in order to complete or modify the message content.

This facility is available only from the Sent view of the mail folder, as shown in Figure 6-36. 
Note that the sender’s copy of the mail message is required in order to collect the information 
required to locate the recipients copies. If the mail message was not saved before it was sent, 
you would not be able to recall it.

In order to recall an e-mail, highlight the e-mail in the Sent view and click the Recall Message 
action button, shown in Figure 6-36.

Figure 6-36   Recall Message action button

Note: The type-ahead drop-down list would also include the address in the recent contacts 
view of your personal contacts. See 6.5, “Contacts” on page 152, for more information 
about recent contacts.

Note: You will only be able to use this feature if it has been enabled on the Lotus Domino 
server and configured for use in the Server Configuration settings document (for all users) 
or in mail policy (which can be for specific users). See 9.3, “Message recall” on page 245, 
for more details.
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A Recall Message dialog then displays, allowing you to select recipients from whom you want 
to recall the message, as shown in Figure 6-37. You also have the option to recall messages 
that have already been read and receive a status report on each recall.

Figure 6-37   Recall Message dialog

If you select the option to receive a recall status report, for each recipient from whom you 
have recalled the e-mail, you will receive a report similar to the one shown in Figure 6-38.

Figure 6-38   Message Recall Report

Important: You can only recall read messages if the message recall configuration on the 
Domino server allows the recall of read messages. If message recall configuration on the 
Domino server does not allow recall of read messages, you would receive a status report 
of Not Recalled (Figure 6-38). For other factors that could cause a not-recalled status, see 
9.3.2, “How message recall works” on page 248.
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You as a recipient can prevent senders from recalling mail messages that were sent to you. 
To do this, open your mail preferences, and in the Basic and from the View and Folder 
Management section, uncheck the option Allow others to recall mail sent to me 
(Figure 6-39).

Figure 6-39   “Allow others to recall mail sent to me” option

For more information about how message recall works and how to configure it on the Domino 
server, refer to 6.3.4, “Message recall” on page 141.

6.3.5  Improved out of office

In previous Notes and Domino versions, the out of office functionality was implemented using 
an agent stored in each user’s mail file. The out of office functionality has been enhanced in 
Lotus Notes and Domino 8 both in terms of performance and flexibility of configuration. In 
Domino 8, administrators now have the option of implementing router-based out-of-office 
processing. For more details see 9.2, “Out of Office router service” on page 242.
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From the client configuration perspective, the out-of-office interface has been refreshed and 
enhanced (Figure 6-40). You now have options to set the hour at which you will be leaving 
and returning to the office, and also to configure whether out-of-office notifications are sent in 
response to every message that a person sends or only to the first message.

Figure 6-40   Out-of-office notification

Also, when the out-of-office time period expires, you no longer have to disable your 
out-of-office notification. This is done for you automatically, reducing the number of 
administrative tasks you need to complete on your return to the office after a period of 
absence.

Also, if you delegate administration of your calendar to an assistant, he is now able to enable 
or disable out of office on your behalf.

6.4  Calendar enhancements

The Lotus Notes calendar is a view in your mail database that you can use to manage your 
time. It enables you to check other users' schedules, send out meeting invitations, track 

Important: The Specify hours option is only available if the out-of-office service has been 
specified in the Domino server configuration document. For more details see 9.2, “Out of 
Office router service” on page 242.

The Specify hours option is not available from the local replica of your mail file when you 
are offline.
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invitee responses, and reserve meeting resources. The calendar view in Notes 8 has been 
enhanced with a fresh interface, as well as having new and improved features.

6.4.1  View navigation

In Notes 8, you can change the format of the calendar view to the days, week, or month 
format from the left navigator, as shown in Figure 6-41, making this consistent with the 
navigation facilities in mail and other standard Lotus Notes databases.

Figure 6-41   Calendar views navigation

6.4.2  Action bar

To provide consistency across mail and calendar, the same techniques are used in the 
calendar interface to make the calendar simple and intuitive to use.
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As with the mail action bar, the calendar action bar also uses both icons and text, with the 
ability to hover over an icon to be reminded of its action. Also, most common actions can be 
carried out with a single click, leaving easily accessible, two-click actions for less frequently 
used tasks. For example, from within an unprocessed calendar invitation, you have 
single-click actions to accept or decline the invitation. However, if you need to give a different 
response, the additional options are easily accessible with two-click actions available from 
the Respond action. See Figure 6-42.

Figure 6-42   Calendar action bar - single-click and two-click actions
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6.4.3  New display of all-day events 

All-day events now display over the whole day rather then just in the top area (Figure 6-43), 
making it obvious at a glance that this time is already scheduled. The title of an all-day event 
remains at the top of the page regardless of the displayed time slot in the calendar view. This 
way you can be aware of the subject of the all-day event without having to scroll back to the 
beginning of the day. 

Figure 6-43   One work week view format - all-day event

6.4.4  Manage new notices from your calendar view - meeting ghosts

In Notes 8 it is now possible to have unprocessed meeting notices. Those that have been 
received but not accepted appear in the calendar view as ghosted entries alongside other 
meetings and appointments. This might be very useful for users who receive a large number 
of meeting invitations and need to be able to see where there are overlaps in their schedule 
and better prioritize before selecting which meetings to accept. This is also true for 
rescheduled notices.

Note: Calendar entries with shorter durations display in time slot views with a duration of 
15 minutes.
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This feature is not turned on by default and must be configured in the calendar preferences. 
To turn on this feature, open the calendar preferences, navigate to Calendar & To Do and 
select Display → Views, and check the Display new (unprocessed) notices box, as shown 
in Figure 6-44.

Figure 6-44   Calendar Preferences - Views tab
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With the Display new (unprocessed) notices option enabled, gray placeholders appears on 
the calendar for meeting notices that have not been responded to yet. Figure 6-45 shows an 
example of the gray placeholder for an unprocessed meeting invitation.

Figure 6-45   One work week view format - unprocessed invitation in calendar view

6.4.5  Choose how to display cancelled invitations

With previous versions of Lotus Notes, you can select to have cancellations for meeting 
invitations processed automatically when they are received in your inbox. With Notes 8, this 
feature has been enhanced to allow you to specify whether you want to keep the cancelled 
invitation showing in your calendar view or have it removed immediately. This enables you to 
keep a record of the cancellation in your calendar, where you are more likely to look for 
information regarding your schedule, rather than in your inbox. This is configured through the 
calendar preferences by checking the Process cancelled meetings automatically box and 
selecting the Show as cancelled in calendar option, as shown in Figure 6-44 on page 148 
(called out in blue).

Note: If you open a cancelled meeting, it is removed from your calendar view.

Meeting ghosts are automatically removed when the invitation is cancelled.
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6.4.6  Check calendar

With Notes 8, you can check your schedule while creating a new meeting invitation or before 
you decide how to respond to a meeting invitation. Click the new Check Calendar action 
button to open a Check Calendar dialog box with a navigable view of the calendar for the date 
in question. See Figure 6-46.

Figure 6-46   Check calendar before responding to meeting invitation

This provides quick access to your calendar in case you need to see how the meeting you are 
scheduling or the new meeting invitation fits in with other events and tasks that you already 
planned. 

6.4.7  Locate free time for subset of invitees list

If you are setting up a meeting for a large number of invitees, it is not always easy to find a 
time slot in which all the invitees are free.

Notes 8 allows you to check for a time slot that works for a subset of the invitee list. You can 
keep the required invitee list and also select the key users who you really need to attend the 
meeting and easily identify a time slot that will be convenient for all of them. 

Note: To switch calendar views, click the down arrow on the Day, Week, or Month tabs, 
and then click a view. This is useful in instances where you might want to propose a 
different date.

To close the dialog box when you finish checking your calendar, click Done. 
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For example, a meeting has to be scheduled for this Wednesday at either 10 a.m. or 2 p.m., 
but the Chair is unable to find a time slot that works for everyone on the invitees list. See 
Figure 6-47.

Figure 6-47   Searching for free time with everyone selected

The Chair decides that there is a user for whom attendance at the meeting is not vital, and 
deselects the user from the invitees list, making it possible to find a time that is free, indicated 
by the green bar, for the rest of the users. The Chair is able to schedule the meeting for 2 
p.m. See Figure 6-48.

Figure 6-48   Searching for free time with only key people selected
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6.5  Contacts

The personal address book, NAMES.NSF, on your client machine has been renamed 
Contacts to better reflect the contents and purpose of the database, and includes new and 
improved features. The new contact-related enhancements are summarized below:

� Business card-like views for displaying individual contact information.

� Contact records can include a photograph of the person.

� Instant messaging chats can be initiated from the Contact view.

� Drop-down addressing and the Recent Contacts view in contacts presents a list of people 
who you have recently collaborated with to speed the addressing of outbound messages.

� Contact records can be synchronized with Domino Web Access.

� Contact delegation allows other users access to your list of personal contacts.

� Enhanced support for printing contacts.

Figure 6-49 shows the new contacts interface with some of the new enhancements.

Figure 6-49   Contacts - Lotus Notes 8
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6.5.1  Contact form

An updated contact form in the new contacts database gives you more flexibility with your 
contacts by providing more fields to store the information when adding or editing a contact 
record, as shown in Figure 6-50. 

Only fields that contain data are shown, as seen in Figure 6-51, when viewed presenting a 
more compact view.

Figure 6-50   Contact form when editing

Figure 6-51   Contact form when reading
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Different countries have varying conventions for how an address is formatted. With Lotus 
Notes 8, you have the option to select the address format that is appropriate for each contact. 
See Figure 6-52.

Figure 6-52   Select address format

You also can change the titles associated with any of the information that is held in the 
contact form to more closely reflect the information that you want to have about a contact, as 
shown in Figure 6-53.

Figure 6-53   Changing headings in the contact form
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With Lotus Notes 8, you can store a photo in your contact record by clicking the icon in the top 
left corner of the contact form, as shown in Figure 6-54.

Figure 6-54   Insert contact picture
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6.5.2  Business card view

To help you quickly locate the contact information you need, the Lotus Notes 8 client provides 
the ability to display contact information in a business card view, as shown in Figure 6-55. 
This enables you to quickly scan through your contacts and potentially identify all of the 
information that you need from the business card rather than having to open up the contact 
record. If you do need to open the contact record to get further information, double-click the 
business card.

Figure 6-55   Business card view
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6.5.3  Recent contacts

The Lotus Notes 8 client includes a Recent Contacts view, as shown in Figure 6-56. This view 
lists all the people with whom you have been collaborating recently regardless of whether you 
have their names listed in your local or server-based address book. 

The names in the Recent Contacts view is dynamic and reflects your recent activity, such as 
e-mail or chats.

Figure 6-56   Recent contacts

The Recent Contacts view is used as the source for the drop-down menu or type-ahead 
addressing when you are addressing e-mails, as shown in Figure 6-57, or while setting up 
meeting invitations. 

You can now automatically select the e-mail address of anyone who has sent you an e-mail 
or who has been copied on an e-mail sent to you, and pull this into an e-mail or meeting 
invitation that you are addressing.

Figure 6-57   Type-ahead addressing in Lotus Notes 8 client

Recent contacts also allows the client to query the address locally. This can potentially save a 
lot of name resolutions calls to the server, thereby improving responsiveness.
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6.5.4  Synchronize contacts with Domino Web Access

Contacts in Lotus Notes 8 can now be synchronized between Domino Web Access and Lotus 
Notes 8 clients.

To synchronize contacts, you have to modify the preferences to enable Synchronize Contacts 
via the Replicator tab.

You can access the preferences for contacts from the Contacts page, as shown in 
Figure 6-58, or by clicking File → Preferences → Contacts.

Figure 6-58   Access contact preferences
158 IBM Lotus Notes and Domino 8 Deployment Guide



You must enable Synchronize Contacts (as shown in Figure 6-59) in the Contact Preferences 
page.

Figure 6-59   Enable Synchronize Contacts in the Contact Preferences page

Synchronize Contacts would now be enabled and visible on the Replicator page, as shown in 
Figure 6-60. 

Figure 6-60   Synchronize Contacts - Replicator tab
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Once the replication task is complete, contacts from your local NAMES.NSF would be 
available in the Domino Web Access client, as shown in Figure 6-61.

Figure 6-61   Synchronized contacts visible in Domino Web Access client

6.5.5  Contact delegation

Lotus Notes 8 client allows you to access and manage other users’ contacts using contact 
delegation.

Important: You must synchronize your contacts, as explained in 6.5.4, “Synchronize 
contacts with Domino Web Access” on page 158, for this feature to work.
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You need to provide delegated access to a user or group using the mail preferences, as 
shown in Figure 6-62. 

Figure 6-62   Delegated access to allow contacts to be shared
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Once delegated access has been provided, you can click Other Contacts → Open other 
contacts in the Contacts view, as shown in Figure 6-63.

Figure 6-63   Open other users contact information
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You can select the user whose contact information has been shared with you. The contact 
view, as shown in Figure 6-64, shows the Lotus Notes 8 client accessing other users’ contact 
information using the contact delegation feature.

Figure 6-64   Lotus Notes 8 client with the contact delegation feature

6.5.6  Enhanced support for printing contacts

Printing of contact information in the Lotus Notes 8 client has been enhanced. You can now 
print the contact information in the following ways:

� Print contact entries as labels.
� Print full contact or group documents.
� Print contact information as it appears in a view.
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Figure 6-65 shows the new enhancements while printing contact information.

Figure 6-65   Printing enhancements for contact information

6.6  Document editing

Document editing has been enhanced in Notes 8 for all Lotus Notes documents in any Lotus 
Notes database, which includes your mail file, contacts, custom applications, and so on.

6.6.1  Multi-level undo

Multi-level undo functionality for text editing in the Lotus Notes 8 client enables you to retrace 
your steps through more than 50 levels of edits.
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6.6.2  Instant spell checking

You now have the option to turn on in-line spell checking. As you type words into a rich text 
field, a red squiggle appears underneath a word that is spelled incorrectly or that is not 
present in your dictionary. You can configure this option in the unified preferences panel, as 
shown in Figure 6-66.

Figure 6-66   Spell check preference

If you right-click the offending word, a list provides suggestions for the correct spelling for the 
word. You can then choose one of the suggestions, as shown in Figure 6-67, or add the word 
to the dictionary so that it will be recognized on future occurrences.

Figure 6-67   Instant spell checking
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6.7  Sidebar plug-ins

On the right side of the panel, there is a sidebar into which plug-ins can be installed. Four 
plug-ins are supplied with the Lotus Notes 8 client installation. See the example in 
Figure 6-68. Organizations can develop their own plug-ins for the sidebar to extend the 
interface to meet specific business requirements.

Figure 6-68   Lotus Notes 8 client sidebar

Activities
This plug-in enables you to view, access, and interact with your activities. See 6.9, “Activities” 
on page 176, for more information about activities.

Lotus Sametime contacts
This plug-in enables you access to your instant messaging contacts list. See 6.8, “Sametime 
contacts” on page 167, for more information about the integrated instant messaging 
functionality.

Day at a glance
This plug-in enables you to navigate your calendar by selecting a day and month from the 
calendar picker, as shown in Figure 6-68. The calendar entries for the selected day then 
appear in the panel above it. If you do not select a day, the current day is selected and 
displayed by default.
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Feeds
The Really Simple Syndication (RSS) feed reader plug-in allows users to scan information 
from their favorite news feeds and use it to answer questions and complete tasks. Note that 
the feed reader supports Atom feeds as well as RSS feeds. See 6.10, “Reading feed content 
in Lotus Notes 8 client” on page 192, for more information.

Each of the sidebar plug-ins can be detached from the sidebar with the Open in New 
Window plug-in option, as shown in Figure 6-69. With this option, users can move the 
plug-ins to different locations on the panel and work in the way in which they are most 
comfortable.

Figure 6-69   Open in New Window option

6.8  Sametime contacts

IBM Lotus Sametime instant messaging software gives you quick and easy access to your 
coworkers. It is simple and versatile so that you can work with your colleagues in whatever 
way suits your need. 

6.8.1  Introduction

Lotus Notes instant messaging was first introduced in the Lotus Notes 6.5 Client for instant 
messaging and presence awareness features, without having to install a client. However, 
Lotus Notes instant messaging had limited features in comparison to the Sametime Connect 
Client. The Lotus Notes instant messaging features continued to be enhanced with later 
releases of the Lotus Notes client.
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With Lotus Notes 8, you get an instant messaging experience based on IBM Lotus Sametime 
Connect 7.5.1 Client, as shown in Figure 6-70, called the Lotus Sametime Contacts. The 
Sametime 7.5.1 Client, just like the Notes 8 client, is based on the Eclipse technology.

Based on your license, you can have all of the same instant messaging features available in 
the Sametime Connect 7.5.1 Client in your Lotus Sametime Contacts.

Figure 6-70   Instant messaging and presence awareness

The new Notes 8 Sametime Contacts features are discussed in the next few sections. 
Depending on your installation and your Sametime server configuration, some features 
mentioned in these sections might not be available to you.

Important: In order to use Notes 8 Sametime Connect you must have it installed, and also 
have a Sametime server installed.
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6.8.2  Log-in 

After logging in to the Notes 8 client, you need to provide a password and other start-up 
information to log in to the IBM Lotus Sametime instant messaging software. See 
Figure 6-71.

Figure 6-71   Initial Log-in dialog

At login, you can choose to have the IM client remember your password as well as log you in 
in automatically when you start the Lotus Notes client. In addition, you can set your 
awareness state and your status message. 
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If you have saved your password or you have enabled Domino single sign-on, you can log-in 
with two clicks. See Figure 6-72.

Figure 6-72   Log-in with two clicks

Support multiple Sametime communities from a single client
An instant messaging community is a group of people belonging to the same directory or user 
registry, such as your corporate directory, or external communities outside of your 
organization. Public instant messaging providers might also be linked to one or more of your 
instant messaging communities, allowing you to communicate with members of these 
networks. There are usually one or more Sametime servers in a community.
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6.8.3  Instant contacts 

It is easy to have quick access to the people you want to keep in touch with. Just add the 
names of those people to your contact list. Figure 6-73 shows an example of the contact list, 
pointing out actions that you can perform.

Figure 6-73   Contacts list

Current Status

Invite to voice chat

Invite to video call

Send announcement
Start instant meeting

Click to add new sametime:

My geographic location

Menu

User in a meeting

Alert when user
is available

-Contact
-Group
-Community

Public group icon

Personal group icon

Note: Most of the actions shown in Figure 6-73 can also be carried out from the Notes 8 
window menus.
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In addition to allowing you to quickly find contacts in your contact list, the Type to find name 
field also allows you to search the directories for users not currently in your list (Figure 6-74) 
and to be able to directly chat without first adding them to your list.

Figure 6-74   Type to find name

Use the Business card view to display information about your chat partner, including his 
picture (if available), professional title, availability status, location, phone number, and local 
time.

Figure 6-75   A business card
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6.8.4  Chat panel 

In the chat panel, you can now do more than exchange typed chat messages with one or 
more chat partners. You can do much more, such as send files, Web addresses, document, 
view, or database links, and so on (Figure 6-76).

Figure 6-76   Chat panel

Additional features available, but not shown in Figure 6-76, include:

� Change your online status or see your partner's online status from the chat panel.
� Customize the view of your chat panel.
� Configure the Enter key to insert a carriage return instead of sending the message. 
� A Send e-mail feature. 
� Voice chat, using embedded VoIP. 
� Print from the chat panel. 
� See a message when a chat partner leaves a chat.

6.8.5  Chat history 

With the Notes 8 Instant Messaging Client, you have the option to automatically, manually, or 
not save a chat. The option to save a chat allows you to later refer back to important 
information shared during a chat session. 

Chat transcript can be saved to either your mail application or to a local file, but not both. This 
as well as enabling saving chat transcript can be set in the Sametime chat history preference.

Support for rich text and emotive icons

Time stamps

Invite others

Open Chat History

Start Instant Meeting Add Chat partner to contact list Save Chat Transcript to Activity

Support for 

Send images and text combined
Spell check while typing

Send a file

Instant image screen capture

User’s picture
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Open the chat history either from the chat panel, as pointed out in Figure 6-76 on page 173, 
or from the Sametime Contacts menu. Figure 6-77 shows an example of the chat history 
panel.

Figure 6-77   Chat History

6.8.6  Presence awareness

With presence awareness in the Lotus Notes application, you are able to immediately tell the 
availability status of a document’s author from the application view, as well as the availability 
status of other users listed in fields enabled for awareness within a document. 
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With Notes 8, you can do more than just tell users’ availability status from an application view 
or document. You now have a lot more instant messaging options from a right-click menu, as 
shown in Figure 6-78. This gives you the ability to immediately perform an instant messaging 
action without having to first go to the Sametime contact list.

Figure 6-78   Right-click menu options available with presence awareness
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6.8.7  Preferences

The Sametime preference, which is part of Notes 8 unified preference, allows you to adjust 
the Sametime settings to better suit your needs. Depending on the installation and the policy 
set on your Sametime server, you might not have some of the Sametime settings shown in 
Figure 6-79.

Figure 6-79   Sametime preferences

For more information about the features available in Lotus Sametime 7.5.1, see the following 
Web site:

http://www.ibm.com/lotus/sametime

6.9  Activities

In our day-to-day working environment all of us perform simple and complex tasks. In order to 
accomplish these tasks we use a set of organized, simple sequences. If these organized 
simple sequences, like sending an e-mail or initiating a chat, were to be observed in isolation 

Note: If you configure instant messaging settings in the Lotus Notes 8 client location 
document, the embedded instant messaging client that was available in Lotus Notes 6.5/7 
opens. To avoid having two different Sametime user interface experiences, remove the 
settings from the location document and instead log in to your Lotus Sametime server by 
selecting File → Sametime → Log In from the Lotus Notes 8 menu, or log in from the 
Sametime contacts sidebar menu.
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without any context they would seem meaningless. It is this context that, when applied to a 
range of simple sequenced operations used to accomplish complex tasks, is called an 
activity.

6.9.1  Introduction

Activities provides a new way of Web-based collaboration that lets you organize work around 
what you are doing rather than what tool you are using.

Activities is a part of IBM Lotus Connections social software, which is designed to empower 
people to be more effective and innovative by building professional networks of coworkers, 
partners, and customers. With this software, you can find and collaborate with experts; easily 
locate people and information; build closer partner and customer relationships; and foster 
bottom-up, community-based innovation.

6.9.2  Examples of activities

Some examples of an activity can be:

� Driving a sales process to a close 
� Preparing for an important meeting 
� Writing a report for a client 
� Hiring a new employee 

6.9.3  How you get started

To improve awareness and team coordination, identify a goal (new employee orientation, 
new product innovation, or top talent retention, for example) and create an activity for that 
goal. All documents, messages, to-do’s, and bookmarks you post to this activity are 
automatically shared with the activity member, which keeps them in sync with the latest 
updates. Content can be posted using various tools and tagged for further search and 
cross-references.

6.9.4  Notes 8 client - activities plug-in

The Notes 8 client has an activities plug-in in the Side Bar panel, which allows the user to 
work with activities that have been hosted on the IBM Lotus Connections Server.

Important: In order to use activities, you must have an Activity server part of the Lotus 
connections software installed. Refer to the following URL for more information:

http://www.ibm.com/lotus/connections
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The following steps can be used as an example of the functionality available in Lotus Notes 8 
client for activities:

1. In order to use activities, you would have to first connect your Lotus Notes 8 client to the 
Lotus Connections Server. Launch the activities plug-in, as shown in Figure 6-80.

Figure 6-80   Launching the activities plug-in from the Lotus Notes 8 client side bar
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2. Provide the details of the Lotus connections server that hosts the activities, as shown in 
Figure 6-81. The Lotus connections server administrator can provide you with details such 
as the Activity task URL, your user ID, and password.

Figure 6-81   Details being provided in Lotus Notes 8 client for activities connection
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3. Activities are initialized in the Lotus Notes 8 client, as shown in Figure 6-82.

Figure 6-82   Activities initialized in a Lotus Notes 8 client
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4. You can click Launch more >> to learn more about activities, as shown in Figure 6-83.

Figure 6-83   Context-sensitive help for activities
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5. You can create a new activity from the Notes client, as shown in Figure 6-84.

Figure 6-84   Creating a new Activity
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6. Fill in the details about the new Activity. Click Display → Membership Options, as shown 
in Figure 6-85.

Figure 6-85   New Activity being displayed
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7. In the membership options you can define owners, readers, authors, and tags related to 
an activity. Click Save, as shown in Figure 6-86, to save this activity.

Figure 6-86   Saving a new activity
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8. The new activity created is shown in Figure 6-87 under activities in the Lotus Notes 8 
client side bar.

Figure 6-87   Newly created activity visible in Lotus Notes 8 client
Chapter 6. Lotus Notes 8 client features 185



9. You cannot only look at activities that have been created by you. In addition to this you can 
also view prioritized, tuned out, completed, and public activities, as shown in Figure 6-88.

Figure 6-88   Viewing different types of activities
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10.You can add a file, to do, related activity, bookmark, or message to an existing activity. We 
add a new file to an existing activity, as shown in Figure 6-89.

Figure 6-89   Adding a new file to an existing activity
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11.You can provide details of the file, as shown in Figure 6-90, which will be saved as a part 
of an existing activity.

Figure 6-90   Saving a file to an existing activity
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12.Any new event, such as adding a new file, message, or bookmark to an activity, can 
trigger an e-mail update to the members of that activity, as shown in Figure 6-91. This will 
provide information to the members even when they are not connected to the activities 
server.

Figure 6-91   E-mail informing members of any new updates to an activity
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13.You can also convert any e-mail into an activity, as shown in Figure 6-92.

Figure 6-92   Existing e-mail being added to an activity
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14.You can also add a Lotus Sametime chat to an activity, as shown in Figure 6-93.

Figure 6-93   Lotus Sametime chat being added to an activity

6.9.5  In conclusion

Users can use activities as a form of ad-hoc collaboration tool from within the Lotus Notes 8 
client to solve complex business tasks.

Using the activities plug-in from the Lotus Notes 8 client side bar we have been able:

� Track your current work projects as activities in the activities panel of the Lotus Notes 
sidebar. 

� Use activities to share files and bookmarks, post messages, track to do items, and 
manage your deadlines. 

� Integrate activities with your existing collaboration tools: your browser, Lotus Notes, 
instant messaging, and more.

For more information about activities and Lotus connections refer to:

http://www.ibm.com/lotus/connections
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6.10  Reading feed content in Lotus Notes 8 client

In today’s online and connected world you sift through hundreds of e-mails, documents, or 
Web sites to get the information or content you need. Content syndication can be used as a 
means of publishing Web content in a push format. Users can subscribe to this content in the 
form of a feed, such as really simple syndication (RSS) and the Atom publishing protocol 
(APP). 

Using technology like RSS or ATOM, you can subscribe to these feeds using a feed reader 
software. This allows you to receive online and updated content in a single panel from various 
applications and Web sites in an aggregated format.

Lotus Notes 8 client also provides you a feed reader via the side bar. This displays the list of 
feeds to which you subscribe. Feed content — specifically, news items and stories — appears 
below the feed name.

6.10.1  Set up Lotus Notes 8 client to read feed content

The Lotus Notes 8 client has a feed reader plug-in that is part of the side bar panel, as shown 
in Figure 6-94.

Figure 6-94   Feed reader plug-in in Lotus Notes 8 client
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Web pages that support content syndication would provide feed icons denoting the page that 
is available as a feed. A Web site may also sometimes display the icon after the URL in the 
browser address bar, as shown in Figure 6-95.

Figure 6-95   Web page showing a feed icon
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You can either drag and drop the icon or Web URL into the feed reader plug-in on the Lotus 
Notes 8 client, or you can subscribe to a new feed, as shown in Figure 6-96.

Figure 6-96   Subscribing to a feed
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The feeds you have subscribed to are now available as a single view in the feed reader inside 
the Lotus Notes 8 client, as shown in Figure 6-97. Real-time updates to various activities 
created in 6.9, “Activities” on page 176, are also available as feeds.

Figure 6-97   Subscribed feeds visible in the Lotus Notes 8 client
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You can view these feeds in the Web browser or via a preview panel, as shown in Figure 6-98.

Figure 6-98   Viewing the feed
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You can also manage the feed subscriptions by grouping them or presenting them, as shown 
in Figure 6-99.

Figure 6-99   Listing feeds individually or grouped together

Feed management may also offer functions such as:

� Unsubscribe to the feed - Remove the feed from the list. 

� Edit feed subscription - Change the feed settings that were set when you first subscribed 
to the feed.

� Delete offline content - Delete the content that appears in the Feed Reader pane for the 
feed. 

� Copy as link - Copy the feed listing and use it as a URL, for example, in a browser or in an 
e-mail. 
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This is shown in Figure 6-100.

Figure 6-100   Feed management functions

In short, the feeds plug-in available in the Lotus Notes 8 client allows you to access real-time 
Web site or blog updates in an aggregated fashion through a single panel. It helps you to get 
the information on your desktop rather than actively going and searching for it.
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Chapter 7. Productivity tools

This chapter discusses the new productivity tools that ship with Notes 8, which include:

� IBM Lotus Documents, for creating and editing word processing documents
� IBM Lotus Presentations, for creating and running presentations
� IBM Lotus Spreadsheets, for creating and editing spreadsheets
� IBM Lotus Productivity Tools Toolkit

Additionally, this chapter discusses installing and configuring IBM Lotus Productivity Tools.

7
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7.1  About productivity tools

IBM Lotus Notes 8 includes a set of office productivity tools that support the Open Document 
Format (ODF) standard. These productivity tools include word processing, spreadsheet, and 
presentation capabilities. Lotus Notes users are able to create, manage, edit, and import 
documents in ODF. The IBM productivity tools can also import and edit Microsoft Office 
documents and export those documents to ODF for sharing with ODF-compliant applications 
and solutions.

For organizations, ODF provides the ability to access, use, and maintain documents over the 
long term without concern about end-of-life uncertainties or ongoing software licensing and 
royalty fees. By using ODF-compliant tools, customers are not locked into one particular 
vendor for their productivity tools. ODF helps provide interoperability and flexibility.

For users, the IBM Lotus Productivity Tools offer easy, immediate access to viewing, editing, 
and creating documents from directly in Notes, without a need to launch a separate program. 
This ease of access makes your workforce more productive and efficient by integrating 
document processing functions directly into the Notes interface, using the same menus and 
intuitive design already familiar to your users. Support for commonly used formats mean that 
users can immediately transition to using the productivity tools with existing documents.

For more detailed information about IBM Lotus Productivity Tools, see the Productivity Tools 
User Guide, available on IBM developerWorks in the Lotus section.

IBM Lotus Productivity Tools compared with traditional office suites
IBM Lotus Productivity Tools are not designed to match a standalone office suite, such as 
Microsoft Office, on a feature-by-feature basis. Instead, the productivity tools are meant to be 
an alternative to standalone office suites for users who perform relatively basic document 
viewing and editing tasks. This class of users is well served by the productivity tools found in 
IBM Lotus Notes 8. 

The productivity tools support Microsoft Office document formats and enable users to read 
these documents. The productivity tools also provide editing capabilities that closely 
approach the feature set in a full office suite. These features enable users to create or edit 
existing documents with ease.

7.1.1  Open Document Format (ODF)

OpenDocument Format is an open format for creating, saving, and exchanging editable office 
documents, spreadsheets, charts, and presentations. ODF is application-independent, 
created by the OpenDocument Format Technical Committee within the Organization for the 
Advancement of Structured Information Systems (OASIS) standards organization. 

Adopting ODF-supporting applications in your business or service means that you are not 
required to purchase an application from a single vendor in order to share and communicate 
your document data. You now have a choice.

ODF is: 

� The open standard developed by a multivendor committee at OASIS and submitted to ISO 
for certification 

� The open standard adopted by many vendors 

� The standard that meets the common test for openness, including for IBM 
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� The default format in Open Office and IBM Workplace™ Managed Client 

� An XML-based specification describing the content and formatting of a document 

� The option that gives you the most choice for interoperability and future-proofing your 
information

ODF is important and valuable because it provides greater choice, greater freedom of action, 
greater cost effectiveness, greater access to innovation, and greater control over the use of 
your documents and the intellectual property contained therein. ODF also enables efficient 
interchange of information between various parts of an organization and between 
organizations.

7.1.2  Exporting to PDF

One of the most exciting features of IBM productivity tools is the ability to export a document 
as a PDF. Portable Document Format (PDF) is widely used to share documents without a 
need for all users to have the program that created the document. Before IBM productivity 
tools, while any user could view a PDF document using a free viewer, the person who created 
the document had to have a specialized program to create the PDF. Now, the ability to export 
a document as a PDF is freely available, and easy to use, by anyone with Lotus Notes 8 
installed.

To create a PDF, all you have to do is choose Export as PDF from the File menu from within 
an open document, as shown in Figure 7-1.

Figure 7-1   Exporting a document as a PDF
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7.2  .Installing and configuring IBM Lotus Productivity Tools

This section discusses installing IBM Lotus Productivity tools, setting preferences, and using 
the new productivity tools settings document to manage your productivity tools deployment.

7.2.1  Installing IBM Lotus Productivity Tools

Installing IBM Lotus Productivity Tools does not require a separate action. It is available as an 
installation option during the Lotus Notes 8 installation process. Figure 7-2 shows the custom 
setup available during Notes 8 installation. The red box indicates the option to install IBM 
productivity tools.

Figure 7-2   Custom Setup options during Lotus Notes 8 installation

In addition to being available directly from within Notes, selecting IBM productivity tools 
during Notes 8 installation places three additional icons on the desktop to allow direct access 
to the productivity tools. Using one of these icons while Notes is not running launches the 
productivity tools in stand-alone mode, which does not provide full access to Notes.

Note: IBM Productivity tools is not selected by default when you install Notes, and you 
need to select it during the installation process. 

For more information about installing Lotus Notes 8, see Chapter 4, “Deploying the Notes 8 
client” on page 63.

Tip: The default home page in Lotus Notes 8 includes links to create new spreadsheets, 
documents, and presentations. If you do not install IBM productivity tools during Notes 8 
installation, those links will still be on the home page, although they will be inactive. 
Nothing will happen if they are clicked. Because of this, you may wish to deploy a 
customized home page to your users if you choose not to deploy IBM productivity tools.
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7.2.2  Productivity tools preferences

There are many preferences available for users to customize their interaction with Lotus 
Productivity Tools. Because the productivity tools are a Notes installation option, the 
preferences for them are housed with the rest of the Notes preferences. 

Some highlights of the preferences are listed in Table 7-1.

Table 7-1   Selected preferences for productivity tools

Note: If installed, IBM productivity tools can be used with the basic configuration of 
Notes 8. Using any of the home page links from the basic configuration to create a new 
productivity tools document launches the productivity tools separately. If file association 
preferences have been set as described in 7.2.2 “Productivity tools preferences” on 
page 203, those file associations are honored by the basic configuration. For example, if 
.doc files have been associated with the productivity tools, opening an attachment with a 
.doc file extension will launch the productivity tools.

Category Setting Comments Default

Productivity tools

Preload options:
� Launch IBM productivity tools in 

the background when the 
operating system starts.

� Launch IBM productivity tools in 
the background when this client 
starts.

� Do not preload productivity tools.

Allows you to set productivity tools to load in 
the background when starting the operating 
system or the Notes client. This may save 
time when first starting to use the productivity 
tools during a session, because the tools will 
already be in memory when invoked. Note 
that when IBM productivity tools is launched, 
a separate executable, soffice.exe, appears 
in the task list.

Launch IBM 
productivity 
tools in the 
background 
when the 
operating 
system 
starts.

File associations

Open MS Office files with the 
productivity tools.

Associates specified MS Office document 
extensions with the productivity tools.

Disabled.

Open MS Office templates with the 
productivity tools.

Associates specified MS Office template 
extensions with the productivity tools.

Disabled.

Open Smartsuite files with the 
productivity tools.

Associates specified SmartSuite document 
extensions with the productivity tools.

Disabled.

Open SmartSuite templates with the 
productivity tools.

Associates specified SmartSuite template 
extensions with the productivity tools.

Disabled.

File supervision

Automatic save. Defines whether auto-save is enabled for 
document editors, and the time interval 
between automatic saves.

Enabled, 
every 10 
minutes.

Recent files. Defines how many files are displayed in the 
file list. Recent files are accessed by clicking 
File → Recent Files.

Enabled,
5 Files.

Memory

Undo. Defines the maximum number of undo steps 
allowed, between 1 and 100.

20.
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Total Cache Size. Defines total cache size for all graphic 
objects.

9 MB.

Maximum per Object. Defines maximum size for any one graphic 
object in memory.

2.4 MB.

Remove from memory after. Specifies the amount of time graphics should 
be kept in memory, in hours and minutes.

10 minutes.

Maximum number of objects. 20.

Category Setting Comments Default

Tip: File associations can be managed via policies. For more information about using 
policies to manage file associations, see 7.2.3 “Using policies to manage Lotus 
Productivity Tools” on page 205.

Note: IBM productivity tools loads an additional executable called soffice.exe into memory. 
The Preload Options preference listed in table Table 7-1 determines when this executable 
is loaded.
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Many other preferences are available to allow users to customize their interaction with Lotus 
Productivity Tools. Figure 7-3 shows the productivity tools preferences in the Preferences 
dialog, accessed by choosing File → Preferences from within your Lotus Notes 8 client.

Figure 7-3   Preferences for Lotus Productivity Tools 

These preferences are discussed at length in the help system. To access the help system, 
choose Help → Help Contents from within your Lotus Notes 8 client.

7.2.3  Using policies to manage Lotus Productivity Tools

A new policy is available in Domino 8 to help manage use of IBM Lotus Productivity Tools. 
With the new settings document, you can manage:

� Access to productivity tools
� File associations for productivity tools
� Access to run macros within productivity tools
Chapter 7. Productivity tools 205



Figure 7-4 shows the policy settings document, which allows administrators to control the 
usage of productivity tools for their organization.

Figure 7-4   Policy settings document for Lotus Productivity Tools

Table 7-2   Policy settings available for managing Lotus Productivity Tools

Field Action

Allow user to run macros. Click Yes to allow the rich client users to run macros in the IBM 
Word document, spreadsheet, and presentation editors.

Allow IBM productivity tools. Click Yes to allow users to use the Word document, spread-
sheet, and presentation editors.

Open MS Office templates with 
IBM productivity tools.

Click Yes and then choose the MS Office templates that you 
want to open with IBM productivity tools.

Open SmartSuite files with IBM 
productivity tools. 

Click Yes and then choose the SmartSuite file types to open 
with IBM productivity tools.
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For more information about the use of policies with IBM Lotus Productivity Tools, refer to 
Lotus Domino Administrator 8 Help.

7.3  Overview of IBM Lotus Productivity Tools

IBM Lotus Productivity tools are integrated into Lotus Notes 8, so getting started with the 
productivity tools is easy. You can create a new document, spreadsheet, or presentation 
directly from the Open menu or from the Home page, as show in Figure 7-5.

Figure 7-5   Creating a new document from the Open menu or the Home page

To open and edit an existing document, from the File menu, simply choose Open → File, as 
shown in Figure 7-6, to get to the Open file dialog, shown in Figure 7-7 on page 208. From 
here, you can navigate to the file location and open a document in any supported format.

Figure 7-6   Opening an existing file in Lotus Documents
Chapter 7. Productivity tools 207



Figure 7-7   The Open file dialog

7.3.1  IBM Lotus Documents

With IBM Lotus Documents, your workforce cannot only create simple documents like memos 
and letters, it can also create highly structured documents that include graphics, tables, 
charts, and spreadsheets. A number of features give you a fine degree of control over the 
formatting of text, pages, sections of documents, and entire documents. You can even create 
complex documents that include bibliographies, reference tables, and indexes. Finally, you 
can save the documents in a variety of formats. 

Also, the Lotus Documents drawing tool lets you create drawings, graphics, legends, and 
other types of drawings directly in your documents. You can insert graphics in JPG or GIF 
format into a document, and edit them directly with the image editor. In addition, the gallery 
provides a collection of graphics organized by theme.
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Figure 7-8 shows a memo created from a template, which includes graphics, a table, and 
some rich text formatting, demonstrating the power of IBM Lotus Documents.

Figure 7-8   Document with logo, table, and formatting in IBM Lotus Documents

Supported formats
IBM Lotus Documents can work with documents in the following formats:

� OpenDocument Text (.odt)
� OpenDocument Text Template (.ott)
� IBM Word Processing Document (.sxw)
� IBM Word Processing Document Template (.stw)
� Microsoft Word 97/2000/XP Document (.doc)
� Microsoft Word 97/2000/XP Document Template (.dot)
� Lotus Word Pro® document (.lwp)
� Lotus Word Pro template (.mwp)
� Microsoft Rich Text Format (.rtf)
� Text (.txt)
� Microsoft Word 2003 (.xml) — open only; must be saved in another format after editing
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Additionally, IBM Lotus Documents can export documents in Portable Document Format 
(PDF).

7.3.2  IBM Lotus Spreadsheets

IBM Lotus Spreadsheets is a spreadsheet application that you can use to calculate, analyze, 
and manage your data. You can also use it to import and modify Microsoft Excel® 
spreadsheets. You can even use formulas and generate charts to make your data more clear.

Figure 7-9 shows a spreadsheet, including calculations and a chart.

Figure 7-9   Spreadsheet with chart in IBM Lotus Spreadsheets

For more information about the features available to you in IBM Lotus Spreadsheets, see the 
Productivity Tools User Guide, available on IBM developerWorks in the Lotus section.

For information about performing calculations and creating charts, access the help system in 
Lotus Notes 8 by choosing Help → Help Contents.

Supported formats
IBM Lotus Spreadsheets can work with documents in the following formats:

� OpenDocument Spreadsheet (.ods)
� OpenDocument Spreadsheet Template (.ots)
� IBM Spreadsheet (.sxc)
� IBM Spreadsheet Template (.stc)
� Microsoft Word 97/2000/XP Spreadsheet (.xls)
� Microsoft Word 97/2000/XP Spreadsheet Template (.xlt)
� Comma-Separated Text (.csv)
� Microsoft Excel 2003 (.xml) — open only; must be saved in another format after editing

Additionally, IBM Lotus Spreadsheets can export documents in Portable Document Format.
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7.3.3  IBM Lotus Presentations

IBM Lotus Presentations lets you create professional slide shows that can include charts, 
drawing objects, text, multimedia, and a variety of other items. Templates are included to help 
you create professional-looking slides. You can use data and chart objects from Lotus 
Spreadsheets, and you can also assign dynamic effects to your slides, including animation 
and transition effects. When you have finished creating your presentation, you can run it as a 
screenshow, print your presentation as handouts, or publish it to the Web as HTML 
documents.

Figure 7-10 shows a presentation created from one of the included templates. The chart in 
the middle was generated by Lotus Spreadsheets and pasted into the presentation as a 
spreadsheet object.

Figure 7-10   Presentation created from template with chart from Lotus Spreadsheets

For more information about the features available to you in IBM Lotus Presentations, see the 
IBM Lotus Productivity Tools User Guide, available at:

http://www.ibm.com/developerworks/lotus/documentation/notes/index.html?S_TACT=105A
GX13&S_CMP=LPLOTUS

For information about using templates and creating animations, access the help system in 
Lotus Notes 8 by choosing Help → Help Contents.
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Supported formats
IBM Lotus Presentations can open, edit, and save documents in the following formats:

� OpenDocument Presentation (.odp)
� OpenDocument Presentation Template (.otp)
� IBM Presentation (.sxi)
� IBM Presentation Template (.sti)
� Microsoft Word 97/2000/XP Presentation (.ppt)
� Microsoft Word 97/2000/XP Presentation Template (.pot)

Additionally, Lotus Presentations can open documents in the following formats, but, if edited, 
they must be saved in one of the formats listed above.

� Lotus Freelance Presentation (.prz)
� Lotus Freelance Presentation SmartMaster Look Template (.mas)
� Lotus Freelance Presentation SmartMaster Content Template (.smc)

Additionally, Lotus Presentations can export documents in Portable Document Format.

7.4  IBM Lotus Productivity Tools Toolkit

Lotus Productivity Tools wraps productivity tool applications as Eclipse components to 
provide rich a document-editor service to Lotus Notes 8. 

The toolkit provides two sets of Java APIs for developer use:

� Control API

The control API lets users integrate the rich functionalities of Lotus Productivity Tools into 
Lotus Notes 8 and the Lotus Expeditor platform as an Eclipse SWT control. For example, 
you can build a rich client application to open, view, edit, and save Microsoft Office 
documents, SmartSuite documents, and ODF documents.

� DOM API

You can use the DOM API, which is based on W3C standards, to access and manipulate 
the content and styles of rich documents. The structure of the document is a sub-set of the 
ODF specification.

With these Java API interfaces, users can build business components that include the rich 
functionalities of Lotus Productivity Tools. 

7.4.1  Getting started with the IBM Lotus Productivity Tools API Toolkit

When you install the API Toolkit, you will also get some good references and sample code to 
help get you started.

These items are included in the API Toolkit installation package:

� HTML reference for all classes in the toolkit
� IBM Lotus Productivity Tools Application Development Guide (PDF)
� Sample code to help you get started

Note: In 8.0, the functionality of the API Toolkit will be limited to word processing 
documents. Toolkit support for presentation and spreadsheet functions will be included in a 
later release.
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7.4.2  Samples included with the API Toolkit

To help you get started with the IBM productivity tools API Toolkit, several samples for Lotus 
Productivity Tools are supplied in the toolkit. The samples are designed to show the use of 
the Lotus Productivity Tools in Notes 8. Once you have installed or deployed the samples, 
they are visible in the target platform.

Simple Editor
This sample demonstrates how to create a simple editor. It has two kinds of menus. The 
MyEditor menu includes some simple editor functions, such as copy, paste, undo, and redo. 
The MyFile menu has the options to open, save, and print items. These menus are added in 
two ways. The first way adds MyEditor1 and MyFile1 by actionSet with extension points. The 
second way adds MyEditor2 and MyFile2 by MenuSet with control API.

DOM tree viewer
This sample demonstrates the DOM tree view. This view shows the entire document as a 
tree. Each element in the text is a tree node, with its parent node, sibling nodes, and 
descendant nodes. The detailed information of the node, such as name, type, value, and 
attributes are displayed on the right of the view.

DOM field
This sample demonstrates how to operate user field elements in a document. It loads a notice 
template that has some user fields in it, such as title, date, text, attachment, key words, 
collation, and so on. The view uses APIs to access each user field with its name and sets the 
proper content in it, and a new notice is completed. There are five buttons with labels and 
icons on the view that perform the actions:

� Insert a new date field element.
� Edit the user fields in the document.
� Remove the newly created date fields.
� Print the current view with printer after content setting.
� Save the view as another file.

DOM table
This sample demonstrates how to operate table elements in a document. It loads a cargo 
transporting sheet template that has three tables. One is a cargo arrangement table. The 
other two are header and footer, with some relational information in them. The view uses API 
to access each item in tables with the name of table cell, sets the proper content in the cell, 
and then a new cargo transporting sheet is completed. There are four buttons with labels and 
icon on the view which that these actions:

� Edit the already existing table.
� Create and insert a newly created footer table.
� Remove the newly created footer table.
� Print the current view with printer after content setting.
� UNO API.

This sample demonstrates how to manipulate text fields in rich documents with UNOAPI. The 
view opens an empty word processing document with three buttons in the upper-left toolbar 
area. Datetime and User fields will be created and inserted into this document by clicking 
these buttons in sequence.
Chapter 7. Productivity tools 213



Auto recognizer
This sample demonstrates how to develop C2A applications based on Lotus Productivity 
Tools. Two keywords are predefined in the sample recognizer: PropertyBroker and 
AutoRecognizer. The AutoRecognizer engine calls the detector to check whether there are 
such keywords found. When users click the context menu for recognized tags, a message 
box is opened.

Composite application
This sample instructs the user to create a new composite application and edit this composite 
application with the Notes CAE tool. One feature and two plug-ins are provided by this 
sample.
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Chapter 8. Domino Web Access

Domino Web Access is a Web client that delivers leading Domino messaging, collaboration, 
and personal information management (PIM) capabilities to Web browsers. Browser users 
can take full advantage of Domino services through an ultra-intuitive, easy-to-use interface, 
both online and offline, seamlessly.

Domino Web Access provides the browser users with a number of features that were 
previously only available for users of non-browser clients, such as the Lotus Notes client. 
These features are in the area of messaging, calendar and scheduling, personal information 
management, and personal journals.

This chapter discusses the new and improved features in the IBM Lotus Domino Web Access 
8 client, the Web client alternative to the Lotus Notes client. Specifically, we discuss: 

� New features of IBM Lotus Domino Web Access 8
� Changes for instant messaging
� Deploying IBM Domino Web Access 8
� Domino Web Access and WebSphere Portal
� RSS feeds for Domino Web Access
� NOTES.INI parameters specific to Domino Web Access 8
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8.1  New features of IBM Lotus Domino Web Access 8

The following list is an overview of what is new in Domino Web Access 8:

� Domino Administrators can now enable Domino Web Access security settings via policies 
using a security policy settings document. For additional information, see the release note 
"Using Security Policy Settings."

� Domino Web Access has a new look and feel, allowing the color scheme to best fit in 
WebSphere Portal when the URL includes the “&client=wps” argument.

� There is an added support and integration of LanguageWare libraries and dictionaries, 
which provides spell check dictionary support for German Reform language, along with a 
multi-threaded server spell check engine for Domino Web Access.

� New integrated instant contact list manger interface and refresh of awareness icons.

� More feature parity with Notes mail client — Feature interoperability enhancements 
including support for preview pane, calendar view filters, preferred rooms and resources, 
and managed mail and calendar.

� Support for RSS feed-enabling of Notes databases. See "Enable RSS feeds for mail 
Inbox" in these release notes for additional information.

8.1.1  User interface

The Lotus Domino Web Access 8 interface has been updated with an interface similar to the 
Lotus Notes 8 client. In fact, the default mail template (MAIL8.NTF) for Lotus Notes 8 also 
provides support for Domino Web Access 8. The fonts, color scheme, and icons are also 
more consistent with WebSphere Portal software. See Figure 8-2 on page 218.

Note: Previous beta releases included a DWA8.NTF template. This template is no longer 
shipped with Domino.
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The welcome page shown in Figure 8-1 has undergone very minimal changes from the 
Domino Web Access 7 Welcome page.

Figure 8-1   Domino Web Access 8 Welcome page
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8.1.2  Mail enhancement

In Domino Web Access 8, your mail action bar now has similar action buttons to what is 
available in Notes 8 client (Figure 8-2). This gives you more options and flexibility when it 
comes to managing your mail file. Also new in Domino Web Access 8 is the ability to open 
another user’s mail file directly from the inbox without having to first create a shortcut to, or 
knowing the URL of, the user’s mail file. To open another user’s mail file when there is no 
shortcut, Open the Mail tab and from the navigator click Open Mail for (Figure 8-2).

Lotus Domino Web Access 8 offers a new preview pane that lets you preview the text of your 
e-mail messages as you scan through your inbox. As with Lotus Notes 8, you can choose to 
display the preview pane horizontally, vertically, or not at all. See Figure 8-2.

Figure 8-2   Preview pane in Domino Web Access 8

Note: Even though you have access to another user’s mail file, you cannot read encrypted 
mail that he receives, and you cannot send signed or encrypted messages on his behalf.

Action bar

 

Quickly switch
to another
mail file
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Domino Web Access 8 gives you the ability to customize the mail header to change what is 
displayed in the form when you create a new message. An example is shown in Figure 8-3.

Figure 8-3   Customized mail header
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Domino Web Access 8 supports the enhanced out-of-office capabilities of Lotus Domino 8 
outlined in 9.2, “Out of Office router service” on page 242. The user interface for the out of 
office has also been enhanced. A summary of the out-of-office configuration is displayed on 
top of the panel. A new option to append return date to subject has also been included, which 
lets the recipient know the return date without opening the message. See Figure 8-4.

Figure 8-4   Out-of-office configuration

In addition, Domino Web Access 8 gives you the ability to publish your inbox through an RSS 
or Atom feed by clicking an icon. This can give you the flexibility to view your mail using other 
client software when you are away from your usual work environment or to easily allow 
access to shared mail boxes. See the Domino Web Access Help topic “Use RSS Feeds for 
Your Mail Inbox” for more information.

8.1.3  Calendar enhancement

New calendar features in Domino Web Access 8 include calendar filters, preferred rooms and 
resources, and improved delegation capabilities.
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Calendar filters give you the option to display only certain kinds of entries at one time. For 
example, you can choose to display your calendar entries by chairperson, by type (meetings, 
appointments, reminders, events, private entries), or by invitee status (confirmed or 
tentatively accepted). To do so, click Show in the top right-hand corner of the calendar, select 
Filter by, and click a filtering option.

Figure 8-5   Option to filter Calendar view
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Through your Lotus Domino Web Access 8 calendar preferences, you can set up a default 
site and one or more default rooms and resources that display when you schedule meetings 
(Figure 8-6). 

Figure 8-6   Set the default site or a default room and resource list
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If you manage other people’s calendars, you can easily access their calendars from within 
your own calendar. To do this, click Calendar → Open Calendar for Another Person and 
enter the person’s name in the Select whose calendar to open field. An example is shown in 
Figure 8-7.

Figure 8-7   Open calendar for another person

8.1.4  PIM enhancement

You may choose to use Lotus Notes 8 in the office but access your mail from a Web browser 
from home or when traveling. Lotus Domino Web Access 8 offers two features to easily keep 
your work in sync.

When you update the password in the Lotus Notes ID that is embedded in your mail file, 
Lotus Domino Web Access 8 automatically updates the Internet password. This management 
feature can help reduce the administrative burden of managing passwords. To use this 
feature, you need to implement an organizational or explicit policy to synchronize users' 
Internet passwords with their Notes passwords.
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Figure 8-8 shows the Security tab of a user with an embedded Notes ID, but no security policy 
to synchronize the internet password with the Notes ID password. You would notice that there 
two different places to change the passwords. In Figure 8-9, there is only one place to change 
the password. Although the dialog you get as a result of the clicking the Change button is 
requesting the Notes ID password, the internet password would be automatically updated 
with the new Notes ID password.

Figure 8-8   Two different places to change internet and Notes ID password

Figure 8-9   One place (Change Password section) to change both Internet and Notes ID passwords

To set up a security settings policy to synchronize the internet password with the Notes ID 
password, see the Lotus Software Knowledge Base Document "How to Synchronize Notes 
and Internet Password with Policy Documents in Notes Domino 6":

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21110671
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In Domino Web Access 8, the mail file is automatically synchronized with changes to your 
Notes 8 mail file and your business contacts in the Notes 8 Contacts database. You no longer 
need to run the Synchronize Address Book agent. See 6.5.4, “Synchronize contacts with 
Domino Web Access” on page 158, for more information about how to set up automatic 
synchronization between Domino Web Access 8 and Notes 8 Contacts.

8.2  Changes for instant messaging

The integrated instant messaging capabilities of Domino Web Access have been enhanced in 
Version 8. This section discuss the enhancements in instant messaging.

You can now work in your mail file without being online and available to other users for chats. 
The option to log off instant messaging is now conveniently listed in the Instant Messaging 
drop-down list. See Figure 8-10. Also new in the drop-down list is the ability to change your 
status to In A Meeting, and your inbox would now properly display the icon for that status.

Figure 8-10   Additional options added to the Instant Messaging drop-down list

Awareness icons are automatically refreshed in the Domino Web Access views.

Note: For more on policy, refer to the Domino Administrator Help.
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Domino Web Access 8 has its own Instant Contact list (shown in Figure 8-11) to replace the 
Sametime Connect for browsers, which was used in Version 7.

Figure 8-11   Domino Web Access 8 Contact list

If you are already using the Sametime Connect Client for desktop, Sametime Connect Client 
for browsers, or Notes Instant Messaging Client, you already have an instant contact list store 
on the Sametime server. Domino Web Access 8 pulls the instant contact list from the 
Sametime server and stores it back on the Sametime server, making your contact list 
available for you regardless of your client.

Note: By default, the Sametime 7.5 server no longer ships with a version of the Sametime 
connect for browser (also known as the Java Connect Client). Version 7.0 Connect for 
browsers can be deployed on a Sametime 7.5 server as a workaround. See the Lotus 
Software Knowledge Base Document Deploying Sametime 7.0 Connect for browsers on a 
Sametime 7.5 server for more information:

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21243158

Note: If you are using Domino Web Access 6.5.x and your instant contact list is stored in 
your mail file, you can send your contact list to the Sametime server before your mail file is 
upgraded to Domino Web Access 8.

Tip: The instant messaging contact lists are stored in the vpuserinfo.nsf database on the 
Sametime server.
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The Domino Web Access 8 instant contact list also allows you how to customize how your 
Instant contact list is displayed, giving you the option to show only online users, only short 
names for users, or have the names sorted alphabetically. See Figure 8-12.

Figure 8-12   Customize instant contact list display

8.3  Deploying IBM Domino Web Access 8

In this section we discuss deploying IBM Domino Web Access 8.

8.3.1  Systems requirements

Note that these requirements are often updated with additional support for future versions of 
browsers and operating systems. Always refer to the Release Notes for the most up-to-date 
information.

Client hardware requirements
The client hardware requirements are:

� Recommended for better performance:
– Windows - Pentium IV 1 GHz with 512 MB of memory
– Linux - Pentium IV 1 GHz with 512 MB of memory 
– Macintosh - G4 1.25 GHz with 512 MB of memory

� Minimum requirements:
– Windows - Pentium III 400 MHz with 128 MB of memory
– Linux - Pentium III 500 MHz with 192 MB of memory 
– Macintosh - G4 1 GHz 256 MB of memory

Client operating systems and supported browsers
Domino Web Access runs on the following client operating systems:

� Windows XP and Vista using the following browsers:
– Internet Explorer 6 and 7
– Mozilla Firefox 2.0 or later

� Novell Linux Desktop (NLD) 10 using Mozilla Firefox 2.0 or later
� Linux RedHat RHEL 5.0 using Mozilla Firefox 2.0 or later
� Macintosh OS 10.4.x using Mozilla Firefox 2.0 or later 

Note: Mozilla Firefox 2.0 or later on the Linux platform does not support Domino 
Off-Line Services (DOLS), local archiving, or Lotus Sametime awareness.
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Server requirements
See "Notes 8 and Domino 8 Beta platforms and system requirements" in the Release Notes 
for a complete list of server operating systems and requirements.

Certified proxy servers
Certified proxy servers are:

� SunOne Portal Server 6.2
� IBM WebSphere Edge Server 2.0.2 efix 49
� Tivoli Access Manager 5.1

Adobe Acrobat
Use Adobe® Acrobat® Reader Version 4.0 or later to print calendars.

8.3.2  Upgrading the Domino Web Access design

Use one of the following options to upgrade the Domino Web Access Web users templates:

� Mail Conversion Utility (issue load convert from the Domino Console).

� Select File → Database → Replace Design (from the Notes, Administrator, or Designer 
client).

To upgrade Domino Web Access users using the load convert utility, use the following 
syntax:

load convert [-r] [-u] filepath\filename OldDesignName NewTemplateName

[-r] recursively converts through subdirectories of the math you specify.

[-u] upgrades the design of the folders to the same design as $inbox.

Consider the following examples:

� The following command converts all users in the mail subdirectory from their current 
template to the Mail 8 template:

load convert mail/*.nsf * mail8.ntf

Important: Mozilla Firefox is supported by the Domino Web Access7 and Domino Web 
Access 8 mail templates only. It is not supported by iNotes6 templates.

Attempting to access Domino Web Access through unsupported browsers results in the 
display of an unsupported browser notice. Netscape 4.x users may see hangs or crashes 
when encountering the Domino Web Access unsupported browser page. If you are a 
Netscape 4.x user and you encounter these problems, you should open your mail file using 
the WebMail UI directly through the &ui=webmail switch. This is documented in the topic 
Switching to WebMail in the Domino Web Access help.

Domino Web Access does not work if JavaScript is disabled or if session cookies are 
disabled. 

Note: Previous releases included a Domino Web Access mail template, for example, 
Domino Web Access 7 (DWA7.NTF). For this release, Domino Web Access uses the MAIL 
(R8) template (MAIL8.NTF).
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� To convert only Domino Web access users, use the following command:

load convert mail/*.nsf dwa7 mail8.ntf

This command skips databases not based on the DWA7.NTF (Domino Web Access 7) 
template.

� To convert all mail files to the Mail 8 template and convert the design of folders, use the 
following command:

load convert -u mail/*.nsf * mail8.ntf

� To create a list of mail files by reading people’s mail files from the Domino directory, use 
the following command:

load convert -l <filename>

After this list is created, you can edit the list to include only the people you want to 
upgrade to a particular template. To read the list of databases from the text file and 
convert only those listed, use the following command:

load convert -u -f <filename> * mail8.ntf

[-f] reads the list of databases to process from a text file

8.4  Domino Web Access and WebSphere Portal

Domino Web Access has a new look and feel when viewed via WebSphere Portal. The color 
scheme has been enhanced when the DWA URL includes the “&client=wps” argument.

Important: Use extreme caution when using a wildcard character (*). A simple mistake 
such as forgetting to specify the mail directory will replace all your databases with the 
Domino Web Access template.

Tip: To easily view switches, descriptions, and some examples for the load convert utility, 
type load convert -? in the Domino Console. 
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You can see the new Domino Web Access interface via WebSphere Portal in Figure 8-13.

Figure 8-13   Domino Web Access 8 interface via WebSphere Portal

Tip: To add the “&client=wps” argument you can customize the Domino Web Access 
redirect database:

1. From the Domino Designer, open the IWAREDIR.NTF file.

2. Open the WMRProfile form.

3. Open the properties for the WMRProfileURL field, which is an editable Combo box.

4. From the Control tab, change the following to the list of choices: 

– Inbox | /iNotes/Mail/?OpenDocument&ui=wps
– Default | /iNotes/Mail/?OpenDocument&ui=wps

5. Replace all entries with ui=wps, if needed.

6. Save the form and close Domino Designer.

7. Update the design of the Domino Web Access redirect database with the modified 
IWAREDIR.NTF template.

8. Make sure that you enable Personal Options in the Domino Web Access redirect 
database configuration and select INBOX as the default value.
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8.5  RSS feeds for Domino Web Access

Lotus Domino 8 allows you to gain the flexibility to view your mail from Internet and non-Lotus 
clients when you are away from your usual work environment by enabling RSS or ATOM 
feeds for your Domino Web Access inbox.

When feeds are enabled, a feed icon is displayed in the inbox, as shown in Figure 8-14. This 
allows feed readers or browser extensions to automatically detect that a feed link is present 
from a user's Domino Web Access inbox.

Figure 8-14   Domino Web Access inbox with feed icons

Take into considerations the following observations for enabling RSS feeds for Domino Web 
Access inbox:

� Domino Web Access mail files are generally not accessible by anonymous users. The 
feed reader application must support storing authentication information.

� You should also be aware that HTTP traffic to your IBM Lotus Domino mail server may 
increase if many users subscribe to these feeds within external feed readers. This may 
impact server performance.
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RSS feeds for Domino Web Access inbox are enabled by using Domino server NOTES.INI 
entries. The NOTES.INI entries listed in Table 8-1 are related to enabling the Domino Web 
Access inbox for RSS.

Table 8-1   NOTES.INI entries related to enabling  RSS feeds for Inbox

Setting Description Example

iNotes_WA_Feeds Applies to Domino Web Access 
clients. Use this setting to 
enable the advertisement and 
access to various inbox feed 
formats for Domino Web 
Access mail files. Possible 
values are: 
� iNotes_WA_Feeds = rss 
� iNotes_WA_Feeds = atom 
� iNotes_WA_Feeds = 

atom,rss 
By default, no feeds are 
enabled or advertised.

iNotes_WA_Feeds=atom,rss

iNotes_WA_FeedsSecured Applies to Domino Web Access 
clients. Use this setting to 
enable non-HTTP (non-secure) 
feeds. By default only, secure 
feeds are enabled to the mail 
file. This is to avoid insecure 
authentication occurring as part 
of a feed retrieval. 
� 0 - Use this setting to allow 

non-secure feeds.
� 1 (default) - Use to allow 

feeds to be accessed via 
http rather than https.

iNotes_WA_FeedsSecured=0

This allows HTTP to be used 
instead of HTTPS. Make sure 
that HTTPS is enabled.

iNotes_WA_DisableForceBasic
AuthForFeeds

Feed readers are not able to 
properly authenticate to access 
Domino Web Access inbox 
RSS feeds if form-based 
authentication is used. This 
setting forces basic 
authentication for feeds. You 
can use the following variants:
� iNotes_WA_DisableForceBasi

cAuthForFeeds=1 (to 
disable basic authentication 
for both Atom and RSS 
requests)

� iNotes_WA_DisableForceBasi
cAuthForRSS=1 (to disable 
basic authentication for 
RSS requests only)

� iNotes_WA_DisableForceBasi
cAuthForAtom=1 (to 
disable basic authentication 
for Atom requests only)

iNotes_WA_DisableForceBasic
AuthForFeeds=1
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In the ITSO Corporation example, we enabled the following entries on our Lotus Domino 8 
Server NOTES.INI, as shown in Figure 8-15. Restart the Lotus Domino 8 Server after making 
these changes.

Figure 8-15   NOTES.INI entries for enabling RSS feeds

iNotes_WA_FeedsProtocol
(optional)

Applies to Domino Web Access 
clients. Use this setting to have 
further control of the feed 
protocol advertised by the inbox 
page. It is applicable only when 
iNotes_WA_FeedsSecured is 
disabled (set to 0). Possible 
values are: 
� iNotes_WA_FeedsProtocol 

= http (http is the default 
advertising protocol) 

� iNotes_WA_FeedsProtocol 
= https (http is the default 
advertising protocol) 

� iNotes_WA_FeedsProtocol 
= not specified (default) 

By default, the feed protocol is 
not specified. The advertised 
feed uses the same protocol as 
the current page on which the 
feed advertisement occurs.

iNotes_WA_FeedsProtocol 
=http 

Note: A current listing of all NOTES.INI settings can also be found on the Lotus 
developerWorks Web site at: 

http://www.ibm.com/developerworks/lotus/documentation/notes-ini/

Setting Description Example
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This allows the Domino Web Access inbox to be available as an RSS/ATOM feed. The 
default URL formats to retrieve the feeds are as follows:

<mailfile>/iNotes/Proxy/?OpenDocument&Form=s_RSS&NKA (for RSS)
<mailfile>/iNotes/Proxy/?OpenDocument&Form=s_Atom&NKA (for Atom)

As shown in Figure 8-16, you can now access the inbox using the Firefox RSS reader.

Figure 8-16   Domino Web Access inbox being accessed as a RSS feed
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8.6  NOTES.INI parameters specific to Domino Web Access 8

Table 8-2 summarizes the consolidated list of new additions to Lotus Domino 8 specific to 
Domino Web Access.

Table 8-2   NOTES.INI parameters specific to Domino Web Access 8

Setting Description Example

iNotes_WA_Areas Applies to Domino Web Access 
clients. Use this setting to 
disable any combination of the 
six functional areas in Domino 
Web Access: Welcome, Mail, 
Calendar, To Do, Contacts, or 
Notebook. Each area can 
contain a value of 0 to disable 
an area, or 1 to enable an area. 
The format is 
iNotes_WA_Areas = ABCDEF, 
where: 
� A = Welcome 
� B = Mail 
� C = Calendar 
� D = ToDo 
� E = Contacts 
� F = Notebook 
Example: In this example, all 
sections except for Mail and 
Contacts are disabled: 
iNotes_WA_Areas = 010010. 
The default setting is 111111. If 
this setting is not used, all 
functional areas are enabled by 
default.

iNotes_WA_Areas = value 
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iNotes_WA_ConfirmBlocked Applies to Domino Web Access 
clients. If a user has not 
installed the latest Domino Web 
Access ActiveX® control and if 
the installation is blocked by the 
browser, she will be asked once 
per session to confirm that 
Domino Web Access should 
continue to try to utilize the 
ActiveX control on subsequent 
pages (which is necessary to 
get the control installed). This 
setting provides a way to 
disable this prompt and for 
Domino Web Access to not use 
the Domino Web Access 
ActiveX control on subsequent 
pages (if it is not already 
installed). 
� 0 - Suppresses 

confirmation box
� 1 (default) - Confirmation 

box displays
If the confirmation box is 
suppressed, a user can now 
install the ActiveX control from 
the Domino Web Access 
Preferences dialog. 

iNotes_WA
_ConfirmBlocked
ActiveX = value 

iNotes_WA_DefaultDictionary Applies to Domino Web Access 
clients. This value can be set by 
the administrator to specify the 
default spell check dictionary 
for Domino Web Access users. 
When used, it should be set to 
one of the dictionary file names 
found in the Domino server's 
data directory (for example, 
us.dic). Users can override this 
default by selecting a default 
dictionary from Domino Web 
Access Preferences. The 
default setting is none. 
wpdic.dic is used if no 
dictionary is supplied.

iNotes_WA
_DefaultDictionary = dictionary 
name 

Setting Description Example
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iNotes_WA_DisplayArchiveList Applies to Domino Web Access 
clients. Use this setting when 
users may have more than one 
private archive policy or the 
administrator has assigned an 
archive policy to the user. When 
this variable is set to one, a 
dialog opens when the user 
clicks the Archives button or 
tries to perform an archive 
operation on a selected 
document from the virtual list or 
from an open message. The 
dialog displays a list of archive 
criteria that the user has set or 
the archive criteria settings as 
assigned through an archive 
policy by the administrator. The 
user can select the desired 
archive on which to perform the 
archive operation. 
� 0 (default) - Disables this 

setting
� 1 - Enables this setting 

iNotes_WA
_DisplayArchiveList = value 

iNotes_WA_Feeds Applies to Domino Web Access 
clients. Use this setting to 
enable the advertisement and 
access to various inbox feed 
formats for Domino Web 
Access mail files. Possible 
values are: 
� iNotes_WA_Feeds = rss 
� iNotes_WA_Feeds = atom 
� iNotes_WA_Feeds = 

atom,rss 
By default, no feeds are 
enabled or advertised.

iNotes_WA_Feeds = value 

Setting Description Example
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iNotes_WA_FeedsProtocol Applies to Domino Web Access 
clients. Use this setting to have 
further control of the feed 
protocol advertised by the inbox 
page. It is applicable only when 
iNotes_WA_FeedsSecured is 
disabled (set to 0). Possible 
values are: 
� iNotes_WA_FeedsProtocol 

= http (http is the default 
advertising protocol.) 

� iNotes_WA_FeedsProtocol 
= https (http is the default 
advertising protocol.) 

� iNotes_WA_FeedsProtocol 
= not specified (default) 

By default, the feed protocol is 
not specified. The advertised 
feed uses the same protocol as 
the current page on which the 
feed advertisement occurs.

iNotes_WA_FeedsProtocol = 
value 

iNotes_WA_FeedsSecured Applies to Domino Web Access 
clients. Use this setting to 
enable non-HTTP (non-secure) 
feeds. By default only secure 
feeds are enabled to the mail 
file. This is to avoid insecure 
authentication occurring as part 
of a feed retrieval. 
� 0 - Use this setting to allow 

non-secure feeds.
� 1 (default) - Use to allow 

feeds to be accessed via 
http rather than https.

iNotes_WA_FeedsSecured = 
value 

iNotes_WA_LogoutRedirect Applies to all Domino Web 
Access clients. Use this setting 
to specify a URL to redirect 
users to a Web page after 
logging out from server. The 
setting provides normal cache 
clearing with the Domino Web 
Access control and clearing of 
browser credentials. It also 
allows sites that perform 
additional actions on a logout, 
such as logging out of a reverse 
proxy server, to specify a URL 
to do this additional activity. 
You can use this variable to 
return people to an initial login 
page. For example: 
iNotes_WA_LogoutRedirect = 
http://www.ibm.com 

iNotes_WA_LogoutRedirect = 
URL 

Setting Description Example
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iNotes_WA_PreferWebEngine
CacheControl

Applies to Domino Web Access 
clients. Domino Web Access 
now sets Cache-Control 
response headers that prevent 
the Domino Web Engine from 
remapping them in certain 
scenarios. Previously, the 
default Domino Web Engine 
logic did not allow returning a 
cache-control response header 
for HTTP 1.0 requests, which 
lead to content being left in the 
browser cache unintentionally. 
Use this setting to revert to the 
prior behavior.
� 0 (default) - disables this 

setting
� 1 - enables this setting 

iNotes_WA_PreferWebEngine
CacheControl = value 

iNotes_WA_PreferXMLHttpRe
quest

Applies to Domino Web Access 
clients. Set this variable to 1 to 
use the Microsoft.XMLHTTP 
ActiveX object instead of the 
load() method of <xml> tag 
where possible. 
� 0 (default) - disables this 

setting
� 1 - enables this setting 

iNotes_WA_PreferXMLHttpRe
quest = value 

Note: A current listing of all NOTES.INI settings can also be found on the Lotus 
developerWorks Web site at: 

http://www.ibm.com/developerworks/lotus/documentation/notes-ini/

Setting Description Example
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Chapter 9. New administration features

In this chapter we introduce each of the major new administration features in Notes and 
Domino 8. For each new feature, details of the installation and configuration are described.

This chapter discusses the following:

� Out of Office router service
� Message recall
� Inbox maintenance
� Administration process improvements
� Database redirects
� Streaming cluster replication
� Policy enhancements
� New Domino domain monitoring features
� The new optional On Disk Structure (ODS48)
� Domino and DB2 deployment
� Other administrative enhancements

9
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9.1  Introduction to new administration features

Throughout the history of Notes and Domino, each new Domino version has presented 
opportunities for administrators to simplify and automate administrative tasks, and provided 
new features that can be implemented to enhance the Domino environment. In this regard, 
Domino 8 is no exception. 

In Domino 8, enhancements to existing administrative tools such as Domino domain 
monitoring and policies aim to automate more administrative tasks and to provide proactive 
management of the Domino environment. New features such as the Out of Office Router 
option and the new On Disk Structure (ODS48) provide new opportunities to improve 
performance and functionality. 

This chapter introduces the new and notable features and enhancements in Notes and 
Domino 8. Implementation and configuration options for the new features are also provided.

9.2  Out of Office router service

In previous Notes and Domino versions, the out-of-office functionality was implemented using 
an agent stored in each user’s mail file. 

In Domino 8, administrators have the option of implementing router-based out-of-office 
processing. This has several advantages over the agent-based approach. A comparison of 
the functions of each approach is given in Table 9-1.

Table 9-1   Comparison of out-of-office agent versus Out of Office router service

Tip: For any Notes and Domino upgrade, it is generally good practice to upgrade the 
Notes and Domino environment to achieve a steady state with the current features and 
functions of the environment before implementing new features. Review Chapter 2, 
“Planning the Notes and Domino 8 Deployment” on page 15, for best practice 
recommendations for your upgrade. Review Chapter 3, “Deploying the Domino 8 server” 
on page 45, for information about upgrading your Domino servers.

Comparison Item Agent Router Service

User execution rights Required (either manager 
access to mail, agent execution 
rights, depositor access to 
admin request database, or a 
combination of these).

Not required.

When out-of-office responses 
are sent back to mail senders

At next agent run time. Immediately when the router 
processes the new message.

Setting out-of-office start and 
end times (hours)

No ability to set start and end 
times. Only whole days (dates) 
can be set for start and end of 
out-of-office period.

Users can set specific times 
when out-of-office period starts 
and ends.

Load on the server Higher at agent run time, if 
several out-of-office responses 
need to be processed.

Spread out - Each message is 
processed as it is received by 
the router.

Disabling out-of-office Manual by user. Automatic.
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9.2.1  How to configure the Out of Office router service

The Out of Office router service is configured in the server configuration document in the 
Domino directory.

To configure the Out of Office router service on a Domino 8 server:

1. In the Domino Administrator client, while connected to the server, go to the Configuration 
tab.

2. Navigate to Servers → Configurations in the left navigation pane.

3. Click Edit Configuration to update an existing configuration document, or click Add 
Configuration to create a new one (Note: Only use Add Configuration if a configuration 
document for the desired server does not already exist.)

If you are creating a new configuration document, add the server name to the Group or 
Server Name field (for example, Boston/ITSO).

4. Go to the Router/SMTP → Advanced → Controls tab.

5. Change the Out-of-Office type field to Service, as shown in Figure 9-1.

Figure 9-1   Configuring the Out of Office router service

6. Save and close the configuration document.

Important: The Out of Office router service can only be configured for Domino 8 servers. 
Earlier server versions do not support this functionality. 

We recommend that the Out of Office router service only be implemented after completing 
the upgrade to Domino 8 on all Domino servers. This is particularly important for clustered 
servers. For Lotus Domino 6.5 or 7 servers or clusters that contain these servers, the 
out-of-office service must be configured as an agent.

It is not a requirement for your Notes clients and mail files to be upgraded to Version 8 
before you enable the Out of Office router service. However, when a user enables 
out-of-office in a mail file that is based on an earlier template version, the router service 
setting will simply be ignored, and the out-of-office agent will be used instead for that user.

Tip: It is not necessary to restart the router process on the server. The new setting is 
detected automatically by the router.
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9.2.2  Viewing Out of Office router service status information

When the Out of Office router service is enabled on a server, the administrator can use the 
Domino Administrator client or the Domino server console to view a list of users who are 
currently using the service.

Viewing Out of Office router service status on the server console
In Domino 8 there is a new tell router server console command that displays a list of 
databases on the server that are currently utilizing the Out of Office router service. To use this 
command, at the Domino server console type:

tell router o

An example of this command and the output is displayed in Figure 9-2.

Figure 9-2   Example output for tell router o command

Viewing Out of Office Service status in the Domino Administrator client
The Files tab in the Domino Administrator client contains a new Out of Office column that you 
can use to view out-of-office service status for mail files on the server. 

The Out of Office column is the right-most column on the Files tab of the administrator (use 
the horizontal scroll bar to scroll to the right to view this column). The column contains a Yes 
for those users who are utilizing the Out of Office router service.

9.2.3  How the out-of-office service process works

Out of Office router service processing occurs after the server mail rules and user mail rules 
are applied, after the before mail delivery agent processing completes, but prior to the after 
mail delivery agent processing. This allows the user to pre-process mail using rules or using 
the before delivery mail agent. A user can pre-process mail in order to control spam or to 
forward messages. 

Out-of-office processing for each user becomes active when a user enables it. The service 
disables itself when processing the first e-mail after the user's designated out-of-office time 
has expired or during routine router maintenance if the user receives no e-mails after the 
out-of-office time period has expired. 

The Out of Office router service runs as part of the mail router. This means that out-of-office 
responses are immediate and server failover is supported. 

Delegation of out-of-office functionality is supported and fully integrated with calendar 
management. Note that a delegate must have a minimum of editor access in the ACL to allow 
him to enable out-of-office in the mail file.

Note: Only users who enabled out-of-office after the router service was configured on the 
Domino server are shown in this list. Users who enabled out-of-office while the 
agent-based function was in use continue to use the agent for the remainder of their 
out-of-office periods. Similarly, users with mail files based on a pre- Version 8 mail 
template also continue to use the agent and therefore do not display in the list.
244 IBM Lotus Notes and Domino 8 Deployment Guide



For information about the new client out-of-office features, refer to 6.3.5, “Improved out of 
office” on page 143.

9.3  Message recall

Message recall is a new feature of Notes and Domino 8 that allows users to recall e-mail 
messages that they sent in error. Message recall is enabled by default on all Domino 8 
servers. The settings for this feature can be configured in the server configuration document.

Message recall is designed to work within the Domino environment. It is only available for 
messages delivered to Domino 8 servers via NRPC. The sender and recipient servers do not 
need to be in the same Domino domain, but must be using NRPC to route mail between 
them. It is not possible to recall a message that was delivered via SMTP. 

9.3.1  How to configure message recall on the Domino server

Message recall is configured in the Domino directory in the server configuration document on 
the Router/SMTP → Message Recall tab. The configuration document settings can also be 
optionally overridden by settings in a mail policy settings document. 

Note: Enabling the Out of Office router service is not retrospective. In other words, any 
out-of-office agents that were already active prior to the activation of the service on the 
Domino server will still use the out-of-office agent. These mail files are not included in the 
list of active Out of Office router service users displayed on the server console or in the Out 
Of Office column in the administrator client because they do not use the service.

In the reverse, if the Out of Office router service was previously enabled on a server, any 
mail files that had the Out Of Office option enabled while the router service was enabled on 
the server will continue to use the service even after it is disabled in the server 
configuration document. These mail files also continue to display in the list of files currently 
using the service.

Disabling and re-enabling the Out of Office option in the mail file forces it to use whichever 
configuration (agent or service) is currently enabled on the Domino server.

Important: It is a good idea to decide whether your organization will allow message recall 
prior to your Domino 8 upgrade. Once the Domino directory design has been upgraded to 
the Domino 8 design, message recall will be enabled by default. This occurs whether or not 
you have any existing configuration documents. Existing configuration documents have the 
message recall settings already enabled. However, even if you do not have a configuration 
document created, message recall is still enabled with the default settings.

Therefore, if you do not want to allow message recall, disable the feature in existing 
configuration documents as part of the Domino server upgrade process. If you do not have 
a configuration document for a server that you are upgrading (or a new Domino server) 
you need to create a configuration document for the server so that you can specifically 
disable message recall if you do not want to use it.

Important: Remember, the default settings (with message recall enabled) are active even 
if a configuration document does not exist for the server.
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Configuration document settings for message recall
The configuration document settings and their default values for message recall are shown in 
Figure 9-3.

Figure 9-3   Message recall settings in the server configuration document

The options for the settings are shown in Table 9-2.

Table 9-2   Options for message recall settings in the server configuration document

Optional mail policy settings for message recall
Message recall settings can be overridden for specific users by configuring message recall 
settings in a mail policy settings document then applying the settings to specific users through 
a policy.

The mail policy settings document contains more granular settings than the configuration 
document. It contains settings for specifying whether a user can recall messages, and 
whether she can have messages recalled from her. The latter is the equivalent of the user 
preference Allow others to recall mail sent to me, and this setting can be locked down so that 
users cannot change it.

Tip: A configuration document for a specific server takes precedence for setting 
configuration options. However, if there is no specific server configuration document in 
existence, you can use the * - [Default] server configuration document to set the same 
message recall settings for all servers in your Domino domain. For information about how 
to create a default server configuration document, refer to the topic “Creating a 
Configuration Settings document” in the Domino 8 Administrator Help.

Note: The settings shown in Figure 9-3 are the default message recall settings used if no 
server configuration document exists.

Message recall setting Options Comments

Message recall. � Enabled (Default)
� Disabled

Enables message recall to be 
used to recall messages from 
mail recipients on this server.

Allow recall of messages with 
unread status.

� Unread only (default)
� Both read and unread

Allows recall for only unread 
messages, or for both read and 
unread messages.

Do not allow recall of messages 
older than.

� x minutes
� x hours
� x days (default - 14 days)
� x weeks

Sets the time limits before recall 
is refused. Setting this field to 0 
(zero) means that there is no 
time limit for recall.
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To override the configuration document message recall settings based on a policy, perform 
these steps:

1. Create or edit a mail policy settings document and go to the Mail → Message Recall tab, 
shown in Figure 9-4.

Figure 9-4   Message recall settings in the mail policy settings document

2. Fill in the message recall settings as required to control which functionality users will have. 
Set one or more of the settings shown in Table 9-3.

Table 9-3   Options for message recall settings in the mail policy settings document

3. Save and close the mail policy settings document.

Tip: The message recall functionality can be invoked from the Notes mail file in several 
ways. In the Sent view, the Recall message button or menu option Actions → Recall 
message can be used on a highlighted message. The right-click context menu also 
contains the rRecall message option. In the All Documents view, More → Recall message 
can be selected or the menu option Actions → Recall message for a highlighted sent 
message. The right-click context menu can also be used in this view.

If you disable message recall in the mail policy settings document by setting “User is 
allowed to recall sent messages” to No, these message recall options are removed from 
the Notes client interface. Note, however, that the Mail Policy setting "User is allowed to 
recall sent messages" only controls whether the recall action is visible in the user's mail 
file. The router does not use this setting to determine whether the requestor is allowed to 
recall messages. 

Setting Options

User is allowed to recall sent messages. � Yes
� No

Other users are allowed to recall messages they 
sent to this user.

� Yes
� No

Allow recall of messages with unread status. � Unread only
� Both read and unread

Do not allow recall of messages older than. � x minutes
� x hours
� x days
� x weeks
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4. If not already in place, create or update a policy document that references this mail policy 
settings document, then apply it to the required users.

5. (Optional) Apply the mail policy settings to the users immediately by typing the following 
command at the Domino server console of the user’s mail server:

tell adminp process mailpolicy

9.3.2  How message recall works

A user can initiate a message recall on an individual sent message as long as the message 
was saved to sent mail when it was originally sent. 

Note: In order for a mail policy settings document to be applied to users, it must be 
referenced in a policy document, in the Mail field. The policy needs to be applied to the 
appropriate users either explicitly in their person document or via an organizational 
policy assignment. 

If you are new to policies, refer to the Policies section in the Lotus Domino 
Administrator 8 Help database for information about how to plan and implement 
policies.

Note: By default, the administration process to apply the mail policy settings runs every 
twelve hours. Therefore, changes do not take effect until the next time the 
administration process runs. The above command forces it to run immediately.

Note: A mail file delegate cannot recall a message sent by the mail file owner. However, a 
mail file owner can recall a message sent by a mail delegate from the owner’s mail file.
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Once a recall request has been initiated, the following occurs:

1. The recall request message is sent to the recipient server’s mail router.

2. The mail router determines whether the message can be recalled. (Table 9-4 lists the main 
factors used by the Domino router to determine whether a message may be recalled. This 
list of factors is a useful guide for configuring message recall, and will also help 
troubleshoot when the result of a recall attempt is not as expected.)

3. If the message can be recalled, the router handles the recall process and sends any 
requested recall notifications back to the sender.

Table 9-4   Factors used by Domino to determine whether a message recall is possible

9.4  Inbox maintenance

The Domino 8 inbox maintenance feature allows administrators to automate the process of 
removing old documents from a user’s inbox folder. This has the potential to improve 
performance on the Domino server and the speed at which the inbox opens for users.

The inbox mail folder ($Inbox) is the default folder in the mail file. Its view index is set to 
refresh every time it is opened. The more documents there are in a user’s inbox, the higher 
the processing load on the server each time the folder is indexed, and the longer it takes for 

Factor Option Recall possible?

Mail delivery protocol. NRPC Yes

SMTP No

Overall message recall setting 
(configuration document).

Enabled Yes

Disabled No

Mail policy setting for user. User is allowed to recall sent 
messages - Yes.

Yes (for the recall requester)

Other users are allowed to 
recall messages they sent to 
this user - Yes.

Yes (for the original message 
recipient)

Allow recall of both read and 
unread messages 
(configuration document or mail 
policy settings document).

Both read and unread. Yes

Unread only. Only for messages that have 
not been read by anyone

Note: Even if a delegated user 
has read the message but the 
mail owner has not, recall will 
be refused.

User preferences - Allow others 
to recall mail sent to me.

Enabled. Yes

Disabled. No

Tip: Debug logging is available to help troubleshoot message recall processing using the 
following notes.ini variables: 

� DebugRouter=3 
� Log_MailRouting=40
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the folder content to display for the user. For very large inbox folders, this problem is greatly 
magnified.

In past releases of Notes and Domino, inbox cleanup largely relied on the user manually 
filing, deleting, or archiving inbox documents. In Domino 8, administrators can automate this 
task.

9.4.1  How to enable inbox maintenance

The inbox maintenance function is configured on a by-server basis in the server document in 
the Domino directory, on the Server Tasks → Administration Process tab, and optionally in 
the mail policy settings document. The server document settings are shown in Figure 9-5.

Figure 9-5   Inbox maintenance settings in server document

Note: The inbox maintenance process does not delete any documents. It simply removes 
them from the inbox folder, so they are still available in the All documents view of the 
user’s mail file. 

Only the inbox folder is updated by the inbox maintenance process. No other folders are 
changed by the process.

Note: By default, inbox maintenance is disabled. The default option “Maintain inboxes only 
for those users on this home server” shows as selected by default, but it only becomes 
active if user names are added to the Selected users field. In other words, the Selected 
users field is a none means none field, so if you leave it blank, no inbox maintenance 
occurs.
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The basic options available for inbox maintenance in the server document are:

� Maintain inboxes only for these selected users on this server (default).
� Maintain inboxes based on policies.

Enabling inbox maintenance in the server document (for all users on a 
server)
To enable inbox maintenance based on users listed in the Mail inbox maintenance section of 
the server document:

1. Edit the server document and go to the Server Tasks → Administration Process tab.

2. In the Mail inbox maintenance section, select the option Maintain inboxes only for these 
selected users.

3. In the Selected users field, enter user or group names, or type an asterisk (*) to enable 
inbox maintenance for all users on the server.

4. Fill in the remove document older than [x] days from inbox field (default value is 90).

5. (Optional) Select the Do not remove unread documents from Inbox option.

6. Set a schedule for inbox maintenance by selecting days and times in the Start executing 
Inbox maintenance fields. Multiple days may be selected.

7. Save and close the server document.

Enabling inbox maintenance in a policy (for selected users on a server)
To enable inbox maintenance based on a policy:

1. Edit the server document and go to the Server Tasks → Administration Process tab.

2. In the Mail inbox maintenance section, select the option Maintain inboxes based on 
Policies.

3. Set a schedule for inbox maintenance by selecting days and times in the Start executing 
Inbox maintenance fields. Multiple days may be selected.

4. Save and close the server document.

5. Create or Edit a mail policy settings document and go to the Mail → Basics tab.

6. Fill in the Remove document older than [x] days from inbox field (default value is 90).

7. (Optional) Select the Do not remove unread documents from Inbox option.

8. Save and close the mail policy settings document.

Note: This option only applies if a document has not been read in the mail file by 
anyone. For example, if a mail delegate has read a message but the mail owner has 
not, the message will be considered read, and will be removed by the inbox 
maintenance process.

Note: This option only applies if a document has not been read in the mail file by 
anyone. For example, if a mail delegate has read a message but the mail owner has 
not, the message will be considered read, and will be removed by the inbox 
maintenance process.
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9. (Optional) Apply the mail policy settings to the users immediately by typing the following 
command at the Domino server console of the user’s mail server:

tell adminp process mailpolicy

9.4.2  How the inbox maintenance process works

Inbox maintenance is an administration process that is carried out according to the schedule 
set in the server document, Mail inbox maintenance section. The default schedule is Saturday 
at 1 a.m. This can be changed, but we recommend that the task be scheduled to complete 
outside of business hours. 

Inbox maintenance processes inbox documents based on the date of the e-mail. Document 
dates (such as created, modified, and added dates) are not used for this process.

If the option Do not remove unread documents from Inbox is selected, the document is 
retained in the inbox only if the document has not been read at all. This means that if a 
delegated mail user has read the e-mail but the mail file owner has not, the mail will still be 
removed from the inbox folder.

When inbox maintenance runs, a single line message is displayed on the Domino server 
console (and to miscellaneous events in the server’s log.nsf), for example:

11/08/2007 01:02:38 AM  Admin Process: Completed maintenance of mailfiles for 102 
databases, 0 databases reported errors.

Note: In order for a mail policy settings document to be applied to users, it must be 
referenced in a policy document, in the Mail field. The policy needs to be applied to the 
appropriate users either explicitly in their person document or via an organizational 
policy assignment. 

If you are new to policies, refer to the Policies section in the Lotus Domino 
Administrator 8 Help database for information about how to plan and implement 
policies.

Note: By default, the administration process to apply the mail policy settings runs every 
twelve hours. Therefore, changes do not take effect until the next time the 
administration process runs. The above command forces it to run immediately.

Tip: When planning the inbox maintenance schedule, try to select a day and time when 
there are no other intensive processes running on the server. For example, the server 
updall task runs at 2 a.m. each night by default (ServerTasksAt2=Updall in the notes.ini). 
Since updall can be an intensive process on a large server, it is a good idea to schedule 
the inbox maintenance at a different time. Remember to also consider the timing and 
requirements of your server’s backup schedule.

Tip: Inbox maintenance can be run manually by typing the following command at the 
server console:

tell adminp process mb

Remember that inbox maintenance can be an intensive server process, so use caution 
when deciding when to run the process manually from the server console.
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9.5  Administration process improvements

The administration process (Adminp) automates many administration tasks in the Domino 
environment. Several enhancements to the administration process have been made in 
Domino 8 to implement new features (such as inbox maintenance and database redirects) 
and to improve the overall efficiency of the administration process. 

Three specific areas of improvement aimed at enhancing the efficiency of the administration 
process are:

� Direct Deposit of administration requests onto the target server
� Redefine time interval default for administration requests
� Database names list for user renames

These three new features are described below.

9.5.1  Direct Deposit of administration requests onto the target server

In previous Domino versions, administration requests were deposited into the administration 
database on the server where the request was created. Replication was then used to 
propagate the request to other servers in the domain. Using this method, a request that 
required processing by another server would not process until it had replicated to that 
server’s database replica.

In Domino 8, administration requests are now deposited directly into the target server’s 
administration requests database replica. Administration requests may be processed sooner 
using this method, since they are not reliant upon replication schedules to deposit the request 
on the target server prior to processing.

Direct deposit of administration requests is the default behavior in Domino 8, but it can be 
disabled on a by-server basis. To disable direct deposit of administration requests, add the 
following parameter to notes.ini on the originating server (the server where the request is 
created):

ADMINP_DONT_ATTEMPT_DIRECT_DEPOSIT=1

9.5.2  Redefine time interval default for administration requests

All administration requests are assigned a default time interval that determines when they are 
processed. The default time intervals are:

� Immediate: These requests typically execute within one minute.

� Interval: These requests are processed according to the interval timing set either in the 
server document or in notes.ini. The default setting is 60 minutes.

� Daily: These requests are processed once a day as defined by a setting in the server 
document.

Tip: This parameter could also be set in the server configuration document in the Domino 
directory by adding the following settings to the NOTES.INI Settings tab:

Item: ADMINP_DONT_ATTEMPT_DIRECT_DEPOSIT
Value: 1

Refer to Figure 9-30 on page 281 for an example of setting a notes.ini parameter using this 
method. 
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� Delayed: These requests are processed according to the timing set in the server 
document.

In Domino 8, the default timing of administration requests can be changed for each individual 
administration request type by specifying a new timing interval in the server’s notes.ini. The 
available override settings are:

� ADMINP_IMMEDIATE_OVERRIDE
� ADMINP_INTERVAL_OVERRIDE
� ADMINP_DAILY_OVERRIDE
� ADMINP_DELAYED_OVERRIDE

The format for the NOTES.INI variable is:

ADMINP_variable_OVERRIDE=X, X, X

Where each X represents the request number of an administration process request.

A practical example of where this override may be useful is for parts of the user rename 
process. User rename processing consists of a number of different administration requests, 
some of which are reliant on successful processing of earlier requests in the process. The two 
perhaps most critical requests for user rename are shown in Table 9-5.

Table 9-5   Two important administration requests that form part of the user rename process

You may decide to process these two processes immediately, so that you can act more 
quickly on any errors that would slow down or prevent the remainder of the rename 
processes from completing successfully. To change the interval for these two processes, add 
their request numbers to the notes.ini file on the Domino server where the requests are 
carried out (in this case, the administration server for the Domino directory), as follows:

ADMINP_IMMEDIATE_OVERRIDE=5.00, 19.00

Tip: Each administration request has a unique request number associated with it. The 
Lotus Domino 8 Administration Help database contains a full list for administration 
requests with their associated request numbers and default time intervals. To view the list, 
refer to the Redefining time interval defaults for administration requests topic in the Lotus 
Domino 8 Administration Help.

Admin process Default timing Request number Why it is important

Rename person in 
Domino directory.

Interval 5.00 Successful processing 
of this request triggers 
the creation of all 
subsequent user 
rename requests.

Rename in person 
documents.

Daily 19.00 This request must be 
processed to remove 
"AdminpOld" fields in 
person documents, a 
requirement for 
successful rename 
completion.
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9.5.3  Database names list for user renames

During a Notes user rename, a series of administration requests are processed to update the 
user’s name details in all areas that affect authentication, mail routing, and access control for 
that user. Part of this processing involves updating the user name in Reader and Author 
fields. This administration process can be resource intensive, since it must check inside every 
document in every database to determine whether a given user’s name is present for 
updating.

For databases that use the new ODS48, this area of the user rename process has been 
streamlined. These databases store a names list, which is a master list of all the user names 
listed within any document in that database.

The names list is created automatically for all ODS48 databases. There is no requirement to 
enable the function and no options to configure it. In a mixed environment with a Domino 8 
administration server and Adminp template, Domino 7 servers process renames in their usual 
way.

During a user rename process, the administration process first checks the master names list 
(in ODS48 databases) to determine whether any of the documents in that database list the 
user in reader or author fields. If the user’s name exists in the names list, the administration 
process searches through every document in the database to process the rename. If the 
user’s name does not exist on the names list, no more processing is completed for that 
database.

9.6  Database redirects

In Domino 8, administrators can select to automatically create a pointer reference to redirect 
users to new a database replica or notify them of a deleted database. This option allows 
administrators to more easily manage client updates to reflect database moves and deletions.

This option is available through the administration client as an option that can be selected in 
the following interfaces:

� Move database.
� Delete database.
� Create redirect.

9.6.1  How to create a database redirect

The interfaces for move database and delete database in the Domino 8 administrator client 
have additional check boxes to allow administrators to automatically create a database 
redirect during these processes.

Note: This feature requires implementation of the new ODS48. For more information about 
ODS48, refer to 9.10, “The new optional On Disk Structure (ODS48)” on page 278. 

Note: The new names list has a size limit of 4 Kb. Once this size is exceeded, the previous 
method is used for reader and author field checking.
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The new options are shown in Figure 9-6 and Figure 9-7.

Figure 9-6   Option in Move Database dialogue to create a database redirect

Figure 9-7   Option in Confirm Delete Database dialogue to create a database redirect

There is also a new create redirect tool on the Files tab of the administrator client. This tool 
allows administrators to create a redirect for a database, usually in preparation for an 
upcoming database move or deletion. This redirect can be used to switch users to one or 
more different replicas, or notify them when the database is deleted.

Using the Create redirect option allows you to specify more than one server to redirect users 
to, and the order used to redirect them (random or sequential). This provides more flexibility 
than the option within the Move database interface, which only allows you to choose one 
redirection server.

Attention: A database redirect created using the create redirect tool does not become 
active until the original (source) database is actually removed. 
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To create a new redirect for a database replica:

1. In the Domino Administrator client connect to the server containing the replica that you 
want to redirect (that is, the source server).

2. Go to the Files tab and highlight the database to redirect.

3. From the Tools pane on the right, select Database → Create redirect to display the 
Create Database Redirect dialogue shown in Figure 9-8.

Figure 9-8   Create Database Redirect dialogue

4. Click the Add button to open the Configure Redirect Replica Reference dialogue shown in 
Figure 9-9.

Figure 9-9   Create redirect configuration dialogue
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5. In the Server field, select the name of the redirect destination server.

6. Select the database in the list. (Note: This must be a replica of the original database. You 
cannot choose a different database to direct users to.)

7. (Optional) Choose users or groups to redirect to the selected server by clicking one of the 
two icons to the right of the Who should be redirected to this replica? field:

– User icon: Choose users or groups from the Domino directory.
– Lock (Access control) icon: Choose users from the database ACL.

8. Click OK to close the Configure dialogue.

9. (Optional) Complete steps 4–7 above to add additional redirect servers.

10.(Optional) If more than one redirect server has been added, the Order field becomes 
active. Choose either Random or Sequential to specify how users will be redirected.

11.Click OK to close the Create redirect dialogue.

9.6.2  How to update a database redirect

There are two ways to update a database redirect:

� If you created the redirect using the Create redirect tool, and the original replica is still in 
place (that is, the redirect is not yet active):

a. Select the database on the File tab of the Domino Administrator client.
b. From the Tools pane on the right, select Database → Create redirect.
c. This displays the Update redirect dialogue where you can update the redirect details.

Note: If you are redirecting selected users to different servers for a database move, 
make sure that you include all users in one of the references. If no references apply 
to a particular user, that user sees the redirect as a deletion, not as a move, and is 
not redirected to another replica.

Tip: You can also use the Create Redirect tool to create a redirect for a database replica 
that has already been deleted from the source server, to redirect users to other replicas of 
the database. To do this, on the Files tab:

1. Select Database → Create Redirect, without highlighting a database first.

2. Click the database button to the right of the empty, but non-editable, Filename field.

3. Type the file name of the database, including the .nsf extension, and click OK.

4. Click the Add button to open the Configure Redirect Replica Reference dialogue.

5. Navigate and add an existing database to redirect users to (typically on a different 
server).

Notice that the last step automatically fills in the replica ID on the Create Database 
Redirect dialogue.
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� If the original replica is no longer in place:

a. On the Files tab of the Domino Administrator client, change the Show Me field to 
Database redirects only, as shown in Figure 9-10.

Figure 9-10   Showing Database redirects only on the Files tab

b. Highlight the redirect to update.

c. From the Tools pane on the right, select Database → Update redirect.

d. This displays the Update redirect dialogue where you can update the redirect details.

9.6.3  What happens behind the scenes

When a redirect request is initiated from the Domino Administrator client, a redirect file is 
automatically created on the original server in the Domino data directory. The name of the file 
is in the following format:

dbFileName.nrf

The exact content of the file varies slightly depending on the type of redirect and options 
chosen. It is a simple text file, so it can be viewed in any text editor. Examples of the redirect 
files are shown in Figure 9-11, Figure 9-12, and Figure 9-13.

Figure 9-11   Redirect file created by a database move action

Figure 9-12   Redirect file created by a database delete action

Figure 9-13   Redirect file created by a create redirect action
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For the delete database and create redirect actions, the .nrf file is created immediately on the 
source server. For the move database action, creation of the .nrf file is controlled by the 
administration process so that it can be coordinated with the administration requests 
associated with the database move process. 

Each of the administration requests associated with the move has a field specifying that a 
database redirect is required. An example of one of these documents is shown in Figure 9-14.

Figure 9-14   Admin request for a database move with redirect

9.7  Streaming cluster replication

Domino 8 introduces improvements to cluster performance and I/O through the use of 
streaming cluster replication.

Domino clustering was introduced in Domino 5 to provide failover and load balancing within a 
Notes and Domino environment. With each new major Notes and Domino release, the 
performance and functionality of the clustering feature has been enhanced.

Cluster replication helps ensure that replica databases in a cluster are as up-to-date as 
possible in order to support failover and load balancing. It is event-driven, rather than 
schedule-driven, so when a cluster replicator learns of a change to a database, it immediately 
pushes that change to other replicas in the cluster.

Streaming cluster replication improves the way in which the event-driven cluster replication is 
performed on Domino 8 servers.

Streaming cluster replication is used automatically for Domino 8 clusters.

Note: Even though the .nrf files are simple text files, we recommend that they are not 
created or edited manually, as any typing errors or mistakes in the file will prevent Domino 
from being able to use it. 

Note: For Domino clusters that contain any combination of Domino 8 servers and 
pre-Domino 8 servers, regular cluster replication is used to replicate between the 
Domino 8 and pre-Domino 8 servers.
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9.7.1  Benefits of streaming cluster replication

Streaming cluster replication in Domino 8 has the following performance benefits over regular 
cluster replication:

� Database changes are sent to the replicas with the assumption that the database replicas 
need the change. (With regular cluster replication, the target database and documents are 
opened across the network before being updated, to check whether the update is really 
still required.)

� Streaming cluster replication does not require one-to-one replication with each 
cluster-mate for a database that has changed.

� The latency time for cluster replication is reduced with streaming cluster replication, 
because the queuing system for updates has been improved. 

9.7.2  How streaming cluster replication works

With previous versions of Lotus Domino, the cluster replicator checked each clustered 
database in turn to identify whether there were changes to replicate. If changes were found, 
all changes queued for that one database would be replicated before moving onto the next 
database.

This section describes how the new streaming cluster replicator functions in Domino 8.

Update queuing and cluster replication management
In Lotus Domino 8, the cluster replicator propagates events (for example, note changes, 
unread changes, and folder changes) to destination servers as changes occur.

As a change occurs to a clustered server's database, the specific change is captured in 
memory and the change is immediately queued for replication to the cluster member servers 
that have a replica of the database. This generally reduces latency because the cluster 
replicator does not get tied up replicating updates for a single busy database at the expense 
of others. 

Streaming cluster replication uses in-memory information, so it generally does not need to 
read data from disk or reopen databases to get the updates that need to be synchronized with 
other cluster member servers. 

Coordination with scheduled replication
Streaming cluster replication in Domino 8 provides coordination with the scheduled replicator 
to help reduce the processing for scheduled replication. To do this, the streaming cluster 
replicator process updates the scheduled replication history periodically. This reduces the 
burden on the scheduled replicator process.

Tip: If you are new to clustering, refer to the Clusters section in the Lotus Domino 
Administrator 8 Help database for information about how to plan and implement clusters.

Important: Streaming cluster replication does not negate the need for scheduled 
replication. For all Domino clusters, scheduled replication should be set to occur on a 
regular basis. This ensures that any changes that are missed by the cluster replicator 
(usually due to an unplanned server outage) are caught by the scheduled replicator. 

For more information, refer to the topic Using standard replication in a cluster in the Lotus 
Domino Administrator 8 Help database.
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Error checking and correction
If the streaming cluster replicator encounters any errors during replication, it reverts back to 
the standard cluster replicator to replicate the changes required to synchronize the database.

9.8  Policy enhancements

Policies were introduced to Notes and Domino 6 to assist administrators with the task of 
implementing standardized Notes client configuration settings. With each new major release 
of Notes and Domino, policies have been enhanced to provide additional configuration 
options and more complete standardization.

9.8.1  New features of policies in Notes and Domino 8

In Notes and Domino 8, the following policies features have been added:

� Additional policy settings
� New policy settings documents for productivity tools and activities
� New option: How to apply this setting

Additional policy settings
Several additional preferences can now be controlled through policy settings documents.

Table 9-6 is a listing of the new settings that have been added in Domino 8 to the existing 
policy settings document types (desktop, mail, registration, security, archive, setup).

Table 9-6   New Domino 8 policy settings added to existing policy settings document types

Tip: If you are new to policies, refer to the Policies section in the Lotus Domino 
Administrator 8 Help database for information about how to plan and implement policies.

Settings document Tab Setting and comments

Desktop 
(dynamic desktop)

Basics Default Web search engine 
(new setting).

Allow user-initiated updates 
(new setting for provisioning).

Preferences → Miscellaneous Several new settings, for 
example, Do not prompt when 
exiting Notes.

Preferences → Window 
Management (new tab)

Contains settings for window 
and sidebar management.

Preferences → Replication Contains a new section for 
default replication schedule 
(the settings in the location 
documents on Notes clients).
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New policy settings documents for productivity tools and activities
Two new policy settings document types have been added to Domino 8:

� Productivity tools

To allow or prevent the use of productivity tools, allow the use of macros, and to set file 
type associations

� Activities

To set server, port, and SSL encryption preferences for connection to the activities server 
from the Notes client

New option: How to apply this setting
Domino 8 introduces a new How to apply this setting option, which is available for all desktop, 
mail, productivity tools, and activities policy settings. This standardizes the method that 
administrators can use to set and lock down policy settings. It replaces various control 

Mail Mail → Basics Warn about blank message 
subject (new setting).

New settings to prompt user 
when he deletes collapsed 
conversations and calendar 
entries.

New tabs: Follow up, Attention 
indicators, message recall

Contain settings for controlling 
these features.

Calendar → Display Settings for displaying 
unprocessed and deleted 
meetings.

Calendar → Scheduling Show 24-hour scheduler (new 
setting).

Registration Mail New settings for advanced mail 
options, for example, to create 
mail file replicas on cluster 
members, mail file 
owner/manager settings.

Security Password management → 
Password management basics

Override server’s Internet 
lockout settings (new setting).

Keys and certificates Enable online certificate status 
protocol checking (new setting).

New tabs: Signed plug-ins, 
Portal server

Contain settings for accepting 
signed plug-ins and for Portal 
home server settings.

Archive - no change

Setup - no change
(initial desktop setup)

Tip: For additional information about productivity tools, refer to Chapter 7, “Productivity 
tools” on page 199.

Settings document Tab Setting and comments
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methods introduced in earlier Domino versions, such as the “Allow user to change settings on 
this tab” and “Apply this setting” (Don’t change, Always, Initially) options introduced in 
Domino 7.

The new How to apply this setting option is a per-field setting. Possible value for this setting 
are:

� Don’t set value. 

Allow users to set their own value for the preference.

� Set initial value.

Set an initial value for the preference, but then allow users to change and keep any new 
value they choose.

� Set value whenever modified.

Set an initial value, allow users to change it, but then change the value back to the initial 
value whenever the user re-authenticates (usually after Notes client restart).

� Set value and prevent changes.

Set a value and do not allow it to be changed by the user.

An example of this setting is shown in Figure 9-15.

Figure 9-15   Example of the How to apply this setting field

There is also a new How to Apply document action, which sets the value for all How to apply 
this setting fields in a document. By setting the initial value of all fields in this way, 
administrators may reduce the number of How to apply this setting fields they need to set 
manually.

Possible values for this action are:

� Don’t set value for all fields.
� Set initial value for all fields.
� Set value whenever modified for all fields.
� Set value and prevent changes for all fields.
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This action is initiated from the action bar while in edit mode in any desktop, mail, productivity 
tools, or activities policy settings document. An example of the action bar is shown in 
Figure 9-16.

Figure 9-16   Example of the How to Apply action

9.9  New Domino domain monitoring features

Domino domain monitoring, first introduced with Domino 7, provides Domino Administrators 
with a single feature-oriented Notes database through which administrators can see the 
status of multiple servers, using the information to prioritize, track, and resolve problems. 

Domino domain monitoring automates problem determination and analysis in order to help 
reduce the costs and time associated with monitoring and troubleshooting your Domino 
environment. With Domino domain monitoring, you can quickly locate and resolve issues 
before they cause more serious problems or outages.

The IBM Redbooks publication Lotus Domino Domain Monitoring, REDP-4089, provides a 
complete Domino domain monitoring overview with example monitoring scenarios and is 
located at the following URL:

http://www.redbooks.ibm.com/abstracts/redp4089.html?Open

Domino 8 improves Domino domain monitoring to assist you in resolving your server issues. 
IBM Lotus is committed to making Domino domain monitoring an essential tool in your 
monitoring and problem management toolkit with new features like:

� Modular documents
� Automatic report closing probe
� LDAP search response probe

9.9.1  Modular documents for cause, solution, and corrective actions

Domino 8 introduces a new type of configuration document into the monitoring configuration 
(events4.nsf) database: the modular document. 
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Modular documents have been introduced to provide more flexibility and manageability of the 
problem determination and automation capabilities of Domino domain monitoring and can 
take one of three forms:

� Probable cause (PC)
� Possible solution (PS)
� Corrective action (CA)

Before we dive into describing the new modular documents, we need to take a step back to 
understand where the probable cause, possible solution, and corrective actions information 
was defined prior to Domino 8.

In Domino 7, Probable Cause, Possible Solution, and Corrective Action fields were located on 
two tabs directly in the event message documents, as shown in Figure 9-17.

Figure 9-17   Pre-Domino 8 event message document

With Domino 8, instead of the probable cause, possible solution, or corrective action 
information being hardcoded into each and every event message document, the new 
Domino 8 event message documents reference (or point to) one or more modular 

Tip: An event message document, sometimes referred to as a server and addin task event 
document, exists for every message that is displayed on the Domino server console. The 
event message documents can be found in the Advanced → Event Messages by Text 
view in events4.nsf. 

Note: Multiple probable causes, possible solutions, and corrective actions can be defined 
in a Domino 7 Event Message document.
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documents. Each modular document defines either a probable cause, possible solution, or 
corrective action. 

Figure 9-18 provides a visual representation of how probable cause, possible solution, and 
corrective actions are associated with event message documents in Domino 7 versus Domino 
8. 

Figure 9-18   Management of PC, PS, and CAs in Domino 7 versus Domino 8

Figure 9-18 shows how in Domino 7 corrective action code can be duplicated on two separate 
event message documents. If the corrective action needs to be changed, it must be changed 
in each event message document. 

With Domino 8, the corrective action code resides in a separate modular document. Each 
event message document simply references the corrective action modular document defining 
the corrective action. If the corrective action needs to be updated, it only has to be updated in 
the corrective action modular document. No changes are needed to the event message 
documents. 

In effect, the use of modular documents decouples the relationship between the event 
message documents and the probable cause, possible solution, or corrective action, allowing 
more flexibility and ease of management when customizing Domino domain monitoring. If 
you create a custom corrective action and want to apply the code to multiple event message 

Domino 7

Event
Message
Document
1

Event
Message
Document
2

Event Message text:
Access control is set in <database name>
to not allow replication from <database name>

Corrective Action:
Open the ACL of the destination database

Event Message text:
Access control is set in <database name> to not 
replicate forms or views from <database name>

Corrective Action:
Open the ACL of the destination database

Duplicate Corrective Action information

Domino 8

Event
Message
Document
1

Event
Message
Document
2

Event Message text:
Access control is set in 
<database name>
to not allow replication 
from <database name>

Event Message text:
Access control is set in 
<database name> to not 
replicate forms or views 
from <database name>

Correction Action:
Open the ACL of the destination database

Modular
Document
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documents, you can do that without having to copy and paste the code into multiple 
documents, which is error-prone and time consuming. Furthermore, if you want to change the 
code in the future, you only need to update it in the modular document once and it will 
automatically apply to the event message documents that refer to that modular document.

Figure 9-19 shows an example modular document that runs a fixup on a target database. The 
last section of the document is an embedded view that lists the event message documents 
that reference this modular document. 

Figure 9-19   Example modular document to run fixup on a target database

If you need to disassociate a certain event message document with a modular document, this 
is a perfect view to use. For example, perhaps you need to make a code change to a 
corrective action modular document and, after the change, that corrective action is no longer 
applicable to certain event message documents with which it is currently associated. A quick 
search through the embedded event message document view is all you need to find the 
documents that should be disassociated with the updated action.

Important: Due to the caching of event message and modular documents, you may find 
that updates to event message and modular documents are not reflected in DDM.nsf 
immediately. You can restart the event task to ensure that updates to event message and 
modular documents are reflected in DDM.nsf immediately.

Attention: Disassociating a modular document from an event message document is done 
from the event message document and is covered in 9.9.2, “Updated event message 
documents” on page 269.
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9.9.2  Updated event message documents

In addition to the removal of the Probable Cause/Possible Solution and Corrective Action(s) 
tabs, there are other enhancements to the event message document form in Domino 8 that 
are worth looking at more closely.

The event message document for the “Database is corrupt -- Cannot allocate space error” is 
shown in Figure 9-20. The document is in edit mode in order to highlight the new features.

Figure 9-20   Event message document for Database is corrupt — Cannot allocate space

As mentioned in 9.9.1, “Modular documents for cause, solution, and corrective actions” on 
page 265, the main Probable Cause/Possible Solution and Corrective Action(s) tabs have 
been removed. Also, the Basic tab has been hidden to protect the configuration fields in that 
tab. If you click the Edit Basic Settings button, you are warned that changing any of the 

Important: The stock entries, which are explained in detail in “Stock entries” on page 270, 
are hidden by default, but you can display them by selecting the Display Stock Entries 
button on the top right of the Event Message form. Hide them again by selecting the Hide 
Stock Entries button, as shown in Figure 9-20.
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basic settings other than severity and/or suppression time may result in unexpected behavior. 
One reason that you might need to modify the basic settings in an event message document 
could be if you have developed a Domino add-in task and supply your own event message 
documents. If you have your own event message documents you might have to modify the 
basic settings as your Domino add-in functionality changes.

As shown in Figure 9-20 on page 269, are the three new tabs, Lotus Entries, Custom Entries, 
and Stock Entries, which are where the Modular documents are referenced.

Lotus Entries
The Lotus Entries tab contains the probable cause, possible solution, and corrective actions 
defined by IBM Lotus Development and shipped with Domino. There can be up to four 
references for each type of modular document.

You can either modify the modular document currently selected or delete it completely with 
the Modify and Delete options, respectively.

Custom entries
The Custom Entries tab is where you can add your own references to probable cause, 
possible solution, and corrective action modular documents. The interface looks similar to the 
Lotus Entries tab, although you only have the option to add up to two probable cause, 
possible solution, and corrective actions and there is no Enabled setting. 

Stock entries
Stock entries consist of all pre-Domino 8 entries for probable causes, possible solutions, and 
corrective actions, and are available for backwards compatibility. The Lotus entries have 
replaced the stock entries for Domino 8 and all subsequent releases. Therefore, if you are 
creating custom probable causes, possible solutions, or corrective actions with the Domino 8 
monitoring configuration template (events4.ntf) on Domino 7 servers, use the stock entries. If 
customizing on Domino 8 servers use custom entries.

Important: Do not modify or delete the Lotus entries. If you want to disassociate a modular 
document defined in the Lotus Entries tab with an event message document, uncheck the 
Enabled setting to the right of the modular document reference. As of this writing, there 
are plans to prevent users from modifying or deleting modular documents from the Lotus 
Entries tab in later versions of Domino 8.0.

Note: The Enabled setting is only available in the Lotus Entries tab as a means to 
disassociate a modular document with an event message document without having to 
delete it from the event message document.
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Figure 9-21 shows the warning message displayed in the Stock Entries tab, stating that stock 
probable cause, possible solution, and corrective actions only execute on Domino 7 or earlier 
servers. 

Figure 9-21   Stock entries tab in the Domino 8 Event Message document

9.9.3  Automatic report closing probe

The automatic report closing probe automatically closes event report documents that have 
been inactive for a specified number of days. This feature is perfect for time-sensitive errors 
or lower severity issues that you only want to address if you have enough time. 

As an example, when users attempt to access a Domino server or application to which they 
have not been granted access, the server denies them access and displays a message on 
the Domino console. These warning messages are on the lower end of the priority list 
compared with other types of failures. Ideally, it would be nice to know if there are certain 
users who are repeatedly attempting to access resources on your Domino servers, but there 
may well be other issues of greater importance in your environment.

Given the lower priority of these event report documents and the diminishing administrative 
value that they provide as they remain inactive, you may want to automatically close them 
after a certain number of days. This is now possible with the automatic report closing probe.

Important: If you have made modifications to event message documents on Domino 7, 
those modifications can be overwritten when you upgrade to Domino 8. To preserve your 
modifications, complete the steps in the “Merging modified Stock entries” sections in the 
Lotus Domino Administrator 8 help documentation.
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As shown in Figure 9-22, selecting the Add Error Codes to List button provides a pop-up 
box where you select one or more event messages to auto-close. You can also define your 
own schedule for this probe on the Schedule tab.

Figure 9-22   Automatic report closing probe configuration document

Tip: There are several other ways to control the volume and type of data that are available 
in DDM, including filter documents, lowering event message severities, and permanently 
closing event report documents.

For more information about these methods, refer to Lotus Domino Domain Monitoring, 
REDP-4089, at the following URL:

http://www.redbooks.ibm.com/abstracts/redp4089.html?Open
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Figure 9-23 shows an Event report document that has been automatically closed by an 
automatic report closing probe, which is noted in the event change history at the bottom of the 
document. The event change history also states that another occurrence of that event will 
cause the event report document to be reopened.

Figure 9-23   Event report document that has been automatically closed

In many cases Domino domain monitoring can detect when an issue is resolved and 
automatically closes that event report document, without the use of an automatic report 
closing probe. For all other event report documents you should utilize an automatic report 
closing probe for auto-closure. There are certain events that are especially good candidates, 
including server down/slow and failed replication events.

9.9.4  LDAP search response probe

The LDAP search response probe monitors the LDAP search response time and generates 
an event if a certain threshold is exceeded. The event can be triggered with either a 
millisecond threshold or if the percentage of the LDAP server timeout is exceeded. If both are 
populated with a value, the percentage of the LDAP server timeout takes precedence. 

Tip: The automatic report closing probes work retroactively, so they are a great way to 
clean up your DDM.nsf databases. If you find that you are overwhelmed with open Event 
Report documents as you are working through your Domino issues with Domino domain 
monitoring, consider implementing an automatic report closing probe to close stale events.
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Figure 9-24 shows an example LDAP search response probe configuration document. Note 
the use of the special target group, which dynamically builds a list of the servers running 
LDAP.

Figure 9-24   LDAP search response probe configuration document

Note: To use percentages, the LDAP server timeout must be set to a value other than the 
default of unlimited (0). The LDAP server timeout is defined in the server configuration 
document. If the LDAP server timeout is set to unlimited and only a percentage is specified 
in the LDAP search response probe, the probe does not run.
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Figure 9-25 provides an example event report document from a triggered LDAP search 
response probe.

Figure 9-25   Event report document triggered by an LDAP search response probe

9.9.5  Additional Domino Domain monitoring features

The following sections provide more high-level coverage of some of the new Domino domain 
monitoring features.

Note: The event report document in Figure 9-25 was not generated by the LDAP search 
response probe configuration document shown in Figure 9-24. As you can see in 
Figure 9-25, the event report document was triggered by a probe with an extremely low 
threshold of 1 millisecond, which we do not recommend as a production threshold for 
monitoring.
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Execute CA role
Domino 8 introduces a new DDM database ACL role, which allows for the display and 
execution of the corrective actions within event report documents in DDM.nsf. The new role, 
called execute CA, is highlighted in Figure 9-26.

Figure 9-26   New execute CA role in ACL of DDM.nsf

As discussed in “Common Actions button” on page 276, this role is also necessary in order to 
see the Common Action button within the event report documents.

Common Actions button
The Common Actions button provides context-sensitive common actions that might need to 
be performed to resolve the documented issue. Figure 9-27 shows the Common Actions 
button displaying actions for an event report document based on the server and database 
name target information available in the event report document.

Figure 9-27   Common actions list is dynamically built based on available target information
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By Database view
The new DDM.nsf design provides a By Database view, which allows you to manage specific 
applications across your Domino domain, regardless of whether the applications are located 
on multiple servers. Figure 9-28 shows an example of the By Database view.

Figure 9-28   By Database view in DDM.nsf

Important: The Common Actions button is only displayed for users who have the execute 
CA role checked in the ACL of DDM.nsf. For more information about the execute CA role, 
refer to “Execute CA role” on page 276.

Tip: The Common Actions button is implemented from the Domino domain monitoring 
template only. Therefore, it is available on Domino 7 generated event report documents, as 
well as on Domino 8.
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Filter by database
The filter documents have been enhanced to provide more granularity, allowing you to filter 
not only by type, severity, and server, but also by database, as shown in Figure 9-29.

Figure 9-29   Filter document that filters in only errors on names.nsf, admin4.nsf and events4.nsf

9.10  The new optional On Disk Structure (ODS48)

The term On Disk Structure (ODS) describes the internal architecture of Notes databases. 
With the exception of Notes and Domino 7.x, each major new release of Notes and Domino 
has included an update to the ODS to accommodate new features and functionality for that 
release.

In Notes and Domino 8, the new ODS is an optional upgrade. Unlike previous ODS 
conversions, the ODS48 upgrade does not occur automatically when a database is 
compacted. This has the benefit of allowing administrators to decouple the ODS upgrade 
from the server upgrade, and to control when and how the new ODS will be implemented on 
servers and clients.

The implementation procedure for the ODS upgrade is different in this version than for 
previous versions. This section describes: 

� New features of the Notes and Domino 8 On Disk Structure
� How to enable the new On Disk Structure on Domino servers
� How to revert to an earlier On Disk Structure
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9.10.1  New features of the Notes and Domino 8 On Disk Structure

The new ODS provides potential improvements for I/O and folder optimization. It is also a 
requirement for the implementation of these new features:

� Database names list for user renames
� Design compression

Database names list for user renames
For databases that use the new ODS48, the update user name in reader and author fields 
process (part of the user rename process) has been streamlined. This administration process 
can be very resource intensive, so streamlining it may improve performance on busy or 
complex Domino server environments. 

ODS48 databases store a names list, which is a master list of all the user names listed within 
any document in that database. Using the new database names list feature, the master 
names list is checked first to determine whether any documents in the database contain the 
user’s name in Reader or Author fields. If the user’s name is found in the master list, 
document processing continues in the usual way. If the name is not found, the database is 
skipped.

This feature is enabled automatically on all ODS48 databases, so no additional configuration 
is required.

For more information about this feature, refer to 9.5.3, “Database names list for user 
renames” on page 255.

Design compression
The option to compress design notes within a database has been added to the new ODS in 
Notes and Domino 8. This feature reduces the size of databases by compressing design 
elements by up to 60%. For example, the design elements in a database based on the 
standard Notes 8 mail template (Mail8.ntf) reduce in size from approximately 25 MB to 11 MB 
once design compression is implemented. The compression percentage achieved varies 
from database to database based upon the individual compression ratio achieved for each 
design element in each database.

The design compression function is available on the Advanced tab of the database properties 
box of ODS48 databases, as shown in Figure 9-31 on page 283. It is also available on the 
Advanced tab of the properties box of ODS43 databases and can be selected. However, the 
compression does not occur unless the database is subsequently upgraded to ODS48.

Note: You may be interested to know the ODS version for each major release of Notes and 
Domino, so here they are:

Version ODS Extension to force ODS*
ND8 ODS48 Not required
ND6/ND7 ODS43 NS6
R5 ODS41 NS5
R4 ODS20 NS4
R3 ODS17/17.1 NS3
R2 ODS16/16.3 NS2

*Note: Once you force an ODS version using its extension, it cannot be removed. The only way to 
remove it is to create a new replica or new copy of the database with a .NSF extension.
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Note that this property is new to Notes and Domino 8. It is not visible when viewing the 
database properties using an earlier client.

By default, design compression is disabled for existing databases. For information about 
enabling design compression, refer to “Optional tasks” on page 282.

9.10.2  How to enable the new On Disk Structure on Domino servers

For databases to be created with the new ODS, set the following variable in the Lotus Domino 
8 server’s NOTES.INI file:

Create_R8_Databases=1

There are three methods that may be used to set this (or in fact, any) parameter in the 
server’s notes.ini file:

� Set the parameter directly on a Domino server console by typing: 

Set conf Create_R8_Databases=1

� Add the parameter directly to a Domino server’s notes.ini file.

� Add the parameter to the configuration document in the Domino directory for a single 
server, or for all servers in the domain (using the * - [All Servers] configuration document).

Tip: Since design compression does not actually occur on ODS43 databases, you may 
ask why the option can be selected. There are two situations where this feature is 
particularly useful:

� When upgrading to Domino 8, administrators can select design compression on the 
ODS43 databases prior to running a copy style compact to upgrade them to ODS48. 
Then when the copy style compact is run, both the ODS upgrade and the design note 
compression are implemented with the single copy style compact process.

� Administrators can select design compression on an ODS43 template. By doing this, 
the template file itself remains an ODS43 database, while ODS48 databases created 
from it automatically have design note compression enabled.

Attention: Design note compression is enabled in the standard Notes 8 mail template 
(Mail8.ntf). This means that design note compression is automatically enabled for:

� Any new mail databases created from the Notes 8 mail template

� Any existing mail databases that are converted to the Notes 8 mail template (using 
either Design → Replace or the load convert server command)

It is important to think about how and when ODS48 and design note compression will be 
implemented in your Domino environment. If you do not want to automatically enable 
design note compression for mail files, deselect the option in the Notes 8 mail template 
(mail8.ntf) before using it for new and existing mail files.

Note that mail8.ntf is the only standard system template that has design note compression 
selected by default. All other templates have the option deselected.

Important: Remember that setting this parameter only enables ODS48 for new databases 
created after the parameter is set. For instructions on how to upgrade existing databases 
to ODS48, refer to “Optional tasks” on page 282.
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We recommend that the parameter be added via a configuration document so that there is an 
easy way to view and audit which servers have the parameter set. Setting the parameter this 
way means that it will be refreshed automatically without requiring a server restart. In 
addition, setting the parameter in the * - [All Servers] configuration document allows the 
administrator to set the parameter on all servers without having to add it to each server 
individually. 

To set the parameter using a configuration document:

1. In the Domino Administrator client while connected to the server, go to the Configuration 
tab.

2. Navigate to Servers → Configurations in the left navigation pane.

3. Click Edit Configuration to update an existing configuration document or Add 
Configuration to create a new one. (Note: Only use Add Configuration if a configuration 
document for the desired server does not already exist.)

If you are creating a new configuration document, add the server name to the Group or 
Server Name field, for example, Boston/ITSO.

4. Go to the NOTES.INI Settings tab.

5. Click the Set/Modify Parameters button and fill in the Item and Value fields:

– Item: Create_R8_Databases
– Value: 1

This interface is shown in Figure 9-30.

Figure 9-30   Updating the configuration document for ODS48

6. Save and close the configuration document.

7. You may restart the server to have the parameter take effect immediately, or wait for the 
confirmation of the parameter change to display on the server (Create_R8_Databases 
changed to 1).

8. To check the current setting for this parameter, at the server console type:

sh conf Create_R8_Databases

Press Enter to display the current setting.

Tip: Pre-Domino 8 servers ignore the Create_R8_Databases=1 setting, even if they have 
it set through the * - [All Servers] configuration document, so it is safe to set this parameter 
even in a mixed version environment.
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Optional tasks
Once the new ODS has been enabled on the server, there are additional optional tasks that 
can be used to take advantage of the new ODS. The optional tasks are:

� Upgrading existing databases to ODS 48
� Enabling design compression

Upgrading existing databases to ODS 48
Use copy style compact to upgrade existing databases to ODS 48 after the 
Create_R8_Databases=1 parameter has been set. To run a copy style compact, type the 
following command at the server console:

lo compact -c filename.nsf

Tip: compact -c is not the only copy style compact switch. Copy-style compact switches 
include the switches in the following list:

load compact [-C] [-D] [-f] [F] [-h] [-H] [-L] [i]

When you run the compact command with any of the copy style compact switches, the 
database is upgraded to ODS48 if the database is modified by the compact. For example, 
using compact -F upgrades the database to ODS48 unless the compact does not make 
any changes to the database.

For a full listing of compact command switches, refer to Compact Options in Lotus Domino 
Administrator 8 Help. 

Note: In-place compacting has been changed in Notes and Domino 8. When a pre-ODS 
48 database is detected, Domino does not automatically convert to copy-style compacting 
to upgrade the database.
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Enabling design compression
Design compression is an optional feature that can be enabled in the advanced properties of 
ODS48 databases, as shown in Figure 9-31. 

Figure 9-31   Design compression in database advanced properties

Once the setting is enabled, performing a copy-style compact implements the compression of 
the database’s design notes.

There are two ways that administrators may implement design compression: either 
individually on each database, or on several databases at once.

To enable design compression on a single database:

1. In the Domino Administrator client, connect to the server containing a replica of the 
database.

2. Open the Files tab.

3. Navigate to the database. 

4. Right-click the database title and select Properties to open the Database Properties box.

5. Change to the Advanced tab and select (enable) the Allow compression of database 
design check box, as shown in Figure 9-31 above.

Note: Once enabled, the Design Compression setting replicates to other replicas of the 
database so that you only need to set the option on one replica of the database. 
Remember, however, that the ODS itself does not replicate, so if you allow the Design 
Compression setting to replicate to existing database replicas, you would still need to run a 
copy-style compact on each server’s replica to actually implement the compression.
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6. Run a copy-style compact to compress the design by entering this command at the server 
console:

lo compact -c filename.nsf

An example of this command and the output is shown in Figure 9-32.

Figure 9-32   Compressing database design using copy style compact

Note the space saving shown. This varies depending on the size of the design notes in the 
database and the ratio of compression achieved.

To enable design compression on several databases at once:

1. In the Domino Administrator client, connect to the server containing a replica of the 
databases.

2. Open the Files tab.

3. Select the databases to enable by clicking each one with Shift+click or Ctrl+click.

4. Right-click one of the highlighted database titles and select Advanced Properties to open 
the multi-database Advanced Properties box.

5. Select (enable) the Allow compression of database design check boxes, as shown in 
Figure 9-33.

Figure 9-33   Enabling design compression for multiple databases

6. Click OK to save the setting.

7. Run a copy-style compact to compress the design by entering this command at the server 
console:

lo compact -c
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Using the new On Disk Structure on Notes clients
The new ODS48 can be enabled on Notes clients by adding the following notes.ini parameter 
to the notes.ini on the client:

Create_R8_Databases=1

Once the notes.ini parameter is in place and the Notes client has restarted, any new 
database created is ODS48 format.

To upgrade existing databases, run a copy-style compact against the existing databases you 
wish to upgrade. For example, to run a copy-style compact on a Windows Notes client:

1. Exit the Notes client.

2. Open a DOS panel.

3. Change to the Notes data directory. For example:

cd\progra~1\lotus\notes\data

4. Type in the command to run a copy style compact on a single database. For example: 

..\ncompact -c mail\jcastle.nsf

Or type in the command to run a copy style compact for an entire subdirectory. For 
example:

..\ncompact -c mail

9.10.3  How to revert to an earlier On Disk Structure

To revert any database on a Domino server to ODS43, type the following command at the 
server console:

lo compact -r filename.nsf

To revert a database on a Notes client:

1. Exit the Notes client.

2. Open a DOS panel.

3. Change to the Notes data directory, for example: 

cd\progra~1\lotus\notes\data

Note: This command runs compact across the entire data directory. Alternatively, you 
could run compact against a single database or a single subdirectory of databases.

Tip: The notes.ini parameter Create_R8_Databases=1 can be set via a policy. This is 
done by adding a new field to the desktop policy settings document. For the ODS48 
parameter, the field to add is:

$PrefCreate_R8_Databases

The value of the field is 1.

For full details of how to add a notes.ini parameter to the desktop policy settings document, 
refer to Lotus Software Knowledge Base Technote #1196837 “Using a Desktop Policy to 
set notes.ini and Location parameters”:

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21196837
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4. Type in the command to run a compact -r on a single database, for example: 

..\ncompact -r mail\jcastle.nsf

9.11  Domino and DB2 deployment

The Domino and DB2 feature, now fully supported with Domino 8, enables Notes applications 
to utilize a DB2 back end for data storage and retrieval. In additional to DB2-enabling a Notes 
application, the feature allows for data federation from a Notes view, which means that you 
can query non-Notes SQL data from within a Notes view. Utilizing the Domino and DB2 
feature means that you can take advantage of the strengths of both data storage systems, 
including the security and user interface of Domino and the scalability and flexibility of DB2.

Enabling DB2 as a back-end data store for Domino requires the administration support 
required to install, configure, and maintain both the Domino and DB2 servers, and this section 
provides an overview of those deployment steps. The overall Domino deployment steps are 
similar to those laid out in 3.5, “Performing the Domino 8 deployment” on page 51. Therefore, 
we do not go into as much detail on the Domino deployment, nor do we discuss the complete 
details of the DB2 and DB2 Runtime Client installations. The goal of this section is to provide 
a more high-level picture of the deployment of the Domino and DB2 feature.

In the final section, we verify the connectivity and successful creation of a DB2-enabled 
database. Creating this test database required the creation of a DB2 Access View (DAV) and 
a Query view, which are described in detail in 9.11.4, “Testing the end-to-end Domino and 
DB2 connectivity” on page 302. 

DAV and Query views are the essential building blocks of the Domino and DB2 feature, and 
we highly recommend that you understand how these views enable the use of DB2 and 
federated data by reviewing the Lotus Notes and Domino 7 Enterprise Upgrade Best 
Practices, REDP-4120:

http://www.redbooks.ibm.com/abstracts/redp4102.html?Open

Attention: Domino 8 licensed users will be entitled to a copy of a DB2 9.1 Enterprise 
Server Restricted License at no additional charge. This limited-use license allows you to 
utilize DB2 for storage and access of Notes application data. Non-Notes data is not 
authorized for use with this limited DB2 license. More information is provided in the 
Domino 8 license agreement.

Note: The Domino and DB2 feature were first available with Domino 7 through a feature 
trial program, with support provided through a Web-based feedback forum. There was also 
a limited availability program for nominated IBM customers, in which formal support was 
provided.

For customers who are interested to know about the new Domino and DB2 features 
available with Domino 8, refer to IBM Lotus Notes and Domino 8 Reviewer’s Guide located 
at the following URL:

ftp://ftp.software.ibm.com/software/lotus/lotusweb/product/domino/ND8_Reviewers
_Guide.pdf

This section provides an overview of the Domino and DB2 deployment process and is not 
intended to only show the new Domino and DB2 features available in Domino 8 versus the 
Domino 7 features.
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9.11.1  Planning for Domino and DB2

This section briefly discusses the personnel, platform, performance, and functionality 
considerations that need to be discussed prior to committing to the new feature and 
beginning the installation phase.

Planning for the deployment of Domino and DB2 is especially important since you are, for the 
first time, introducing the direct integration of DB2 with Domino. While there are products that 
integrate Domino and DB2 data, like Lotus Enterprise Integrator® (LEI) and Domino 
Enterprise Connection Services (DECS), they do not involve a direct linkage. 

Domino and DB2 integration in Domino 8 introduces many new concepts, features, and 
configurations, which are necessary because of this very close linkage between Domino and 
DB2. While we cover the steps required to deploy the Domino and DB2 feature, including the 
planning considerations in this section, we cannot cover all of the new concepts and features 
that are available with the Domino and DB2 feature. 

Reference the Lotus Domino Administrator 8 help documentation and the additional 
resources provided in 9.11.5, “Additional Domino and DB2 resources” on page 308, before 
enabling and building applications around the Domino and DB2 feature. 

Personnel required to support Domino and DB2
To provide DB2-enabled Notes applications, you need to engage an existing DB2 
administration team within your organization. If you do not have DB2 skills within your 
organization you need to hire skilled DB2 administrators or train existing employees as DB2 
administrators, as mentioned in 2.1.1, “Identifying team members” on page 16.

Assuming a separate DB2 administration team will be engaged for support of your 
deployment, we also highly recommend that you train your existing Domino Administrators on 
at least the basics of DB2 administration. This is required so that the Domino administration 
team can effectively interpret installation, configuration, and troubleshooting documentation, 
providing the appropriate steps to the DB2 administration team.

Platforms and required hardware, software, and features
The full platform, hardware, and software requirements are listed in the Lotus Domino 
Administrator 8 help documentation, but a summary is provided here for reference.

The Domino 8 32-bit application is supported on the following platforms:

� MS Windows 32-bit and MS Windows 64-bit
� IBM AIX 5.3, 64-bit
� Linux (SLES10, RHEL v5) 64-bit

DB2 9.1 can be installed on the following platforms:

� MS Windows 32-bit and MS Windows 64-bit 
� IBM AIX 5.3, 64-bit
� Linux (SLES10, RHEL v5), 64-bit

Important: The crux of the Domino and DB2 linkage lies at the DB2 Access View (DAV), 
also referred to as the DAV view. When you create a DAV view a new DB2 table is created 
on the DB2 back end. 
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Software requirements include:

� IBM Lotus Domino server 8.0 

� IBM Lotus Domino Administrator and Designer 8.0

� IBM DB2 Universal Database™ Enterprise Server Edition Version 9.1 FP 2 for Windows 
or Version 9.1 FP 2a for UNIX/Linux platforms

� DB2 Run-Time Client is required for remote configurations

� IBM DB2 Access for Lotus Domino 8.0 for SQL access to Domino data

� IBM Lotus Notes client 7.x or 8.0 

Feature requirements include:

� Transactional logging on Domino server
� Administration process running successfully on Domino server

Deciding on a Domino and DB2 configuration
There are two supported configurations for Domino and DB2: local or remote. In both cases, 
a DB2 instance can support one or more Domino servers, although IBM Lotus recommends 
only supporting one Domino server per DB2 instance. Each Domino server creates and 
connects to its own DB2 database, with the default database name being DOMINO. The 
default DB2 instance name is DB2 on Windows and is defined by the administrator on AIX or 
Linux.

Local configuration
A local configuration has Domino and DB2 installed and running on the same server, as 
depicted in Figure 9-34. We recommend a local configuration for a test or smaller Domino and 
DB2 installation. You can configure DB2 to support one or more Domino servers with a local 
installation.

Figure 9-34   Domino and DB2 local installation

Remote configuration
In a remote configuration, Domino and DB2 run on separate servers. Mixed platforms are 
supported with a remote installation (for example, Domino running on MS Windows and DB2 
running on AIX).

Important: The Notes 6.x client is not supported for Query views. Also, the Domino 
Administrator and Designer 7.x and earlier client versions are not supported for 
administration or development of DB2-enabled servers or applications.
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The configuration depicted in Figure 9-35 is provided for example purposes. The Lotus 
Domino Administrator 8 help documentation provides more remote configuration scenarios, 
including a larger deployment involving multiple DB2 servers and partitioned Domino servers.

Figure 9-35   Domino and DB2 remote installation

There are two important installation and configuration steps to note for a remote 
configuration:

� The DB2 Run-Time Client needs to be installed on the Domino servers and acts as the 
intermediary between the Domino and DB2 servers.

� When configuring connectivity between the Domino and DB2 server, you need to perform 
an extra step to catalog the new DB2-enabled database from the DB2 Runtime Client on 
the Domino server.

9.11.2  Installing and configuring Domino and DB2

Installing and configuring Domino and DB2 requires a good deal of coordination and 
communication between the Domino and DB2 administration teams. There are several times 
during the Domino and DB2 feature deployment when the team responsible for a given task 
alternates between one of the three main support teams, either the Domino, DB2, or 
operating system team, as documented in Table 9-7 on page 290.

Typically, your Domino administration team drives the Domino and DB2 installation. The 
Domino administration team provides the DB2 and operating system installation and 
configuration requirements to the DB2 and OS teams, ensuring that the installation tasks are 
occurring in the required sequence.

Attention: In a remote configuration, only one DB2 instance per server is supported for 
Windows. 

DB2 Instance 1

DB2 Instance 2

DB2 Instance 3
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A note on upgrading versus a new installation
This book was written assuming a new installation versus an upgrade of a Domino 7 
installation of Domino and DB2. While upgrading from Domino 7 and DB2 8.2 is possible, you 
should take great care to follow the specific steps outlined in the Lotus Domino Administrator 
8 help documentation.

Keep the following information in mind when deciding whether to upgrade or perform a new 
Domino 8 and DB2 9.1 installation:

� Mixed Domino and DB2 versions are not supported:

– Domino 7.x and DB2 9.1.0 are not supported together.
– Domino 8.0 and DB2 8.2.2 are not supported together.

� After a Domino 7 server has been upgraded to Domino 8, it cannot be downgraded back 
to Domino 7.

� You must create NSF replicas of your DB2-enabled Notes databases, upgrade to Domino 
8 and DB2 9.1, and then convert the NSF replicas back into DB2-enabled versions.

Given the above restrictions with mixed versions of Domino and DB2 and the requirement to 
convert your DB2-enabled databases back to NSF, we recommend that you perform a new 
installation in order to start fresh at the fully supported level of Domino 8 and DB2 9.1.

The ITSO Domino and DB2 servers
In order to provide an example deployment of the Domino and DB2 feature, we utilize two 
servers in our ITSO Domino environment, both of which are running Windows 2003 server. 
The servers are London/ITSO for the Domino server and DB2.cam.itso.ibm.com for the DB2 
server, as depicted in Figure 9-36.

Figure 9-36   Domino and DB2 servers in the ITSO Domino domain

Installation and configuration overview
Table 9-7 outlines the steps completed to deploy Domino and DB2 in the ITSO Domino 
domain. The second column specifies the administration team that completed the task.

Table 9-7   Steps completed to install Domino and DB2 feature in ITSO Domino domain

Step completed for Domino and DB2 deployment in ITSO Domino domain Team

Install Domino on London/ITSO. Domino

Install the DB2 Runtime Client on London/ITSO (for remote configurations only). DB2

Create an ID for the DB2 installation on db2.cam.itso.ibm.com. Windows

Install the DB2 server on db2.cam.itso.ibm.com. DB2

London/ITSO DB2.cam.itso.ibm.com
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Performing the installation and configuration
This section provides additional details on the more important installation and configuration 
steps that are documented in Table 9-7 on page 290.

Install Domino 8
The steps to install and configure a DB2-enabled Domino 8 server are similar to the steps for 
a regular NSF-based Domino server installation and configuration, which are documented in 

Create a DB2 administration ID on db2.cam.itso.ibm.com (optionally, create during 
the DB2 installation)*.

Windows

Set DB2DOM as the SYSCTRL group*. DB2

Enable Domino to communicate with DB2. Domino

Grant the SETSESSIONUSER privilege to the Domino server user*. DB2

For remote installations, catalog the DOMINO DB2 database from 
london.cam.itso.ibm.com*.

DB2

Setting up the DB2 Access Server (optional)

Create a server ID for the DB2 Access server in the ITSO Domino domain. Domino

Install the DB2 Access servers on db2.cam.itso.ibm.com. Domino

Enable and test the DB2 Access server from the Notes Admin client. Domino

Map Notes IDs to DB2 IDs and set a default DB2 user ID mapping*. Domino

Attention: The steps marked with an asterisk (*) are not described in further detail in this 
book. While these steps are important, they are fairly straightforward. For more information 
regarding these steps, reference the Lotus Domino Administrator 8 help documentation.

Important: Table 9-7 does not contain all of the steps involved to install and configure 
Domino and DB2. The table is provided as a high-level guide of the tasks required for the 
Domino, DB2, and operating system teams, assuming Windows 2003 servers. Both the 
order of the steps and the actual steps themselves are different for an AIX or Linux Domino 
and DB2 installation.

The order of installing and configuring the Domino and DB2 components is crucial to a 
successful deployment. The latest steps documented in the Lotus Domino Administrator 8 
help documentation should be followed.

Also, the Team column is provided to help give you an idea of what support team performs 
what high-level task and, again, should only be used as a guideline. Your enterprise IT 
support structure might mandate that certain software installations are performed by a 
separate installation or deployment team.

Important: Not all steps from Table 9-7 on page 290 are documented in this section. For 
the latest and most complete deployment steps, see Lotus Domino Administrator 8 help 
documentation.

Step completed for Domino and DB2 deployment in ITSO Domino domain Team
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Chapter 3, “Deploying the Domino 8 server” on page 45. With that said, there are a few 
special configuration and installation steps that are required for the Domino and DB2 feature:

� For Windows Domino servers and as a best practice, run Domino as an application, not a 
Windows service. If you run Domino as a Windows service, ensure that the DB2 server is 
started and fully initialized prior to starting Domino, whether manually or via a Windows 
service.

� Transaction logging is required and either linear, circular, or archival transaction logging 
can be used. Domino transaction log space will be used to store only data from NSF 
databases that have logging enabled. If you will not be running transaction logging on any 
NSF-based applications, you can set the maximum log space setting in the Server 
document to the minimum of 192 MB.

� The administration process is required to be working properly from your Domino 
administration server to your DB2-enabled Domino server in order to populate the DB2 tab 
in the Server document with the necessary configuration information.

Install the DB2 Runtime Client
For a remote configuration, install the DB2 Run-Time Client on the Domino servers. The DB2 
Run-Time Client acts as the intermediary between the Domino and DB2 servers.

Figure 9-37 shows the main DB2 Run-Time Client installation splash window.

Figure 9-37   DB2 Runtime Client Version 9.1 installation
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Install DB2 server
Install the DB2 server, which will give you the option to create a DB2 administration account. 

Figure 9-38   DB2 Enterprise Server Edition Version 9.1 installation

Enable Domino to communicate with DB2
We are now ready to enable the communication of Domino and DB2 with the DB2 Server 
Enablement Tool in the Domino Administrator client. While you can manually enable Domino 
to access a DB2 server, we do not recommend using the DB2 Server Enablement Tool, 
which is the tool we cover in this section.

Tip: An alternative to installing the DB2 Run-Time Client, which requires a separate 
installation executable, is the DB2 client from the Enterprise Server Edition installation. 
The benefits are that you will already have the installation code from the DB2 server 
installation and you can install the GUI tools, like the DB2 Control Center, with the 
Enterprise Server Edition version for the DB2 client.

Important: On AIX and Linux, the order and steps to create DB2 IDs and groups is very 
different from Windows servers. If you are installing Domino and DB2 on AIX or Linux, 
follow the Lotus Domino Administrator 8 help documentation carefully to make sure that 
you do not miss any steps.
Chapter 9. New administration features 293



As shown in Figure 9-39, when you click the Enable Server for DB2 button in the DB2 Server 
section on the Configuration tab, you are presented with a warning to complete all of the 
prerequisite steps prior to enabling the Domino server for DB2.

Figure 9-39   Pop-up box warning that DB2 prerequisites need to be installed

If you click the Enable Server for DB2 button without meeting certain prerequisites, like 
installing the DB2 server or enabling transactional logging, you will receive an error stating 
which prerequisite needs to be completed.
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After clicking the Continue button, you are presented with a configuration pop-up box, as 
shown in Figure 9-40.

Figure 9-40   Enable Domino for DB2 data configuration pop-up

Three settings are automatically defined when the configuration pop-up first opens:

1. The DB2 database name of DOMINO.
2. The DB2 password expiration of 90 days. 
3. By default, create databases as DB2.

The rest of the settings in Figure 9-40 have to be entered manually. As you move the cursor to 
each setting there is context-sensitive help provided in the light gray box at the bottom of the 
pop-up box to guide you through the configuration.
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After you click Enable you are presented with a results pop-up box stating that the DB2 
enablement is complete, as shown in Figure 9-41.

Figure 9-41   DB2 Enablement complete pop-up box

The pop-up box provides information regarding the tasks that have been completed by the 
enablement process and explains that the AdminP request to update the DB2 tab in the 
server document must be completed before you can restart the Domino server and verify the 
connectivity from Domino to DB2.

As you can see in Figure 9-42, the AdminP request has been generated. A snapshot of the 
Requests → All Requests by Action view in the Administration Requests database in the 
lower portion of Figure 9-42 shows the completed AdminP request.

Figure 9-42   Administration process request to update DB2 tab in the Domino server document
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For remote installations, catalog the DOMINO DB2 database
Given that we have a remote configuration with Domino and DB2 running on two separate 
servers, we need to manually catalog the DOMINO DB2 database so that the Domino server 
can utilize it. The full instructions to complete this step are provided in the Lotus Domino 
Administrator 8 help documentation.

We are now ready to restart Domino to verify connectivity with DB2.

After restarting Domino, the server console shows the connection status from Domino to 
DB2, as shown in Figure 9-43. Domino first attaches to the DB2 instance with the db2user ID 
(the ID we specified as the OS account to be used by Domino in the DB2 enablement 
configuration in Figure 9-41 on page 296). Next, the DOMINO database is created in DB2. 
Next, there are a few messages related to the DB2 integration and, finally, we see the Server 
started console message indicating that Domino has been started successfully.

Figure 9-43   Confirmation of DOMINO DB2 database creation

9.11.3  Installing and configuring DB2 Access Server

Domino and DB2 are now successfully connecting and it is time to assess whether you need 
to install a DB2 Access Server. 

A DB2 Access Server is required for SQL access to DB2-enabled Notes data, including 
access to query views and Notes SQL data from outside of the Notes client. In other words, if 
you want to access DB2-enabled Notes application data from outside of Notes, for example, 
the DB2 Connect™ client or an SQL graphing tool, you will need a DB2 Access Server. 

The DB2 Access Server enforces Domino database security, such as ACLs and reader lists 
for DB2-enabled data. If the DB2 Access Server is not installed properly, the Query view and 
DAV view Designer functions will not be available and you will not be able to access DB2 
data.

Tip: In order for the Domino server to communicate with the remote DB2 server, update 
your services configuration file with the service name and port/protocol for the DB2 server. 
In our example environment, we run DB2 on a Windows 2003 server and use the default 
service name and port/protocol of db2c_DB2 and 50000/tcp, respectively. We add the 
following line to the C:\Windows\system32\drivers\etc\services configuration file on the 
London/ITSO Domino server:

db2c_DB2 50000/tcp
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To take full advantage of the Domino and DB2 feature, you need to install and configure a 
DB2 Access Server, which is what we have done in our ITSO environment.

Creating the server ID for the DB2 Access Server
The DB2 Access Server requires the use of a Domino server ID, which we create by clicking 
the Registration → Server option from the Configuration tab in the Domino Administrator 
client. Figure 9-44 shows the options we selected for the DB2 Access Server.

Figure 9-44   Registration of DB2 Access Server

Important: If you only host NSF databases in DB2, you do not need to install the DB2 
Access Server. If you only host NSF data in DB2, this means that the Notes application is 
DB2-enabled, per the Database Information tab in the Database properties, but there is no 
DAV view created or in use.

Also, Query views of non-Domino data, also known as federated data, do not require the 
DB2 Access server. 

For more information about how to set up federation of SQL data from the Notes client, 
review the Lotus Notes and Domino 7 Enterprise Upgrade Best Practices, REDP-4120:

http://www.redbooks.ibm.com/abstracts/redp4102.html?Open
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After entering all of the standard information for registering a new Domino server, click the 
Advanced tab and select the This server is a DB2 Access server only option, as shown in 
Figure 9-45. The name of our DB2 Access Server is DB2ACCESS.

Figure 9-45   Option to create Domino server as a DB2 Access Server

After adding the server to the registration queue, highlight the DB2 Access Server in the list 
and click Register to register the server and create the server ID.

As shown in Figure 9-46, the DB2 Access Server creates a server document, but the contents 
of the document are limited to the server name and description.

Figure 9-46   All Servers view in the ITSO Domino directory and the DB2ACCESS server document
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Installing the DB2 Access Server
The DB2 Access Server needs to be installed on the DB2 server that is hosting the Lotus 
Notes data. In a local installation, this is also the Domino server.

First, copy the DB2ACCESS server ID onto the DB2 server. Next, run the DB2 Access Server 
install executable and click through the installation windows as appropriate. The main 
installation panel is shown in Figure 9-47.

Figure 9-47   DB2 Access Server installation

Tip: At this point, you do not need to maintain the DB2ACCESS server document in the 
Domino directory for the DB2 Access Server. You can delete the server document, but 
keep a copy of the server ID because you will need it for the DB2 Access Server 
installation.
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Enable and test the DB2 Access Server connection
Now that we have the DB2 Access Server installed we are ready to enable DB2 access for 
the London/ITSO server, which we do by clicking the Enable DB2 Access button in the DB2 
Server section on the Configuration tab in the Domino Administrator, as shown in Figure 9-48.

Figure 9-48   Enable DB2 Access option in Domino Administrator

After clicking Enable DB2 Access you are prompted with a pop-up box where you specify the 
name of the DB2 Access Server, which in our case is DB2ACCESS/ITSO. The DB2 Access 
path, which should specify the complete path that DB2 uses to load the DB2 Access server 
DLL, is not required if the DB2 Access Server is installed on a Windows server. The default 
path for AIX or Linux is /opt/IBM/DALD.

The server name is saved to the server document, as shown in Figure 9-49.

Figure 9-49   DB2 tab from the London DB2-enabled server document

We are now ready to verify that the DB2 Access server is installed and configured properly. 
To do this we click the Test DB2 Access button in the DB2 Server section on the 
Configuration tab in the Domino Administrator client, which is now highlighted. When we test 
the connection, the DB2 Access test tool provides a pop-up box with the status of various 
checks that are performed to make the DB2 Access Server connection. Figure 9-50 provides 
an example of a successful connection from the DB2ACCESS server to the London server.
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Figure 9-50   DB2 Access test results

The DB2 Access Test tool tests all DB2 Access Server field parameters from the server 
document and all DB2 Access Server settings from the notes.ini file. If all fields and settings 
are correct, it tests the connection between the DB2 Access Server and the selected Domino 
server, verifies whether the DB2 functions and properties exist, determines whether the DB2 
Access server connection document is valid, and attempts to open the Domino directory on 
the DB2 Access Server. If the DB2 Access Test tool locates any problems, the information is 
returned to the Domino server console or to the Domino Administrator client.

9.11.4  Testing the end-to-end Domino and DB2 connectivity

To verify the successful end-to-end configuration of Domino and DB2, you can create a test 
DB-enabled Notes database with a DB2 Access View (DAV) and a Query view. Populate the 
test database with example data to ensure that it is stored in DB2. 

For the purposes of testing the Domino and DB2 connectivity, we create a sample database 
using the familiar document library template. For more detailed information regarding Notes 
application development using the Domino and DB2 feature, reference the IBM Redbooks 
Lotus Domino 7 Application Development publication at the following URL:

http://www.redbooks.ibm.com/abstracts/redp4102.html?Open
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First, create a new Notes database from Lotus Notes 8, as you would for a regular 
NSF-based Notes application. The database will be DB2-enabled if the DB2 default creation 
setting in the DB2 tab in the server document is set to DB2. 

Next, open the new test application in the Domino Designer client and verify that the DAV 
view is exposed in the Shared Resources section, as highlighted in Figure 9-51.

Figure 9-51   DB2 Access Views in Domino Designer

Click New DB2 Access View and add the fields that you want to store in DB2. For the 
purposes of creating a simple test application, we use the default document form and 
DB2-enable the Categories and Subject fields. Figure 9-52 shows the selection of the 
Document form and the Subject field.

Figure 9-52   Add Subject field from the Document form into the test Domino Access view

Tip: If the DB2 default creation setting is set to NSF, run a compact -p on the database to 
convert it from NSF to DB2-based.
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After adding the Notes document fields to the test DAV, which we named TESTDAV, the DAV 
displays the fields in a single column, as shown in Figure 9-53.

Figure 9-53   TESTDAV Domino Access view

After saving and closing the DAV view, you will see it listed as the only DAV in the view. We 
are now ready to create and, if there is data to be updated into DB2, populate the DAV in DB2 
by clicking the Create/Update in DB2 and Populate in DB2 buttons, respectively. Once 
created and populated in DB2, the TESTDAV will be listed in DB2 Access views with a green 
check mark, as shown in Figure 9-54.

Figure 9-54   TESTDAV created and populated in DB2

Important: This test application does not have any Notes document data to be populated 
into DB2 initially, so we did not need to select the Populate in DB2 button once we created 
the DAV in DB2. Only when there is Notes data to be populated into DB2 will you need to 
select the Populate in DB2 button.
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We are now ready to create a Query view. We perform a simple check to ensure that the 
option to create a view based on an SQL query is available. Click New View from the Views 
section in the Domino Designer. In the Select conditions section in the bottom left of the 
pop-up box, select By SQL Query and enter an SQL query to select all of the data from the 
TESTDAV, as shown in Figure 9-55.

Figure 9-55   DB2\TestQueryView Query View creation based on SQL select statement

Verify that the Query view is displayed in the test Notes database. The default icon used for 
Query views contains a database icon, as highlighted in Figure 9-56.

Figure 9-56   DB2\TestQueryView query view navigation

Note: In a production application, selecting all data with an asterisk (*) is not a best 
practice, given the negative impact on server performance. Since we are only creating a 
test database, selecting all data does not present a significant increase in resource 
utilization on our Domino and DB2 servers.
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Now that we have both the DAV and Query views created, we create a test Notes document, 
populating the Categories and Subject fields, as highlighted in Figure 9-57.

Figure 9-57   Test Document Library Notes document

Saving the document saves the Subject and Categories field data into DB2, and the 
document is displayed in the test Query view, appearing as a standard NSF-based document, 
as shown in Figure 9-58.

Figure 9-58   Test document in Query view

Note: Query views can be accessed from the Notes client or a Web browser.

Important: Query views hosted by a Domino 8 server are supported by Notes 7 clients. 
However, the Domino Designer 7.x and Domino Administrator 7.x clients are not supported 
for the design or administration of Domino 8 DB2-enabled data. 

We recommend performing all Domino and DB2 deployment and administration work with 
the latest release of the full Notes 8 client.
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To verify the creation of the DB2 table, utilize the DB2 Control Center and navigate to the 
DB2 instance, DOMINO database, and to the TESTDAV view, as shown in Figure 9-59.

Figure 9-59   TESTDAV view in the DB2 Control Center 

The TESTDAV view is not the DB2 table itself, but a virtual table that references the raw data, 
which exists in the TESTDAV_T table, as shown in Figure 9-60.

Figure 9-60   TESTDAV_T table in the DB2 Control Center 
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In the Action section in the table details pane, select Open to open the TESTDAV_T table and 
verify the Subject and Categories fields were stored in DB2, as shown in Figure 9-61.

Figure 9-61   TESTDAV_T table opened in the DB2 Control Center

With this final verification of the Domino and DB2 integration, we conclude the overview of the 
Domino and DB2 feature deployment.

Given that the overall goal of this book is as a deployment guide, this section focused on a 
typical Domino and DB2 installation and configuration, based on our deployment of the 
feature in our example ITSO Domino domain.

9.11.5  Additional Domino and DB2 resources

As a Domino and DB2 administrator, there are other resources available to assist with both 
deployment and day-to-day administration and required maintenance of your Domino and 
DB2 environment, including DB2 group management, Notes and DB2 user management, 
DB2-enabled Notes application maintenance, backup, and performance. 

Available Domino and DB2 feature resources are:

� Lotus Domino 8 Administrator Help and Release Notes

� IBM Lotus Domino and DB2 feature for Domino 7 program Forum

http://www-10.lotus.com/ldd/d7db2.nsf/DateAllThreadedWeb?OpenView

� FAQ on DB2 and Domino 8 on Domino Blog Web site

http://www.dominoblog.com/dominoblog/dblog.nsf/dx/faq-on-db2-integration

� Course: Developing Applications With IBM Lotus Domino 8 Enabled for IBM DB2

https://education.lotus.com/rw/lewwschd.nsf/594045664318da9e80256cae00361321/e6
a2aba6aeb99ca2852572e50053e98e?OpenDocument

Important: When using Query views or accessing DB2-enabled Notes data from other 
SQL applications, you should always use the DB2 view associated with your DB2 Access 
View design element, the tables that are appended with _T or _X. Accessing the tables 
appended with _T and _X bypasess Domino security and the ability to roll-back bulk 
operations, respectively.
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� Course: Configuring IBM Lotus Domino 8 with IBM DB2

https://education.lotus.com/rw/lewwschd.nsf/594045664318da9e80256cae00361321/af
d557a1b0c4dbf7852572e4006d6d21?OpenDocument

� Improving Domino and DB2 Performance, Version 1

http://www-12.lotus.com/ldd/doc/uafiles.nsf/docs/domino70/$File/db2perf.pdf

� Exploiting IBM DB2 in your Lotus Domino 7 application article

http://www.ibm.com/developerworks/lotus/library/domino7-db2/

� IBM Lotus Domino with IBM DB2 storage for Lotus Notes mail users

http://www.ibm.com/developerworks/lotus/library/domino-mail-db2/

9.12  Other administrative enhancements

In this section we take a brief look at some of the other administrative enhancements in 
Domino 8. Rather than try to list every new administrative feature in Domino 8 (there are 
many) we have chosen some of our favorites to highlight. 

For a full list of the new administrative features and further information about each one, refer 
to these sources:

� What’s New in IBM Lotus Domino 8 topic in Lotus Domino 8 Administrator Help

� IBM Lotus and Domino 8 Reviewers Guide:

ftp://ftp.software.ibm.com/software/lotus/lotusweb/product/domino/ND8_Reviewers
_Guide.pdf 

9.12.1  Deferred sort index creation

Domino 8 provides the ability to configure view and folder columns for deferred sort index 
creation. This means that for sortable columns, an index in not built unless a user chooses to 
sort by that column.

Indexing of views and folders is a server task, so the deferred sort index creation feature has 
the potential to reduce the indexing load on the server. In addition, since each index is stored 
within the database, a database with many unused sortable columns will be comparably 
smaller if the sortable columns have deferred sort index creation enabled.

Deferred sort index creation is an optional design setting for columns that is available to 
developers for databases on any Domino 8 server. No particular configuration changes need 
to be made by the Domino Administrator to allow the function to work on Domino 8 servers. 
Application developers can activate the function in the design properties for each individual 
view or folder column. For information about how to enable this function in column properties, 
refer to “Deferred sort index creation” on page 404.
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9.12.2  Prevent simple search

Simple search is the type of processing used when a user searches a non-full text indexed 
database. The simple search algorithm can significantly impact performance on a Domino 
server. For some databases, the ability to search documents may not really be necessary, yet 
the default functionality still allows users to do this.

In Domino 8, Simple search can be disabled for each individual database by administrators to 
prevent users from searching non-full text indexed databases. The setting is enabled by 
selecting the option Don’t allow simple search on the Advanced tab of the Database 
Properties dialogue, as shown in Figure 9-62.

Figure 9-62   Don’t allow simple search setting

Note: With this setting enabled, after an index is created it obeys the values set for index 
refresh and discard (set at the view or folder level). For example, if the refresh setting is 
“Auto after first use” and the discard setting is “If inactive for 10 days,” the index would 
continue to be maintained by the refresh setting unless there is a 10-day period in which no 
users sort by that column. After the 10 days of inactivity, the index would be discarded, and 
index creation is again deferred until a user sorts by that column.

Tip: Indices for columns that have deferred sort index creation set can be discarded 
immediately by typing the following command at the Domino server console:

load updall dbfilename -r -g
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With this option enabled, users see the dialogue shown in Figure 9-63 when they attempt to 
search the database.

Figure 9-63   Dialogue returned when simple search is disabled

Open databases and live console when the Domino Administrator starts
The Domino Administrator client has two new startup settings:

� Automatically open one or more databases. 
� Automatically run in live console mode.

Important: The Do not allow simple search database property does not replicate for 
existing database replicas. This allows administrators to decide selectively whether each 
replica should have the setting enabled, to allow users to perform simple searches on 
some servers’ replicas while preventing it on others.

The setting is carried over to new database replicas and copies.
Chapter 9. New administration features 311



Figure 9-64 highlights where these settings reside in the Basics → Domino Administrator 
Startup Settings section in the Administration Preferences panel.

Figure 9-64   New administration preference to open a database when Domino Administrator client 
opens

If the Automatically run in live console mode setting is checked, the Domino Administrator 
client automatically navigates to the Server → Status → Server Console tab and displays the 
live console for whatever server is specified in the On startup setting, which can either be 
Connect to last used or Connect to specific server.

The Open Specific Database(s) setting allows you to specify a database, or multiple 
databases, to open each time the Domino Administrator client is started. While this is not 
specifically a Domino domain monitoring feature, the default setting for this preference is to 
open the DDM.nsf database.
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Chapter 10. New concepts in administration: 
Eclipse, composite applications, 
and provisioning

The Notes 8 client is built on the Eclipse Rich Client platform, which provides opportunities to 
exploit the open-source, extensible capability of the platform to provide enhanced client 
capabilities such as composite applications and plug-ins, along with the ability to 
automatically provision updates to the client.

This chapter presents a primer for Domino Administrators and architects to explain some new 
and important concepts in Notes and Domino 8 in the context of deploying and managing a 
Lotus Notes and Domino 8 environment.

10
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10.1  Introduction to the new administration concepts in Notes 
and Domino 8

In Lotus Notes and Domino 8, there are several new concepts to understand, particularly in 
relation to the architecture and features of the Lotus Notes 8 client. Concepts such as 
provisioning, composite applications, plug-ins, components, and Eclipse are all important 
within the context of Lotus Notes and Domino 8. 

For example, provisioning as a concept is new to Lotus Notes and Domino 8, although it has 
roots in some earlier tools used to help manage updates to client workstations, such as Smart 
Upgrade. Outside of Notes and Domino, provisioning has been used by other tools and 
frameworks such as Eclipse and Lotus Expeditor, as a way to automatically manage and 
provision software updates to users. In Notes and Domino 8, provisioning encompasses a 
number of different interrelated concepts and functions. 

It is worthwhile for Domino administrators and architects in particular to take the time to 
understand the components that comprise the Lotus Notes 8 client itself, and the components 
that comprise provisioning, composite applications, and other features of Lotus Notes and 
Domino 8.

10.2  Definitions

As a first step to understanding the new features and concepts of Notes and Domino 8, this 
section presents a short, clear, and concise definition of each of the major new concepts and 
elements of the software.

10.2.1  Components

Component as a generic term describes one part of a larger integrated entity. In terms of the 
Lotus Notes 8 client, a component usually means one part of a composite application. This 
may be a part of a Notes database such as a view, an Eclipse feature, or plug-in, or part of 
another non-Notes source such as a Web page. Components can be wired together to form a 
composite application.

The term component may also be used to describe a plug-in that forms part of the Notes user 
interface, such as the Sametime plug-in in the side bar of the Notes 8 client. 

10.2.2  Composite applications

Composite applications consist of separate but interconnected components assembled 
together to appear to the user as a single integrated application. 

In terms of Notes and Domino 8, composite application functionality can be provided by 
adding composite application design elements to any NSF database. There is also a new 
composite application standard template, which is used to create new NSF-based composite 
applications. The separate but interconnected components may be from Notes databases, or 
they may be non-Notes components such as Web pages, Java applications, or Eclipse 
components. 

The components are usually created by application developers, then wired together by the 
developers or business managers to create the single application entity known as the 
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composite application. To the Notes 8 user, an NSF-based composite application looks no 
different from a regular Notes application (database), but behind the scenes, the composite 
application wiring is pulling together data and views from several separate components to 
display a single view on the user’s window.

Below are definitions of each of the important composite application concepts:

� Page

A page is the interface that displays to the user in a composite application. Pages consist 
of component definitions (where to locate the components and how to display them) and 
wiring definitions (how the components interact together).

� Component

In the context of a composite application, a component is a small self-contained design 
element that is wired together to interact with other components on a single page within a 
composite application.

� Wiring

Wiring is the linkage between multiple components that makes them interact with each 
other, so that when an user makes a selection in one component, the other components 
on the page are updated to reflect the selection.

� Domino composite application template

The Domino composite applications template is a new Domino 8 standard template used 
to create NSF-based composite applications. Domino databases created from this 
template store the layout and communication logic that defines how the components 
display and interact when the composite application database is used. This database may 
also contain the components themselves, or may refer to components that are stored 
elsewhere.

Note: NSF-based composite applications store their own application code for layout 
and communication logic. This is conceptually the same as any other Domino 
database, which also stores its own code and logic. This is important to understand 
because it means that the Notes 8 client can interpret and display both local and 
server-based composite applications in the same way as it does for other Notes 
databases. No additional requirement such as a composite application server or 
provider is needed.

The major difference between NSF-based composite applications and other Domino 
databases is that composite applications use Eclipse-based coding constructs. 

In practical terms, this means that composite applications can be made available to 
Notes 8 clients using the standard Domino composite application template, with nothing 
more than a Notes 8 client environment in place. However, it also means that the Notes 
8 client is a requirement for NSF-based composite applications. These applications 
cannot be displayed in the Notes 8 basic configuration client, older pre-8 Notes clients, 
or from a browser.

For browser access to composite applications, the environment can be extended to 
include a composite application server such as WebSphere Portal 6.x, which has the 
ability to display composite applications to browser clients.
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10.2.3  Composite application editor

The composite application editor is an optional install item provided with the Lotus Notes 8 
client. The editor is used to add and edit the pages and wiring for composite applications. It is 
the tool that Domino developers and business managers use if they want to manage 
composite application wiring within the Notes client.

The composite application editor can be invoked from within the Notes client in two ways:

� To manage component wiring in an existing database, open the database and select 
Action → Edit Application.

� To create component wiring for a new composite application, create a database from the 
blank composite application template, then select Actions → Edit Application from 
within the blank database.

10.2.4  Composite application server

10.2.5  Eclipse

Eclipse is an open-source, platform-independent software framework. This means that it is 
based on open standards rather than proprietary coding, and it can be used on many client 
operating systems. It provides the basic underlying framework upon which components, 
sometimes known as plug-ins or features, can be deployed to users. 

Two of the main benefits of the Eclipse approach are:

� It reduces deployment overhead, because new functions and updates to existing functions 
can be automatically delivered (provisioned) in small packages to users.

� It provides a rich client platform, which means that it offers greater functionality than a thin 
client (such as a browser), but still with similar ability to deliver small packaged 
functionality updates, a function for which thin clients are traditionally known.

Note: A composite application server is a server that understands the logic and structure 
of composite applications and can interpret these to display the composite application to 
the user.

The Domino 8 server is a composite application server in the sense that it has the 
capability to provide composite applications to Lotus Notes 8 clients. In practical terms, this 
means that composite applications can be made available to Notes 8 clients using the 
standard composite application system template, with nothing more than a Notes and 
Domino 8 environment in place.

For browser access to composite applications, the environment can be extended to include 
a composite application server such as WebSphere Portal 6.x, which has the ability to 
display composite applications to browser clients.

Important: In terms of provisioning and Lotus Notes 8, it is important to have a conceptual 
understanding of Eclipse because the Notes 8 client is built on the Eclipse framework, 
which means that it is a rich client platform where components (plug-ins) can be easily 
provisioned to users.
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10.2.6  Lotus Expeditor Client for Desktop 

The Lotus Expeditor Client for Desktop is delivered as part of the Notes 8 client. It is the 
Notes client subsystem that provides the ability to wire components together within Notes and 
provision them to users. 

10.2.7  Provisioning

In general terms, provisioning describes both the function and act of automatically sending 
client software updates to users. In terms of the Lotus Notes 8 client, provisioning 
encompasses two main features:

� Traditional Notes client provisioning, for example, Smart Upgrade

Smart Upgrade has been available since Notes and Domino 6.0, and provides the ability 
to send (provision) updates to the Notes client software itself out to Notes users. It uses 
the Smart Upgrade database to manage updates. Other client packaging tools may also 
be used for this purpose.

� Plug-in and non-Notes component provisioning, for example, the Domino update site

This type of provisioning is new to Notes and Domino 8. The Domino update site database 
provides the ability to send (provision) plug-in components and non-Notes composite 
applications to Notes users, and to update them when required. Other (non-Domino) 
Eclipse update sites may also be used for this purpose.

10.2.8  Update Manager (Eclipse Update Manager)

The Eclipse Update Manager is the subsystem in Eclipse Rich Client applications (such as 
Lotus Notes 8 client) responsible for feature version detection, and download of new or 
updated features and plug-ins. 

Important: Eclipse is one of the parts that comprise the Lotus Notes 8 client. It is not a 
separate installation option and it requires no configuration. It is installed automatically 
when you install the Notes 8 client. For more information about the architecture of the 
Notes 8 client, refer to 10.3, “The Lotus Notes client architecture” on page 320. 

Important: Like Eclipse, Lotus Expeditor Client for Desktop is one of the parts that 
comprise the Lotus Notes 8 client. It is not a separate installation option and it requires no 
configuration. It is installed automatically when you install the Notes 8 client. For more 
information about the architecture of the Notes 8 client, refer to 10.3, “The Lotus Notes 
client architecture” on page 320.

Note: For upgrading to Notes 8.0 from an earlier client, the update site is not an option 
(because earlier clients do not have the Update Manager — the client part of this tool — in 
place).

In the future, it may be possible to upgrade the Notes 8.x client to newer releases using an 
update site. This capability is not currently available for the Notes 8.x client. Until this 
capability becomes available, you can still use the Smart Upgrade database (or another 
provisioning method) to roll out newer Notes client releases for Notes 8.x clients.
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The Eclipse Update Manager subsystem has the information required to allow it to 
communicate with the update site to manage the update requirements of the client. Normally 
the communication is via HTTP protocol, but the Update Manager in the Notes client has a 
special protocol handler built in to allow communication over NRPC as well. This is useful if 
you are using your Domino server as the update site for your Notes clients, especially if you 
do not want to enable HTTP on the Domino server.

10.2.9  Update site (and discovery site)

An update site contains features and plug-ins that can be provisioned to Eclipse Rich Client 
applications (such as the Lotus Notes 8 client). The update site publishes a set of files in the 
structure and form expected by the Eclipse Update Manager (which is installed as part of the 
Notes 8 client).

The update site can be used by the Notes 8 client in several ways:

1. The Update Manager process on the Notes 8 client can automatically check for updates to 
any installed features that have an update site URL or discovery site URL in them. 

2. If the user opens a composite application that includes a component that is a feature that 
requires provisioning, that feature will be pulled down by the client.

3. The user may manually invoke a search for new features to install updates to currently 
installed features, if they are allowed to perform manual searches.

Feature developers can optionally include an update site URL within a feature, so that after it 
is installed, the feature will search for updates at the included URL. (A Domino Administrator 
can update these URLs for features stored in a Domino update site database. For further 
information refer to “Updating Site URLs” on page 335.)

Important: The Eclipse Update Manager is part of the Eclipse platform that is installed as 
part of the Lotus Notes 8 client.

Note: This process will try to connect to the URL included in each feature to search for 
an updated version to that feature. Features that do not have URLs included are not 
updated in this way. In Notes 8.0 the Notes client itself cannot be updated in this way. 
The ability to update the Notes client in this way may be added in a future release.

Note: Developers also have the option of including a discovery site URL in a feature (note 
that this is called Discovery URL in the feature document interface). In real-world 
implementations, the discovery site URL is usually set to the same value as the update site 
URL, but in terms of Eclipse standard definitions, these two are subtly different. 

In the Eclipse standard, the update site URL is used to update existing installed features, 
while a discovery site URL allows you to install new features. Since both of these site types 
use the standard Eclipse update site structure and both therefore provide the same 
functionality, it is unusual to see them set to different values.

In “Updating Site URLs” on page 335 you will see that it is possible for an administrator to 
set either one or both of the Update and discovery site URLs. 

For the purpose of gaining a conceptual understanding, the function of an update site and 
a discovery site are essentially the same.
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The simplest type of update site is a server that is accessible via HTTP protocol, and contains 
the specific set of files in the format the Update Manager expects. 

The specific set of files required on an update site comprises:

� site.xml

A single XML file in the root of the update site, listing all of the features and plug-ins 
contained within the site. This can be manually maintained or can be dynamically 
computed by the server.

� Features

Features are files that describe collections of plug-ins (which logically go together). They 
are located under the \features subdirectory of the update site. Each feature consists of a 
packaged JAR file that contains information about the plug-ins that comprise the feature 
and a manifest XML file that contains metadata about the feature. An update site URL 
(and discovery site URL) may also be included to tell the feature where to search for 
updates.

� Plug-ins

Plug-ins are the basic building blocks in any Eclipse-based application and contain the 
actual code. They are located under the \plugins subdirectory of the update site. Each 
plug-in consists, at a minimum, of a packaged JAR file containing code and a manifest file 
containing metadata about the plug-in.

The Domino Site Update database (based on the updatesite.ntf template) takes care of the 
structural requirements by computing the site.xml on-the-fly when it is required by an 
Eclipse-based client (such as the Notes 8 client). 

Important: There are two important things that you need to know to understand update 
sites in relation to Notes and Domino 8: 

� A Domino 8 server can act as an update site for Notes 8 clients and for other Eclipse 
Rich Client applications (such as Sametime 7.5) by using the updatesite.ntf template.

Note that the update site database can also be replicated to Domino 6.5.x and 7.x 
servers for use via HTTP. NRPC provisioning is only available on Domino 8 servers.

� Notes clients can receive updates from any type of update site server, that is, either a 
Domino 8 server acting as an update site server, or a non-Domino update site server 
(via HTTP).
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Figure 10-1 shows the file and directory structure of a basic update site.

Figure 10-1   Basic update site file and directory structure

10.3  The Lotus Notes client architecture

The Lotus Notes 8 client consists of three basic architectural layers, as shown in Figure 10-2.

Figure 10-2   Notes client architectural layers

The basic architectural layers of the Lotus Notes client shown in Figure 10-2 are:

� Notes client

The overall Notes client application and user interface 

� Expeditor

The technology that provides the ability to wire components together within Notes, 
provision them, and display them in an organized way to users

� Eclipse framework and Notes underlying C++ code

The underlying basic application platform code 
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Past versions of the Lotus Notes client consisted only of two parts of the Lotus Notes 8 
architectural model: the Notes underlying C++ code and the Notes client itself (the user 
interface).

10.4  Composite applications from administrator’s perspective

As discussed in 10.2.2, “Composite applications” on page 314 definition on page 314, a 
composite application is an assembly definition for interconnected application components. 
More specifically, an NSF-based composite application is just a Domino database with design 
elements in it to specify the details of the components and how they are wired together for 
display to the user.

The easiest way to gain a practical understanding of composite applications is to look at a 
simple example. The Notes 8 mail template is a composite application, as is the Notes 8 
Contacts template. 

Using the example of the Notes 8 mail template, there are three composite application pages 
in this template, each with three components, as shown in Table 10-1.

Table 10-1   Composite application pages in the Notes 8 mail template

Important: Understanding this architectural model explains why the Lotus Notes 8 client 
provides both full backward compatibility through the underlying C++ code, and the new 
user interface and capabilities that come with the Eclipse Platform technology.

Tip: The components themselves may or may not be stored in the composite application 
database. The component definitions may refer either to components that are stored in the 
same database (such as a Notes View) or to components that are stored elsewhere (in 
another Notes database, or outside of the Notes environment in the case of non-Notes 
components).

Composite application page Components on the page What is it?

Mail Notes Mail Navigator
Notes Mail Mini View
Notes Mail View

This page is an assembly of 
three mail elements that 
interact together to display the 
user’s mail.

Calendar Notes Calendar Navigator
Notes Calendar Mini View
Notes Calendar View

This page is an assembly of 
three calendar elements that 
interact to display the calendar.

To Do Notes ToDo Navigator
Notes ToDo View

This page contains the To Do 
navigator and view, to display 
To Do documents.
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Considering the Mail Composite Application Page listed in Table 10-1 on page 321 above, the 
components of this page are shown in Figure 10-3. Notice that each of the three components 
on the Mail Composite Application page are actually regular Notes design elements from the 
Notes 8 mail template itself.

Figure 10-3   Example of a Composite Application page: The Mail page from a standard Notes 8 mail template

Figure 10-4 shows the same Mail Composite Application page in the composite application 
editor navigator.

Figure 10-4   Mail page in composite application editor

Notes Mail Navigator
(MailFS Frameset)

Notes Mail View
(Threads View)

Notes Mail Mini View
(Switcher MV Form for Mail Form)
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10.4.1  How to determine whether an application is a composite application

Remembering that a composite application is really just a Domino database with additional 
design elements in it, there are two simple methods that you can use to determine whether 
any given database is a composite application:

� Open the database in the Notes 8 client and select Actions from the menu. If there is an 
Edit Application option on the Actions menu, then this database is a composite 
application. (Note: You must have the composite application editor installed for the Edit 
Application option to show.)

� Open the database in the Domino Designer client and expand the Composite 
Applications section in the left navigator. Open each of the Composite Applications 
subsections: Wiring Properties and Applications. If there are design documents 
showing in these two subsections (in the main design pane on the right), this is a 
composite application. If there are no design documents showing in these subsections, 
then it is not a composite application.

10.5  Using the Domino server as an update site

As discussed in 10.2.9, “Update site (and discovery site)” on page 318 definition on page 
318, a Domino server can act as an update site server for the purpose of manual and 
automatic provisioning of features and plug-ins to the Notes 8 client (as well as other Eclipse 
Rich Client applications). 

The update site template (updatesite.ntf) is a new advanced template that is installed with the 
Domino 8 server and Notes 8 client. It provides storage for features and plug-ins (and all their 
associated files) as well as tools to inspect and manage content inside Eclipse update sites. 
Using Domino as an update site server has specific benefits for Domino Administrators 
because it provides the update site functionality in a familiar Notes database interface, with 
the additional security and functionality benefits that Domino databases provide.

The specific benefits of using a Domino 8 server as an update site server include:

� Robust Domino-based security

ACLs and reader fields can be used to control access to the plug-ins and features stored 
in the database.

� Replication

Easy distribution of features and plug-ins across wide geographies. Particularly important 
for NRPC-based provisioning in enterprises.

� Notes metadata and doclinks

Understanding the update site structure is easy because all plug-ins used by a feature are 
categorized and linked, and all metadata is displayed in the documents using familiar 
Notes doclinking and Notes navigation.

Note: This section has explained composite applications from an administrator’s 
perspective. If you would like to learn more about developing composite applications, refer 
to 12.6, “Composite applications” on page 418.
Chapter 10. New concepts in administration: Eclipse, composite applications, and provisioning 323



In addition to these specific benefits of being a Domino database, the Domino update site 
provides additional functionality over a basic file system based update site. In particular, the 
Domino update site provides:

� Built-in tools for: 

– Importing and merging from other update sites
– Globally changing embedded URLs inside JAR files, and so on

� Automatic collation and dynamic computing of the site.xml file (the single root level file that 
lists all the features and plug-ins on the site)

� The ability to have more than one update site hosted on the Domino server

The remainder of this section describes the update site database and how to implement it.

10.5.1  Exploring the update site database

The update site database stores each feature and each plug-in in a separate Notes 
document. An example of the update site database is shown in Figure 10-5.

Figure 10-5   Example of a Domino update site database

The structure and logic of the update site is managed automatically by the database, and the 
site.xml file, which stores this structure, is dynamically computed and generated on-the-fly.

Tip: The site.xml is not displayed in any view in the database, but you can preview it. To 
preview the site.xml:

1. In a Notes 8 client, hold down the Ctrl and Shift keys, and open the Site Update 
database (this displays hidden views in the database).

2. Click Debug site.xml in the left navigator. This dynamically computes the site.xml and 
displays the result.
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Actions in the update site database
There are four action buttons available on the toolbar within the update site database, to allow 
you to manage the plug-ins and features stored in the database. These are described in 
Table 10-2.

Table 10-2   Action buttons in the update site database

Feature documents
As discussed in 10.2.9, “Update site (and discovery site)” on page 318, features are files that 
describe collections of plug-ins (that logically go together). 

Feature documents in the Domino update site database contain all of the information required 
by the client Update Manager process to install the feature, organized in a familiar Notes 
document format with additional metadata and doclinks.

Action buttons Usage

� Import Local update site
� Import Features
� Import Database

Use these actions to import features and 
plug-ins. For further information refer to 10.5.3, 
“How to populate the update site database with 
features and plug-ins” on page 329.

� Update URL References This action updates existing URL references 
stored in the features documents and attached 
.jar files in the database. For further information 
refer to “Updating Site URLs” on page 335.
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An example of a feature document is shown in Figure 10-6. This example is for a feature 
called QuickResponse, which is used by ITSO Corp to provide a list of common phrases that 
can be selected to bed used within a Sametime chat panel.

Figure 10-6   Example of a Domino update site feature document

The information contained in the feature document is organized into tabs. The fields on the 
document are populated during the import process, using the information from the original 
feature file (that is, whatever information was added into the feature by the feature 
developer). 
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Table 10-3 describes the content and usage of the feature document by tab.

Table 10-3   Information contained in the Domino update site feature document

Plug-in documents
Plug-ins are the basic building blocks in any Eclipse-based application and contain the actual 
code.

Plug-in documents in the Domino update site database contain all the information required by 
the client Update Manager process to install the plug-in, organized in a familiar Notes 
document format with additional metadata describing the plug-in.

Note: Administrators should never make manual edits to feature or plug-in documents. 

Rather than making changes within the feature and plug-in documents, the feature 
developer would usually provide a new version of the feature or plug-in, which would be 
imported into the update site database as a new document with an updated version 
number.

Although some fields are currently editable in the Domino 8.0 release of the update site 
template, the ability to edit fields will be removed in a future version.

Tab Contents and usage

Basics Contains metadata describing the feature, such 
as version, update information, and language.
Provides easy access to information about each 
feature

Plug-ins Contains a list of plug-ins bundled (used) by this 
feature, along with a Notes Doclink to each 
plug-in document. 
Provides a readily available reference list of 
plug-ins used by the feature, along with the ability 
to access each one via the included Doclink.

License Displays features license information (license 
information can be added by the feature 
developer).
Provides easy access to feature copyright and 
license information.

Manifest Displays the content of the manifest file 
(feature.xml). 

Attachment(s) Contains the original features .jar files as 
attachments.
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An example of a plug-in document is shown in Figure 10-7.

Figure 10-7   Example of a Domino update site plug-in document

The information contained in the plug-in document is organized into tabs. The fields in the 
document are populated during the import process, using the information from the original 
plug-in file (that is, whatever information was added into the plug-in by the plug-in developer). 
Some fields in the plug-in document are editable, but most fields are not. 

Table 10-4 describes the content and usage of the plug-in document by tab, including 
information about which fields are editable.

Table 10-4   Information contained in the Domino update site plug-in document

10.5.2  How to create the update site database

The update site database is based on the Eclipse update site template. This is a new 
advanced template that is installed with the Domino 8 server and Notes 8 client. 

To create a new update site database from the template:

1. In the Notes 8 client, select File → Application → New.

Tab Contents and usage

Basics Contains basic information about the plug-in: 
name, provider, version, and ID.
Provides easy access for administrators to find 
information about each plug-in.

Manifest Displays the content of the manifest files 
(manifest.mf and plug-in.xml), each on its own 
sub-tab.

Attachment(s) Contains the original plug-in code files as 
attachments.
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2. Select the server and template details, and fill in the database title and file name, as 
shown in Figure 10-8.

Figure 10-8   Creating a new update site database

3. Select OK to create the database.

4. Add the required users and groups to the ACL of the database using File → 
Application → Access Control to provide user access to the new update site database.

10.5.3  How to populate the update site database with features and plug-ins

Once the Domino update site database has been created, there are several ways to populate 
the database with the features and plug-ins files. The different import methods and their 
usage are listed in Table 10-5.

Table 10-5   Domino update site import methods and their usage

a. Choose update site
server, database title,
and file name.

b. Choose template server.

c. Select Show advanced
templates, then choose the
Eclipse Update Site template.

Import method for update site database Usage

Import a local update site. This allows you to import the entire Eclipse 
update site based on the standard Eclipse update 
site structure (that is, site.xml file in the root 
directory, with \features and \plug-ins 
subdirectories containing these files). Review 
Figure 10-1 on page 320 for the standard Eclipse 
update site Structure.
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Importing a local update site
To import a local update site, you must be able to access the site files from your Notes client 
workstation. In other words, you need to be able to access the standard Eclipse set of files 
that make up an Eclipse update site (that is, a site.xml file with \features and \plugins 
subdirectories below it, each containing the features and plug-ins files).

Once you have access to an update site, import it into the Domino update site database as 
follows:

1. In the Domino 8 Administrator client or Notes 8 client, open the Domino update site 
database.

Import features. This allows you to import one or more features 
files if they have been packaged as deployable 
features by the feature developer. 
Note: Do not use this method to import a feature 
unless it has been packaged as a deployable 
feature. Plug-ins will not be imported with 
features that have not been packaged as 
deployable features. Use the Import a local 
update site method to import features that have 
not been packaged.

Import a database. This allows you to import the contents of another 
Domino update site database, effectively 
merging or consolidating the two databases into 
one.

Tip: An Eclipse update site is not usually something a Domino Administrator would create. 
Most often, these files would be provided to you by a Java or Eclipse developer. Using an 
Eclipse-based development environment allows a developer both to create the features 
and plug-ins and to create the site.xml and associated site structure.

If you would like to test the process of importing a local update site, there is a sample site 
available for download on the Lotus Sandbox Web site:

http://www-10.lotus.com/ldd/sandbox.nsf/ByDate/53833531887a864d852572f10068e6a6
?OpenDocument

Inside the zipped download file is another called Updatesite.zip. This zip file contains a 
sample update site.

Import method for update site database Usage
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2. Click the Import Local Update Site action button to display the Import Local Update Site 
dialogue, as shown in Figure 10-9.

Figure 10-9   Import Local Update Site dialogue

3. In the Import dialogue, click the Browse button.

4. In the Select File dialogue, navigate to the site.xml file and highlight it, as shown in 
Figure 10-10.

Figure 10-10   Importing an update site - selecting a site.xml file

5. Click Open, then OK to begin the import.

Tip: Note the statement highlighted in Figure 10-9, which states that it is safe to 
re-import already imported update sites. Existing features and plug-ins only get 
updated if they have changes since the last import.

Tip: Notice the \features and \plugins subdirectories showing in Figure 10-10. This 
indicates that the Eclipse update site structure is correct. These directories should 
always display in the location where you select to import the site.xml file from.
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Importing features
Individual features can be imported into the Domino update site database. This allows the 
features to be updated when they change, and for new features to be added. 

To import individual features:

1. In the Domino 8 Administrator client or Notes 8 client, open the Domino update site 
database.

Important: The site.xml within the Domino Site Update database is computed 
dynamically, so it immediately reflects the new update site that you import. 

However, if a user has already manually searched for plug-ins during his current Notes 
session (using the menu option File → Application → Install), he needs to restart the Notes 
client for the new plug-ins to display in the Install dialogue. This is because the Update 
Manager caches the last check. 

Note that it is important to understand this caching behavior, especially during client 
provisioning testing. This behavior also occurs with other Eclipse applications such as 
Sametime 7.5. 

Attention: When you import an individual feature, any associated plug-ins need to be 
available to allow the import process to import associated plug-ins as well. This requires 
that either:

� The feature and associated plug-ins are available in the Eclipse site directory structure 
(that is, the feature is located in the /features directory with associated plug-ins in the 
/plugins directory).

� The feature has been packaged as a deployable feature by the feature developer. As 
an administrator, if you need to import an individual feature, you may need to confirm 
with the Feature developer that she has packaged it as a deployable feature. 

If there are many features to import and you have access to the entire Eclipse site 
structure (that is, site.xml, /features directory, /plugins directory), it may be easier to import 
the entire site using the method described in “Importing a local update site” on page 330.

Tip for the feature developer: When exporting the feature as a deployable feature in 
Eclipse, select Package as individual JAR archives (required for JNLP and update 
sites) on the Options tab.
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2. Click the Import Features action button to display the Import Features dialogue, as 
shown in Figure 10-11.

Figure 10-11   Import Features dialogue

3. In the Import dialogue, click the Browse button.

4. In the Select File dialogue, navigate to the features files and highlight one or more feature 
.jar files for import, as shown in Figure 10-12.

Figure 10-12   Importing individual features - selecting the feature .jar files

5. Click Open, then OK to begin the import.

The site.xml within the Domino Site Update database is computed dynamically, so it 
immediately reflects the new update site that you import. (As stated previously, users may 
need to restart their Notes client to see any new features.)

Tip: Note the statement highlighted in Figure 10-11, which states that it is safe to 
re-import already imported features. Existing features only get updated if they have 
changes since the last import.
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Importing a database
You can import the contents of a Domino update site into another Domino update site. This is 
useful if you have been using multiple sites for different purposes (or perhaps in different 
Domino domains) and now need to combine them. 

To import one Domino update site database into another:

1. In the Domino 8 Administrator client or Notes 8 client, open the Domino update site 
database.

2. Click the Import Database action button.

3. In the Import dialogue, click the Browse button.

4. Select the server and database names for the database that you want to import content 
from, as shown in Figure 10-13.

Figure 10-13   Importing a Database dialogue

5. Click Open, then OK to begin the import.

The site.xml within the Domino Site Update database is computed dynamically, so it 
immediately reflects the new update site that you import. (Users may need to restart their 
Notes client to see any new features.)

Tip: Note the statement highlighted in Figure 10-13, which states that it is safe to 
re-import already imported update site databases. Existing features and plug-ins are 
only updated if they have changes since the last import.
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Updating Site URLs
There is one additional action button that can be used to manage features in the Domino 
update site database: the Update URL References action. This action updates the update site 
URLs and discovery site URLs within features in the database.

As discussed in 10.2.9, “Update site (and discovery site)” on page 318, a feature can 
optionally contain an update site URL or a discovery site URL that can be used to manually or 
automatically update the feature when new versions become available on the update site 
server. 

The Update URL References action allows you to populate all Update and discovery site 
URLs within the Domino update site documents with a single site URL of your choosing. The 
action updates URLs in the feature documents themselves and in the attached .JAR files.

To update site URLs in features:

1. In the Domino 8 Administrator client or Notes 8 client, open the Domino update site 
database.

2. Click the Import URL References action button.

Attention: Updating the update site or discovery site URLs for signed features breaks the 
existing signatures in the feature .JAR files. It does not break the actual functionality of the 
feature, only the signature. 

There is currently no tool to re-sign feature .JAR files inside an NSF-based update site. 
This tool may be added in a future release of Notes and Domino.

Why this is important: Features that have been imported into the Domino update site 
database are likely to contain site URLs pointing to another Eclipse update site, as this is a 
parameter that the feature developer can add when he creates the feature. 

The Update URL References action is useful because it allows you to update all site URLs 
in the feature documents to point to the Domino update site (or another site of your 
choosing) so that whenever a manual or automatic feature search is performed, it will 
search using the URL you provided.
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3. In the Update URL References dialogue, fill in the new site label and new site URL, as 
shown in the example in Figure 10-14.

Figure 10-14   Update URL References dialogue

4. (Optional) Select or deselect each of the Apply To check boxes for update site URLs and 
discovery site URLs (one or both may be selected).

5. Select an update option, either:

– Change Features with existing embedded URLs only.
– Change ALL features.

6. Click OK.

Step 3

Step 4

Step 5
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Figure 10-15 shows an example of a feature document with the updated Site and Discovery 
URL fields.

Figure 10-15   Updated URL fields in a feature document

10.5.4  How to enable feature installation (provisioning) for Notes users

The update manager process (which is installed as part of the Notes 8 client) is responsible 
for managing the update process for installed features.

The update manager process on the Notes 8 client can automatically check for updates to 
any installed features that have an update site URL or discovery site URL in them. Features 
can also be provisioned to users automatically via the component palette in the composite 
application editor, or due the user opening a composite application that includes a component 
that is a feature that requires provisioning.

Tip: The Update URL References action can also be used to remove all update site and 
discovery site URLs. This is useful if you want to install features for your Notes client but 
you do not want them to automatically search for updates in future.

To remove all existing URLs in feature documents, use the procedure above, skipping step 
3 (that is, leave the New Site label and New Site URL fields blank).
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You can also allow Notes users to manually invoke updates to existing features and 
installation of new features. With this function enabled, users see two additional menu items 
on the Notes client File menu:

� File → Application → Install - to search for and install new plug-ins
� File → Application → Application Management - to manage installed plug-ins

To allow users to manually invoke updates:

1. Create a desktop policy settings document (or edit an existing one).

2. On the Basics tab, towards the bottom, set the Allow user initiated updates field to Enable, 
as shown in Figure 10-16.

Figure 10-16   Enabling user-initiated feature updates

3. Save and close the desktop policy settings document.

4. Apply the settings to the required users via a policy document.

If your organization does not use policies, or you prefer not to enable user-initiated updates 
through a policy, it can instead be enabled directly on the client machine, as follows:

1. Locate the plug-in_customization.ini file in the following location:

<NotesProgramDir>\framework\rcp\plug-in_customization.ini

2. Edit this file by adding the following line to the file:

com.ibm.notes.branding/enable.update.ui=true

3. Save and close the file.

4. Restart the Notes client.

10.5.5  Providing a list of update site URLs to include in searches

It is possible to pre-fill the list of update site URLs available when a user manually searches 
for new and updated plug-ins (using the File → Application → Install menu option). This 
provides users with the ability to search for new and updated plug-ins without needing to 
know how to fill in the update site server details in the interface.

Note: In the future, it may be possible to upgrade the Notes 8.x client to newer releases 
using the update site. This capability is not currently available for the Notes 8.x client. At 
present, the Update Manager only downloads updates to additional features and plug-ins 
that have been installed on top of the client, using the URL reference listed in the feature.

Tip: If you are new to policies, refer to the Policies section in the Lotus Domino 
Administrator 8 Help database for information about how to plan and implement policies.

Note: The setting in the Allow user initiated updates field of the desktop policy settings 
document overrides the setting in the plug-in_customization.ini file. The setting in this file is 
only used if a policy setting is not available.
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How to pre-populate the update site URL list for users
The update site server details are stored in the bookmarks.xml file on the Notes workstation, 
in the following location:

NotesDataDir\workspace\.config\org.eclipse.update\bookmarks.xml

This file could be pre-populated for users and then added to the correct location on each 
user’s workstation during or after the Notes 8 client installation.

The easiest way to pre-populate the bookmarks.xml file is by adding the sites to the manual 
update interface of a Notes client, then using the resulting bookmarks.xml file as the file that 
gets deployed to the user workstations. An example of the New Update Site dialogue that 
displays when you add a new site in the manual update interface is shown in Figure 10-17.

Figure 10-17   New Update Site dialogue in manual update interface of the Notes client

It is also possible to create the bookmarks.xml file manually, but you need to ensure that the 
syntax is completely correct, so we do not recommend this option.

Use the procedure described in “Initiating manual feature installation on the Notes 8 client” on 
page 341 to add the update sites to the bookmarks.xml file.

Figure 10-18 shows an NRPC update site and an HTTP update site as they are added in the 
Notes client manual update interface, with their corresponding entries in the bookmarks.xml 
file.

Figure 10-18   Update site syntax shown in Notes client interface and bookmarks.xml file

Update site URL syntax
The update site URL can be added to the manual update interface in the client, as shown in 
Figure 10-18. The syntax of the URL that is added needs to be correct, or the Update search 
fails to locate the update site server.
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The syntax is described below.

Syntax for HTTP site URLs
The correct syntax for a site URL for an HTTP update site is:

http://UpdateSiteFQHN/Filename.nsf/site.xml

For example:

http://richmond.itso.com/updatesite.nsf/site.xml

Syntax for NRPC URL references
The correct syntax for a site URL for an NRPC update site is:

nrpc://UpdateSiteFQHN/__ReplicaID/site.xml

For example:

nrpc://richmond.itso.com/__852572FA0077A5A3/site.xml

Note the double underscore followed by the replica ID of the update site database. To obtain 
this information from the update site database:

1. In a Notes Domino Administrator client or Notes client, select or open the update site 
database that you want to use via NRPC.

2. From the menu, select File → Application → Properties.

3. Click the Info tab (the second tab) and write down or take an image of the dialogue box 
with the replica ID displayed, as shown in Figure 10-19.

Figure 10-19   Update site database properties, showing the replica ID

4. Using the procedure for adding a new update site to the Notes client (described in 
“Initiating manual feature installation on the Notes 8 client” on page 341), add the replica 
ID of the update site database to the New Update Site dialogue. Remember to add the two 
underscores at the beginning and remove the colon (:) in the middle, as shown in the 
example in Figure 10-19.

Note: The Notes protocol site URL begins with nrpc://. This is different from normal 
Notes-style URLs (which typically begin with notes://).
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10.5.6  How plug-in (feature) provisioning works on the Notes 8 client

As discussed in 10.2.8, “Update Manager (Eclipse Update Manager)” on page 317, the 
update manager task is installed as part of the Notes 8 client, and this process takes care of 
Eclipse feature and plug-in provisioning on the client.

The concepts and usage of the update manager are discussed in this section.

Important files
There are two update manager files that are particularly important for the Domino 
Administrator to be aware of. These are described in Table 10-6.

Table 10-6   Important update manager files

Initiating manual feature installation on the Notes 8 client
If manual feature installation is enabled, users will be able to manually search for and install 
features from within the Notes client. Users can also optionally add new update sites to the 
list of sites to search.

Manually initiating a search in the Notes client provides the ability for users to search for 
updates to currently installed features, and for new features to install. Refer to 10.5.4, “How to 
enable feature installation (provisioning) for Notes users” on page 337, for more information 
about enabling this feature for users. 

Updating currently installed features 
To initiate an update of currently installed Eclipse features:

1. In the Notes client, select the menu option File → Application → Install.

Update manager file What it is for

<NotesProgramDir>\framework\rcp
\plug-in_customization.ini

This is used by the update manager client 
process to determine whether to display the 
menu options for user-initiated plug-in updates. 
Refer to 10.5.4, “How to enable feature 
installation (provisioning) for Notes users” on 
page 337 for further information.

<NotesDataDir>\workspace\.config
\org.eclipse.update\bookmarks.xml

This stores the list of update site URLs to display 
when a user manually searches for plug-ins 
(using File → Application → Install). Refer to 
10.5.5, “Providing a list of update site URLs to 
include in searches” on page 338 for further 
information.

Tip: Adding new update sites in the Notes client interface updates the bookmarks.xml file 
on the workstation. This file stores the list of update sites that display in the manual feature 
installation dialogue. For more information about the bookmarks.xml file and how to 
populate it for users, refer to 10.5.5, “Providing a list of update site URLs to include in 
searches” on page 338.
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2. In the Install/Update dialogue, select Search for updates of the currently installed 
features, as shown in Figure 10-20.

Figure 10-20   Install/Update dialogue - Searching for updates to installed features

3. Click Finish to complete the process. Newer versions of currently installed features will 
install on the client.

Searching for new features to install
To initiate a search for new Eclipse features for installation:

1. In the Notes client, select the menu option File → Application → Install.

2. Select Search for new features to install, as shown in Figure 10-21, then click Next.

Figure 10-21   Install/Update dialogue - searching for new features to install
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3. (Optional) To add a new location to search:

a. In the Install dialogue, click the button that represents the type of location to search for 
features, for example, click Add remote site to add a new Domino update site 
database.

b. In the New Update Site dialogue, type in a descriptive name for the site and the HTTP 
or NRPC URL reference, as shown in the examples in Figure 10-22.

Figure 10-22   Examples of adding a new update site

c. Click OK to close the New Update Site dialogue.

Tip: Note the use of the double underscore followed by the replica ID in the NRPC 
URL. Refer to “Update site URL syntax” on page 339 for further information.

New HTTP Domino update site example:

New NRPC Domino update site example:
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4. In the Install dialogue select or deselect the check box for each location to include in the 
features search, as shown in the example in Figure 10-23.

Figure 10-23   Check boxes to select update site locations to search

5. Click Finish to begin the location search.
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6. In the Updates dialogue, select the check boxes for the features to install, as shown in the 
example in Figure 10-24.

Figure 10-24   Selecting features to install

7. Select Next.

8. In the License dialogue, select I accept the terms in the license agreements.

9. Click Next then Finish to begin the installation process.
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10.If the plug-ins in the feature being installed have not been signed by a trusted source, the 
dialogue in Figure 10-25 will display, prompting the user to choose whether to continue 
with the installation. Select Do not install this plug-in or Install this plug-in, then click 
OK to continue.

Figure 10-25   Unsigned plug-in prompt

10.5.7  Accessing the update site from a browser

The content of a Domino update site database can also be viewed via a Web browser. The 
browser view provides a list of the features available on the update site, along with the actual 
URL to use for provisioning them.

To access the update site via a browser, use the database URL in the form:

http://serverFQHN/updatesite.nsf

Tip: Developers can sign plug-ins using a trusted signer within their plug-in development 
environment. If you do not want users to receive the unsigned plug-in prompt, ask the 
plug-in developer to sign the plug-ins, then reimport them into the update site.
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Figure 10-26 shows an example of the Web browser view of a Domino update site.

Figure 10-26   Web browser view of a Domino update site

10.5.8  Server configuration options for the Domino update site 

In a future Domino 8.x point release, it is expected that there will be a new option to configure 
Domino update site server settings within the server configuration document.

The new options will be available on the Client Upgrade → Provisioning tab of the server 
configuration document, and will allow you to set the following options for user-initiated 
updates:

� List of update site URLs to include in searches.
� Restrict clients to only update from that list of allowed update site URLs.

In the meantime, you can provide a pre-populated list of update site URLs using the 
procedure described in 10.5.5, “Providing a list of update site URLs to include in searches” on 
page 338.
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Chapter 11. IBM WebSphere Portal 
integration

This chapter provides an insight into the new enhancements in Notes and Domino 8 with 
respect to IBM WebSphere Portal. The focus of this chapter is on how WebSphere Portal 
features can be leveraged along with Lotus Notes and Domino 8.

This chapter helps Domino 8 and WebSphere Portal administrator’s understand and 
configure these enhancements.

In this chapter, the following topics are discussed:

� Domino Portal Integration wizard
� Domino Portal Federated Administration
� Domino 8 Administrator - Web administration server bookmarks
� Composite applications - installation of SCI and home portal account

This chapter focuses on integrating WebSphere Portal into your Lotus Notes and Domino 8 
deployment.
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11.1  Introduction to WebSphere Portal

IBM WebSphere Portal software delivers quantifiable business value by improving employee 
productivity and customer service through role-based solutions. In addition, WebSphere 
Portal software delivers business flexibility by allowing for the quick creation and deployment 
of composite applications built on a service-oriented architecture (SOA), all from a trusted 
provider of market-leading portal technology.

WebSphere Portal provides a personalized single point of integrated access to experts, 
information, and business applications. Portals unify applications into one relevant and 
homogeneous environment. To deliver a unified user experience, WebSphere Portal brings 
together a range of leading-edge technologies designed to give you a flexible, open, 
extensible framework to build successful business-to-employee (B2E), business-to-business 
(B2B), and business-to-consumer (B2C) portals. By providing industry-leading portal 
solutions for your on demand business, IBM helps you improve employee productivity, cut 
costs, and strengthen relationships with your customers and trading partner.

Figure 11-1   IBM WebSphere Portal software provides role-based delivery of applications and 
information, in the context of business processes, to users in the form of portlets

Key benefits of WebSphere Portal are that it:

� Helps improve operational efficiency and productivity by linking the correct people, 
process, and information so that transactions are executed quickly and accurately

� Accelerates application and content deployment through new tools and the innovative use 
of SOA

� Helps to lower the overall costs of portal deployment with faster performance and easier 
administration

� Continues the delivery of responsiveness and reliability from a leader in the enterprise 
portal market
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Web-enabled application
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HTML page

Electronic form

Web service

IBM WebSphere
Portal software

Role
based

In
context

Process driven

Mobile clients

Rich clients

Browser
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11.1.1  Business value of integrating WebSphere Portal and Lotus Domino

Collaboration represents the simple act of working together to accomplish a common goal. 
WebSphere Portal helps companies extend their investments in Lotus Notes and Domino to 
more people. WebSphere Portal simplifies and integrates access to Lotus Domino 
applications, along with other information, applications, and business processes. Lotus 
Domino customers can easily get the dynamic information they need and can quickly execute 
business processes across critical applications. They can collaborate with WebSphere Portal 
users inside and outside the business.

Some other business value benefits include:

� Weave collaboration and human interaction by combining WebSphere Portal software 
with the Lotus Notes and Lotus Domino platform into key applications and processes that 
span your value chain of employees, suppliers, partners, and customers. This allows 
everyone involved to work together more easily than before.

� Larger reach for Domino applications - IBM WebSphere Portal software enables you to 
deploy existing applications more widely than you could before, including applications that 
are only available within the Lotus Notes client. You can allow users to launch Lotus Notes 
applications from within the portal, without having to invest resources to Web enable them.

� Contextual collaboration - A portal user can see whether other users are online directly 
from the portlet or a page, thereby providing contextual awareness and collaboration 
capabilities.

� Leverage single sign-on. Lotus Domino integration with WebSphere Portals allows the 
leverage of the single sign-on capability for access to the portal, as well as for access to 
the supporting Lotus software collaborative products. Users must only sign in once, 
resulting in fewer passwords to administer and a better user experience.

� Deploy composite applications quickly and easily. Composite applications integrate 
components, or data and information, from multiple applications. These component parts 
can be mixed and matched. For instance, a composite application can include a mix of 
transactional applications, such as Siebel®, Oracle®, and SAP® enterprise software, and 
document-based collaborative applications built on Lotus Domino software. By 
assembling different application components, you can provide employees with the tools 
they need in the context of a business process, as well as content based on their job 
functions.

In addition to these benefits, for easy integration with Lotus Notes and Domino mail and 
applications, several Lotus Domino software-specific portlets and portlet packages are 
available to WebSphere Portal software licensees at no additional charge. The following 
portlets provide easy access to Lotus Notes and Domino features:

� The IBM Lotus Domino Application Portlet allows a Lotus Domino Web application to be 
surfaced in a portlet while maintaining full function of the application and without changing 
the application design.

� Common Personal Information Management (PIM) Portlets allow portal access to several 
back-end mail systems and protocols, including Lotus Domino mail and calendars and 
Microsoft Exchange software.

� IBM Lotus Notes/Domino and Extended Products Portlets deliver a set of prebuilt portlets 
and sample pages for integration with Lotus Notes and Domino applications, as well as 
Lotus Domino extended products such as IBM Lotus Sametime, IBM Lotus QuickPlace®, 
and IBM Lotus Domino Document Manager software.
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11.2  Domino Portal Integration wizard

Integration of WebSphere Portal in a Notes and Domino 8 environment has been simplified 
by the introduction of the Domino Portal Integration (DPI) wizard. The integration wizard is 
designed to speed the integration of Lotus Domino and Sametime software within a 
WebSphere Portal environment.

The DPI wizard streamlines the configuration process by reducing the burden required to 
enable Lotus Domino and WebSphere Portal Integration. The wizard also automates the 
setup of the Common Personal Information Management (PIM) Portlets (CPP), along with the 
Lotus Domino Extended Products Portlets (DEPP).

11.2.1  Domino Portal Integration wizard prerequisites

Domino Portal Integration wizard requires the following:

� WebSphere Portal Server prerequisites

– WebSphere Portal Server should be Version 6.0.1.

– In case you wish to install or upgrade an existing WebSphere Portal Server version, 
refer to the Portal InfoCenter at:

http://publib.boulder.ibm.com/infocenter/wpdoc/v6r0/index.jsp

– WebSphere Portal Server must not be configured with clusters.

– WebSphere Portal Server should not have support for IBM Tivoli Access Manager or 
Computer Associates eTrust SiteMinder.

� Lotus Domino prerequisites

– Lotus Domino servers should be Version 8.0.

– Lotus Domino servers should have the LDAP service configured and running.

– Lotus Domino servers should have HTTP/HTTPS service configured and running.

– Lotus Domino servers should have DWA configured and running.

Important: This chapter assumes that you already have WebSphere Portal Version 6.0.1 
installed and running in your environment, so it does not include information about 
installing and configuring WebSphere Portal.

For details about how to install and configure WebSphere Portal, refer to the product 
documentation that accompanies WebSphere Portal (or the following Information Center 
link).

An excellent source of information for WebSphere Portal is the online information center. 
The WebSphere Portal Version 6 Information Center is available at:

http://publib.boulder.ibm.com/infocenter/wpdoc/v6r0/index.jsp

Information centers are available for every version of these products, and they contain a 
wealth of installation, configuration, troubleshooting, and upgrade documentation.

Whether you are new to these products or are already familiar with them, we highly 
recommend that you bookmark this site and refer to it frequently before carrying out any of 
the configuration or upgrades described in this chapter.
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– All Lotus Domino servers must be behind the same Internet security firewall and in the 
same Internet domain. 

– Lotus Domino servers must be in the same Domino domain.

� Lotus Domino and WebSphere Portal prerequisites

– WebSphere Portal Server must be configured with LDAP using Lotus Domino directory 
using the config wizard.

– WebSphere Portal Server must also be security enabled using the config wizard.

For more details, refer to the WebSphere Portal Infocenter at:

http://publib.boulder.ibm.com/infocenter/wpdoc/v6r0/index.jsp

� Lotus Sametime prerequisites

– Lotus Sametime is optional in case you do not have Lotus Sametime in your 
deployment.

– Lotus Sametime Server should be Version 7.5 or later.

– Lotus Sametime Server must be configured for using Lotus Domino server as LDAP 
and not Domino directory.

– Copy the file DPICFG.NSF from the Lotus Domino 8 Server to the following directory 
path on the Lotus Sametime Server, which would be integrated with the WebSphere 
Portal Server:

<PortalServerHome>/config/wizard/dpicfg.nsf to D:\Lotus\Domino\Data

11.2.2  Running the Domino Portal Integration wizard

The Domino Portal Integration wizard accomplishes the following tasks:

� Single Sign-On (SSO)
– Export LTPA token.
– Create Web Single Sign-On Document on Lotus Domino.

� Lotus Sametime
– Single Sign-On, enable awareness for Lotus Domino Web Access.
– Set up trusted servers in stcenter.nsf.

� Lotus Domino directory
– Single Sign-On, DIIOP.
– Configure collaborative services to bind to Lotus Domino LDAP.

� Lotus Domino mail servers (for each mail server)
– Single Sign-On, DIIOP, NOTES.INI settings for HTTP, enable XML services.

Note: Refer to the Notes and Domino 8 Release notes for more details on considerations 
for existing SSO environments:

http://www.ibm.com/developerworks/lotus/documentation/releasenotes

The same information is also contained in the WebSphere Portal InfoCenter at:

http://publib.boulder.ibm.com/infocenter/wpdoc/v6r0/index.jsp

Important: Read 11.2.1, “Domino Portal Integration wizard prerequisites” on page 352, 
before attempting to run the DPI Wizard.
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For the smooth execution of the wizard the following data should be collected before running 
the DPI wizard. Table 11-1 summarizes the data to be collected and also provides the value 
being used in the ITSO Corporation example.

Table 11-1   Data required for Domino Portal Integration wizard

Important: For platforms supported by the DPI wizard, refer to the product release notes:

http://www.ibm.com/developerworks/lotus/documentation/releasenotes

Data required Person responsible Example

WebSphere Portal Server 
installation path

WebSphere Portal 
administrator.

D:\IBM\WebSphere\PortalServ
er\

WebSphere Portal, Lotus 
Domino, and Sametime Server 
host names or IP address

Network/Lotus 
Domino/WebSphere Portal 
administrator.

la.itso.com (Domino server),
portal.itso.com (Portal server),
sametime.itso.com (Sametime 
Server)

WebSphere Application Server 
administrator ID and password 
(in LDAP format)

WebSphere Portal or 
Application Server or network 
administrator.

WAS Admin id - 
cn=wpsadmin,o=itso
WAS Admin passwd = 
password

WebSphere Portal Server 
administrator ID and password 
(in LDAP format)

WebSphere Portal or network 
administrator.

Portal Admin id - 
cn=wpsadmin,o=itso
Portal Admin passwd = 
password

Lightweight Third Party 
Authentication (LTPA) 
password

Input required by the DPI 
wizard at run-time. To be 
provided at Wizard runtime.
Previous value does not exist.

LTPA password = password

Lotus Domino LDAP port 
number

Lotus Domino or network 
administrator.

389

Lotus Domino HTTP Port (in 
case running HTTPS then 
HTTPS port number also 
required)

Lotus Domino or network 
administrator.

80

Lotus Domino administrator ID 
and password

Lotus Domino or network 
administrator.

Administrator ID = Domino 
Admin/ITSO
Administrator password = 
password

Lotus Sametime administrator 
ID and password

Lotus Domino or network 
administrator.

Administrator ID = 
Domino Admin/ITSO
Administrator password = 
password

Lotus Sametime Server fully 
qualified host name

Lotus Domino or network 
administrator.

sametime.itso.com

Lotus Sametime Server HTTP 
port number (in case running 
HTTPS then HTTPS port 
number also required)

Lotus Domino or network 
administrator.

80
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The Domino Portal Integration wizard executes the following steps to achieve the integration:

1. Execute the wizard from the WebSphere Portal Server, as shown in the Figure 11-2.

Figure 11-2   Executing the DPI wizard

2. This launches the DPI wizard welcome window, as shown in Figure 11-3. Click Next to 
continue.

Figure 11-3   DPI wizard welcome page
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3. The wizard asks you to provide the WebSphere Portal administrator ID and password, as 
shown in Figure 11-4. Click Next to continue.

Figure 11-4   Providing the WebSphere Portal administrator user details
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4. The wizard then asks you whether you wish to configure the Sametime Server to support 
awareness, as shown as in Figure 11-5. Select Yes and click Next to continue.

Figure 11-5   Sametime Portlets to be enabled or not

Attention: This step can be skipped for deployments that do not have Lotus Sametime 
installed or do not intend to integrate Lotus Sametime with WebSphere Portal Server.
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5. Select the Lotus Domino server running the Domino LDAP service that will be used for 
automatic detection of mail files, as shown in Figure 11-6. Click Next to continue.

Figure 11-6   LDAP Server to be selected for the DPI wizard

6. You will be asked for the port numbers on which LDAP, HTTP, and HTTPS are running on 
the Lotus Domino server, as shown in Figure 11-7. Click Next to continue.

Figure 11-7   Ports running HTTP and LDAP on Domino server (la.itso.com)

7. You will be asked to provide the Domino Administrator’s ID and password. Note that this 
ID should be listed as an administrator in the server document. This ID should also have 
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manager access to the Domino directory (NAMES.NSF). Provide details as shown in 
Figure 11-8. Click Next to continue.

Figure 11-8   Domino Administrator details to be provided

8. You now need to select the Lotus Domino server’s that would use the 
messaging/application portlets. Select the relevant servers, as shown in Figure 11-9. Click 
Next to continue.

Figure 11-9   Select Domino servers that require mail or application access via the WebSphere Portal
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9. You need to specify the Lotus Sametime Server details, as shown in Figure 11-10. Click 
Next to continue.

Figure 11-10   Sametime server - details to be provided

10.Specify the Lotus Sametime server’s administrator ID and password, as shown in 
Figure 11-11. Click Next to continue.

Figure 11-11   Sametime Administrator - details to be provided
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11.The wizard asks you for the WebSphere Portal administrator ID and password, as shown 
in Figure 11-12. Click Next to continue.

Figure 11-12   Portal administrator ID and password to be provided - final step

12.The system processes the data and gives you a successful window, as shown in 
Figure 11-13. Click Finish to exit the wizard.

Figure 11-13   DPI wizard success page
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WebSphere Portal has been integrated with Lotus Domino and Sametime servers. 

You can observe the outcome of that integration for our ITSO Corporation example in 
Figure 11-14, which shows Domino Web Access with Sametime enabled as displayed 
through our WebSphere Portal Server with automatic discovery of Lotus Domino mail file and 
SSO enabled.

Figure 11-14   WebSphere Portal with Lotus Domino 8 and Sametime integrated via the DPI wizard

11.3  Domino Portal Federated Administration

Now you can administer the Domino 8 Server from within the WebSphere Portal 
administration user interface. This feature will be of interest to all Domino Administrator’s who 
also manage WebSphere Portal installations. 

In this configuration, the Domino Web Administration (WEBADMIN.NSF) user interface is 
embedded within the WebSphere Portal Administration user interface. In our ITSO 
Corporation example, we integrate the Lotus Domino server (LA) with the WebSphere Portal 
Server (PORTAL) to demonstrate the steps involved in such an integration.

Note: Logs for the operation of the wizard are located in the portal_server_root/log 
directory. The dpitasks.log contains all information about tasks run by the wizard.
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11.3.1  Domino Portal Federated Administration prerequisites

Note that the following are required in order to enable Lotus Domino and WebSphere Portal 
Server federated administration:

� A successful SSO configuration between Domino 8 Server and WebSphere Portal Server 
6.0 /6.0.0.1/6.0.1 should exist.

� In case SSO does not exist, run the DPI wizard, as discussed in 11.2, “Domino Portal 
Integration wizard” on page 352.

11.3.2  Configuration of Domino Portal Federated Administration

Domino Portal Federated Administration needs to accomplish the following tasks:

1. Download and install the Portal Update Installer (PUI) tool. (You need to perform this step 
for WebSphere Portal 6.0/6.0.0.1 server setup only.)

2. Download and install federation fix (iFix.zip) on WebSphere Portal Server. (You need to 
perform this step for WebSphere Portal 6.0/6.0.0.1 server setup only.)

3. Configure the federation fix on WebSphere Portal Server.

4. Download the addfederation.xml file from the Domino 8 Server.

5. Edit the addfederation.xml file. (You need to perform this step for WebSphere Portal 
6.0/6.0.0.1 server setup only.)

6. Execute the xmlaccess script to apply addfederation.xml to the WebSphere Portal Server.

7. Configure WebSphere Portal Server.

Download and install the Portal Update Installer (PUI) tool

To do this:

1. The WebSphere Portal 6 Update Installer (PUI) tool must be downloaded before this step. 
You can download the PUI from:

http://www.ibm.com/software/genservers/portal/support

Note: The prerequisites and instructions provided use the Domino M5 Public Beta Build 
released on May 23, 2007.

Important: Perform this step only for WebSphere Portal Server 6.0/6.0.0.1 installations.
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The PUI tool needs to be extracted as shown in Figure 11-15.

Figure 11-15   Extracting the Portal Update Installer tool
364 IBM Lotus Notes and Domino 8 Deployment Guide



Download and install federation fix (iFix.zip) on WebSphere Portal
Server

To do this:

1. Download the file iFix.zip, which contains the federation fix for WebSphere Portal from any 
Domino 8 Server running HTTP by pointing to this URL:

http://<dominoserver>/webadmin.nsf/iFix.zip

This triggers the download of the iFix.zip file, as shown in Figure 11-16. Make sure to 
extract and copy the file locally on the WebSphere Portal Server.

Figure 11-16   Downloading the iFix.zip from the Lotus Domino 8 server

Important: Perform this step only for WebSphere Portal Server 6.0/6.0.0.1 installations.

Note: iFix.zip is available only on Lotus Domino 8 servers. It can be accessed only 
through the URL:

http://<dominoserver>/webadmin.nsf/iFix.zip
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2. Execute setupCMDline.bat from the WebSphere/AppServer/bin directory, as shown in 
Figure 11-17.

Figure 11-17   Executing setupCMDline.bat before running the Portal Update wizard

3. You are now ready to execute the Portal Update Installer (PUI) tool from the update 
directory. (You already downloaded and installed the PUI tool in “Download and install the 
Portal Update Installer (PUI) tool” on page 363), as shown Figure 11-18.

Figure 11-18   Executing the Portal Update Installer wizard tool
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4. This shows you the PUI wizard welcome window, as shown in Figure 11-19. Click Next to 
continue.

Figure 11-19   Portal Update Installer wizard - welcome page

5. The wizard searches and shows you the applicable WebSphere Portal installation, as in 
Figure 11-20. Click Next to continue.

Figure 11-20   Portal Update Installer detects applicable portal installation
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6. You are now prompted to install either fix packs or fixes. Note that we install a fix, as 
shown in Figure 11-21. Click Next to continue.

Figure 11-21   Select fixes to install the iFix

7. Select the directory where the fixes are located. Select the directory where you have 
extracted the iFix.zip contents, as shown in Figure 11-22. Click Next to continue.

Figure 11-22   Selecting the directory where WebSphere Portal fixes reside
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8. The wizard now scans the directory for fixes to install. Select the fix, as shown in 
Figure 11-23. Click Next to continue.

Figure 11-23   Select the iFix to install

9. The wizard confirms the fix about to be installed, as shown in Figure 11-24. Click Next to 
continue.

Figure 11-24   Confirmation of the fix to be installed
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10.The federation fix is installed successfully, as shown in Figure 11-25. Click Finish to 
continue.

Figure 11-25   Federation fix has been applied to the WebSphere Portal successfully

Configure the federation fix on WebSphere Portal Server

Make sure that WebSphere Portal Server is running for this step. 

Access the directory <PortalServerRootDirectory>\bin subdirectory, and then run this 
command:

WPSconfig.bat init deploy-transformation-federation -DPortalAdminId=<wpsadminid> 
-DPortalAdminPwd=<wpsadminpwd>g

This command configures the federation fix we just installed on the WebSphere Portal 
Server.

Important: Perform this step for WebSphere Portal Server 6.0/6.0.0.1/6.0.1 installations.
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The command is shown in Figure 11-26 for your reference.

Figure 11-26   Configuring the WebSphere Portal Server for federation

The base steps required to prepare the WebSphere Portal Server for Lotus Domino 
administration have concluded. 

Download the addfederation.xml file from the Domino 8 Server

Download the addFederation.xml from this URL on the WebSphere Portal Server:

http://<dominoserver>/webadmin.nsf/addfederation.xml

Important: Perform this step for the WebSphere Portal Server 6.0/6.0.0.1/6.0.1 
installations.
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In the ITSO Corporation example, we download the addFederation.xml file, as shown in 
Figure 11-27. The file needs to be saved locally on the WebSphere Portal Server.

Figure 11-27   Downloading the addfederation.xml from the Domino server

Edit the addfederation.xml file

Note: addFederation.xml is available on the Lotus Domino 8 Servers only. It can be 
accessed only through the following URL:

http://<dominoserver>/webadmin.nsf/addfederation.xml

Important: Perform this step only for WebSphere Portal Server 6.0/6.0.0.1 installations.
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Edit the addfederation.xml file. This is required because WebSphere Portal 6.0 supports 
1.4.1.xsd and not 6.0.1.xsd. The changes made to the xml file are shown in Figure 11-28 and 
Figure 11-29 on page 374.

Figure 11-28   These changes need to be made to addfederation.xml
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Figure 11-29   Changed value in addfederation.xml

Execute the xmlaccess script to apply addfederation.xml to the
WebSphere Portal Server

Important: Perform this step for WebSphere Portal Server 6.0/6.0.0.1/6.0.1 installations.
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Execute the XML access command, as shown in Figure 11-30, to add the Domino server to 
the WebSphere Portal Administration UI.

xmlaccess.bat -in c:\addfederation.xml -user <wpsadminid> -password 
<wpsadminpwd> -url localhost:10038/wps/config

Figure 11-30   Executing the xmlaccess script to add Domino to Portal Administration interface

Note: The XML configuration command-line client is also called XMLAccess, which 
provides all the XML configuration interface functions in WebSphere Portal.
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Configure WebSphere Portal Server

WebSphere Portal Server also will be prepared in order to enable federated administration.

1. Launch the WebSphere Portal Admin Console, then select Resources → Resource 
Environment Providers. Select WP ConfigServer, as shown in Figure 11-31.

Figure 11-31   Select WP ConfigServer from list of available providers in WebSphere Administration Console

Important: Perform this step for WebSphere Portal Server 6.0/6.0.0.1/6.0.1 installations.

Note: By default, for accessing the WebSphere Portal Server 6 Administration console, 
you can use the following URL:

http://hostname:10027/admin

For Windows, you can also use Start → Programs → IBM WebSphere → 
Application Server → wp_profile → Administration Console.
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2. Once WP ConfigServer has been selected. Click Custom Properties, as shown in 
Figure 11-32.

Figure 11-32   Selecting custom properties
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3. Click New to add two new custom properties, as shown in Figure 11-33.

Figure 11-33   Creating new custom properties
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4. The first custom property to be added is called federation enabled. In the Name field enter 
federation enabled and in the Value field enter true, as shown in Figure 11-34. Click 
Apply and then Save.

Figure 11-34   Creating federation-enabled property
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5. Click New again to create the second custom property federation.useAbsoluteURLs. In 
the Name field enter federation.useAbsoluteURLs and in the Value field enter true, as 
shown in Figure 11-35. Click Apply and then Save.

Figure 11-35   Creating federation.useAbsoluteURLs property
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6. Both of the custom properties that you just created are shown in Figure 11-36.

Figure 11-36   Custom properties that were created recently
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7. Restart the WebSphere Portal Server. Once the WebSphere Portal Server has restarted, 
you can now log in to the Portal and go the Domino Integration page. You can view the 
Domino Web Administration UI that has been federated to the WebSphere Portal 
Administration UI, as shown in Figure 11-37.

Figure 11-37   WebSphere Portal and Domino federated administration

11.4  Domino 8 Administrator - Web administration server 
bookmarks

The Lotus Domino 8 administrator client contains a feature called Web administration server 
bookmarks. This allows the Lotus Domino 8 administrator client to connect to any remote 
administration console from a single administration interface to administer servers like 
WebSphere Portal, WebSphere Application Server, Sametime, Quickr™, or third-party 
software.
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11.4.1  Web administration server bookmarks configuration

Using our ITSO Corporation example, we plan to integrate the WebSphere Portal 
Administration Console with the Lotus Domino 8 administration client. The following steps are 
required:

1. Launch the Domino 8 administration client. Click Administration → Add Server to → 
Web Administration Bookmarks. This is shown in Figure 11-38.

Figure 11-38   Launching Web administration bookmarks
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2. ITSO Corporation’s WebSphere Portal Server (portal.itso.com) will be added to the Web 
administration bookmarks, as shown in Figure 11-39. The following values are provided:

– Server name: ITSO Portal

– Administration URL: http://portal.itso.com:10001/admin or 
http://portal.itso.com:10001/ibm/console

– Type of administration: WebSphere Portal

Figure 11-39   Adding Portal Server to Web administration bookmarks

Note: By default, for accessing the WebSphere Portal Server 6 administration console, 
you can use one of the following URL:

http://hostname:10027/admin 

http://hostname:10001/ibm/console
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3. You can now view the remote administration console of the WebSphere Portal Server 
through the Lotus Domino Administrator client, as shown in Figure 11-40.

Figure 11-40   WebSphere Portal administration console inside Domino Administrator using Web administration 
bookmarks

11.5  Composite applications - installation of SCI and home 
portal account

Notes 8 provides support for composite applications, a key element of IBM service-oriented 
architecture and contextual collaboration strategy. Composite applications combine 
components from multiple applications into a single, role-based work environment. 
Composite applications are a loose coupling of Eclipse components, Lotus Component 
Designer components, and Notes applications (known within composite applications as NSF 
components) encompassed within a single panel to create a unified view of disparate data.

Composite applications can potentially help increase return on investment by leveraging your 
existing technology, such as IBM WebSphere Portal and Lotus Domino infrastructures. NSF, 
Eclipse, and Lotus Component Designer Components, along with WebSphere Portal, can be 
brought together in context to deliver a single user experience by developing composite 
applications. You can also reuse previously developed Eclipse technology-based 
components within the composite applications hosted on Lotus Domino 8 software, helping to 
increase return on investment in application development tools and skills.
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Composite applications can be hosted from Lotus Domino servers or WebSphere Portal or as 
a local NSF. The composite application editor (CAE), provided as a feature in the Notes 8 
client, can be used to define or edit local NSF or Portal-based composite applications.

If you use WebSphere Portal as your hosting platform, you can create composite applications 
that can be accessed using a Web browser as well as a Lotus Notes 8 client. You can define 
your composite applications using either the CAE of Lotus Notes 8 or the application template 
editor provided with WebSphere Portal.

If you use Lotus Domino as your hosting platform, you can define your composite applications 
using the composite application editor of the Lotus Notes 8 client.

Configuration of the following components is required in order to use the composite 
application editor with Lotus Notes 8 and IBM WebSphere Portal Server:

� Home portal account - allows the CAE to access, edit, or use the templates and 
applications that reside on the WebSphere Portal to develop composite applications.

� Notes server client installer (SCI) - is used in conjunction with the home portal account 
when you wish to access the template and applications or install portlets created using 
NSF or Eclipse components on IBM WebSphere Portal. 

11.5.1  Home portal account

The home portal account is a unique account that allows the Notes 8 client to connect to 
composite applications that require a WebSphere Portal Server. The Domino Administrator 
can set up a home portal account for users. However, Lotus Notes 8 users can create and 
edit some elements of the account using the following procedure.

Note: Refer to 12.6, “Composite applications” on page 418, for more information.

For more details on composite applications you can also refer to Building Composite 
Applications, SG24-7367.

Tip: You can also use the security settings document to specify the home portal account 
preferences. Refer to the Domino 8 Administration Help topic Creating a Security Settings 
document.
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Configuring the home portal account
To set up a home portal account:

1. Click File → Preferences and click Home Portal Account, as shown in Figure 11-41.

Figure 11-41   Accessing the home portal account in File → Preferences
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2. Provide the details for the WebSphere Portal as shown in Figure 11-42. You would provide 
details as given in Table 11-2.

Table 11-2   Home portal account details

Figure 11-42   Providing home portal account details

Value Explanation

Server WebSphere Portal Server home URL. You can 
get this from your WebSphere Portal 
administrator.

Name WebSphere Portal administrator ID.

Password WebSphere Portal administrator password.
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11.5.2  Notes server client installer 

The Lotus server client installer installs portlets onto the WebSphere Portal Server and 
enables client communication between the WebSphere Portal Server and the Notes 8 client. 
The Notes server client installer program installs the .war files that are required by the CAE 
when working with the WebSphere Portal Server.

The Notes SCI is required if you plan to allow Notes 8 client’s CAE to be able access and edit 
a composite application using components from your WebSphere Portal Server.

This section discusses the prerequisites for SCI installation, and walks you through the SCI 
installation steps.

Prerequisites for Notes server client installer 
You must have a WebSphere Portal 6.0, 6.0.0.x, or 6.0.x installed and configured for this 
feature to work.

If your Web server or WebSphere Portal Server uses SSL you must perform additional steps 
before running the Notes server client installer to provide SSL communication between all the 
components. Refer to the readme file or Release Notes for more information:

http://www.ibm.com/developerworks/lotus/documentation/releasenotes

Tip: The URL for the WebSphere Portal Server should be:

http://portal.itso.com:10038/wps

Not: 

http://portal.itso.com:10038/

In case you are using a different port number for WebSphere Portal, use the appropriate 
port number.

Important: The administrator also needs a home portal account to utilize this feature. 
Refer to 11.5.1, “Home portal account” on page 386, for more information.
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SCI installation
The following steps are involved in the SCI installation:

1. Launch setupwin32.exe, as shown in Figure 11-43, from the directory where the 
installation package resides. Make sure that you are running this setup on the machine 
that has WebSphere Portal installed and configured.

Figure 11-43   Launching the installer
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2. This launches the installer and gives you the welcome window, as shown in Figure 11-44. 
Click Next to continue.

Figure 11-44   Welcome page

3. Click Yes to accept the license terms and conditions, as shown in Figure 11-45. Click Next 
to continue.

Figure 11-45   License agreement page
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4. Specify the path were you wish to install the package, as shown in Figure 11-46. Click 
Next to continue.

Figure 11-46   Path where the package needs to be installed

5. You are now prompted to provide details about the WebSphere Portal Server installation, 
as shown in Figure 11-47. Click Next to continue.

Figure 11-47   WebSphere Portal installation details

Tip: Make sure that the WebSphere Portal Server is running.
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6. The installer verifies the connectivity to WebSphere Portal. The installer is now ready to 
install the package, as shown in Figure 11-48. Click Install to continue.

Figure 11-48   Package is ready to be installed

7. On successful installation of the package you will be prompted to restart your WebSphere 
Portal Server, as shown in Figure 11-49. Click OK to continue.

Figure 11-49   WebSphere Portal restart is required
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8. Stop your WebSphere Portal Server as shown in Figure 11-50. 

Figure 11-50   Stop WebSphere Portal Server

9. After the WebSphere Portal Server has stopped, restart your WebSphere Portal Server as 
shown Figure 11-51. 

Figure 11-51   Start WebSphere Portal Server
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Figure 11-52 shows that the WebSphere Portal Server has been successfully started.

Figure 11-52   WebSphere Portal Server successfully started

Congratulations. Your SCI package on WebSphere Portal, which enables Notes 8 CAE to 
access applications and templates, has been successfully deployed.
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You can launch the Notes client and click Start → Portal Applications (as shown in 
Figure 11-53) to view the list of WebSphere Portal Applications (as shown in Figure 11-54) 
that can be used for composite applications. 

Figure 11-53   Launching the Notes client to test Portal applications

Figure 11-54   Portal applications shown in the Notes client for CAE
396 IBM Lotus Notes and Domino 8 Deployment Guide



Click Start → Portal Templates (as shown in Figure 11-55), which shows you the available 
portal templates (shown in Figure 11-56) for use in CAE.

Figure 11-55   Launching the Notes client to test portal templates

Figure 11-56   WebSphere portal templates shown in the Notes client for CAE use
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11.6  Summary

WebSphere Portal and Lotus Notes 8 integration like the Domino Portal Integration wizard 
help the administrator to reduce the time taken to do configuration tasks or set up the 
infrastructure.

Federation and Web administration bookmark features allow for ubiquity between 
WebSphere Portal and Domino Administrator with both supporting federation to each other’s 
native interface. This allows for ease of use and better UI for the administrator.

Using the Notes server client installer, you can reuse and deploy composite applications 
using WebSphere Portal, NSF, Eclipse, and Lotus Component Designer Components using 
the composite application editor in the Notes 8 client.

Important: Additional application development steps would be required to achieve the 
functionality shown in Figure 11-54 on page 396 and Figure 11-56 on page 397. Refer to 
Building Composite Applications, SG24-7367, for more information.
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Chapter 12. New application development 
features

Notes and Domino 8 provide some exciting new abilities for the application developer, from 
new design elements, formula language commands, and LotusScript commands, to the new 
worlds of composite applications and DB2 integration. In this chapter we discuss the new and 
enhanced features available to developers. 

This chapter describes the following:

� Design elements
� Formula language
� LotusScript
� Java
� Web applications and services
� Composite applications
� DB2 integration
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12.1  Design elements

Notes and Domino 8 provide significant improvements to Notes database design elements. 
Most of the enhancements have been made to views, giving the developer increased 
flexibility in how she chooses to display data and actions. There have also been a few 
important enhancements made to assist the developer in creating applications with less 
server overhead.

12.1.1  Views

Notes and Domino 8 provide the developer with several additions and enhancements to 
views. Many allow the developer to make her application more visually appealing and 
enhance the users’ overall usability experience, while one addition can aid in providing 
increased server performance.

Right-mouse menu
In Notes 7, application developers were given the ability to extend the functionality of the 
right-mouse menu to add view actions. These view actions would appear alongside the 
default right-mouse menu items such as cut, copy, paste, and so on. For example, ITSO Corp 
maintains an in-house developed help desk application. The application allows field support 
to modify tickets with a status of assigned, pending, and closed. Notes 7 allowed ITSO Corp 
to add these actions to the right-mouse menu, as shown Figure 12-1, providing quicker 
access to frequently used view actions.

Figure 12-1   Right-mouse menu with default items
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With Notes 8 you can now remove the default menu items. When coupled with the ability to 
add customized view actions this can help focus your users on the specific actions that you 
have made available. ITSO Corp has added this feature to its help desk application because 
many of the default menu items were not applicable to the application’s use. Now field 
support only sees the assigned, pending, and closed actions, making the application’s 
right-mouse menu less cluttered and easier to navigate, as shown in Figure 12-2.

Figure 12-2   Right-mouse menu without default items

To remove default menu items from the right-click menu:

1. Open the view in the Domino Designer and bring up the action bar properties.

2. Uncheck the field labeled Show Default Items in the right-mouse menu, as shown in 
Figure 12-3.

3. Save and close the view.

4. Refresh the design of the application.

Figure 12-3   Action bar properties

If the view contains actions that have the Include in Right Mouse Button Menu item checked, 
then only those items display in the right-mouse menu. Otherwise, no right-mouse menu 
displays. Because this option is set at the view level, each view in your database can display 
different right-mouse menus as appropriate.

Bytes column format
Prior to Notes 8, if you wanted to display numbers in a column as kilobytes (1024 bytes), 
megabytes (1024 kilobytes), gigabytes (1024 megabytes), or terabytes (1024 gigabytes), you 

Attention: Note that in Figure 12-2 the activities menu items are visible. This is because 
configuring a view to suppress the standard right-click menu items does not affect the 
display of items related to installed plug-ins, such as activities.
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had to write a formula for your column to handle the conversion from decimal number to a 
byte. Notes 8 does away with the need to create that customized formula by adding a new 
bytes format-type for number columns. This format displays values in kilobytes, megabytes, 
gigabytes, or terabytes where the number is followed by a K, M, G, or T, respectively.

In order to modify an existing number column or create a new one with this feature, open the 
column properties in the Domino Designer client and select the Advanced Format tab. The 
style must be set to Number and the number format must be set to Bytes (K/M/G), as 
displayed in Figure 12-4.

Figure 12-4   Byte number format column property

Decimal numbers are automatically converted to the most appropriate byte type of kilobyte, 
megabyte, gigabyte, or terabyte, depending on the size of the number being converted. For 
instance, you will not be able to choose to display all numbers as megabytes.

Numbers displayed in a bytes formatted column are rounded up or down as appropriate. For 
example, 0.01 rounds up to 1K. See Table 12-1 for examples of how numbers are displayed 
when the bytes number format is selected for a column.

Table 12-1   Examples of how numbers are displayed in a bytes-formatted column

Actual number Number as displayed in column

0.00 0K

0.01 1K

1535.00 1K

1536.00 2K

1048576.00 1M

6828709128.336 6.4G

16762054765445.1 15.2T
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Extend to use available window width
In previous releases of ND you were able to configure the view properties to extend the last 
column to fill the entire remaining width of the window. With Notes and Domino 8 you can now 
control which column extends to fill the window width, as shown with the Ticket column in 
Figure 12-5.

Figure 12-5   Ticket column extended to use width of window

Tip: Be aware that kilobytes display a bit differently from megabytes, gigabytes, and 
terabytes in a bytes-formatted number column. Kilobytes display as whole numbers and 
always round to the nearest whole number. For example, you might expect the number 
1535 to display as 1.4K. However, it actually rounds down to the nearest whole number 
and displays as 1K. Likewise, the number 1536 rounds up to 2K.

Megabytes, gigabytes, and terabytes round to the nearest tenth.
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To accomplish this, open the column properties of the column that you would like to extend. 
From the Advanced tab check the box labeled Extend to Use Available Window Width, as 
shown in Figure 12-6.

Figure 12-6   Extend to use available window width column properties

Deferred sort index creation
User-sorted columns in views and folders can increase server load during the view indexing 
process. To lessen this strain on the server, Notes and Domino 8 allow you to defer the 
creation of the view index for user-sortable columns. As soon as a user chooses to sort the 
view by one of these user-sortable columns, the view index is updated on-the-fly. Because 
you may have some columns that are sorted infrequently, you can choose to enable index 
deferment only for those specific columns, thus allowing the frequently used sortable columns 

Important: The Extend Last Column to Window Width setting in the view properties 
overrides the extend setting in the column properties. Therefore, if a column in a view is set 
to extend to window width and the view is set to extend the last column, the last column is 
extended.
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to be indexed by the server as normal. This avoids causing a performance lag for frequently 
used user-sortable columns, while at the same time decreasing server overhead by deferring 
the index of user-sortable columns that are rarely used. The deferment option is available in 
the column properties Sorting tab only when the Click on Column Header to Sort option is 
enabled, as shown in Figure 12-7.

Figure 12-7   Defer index creation until first use

12.1.2  Forms

In Notes and Domino 8 there is a new form design element that allows thumbnails to be 
added to rich text lite fields.

Tip: Indicies created by deferred sort obey the index discard rules as set in the view 
properties. The default is to discard inactive indices after 45 days.

To manually discard the indicies for deferred sort columns only, the following command 
can be issued at the Domino console:

load updall <dbname> -r -g
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Thumbnails
With Notes and Domino 8 you can now include thumbnails of photo attachments in your 
documents. A great example of this new feature is found in the contact form of the Notes 8 
contacts application, as shown in Figure 12-8.

Figure 12-8   Thumbnail photo from contact form in the Notes 8 contacts application

The thumbnail photo of Betty is displayed in a thumbnail rich text lite field. To add this to your 
own application you will need to create a rich text lite field in the desired form:

1. In the field properties Control tab, select the Thumbnail option in the limit input’s Only 
Allow field. Figure 12-9 shows the photo field properties from the contact form that was 
displayed in Figure 12-8.

Figure 12-9   Photo field properties showing the Thumbnail option
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2. (Optional) By checking the Resize Thumbnail Image in Pixels check box you can control 
the size of the thumbnail when it is first imported into the document. If not checked, the 
image is imported at its full size.

3. The Image Attachment Name field is used to assign the imported image a file name. Even 
though the imported image already has a file name outside of Notes, inside Notes the 
imported image is saved as an attachment in a $FILE field. Because of this, the Rich Text 
Lite thumbnail field needs to know the attachment name in order to reference it. This is 
done by renaming the imported photos with a file name that you supply in the Image 
Attachment Name field. In the contact application’s contact form, the imported images are 
renamed to ContactPhoto, as shown in Figure 12-9 on page 406. You can use any file 
name that you wish.

12.1.3  Agents

In Domino 8, agents can be set to run at Domino server startup.

When server starts runtime trigger
With the new runtime trigger when server starts, agents can now be configured to run only 
when the server starts. This is significant in that it does not allow agents with this trigger to 
run at any other time, including times when Agent manager is restarted. To configure an 
agent to only run at server start, you must set the agent properties Runtime Trigger to On 
Event and then select When Server Starts from the drop-down menu, as shown in 
Figure 12-10.

Figure 12-10   When server starts agent runtime trigger

Note: By applying a consistent size to user-supplied graphics and photos you can 
enhance your application’s user interface.

Important: A thumbnail Rich Text Lite field may only contain thumbnails. Checking the 
Thumbnail option automatically unchecks all other options.
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12.2  Formula language

Over the past several releases of Notes and Domino, the formula language has made great 
strides in becoming a more robust language. Notes and Domino 8 is no exception, with 
several additions made to the formula language. For a more complete and detailed 
description of how to use these improvements refer to the Domino Designer 8 Help.

@URLQueryString
This function has been enhanced to now compose dynamic DB2 query views.

@GetViewInfo([IsViewFiltered])
This new attribute to the @GetViewInfo function can be used to determine whether 
@SetViewInfo has been used to filter documents from a view.

@Command([CopySelectedAsTable])
This is a new function that can be used to copy selected entries as a table.

@Command([OpenInNewWindow])
This is a new function that can be used to open a document into a new window.

@Command([CalendarFormat])
This function has been modified to provide two work week and one work month formats.

12.3  LotusScript

The powerful programming language that is at the heart of Notes and Domino applications, 
LotusScript, has seen a number of enhancements and significant additions in Notes and 
Domino 8.

12.3.1  Statements

The modified statements to LotusScript in Notes and Domino 8 are listed below. For a more 
complete and detailed description of how to use these statements refer to the Domino 
Designer 8 Help.

Date
While this statement is not new, note that it is not valid on systems using the UNIX or 
Macintosh OS X operating system.

Time
Just as with the date statement, the time statement is not valid on systems using the UNIX or 
Macintosh OS X operating system.

Write
The write statement no longer has a limit to its line length. Previously this limit was 255 
characters.
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12.3.2  Classes, methods, properties, and events

The new and modified classes, methods, properties, and events to LotusScript are listed 
below. For a more complete and detailed description of how to use these refer to the Domino 
Designer 8 Help.

NotesAdministrationProcess class
AddInternetCertificateToUser method
This new method can be used to add a request into the administration requests database to 
add an Internet certificate to a user ID.

NotesDatabase class
GetAllReadDocuments method
This new method can be used to create a NoteCollection of all read documents in a database. 
You can specify whether to get all read documents of the current ID in use or a specified user 
name.

GetAllUnreadDocuments method
This new method can be used to create a NoteCollection of all unread documents in a 
database. The developer can specify whether to get all unread documents of the current ID in 
use or a specified user name.

GetProfileDocCollection method
This method has been modified so that now the name of the profile document is optional. By 
not supplying a profile document name, all profile documents are returned in a 
DocumentCollection.

UnprocessedDocuments property
This property has been modified so that it can now run before new mail arrives and after new 
mail arrives.

NotesDirectory class
This is a new class used to represent directories on a Domino server or local computer. The 
directories are associated with NotesDirectoryNavigators. For a list of all properties and 
methods associated with this class refer to the Domino Designer 8 Help.

NotesDirectoryNavigator class
This is a new class used to preform lookups associated with a NotesDirectory. For a list of all 
properties and methods associated with this class refer to the Domino Designer 8 Help.

NotesDocument class
MarkRead method
This new method marks the document as read by the current ID in use or a specific user 
name.

MarkUnread method
This new method marks the document as unread by the current ID in use or a specific user 
name.
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NotesDocumentCollection
Clone method
This new method returns a copy of the document collection in a NotesDocumentCollection 
object.

Contains method
This new method indicates whether the document collection contains a NotesDocument or all 
of the documents in a NotesDocumentCollection passed to it.

Intersect method
This new method removes any documents in the collection that are not contained in a 
secondary collection.

MarkAllRead method
This new method marks all the documents in the collection as read by the current ID in use or 
a specific user name.

MarkAllUnread method
This new method marks all the documents in the collection as unread by the current ID in use 
or a specific user name.

Merge method
This new method adds to the collection those documents that are not contained in the 
collection but that are contained by a secondary collection.

Subtract method
This new method removes documents from the collection that are also contained by a 
secondary collection.

NotesDXLExporter class
AttachmentOmittedText property
This new property can be used to insert text were an <attachmentref> has been omitted.

MIMEOption property
This new property can be used to specify whether MIME items are exported as a <mime> 
element or <rawitemdata> element contained within an <item> element.

OLEObjectOmittedText property
This new property can be used to insert text were an <objectref> has been omitted.

OmitItemNames property
This new property can be used to specify a list of item names to be omitted from the DXL 
export.

OmitMiscFileObject property
This new property can be used to omit miscellaneous file objects that are found in 
documents.

OmitOLEObjects property
This new property can be used to omit OLE objects that are found in documents.
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OmitRichtextAttachments property
This new property can be used to omit richtext attachments that are found in documents.

OmitRichtextPictures property
This new property can be used to omit richtext graphics that are found in documents.

PictureOmittedText property
This new property can be used to insert text were a <picture> has been omitted.

RestrictToItemNames property
This new property can be used to specify which item names from a document should be 
included in the exported DXL.

RichTextOption property
This new property can be used to specify whether richtext items are exported as a <richtext> 
element or <rawitemdata> element.

UncompressAttachments property
This new property can be used to specify wither to uncompress Huffman or LZ1 compressed 
attachments that occur within the exported DXL.

NotesDXLImporter class
CompileLotusScript property
This new property can be used to specify whether to compile any LotusScript code that is 
contained within the imported DXL.

NotesProperty class
This new class is used to represent a single property from a composite application. For a list 
of all properties and methods associated with this class refer to the Domino Designer 8 Help.

NotesPropertyBroker class
This new class is used to handle communications between composite application 
components. For a list of all properties and methods associated with this class refer to the 
Domino Designer 8 Help.

NotesSession class
GetDirectory method
This new method is used to create a NotesDirectory object.

GetPropertyBroker method
This new method is used to populate the NotesPropertyBroker object with the session’s 
property broker.

NotesUIScheduler class
DisplayCheckboxes property
This new property can be used to determine whether the scheduler display includes check 
boxes to toggle participants inclusion.
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NotesUIView class
Onselect event
This new event occurs in a view when a document is highlighted, selected, or deselected.

NotesUIWorkspace class
OutlineReload method
This new method can be used to reload the outline.

NotesView class
CreateViewNavFromAllRead method
This new method can be used to create a view navigator based on all read documents in a 
view. Read documents can be determined for the current ID in use or a specific user name.

CreateViewNavFromAllUnread method
This new method can be used to create a view navigator based on all unread documents in a 
view. Unread documents can be determined for the current ID in use or a specific user name.

GetAllReadEntries method
This new method can be used to populate a NotesViewEntryCollection with all read 
documents in a view. Read documents can be determined for the current ID in use or for a 
specific user name.

GetAllUnreadEntries method
This new method can be used to populate a NotesViewEntryCollection with all unread 
documents in a view. Unread documents can be determined for the current ID in use or for a 
specific user name.

MarkAllRead method
This new method can be used to mark all documents in the view as read by the current ID in 
use or a by specific user name.

MarkAllUnread method
This new method can be used to mark all documents in the view as unread by the current ID 
in use or a by specific user name.

NotesViewEntryCollection
Clone method
This new method returns a copy of the NotesViewEntryCollection in a new 
NotesViewEntryCollection object.

Contains method
This new method indicates whether a NotesViewEntryCollection contains the 
NotesDocument or all of the documents in a NotesViewEntryCollection passed to it.

Intersect method
This new method removes any documents in the collection that are not contained in a 
secondary collection.

MarkAllRead method
This new method marks all the documents in the collection as read by the current ID in use or 
by a specific user name.
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MarkAllUnread method
This new method marks all the documents in the collection as unread by the current ID in use 
or a by specific user name.

Merge method
This new method adds to the collection those documents that are not contained in the 
collection but that are contained by a secondary collection.

Subtract method
This new method removes documents from the collection that are also contained by a 
secondary collection.

NotesViewNavigator class
MarkAllRead method
This new method can be used to mark all documents in a view navigator as read.

MarkAllUnread method
This new method can be used to mark all documents in a view navigator as unread.

12.3.3  DXL

Domino eXtensible Markup Language (XML), or DXL, is a powerful method used to represent 
Domino data in XML format. DXL can be used to move data outside of the Domino framework 
in order to allow non-Domino applications to access and possibly manipulate the data, thus 
leveraging your Domino infrastructure and databases in a whole new way.

Since its introduction in Domino 6, several new enhancements have been made to DXL, and 
they can all be found in 12.3.2, “Classes, methods, properties, and events” on page 409, and 
12.4.2, “Java/CORBA” on page 414.

12.4  Java

As with LotusScript, Notes and Domino 8 provide improvements to Java such as support for 
Java 5 and enhancements to the Java/CORBA API.

12.4.1  Java 5 support

Notes and Domino 8 bring with it the new IBM Java SE technology. The benefits of this new 
technology include:

� Use of Java 5 syntax
� Improved garbage collector
� Increased reliability
� Just-In-Time (JIT) compiler

Note: For more information about Java 5 support, refer to the Domino Design 8 Help.
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12.4.2  Java/CORBA

The new and modified classes, methods, properties, and events to Java/CORBA are listed 
below. For a more complete and detailed description of how to use these refer to the Domino 
Designer 8 Help.

AdministrationProcess class
addInternetCertificateToUser method
This new method can be used to add a request to the Administration Requests database to 
add an Internet certificate to a user ID.

AgentContext class
UnprocessedDocuments property
This property has been modified so that it can now run before new mail arrives and after new 
mail arrives.

Database class
getAllReadDocuments method
This new method can be used to create a document collection of all read documents in a 
database. The developer can specifiy whether to get all read documents of the current ID in 
use or a specified user name.

getAllUnreadDocuments method
This new method can be used to create a document collection of all unread documents in a 
database. The developer can specifiy whether to get all unread documents of the current ID in 
use or a specified user name.

Document class
markRead method
This new method marks the document as read by the current ID in use or a by specific user 
name.

markUnread method
This new method marks the document as unread by the current ID in use or a by specific user 
name.

DocumentCollection class
markAllRead method
This new method marks all documents in a collection as read by the current ID in use or by a 
specific user name.

markAllUnread method
This new method marks all documents in a collection as unread by the current ID in use or by 
a specific user name.

DXLExporter class
attachmentOmittedText property
This new property can be used to insert text were an <attachmentref> has been omitted.
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MIMEOption property
This new property can be used to specify whether MIME items are exported as a <mime> 
element or <rawitemdata> element contained within an <item> element.

OLEObjectOmittedText property
This new property can be used to insert text were an <objectref> has been omitted.

omitItemNames property
This new property can be used to specify a list of item names to be omitted from the DXL 
export.

omitMiscFileObjects property
This new property can be used to omit miscellaneous file objects that are found in 
documents.

omitOLEObjects property
This new property can be used to omit OLE objects that are found in documents.

omitRichtextAttachments property
This new property can be used to omit richtext attachments that are found in documents.

omitRichtextPictures property
This new property can be used to omit richtext graphics that are found in documents.

pictureOmittedText property
This new property can be used to insert text were a <picture> has been omitted.

restrictToItemNames property
This new property can be used to specify which item names from a document should be 
included in the exported DXL.

richTextOption property
This new property can be used to specify whether richtext items are exported as a <richtext> 
element or a <rawitemdata> element.

DXLImporter class
compileLotusScript property
This new property can be used to specify whether to compile any LotusScript code that is 
contained within the imported DXL.

View class
createViewNavFromAllRead method
This new method can be used to create a view navigator based on all read documents in a 
view. Read documents can be determined for the current ID in use or for a specific user 
name.

createViewNavFromAllUnread method
This new method can be used to create a view navigator based on all unread documents in a 
view. Unread documents can be determined for the current ID in use or a specific user name.
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getAllReadEntries method
This new method can be used to populate a view entry collection with all read documents in a 
view. Read documents can be determined for the current ID in use or for a specific user 
name.

getAllUnreadEntries method
This new method can be used to populate a view entry collection with all unread documents 
in a view. Unread documents can be determined for the current ID in use or for a specific user 
name.

markAllRead method
This new method can be used to mark all documents in the view as read by the current ID in 
use or by a specific user name.

markAllUnread method
This new method can be used to mark all documents in the view as unread by the current ID 
in use or by a specific user name.

ViewEntryCollection
markAllRead method
This new method marks all the documents in the collection as read by the current ID in use or 
by a specific user name.

markAllUnread method
This new method marks all the documents in the collection as unread by the current ID in use 
or by a specific user name.

ViewNavigator
markAllRead method
This new method can be used to mark all documents in a view navigator as read.

markAllUnread method
This new method can be used to mark all documents in a view navigator as unread.

12.5  Web applications and services

The realm of Web applications and Web services has seen a number of useful enhancements 
in Notes and Domino 8.

12.5.1  Web applications

The main enhancements to Web applications in Notes and Domino 8 revolve around the 
URL, which is the entrypoint into all Web applications. The Universal Resource Locator or 
Uniform Resource Locator, most commonly referred to as the URL, has seen improvements 
in the ReadViewEntries command and the Request_Connect_nnn CGI variable.

ReadViewEntries
The ReadViewEntries command is used in the URL to access data from the view in XML 
format. This data is returned without appearance attributes such as fonts or HTML. 
ReadViewEntries has been given the following new optional arguments.
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Endview=1
When this argument is added to ReadViewEntries, the last document returned will be the last 
document in the view. For example:

http://la.itso.com/names.nsf/DDC087A8ACE170F8852562F30070226400000196?ReadViewEntr
ies&Endview=1

Keytype=text|time|number
The Keytype argument, which is used to specify the type of StartKey, could previously be set 
to text or time, but now in Notes and Domino 8 it can be set to number, allowing the StartKey 
to be treated as a numerical value. For example:

http://la.itso.com/names.nsf/DDC087A8ACE170F8852562F30070226400000196?ReadViewEntr
ies&StartKey=312&Keytype=number

NavigateReverse=1
This new argument allows you to navigate the rows of the view in reverse order. For example:

http://la.itso.com/names.nsf/DDC087A8ACE170F8852562F30070226400000196?ReadViewEntr
ies&NavigateReverse=1

Outputformat=JSON
The view being read will be displayed in JavaScript Object Notation (JSON) format. For 
example:

http://la.itso.com/names.nsf/DDC087A8ACE170F8852562F30070226400000196?ReadViewEntr
ies&Outputformat=JSON

CGI variables
One new CGI variable, Request_Content_nnn, has been added. This new variable is used 
when the HTTP Post request exceeds 64 K. The first 64 K will be sent in 
Request_Content_000, the second 64 K in Request_Content_001, and so forth, until all data 
has been sent.

12.5.2  Web services

A Web service is a standard form of communication between software applications, even if 
those applications are running on different computing platforms. Web services are part of an 
overall approach to building systems and applications based on the concept of a repeatable 
business task or service, also known as a service-oriented architecture (SOA). This type of 
architecture allows applications to share data via the invocation of each other’s services. Web 
services are not new to Domino 8. In fact, Domino 7 introduced this form of software 
communication by including the ability to host Web services natively. Notes and Domino 8 
take Web services to the next logical step by providing the ability to consume Web services.

Providing Web service consumer support in Notes and Domino 8 allows developers the 
option to use, or consume, Web service components rather than re-writing code that may 
already exist to preform the function they need. For instance, using the ITSO Help Desk 
application from above as an example, the developer may want to provide the contact 
information of the caller with the ticket details. If a non-Notes application contains the contact 
information and is hosting a Web service that allows contact data to be queried, the developer 
of the ITSO Help Desk would only need to call this Web service to retrieve the contact data, 
rather than writing all new code to interface with the non-Notes data.
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Unlike Web server hosting, Web service consumability does not require a Web service design 
element. Instead, a script library is created, either using LotusScript or Java, to call the Web 
service.

When creating this script library you will need:

� Access to the Web services Description Language, WSDL) file that is associated with the 
Web service. The WSDL file, which contains the various attributes and method of the Web 
service in XML format, should be easily obtained, as it is the interface into the Web 
service.

� To create individual script libraries for each Web service to be consumed.

� To use the script libraries in your application to call the Web services.

12.6  Composite applications

Composite applications are a loose coupling of Eclipse components, Lotus Component 
Designer components, and Notes applications (known within composite applications as NSF 
components) encompassed within a single panel to create a unified view of disparate data. 
Utilizing this powerful approach to displaying data can yield interconnections that may have 
previously been difficult to uncover when the components were disconnected and displayed 
within their own independent panels.

Not unlike Web services, composite applications are an extension of a service-oriented 
architecture. A composite application is a set of related and integrated services that support a 
business processes built on an SOA.

A composite application can be thought of as a window in your home that is divided into 
multiple panes of glass. Each pane can possibly stand on its own and show you a portion of 
your yard, but when put together with other panes of glass within the framework of the 
window you are able to see the entire yard. A composite application is simply the framework. 
Each pane of glass represents a component in the composite application.

Each component in the composite application can be, and usually is, a fully functional 
stand-alone application. When acting as composite application components, they are loosely 
coupled together with other stand-alone applications through a process known as wiring. The 
wiring of one component to another is the process that transforms individual components into 
a composite application. Via the wiring process, when the state of one component is 
changed, any other component that is wired to it will also change, if appropriate, to display 
data that is related. Composite applications only contain the wiring and display information 
that tie the component together. The components themselves remain as independent entities 
that can still be used alone or in other composite applications.

As a Notes developer trying to grasp the concept of composite applications, it may help to 
compare it to something you already know: framesets. In Notes, a frameset allows you to split 
a Notes application window into multiple frames, where each frame displays a different 
element of the application. Frames are, in essence, wired together so that a change in state 
in one frame causes an appropriate change in state in an associated frame. Framsesets are 
commonly used for navigational purposes where the frameset is divided into two frames. 
There is usually a navigational frame on the left that displays the view navigation or outline, 
and a view frame on the right that displays the currently selected view. Selecting a different 

Note: Refer to “Creating Web Service Consumers” in the Domino Designer 8 Help for 
more details.
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view in the navigation frame changes the view displayed in the view frame. That said, 
composite applications give you greater flexibility and functionality than framesets, such as 
the ability to wire an NSF component to an Eclipse component. Furthermore, framesets are 
tightly coupled together, whereas composite applications are not. And if you think you have 
never used a composite application before, think again. If you have the Notes 8 client 
installed with the Notes 8 mail template, that is not a frameset you are looking at, it is a 
composite application. Figure 12-11 shows a Notes 8 mail database in the composite 
application editor.

Figure 12-11   Notes 8 mail application in the composite application editor

Composite applications can contain any combination of NSF and Eclipse components, 
including those created in the Lotus Component Designer. For instance, a composite 
application does not need to contain an NSF component wired to an Eclipse component, but 
rather could be two or more NSF components wired, even if those components are from the 
same Notes application. Furthermore, composite applications can be hosted on a Domino 
server or a WebSphere server, or can even be hosted locally.

To create a composite application on a Domino server you need rights sufficient to create 
databases on the server.

Notes Mail Navigator Notes Mail View

Notes Mail Mini View

Tip: Composite applications have no server requirements to function. Neither a 
WebSphere Portal Server nor a Domino server is necessary. Composite applications can 
be created, saved, and opened locally.
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Composite applications provide you with the ability to tap into previously unreachable 
resources within your IT infrastructure to begin creating business applications. Coupled with 
Notes and Domino’s strength in collaboration, you can begin to leverage your entire 
infrastructure in a more dynamic and compelling manner.

12.6.1  Component communication

Communication is powered by the wiring of components. Without communication, 
components remain stagnant. With communication, components are lively and responsive to 
the changes occurring within other components. So just how do components have these 
important chats with each other? To begin with, components can both talk and listen. 
Components that talk are known as publishers, while components that listen are known as 
consumers. A component can be both a publisher and a consumer. Because components are 
intended to be reusable, communication between them is relatively simplistic.

Important: Composite applications require the Lotus Expeditor framework and therefore 
cannot be opened in the Notes 8 Basic client or any pre-Notes 8 client.
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Figure 12-12 depicts the wiring between three Notes databases, each with its own 
component:

� Database 1 contains a component that is a publisher. When it publishes data, the property 
broker ensures that database 2, which has a consumer component wired to database 1, 
receives the data.

� The consumer component in database 2 takes action on the data by publishing new data. 
The property broker ensures that the consumer component in database 3, which is wired 
to the publisher component in database 2, receives the data.

� Database 3 contains a consumer component that takes action on the data received from 
database 2.

Figure 12-12   Component communication

The creation of components can be done in total isolation, meaning that knowledge of what 
the consuming components will do with the data is irrelevant to the creation of a component 
that publishes data. You could be asked to turn certain views of your application into a 
publishing component without ever knowing, or needing to know, who will be consuming that 
published data or what they will be doing with it.

Wiring 

Consumer 
Property Broker

Publisher &
Consumer

Publisher
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For example, the ITSO Corp Help Desk application was architected to intentionally exclude 
the caller’s contact data. All ITSO employee contact data is contained within the Domino 
directory. Therefore, it was considered that adding it to the help desk application would be a 
duplication of data and effort. However, this design has lead to the field support engineers 
spending more time everyday looking up contact data than they really should. Typically, an 
engineer will open the help desk application, find his assigned tickets, note down the caller’s 
name, and then switch to the Domino directory to find the caller’s contact data. With 
composite applications you can make this process easier and faster for them by creating a 
composite application that links the trouble tickets to the caller’s contact information in the 
Domino directory.

Retrofitting existing applications to make use of composite applications is really rather simple. 
The steps to accomplish this are outlined in 12.6.2, “Creating a composite application” on 
page 423, but for now let us look at the task at a higher level. First, the help desk application 
developer creates a component that publishes a trouble ticket’s user name when a trouble 
ticket is selected in the Tickets by Status view. Next, the Domino directory is modified to listen 
for a user’s name and return that user’s contact information.

The composite application developer may or may not have been involved with creating these 
components, but this is irrelevant, as his only concern is that these components exist. At this 
point, his task is actually quite simple. Simple enough, in fact, that a user with sufficient 
knowledge and rights can create the composite application herself. 

The following is a high-level overview of the steps to bring these two components together 
into a single, unified application:

1. Start by creating a new composite application using the blank composite application 
template.

2. Utilizing the composite application editor, bring the two components into the composite 
application.

3. Wire the components together thus creating a communication path between the 
components.

The wiring process loosely couples the publishing component to the consuming component. 
Therefore, when the help desk application component publishes a user name, the Domino 
directory component consumes it and displays the user’s contact information in its specified 
area of the window.

Components speak in their own language based on properties, actions, and datatypes that 
are defined in a Web Services Description Language (WSDL) file. When a component 
publishes data, it is the IBM Lotus Notes/Expeditor property broker that ensures that the 
appropriate components consume the data so that action can be taken. The property broker 
does not intervene, it simply ensures that communication is taking place. When the publishing 
component publishes data, the property broker takes this data and hands it off to the wired 
consumer component. The consumer component is then responsible for acting on the data. 
These are three separate, loosely coupled, and distinct processes.

The WSDL files used with composite applications are different from the ones used for Web 
services. These WSDL files are used to declare and define the properties, actions, and 
datatypes used by components to communicate. The property broker editor feature of the 
Domino Designer 8 client provides developers with an interface for defining properties, 
actions, and datatypes without requiring WSDL knowledge.

The component publishing and consuming process is created with standard Domino 
programming languages, which minimize the learning requirements for developers who are 
already familiar with Domino programming. For example, NSF components can be 
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programmed in LotusScript or Java utilizing the new NotesProperty and NotesPropertyBroker 
classes.

12.6.2  Creating a composite application

In this section, we use the ITSO Corp environment to describe how existing applications can 
be used within a composite application.

The two applications that we modify are the ITSO help desk application and the Domino 
directory. Both are standard NSF databases that utilize forms, views, LotusScript, formula 
language, and all the other usual design elements that make up a Notes application. Users 
can still open and use each database exactly as they did prior to the modifications we make. 
We simply add an additional layer of functionality for these existing applications to use when 
displaying data. The underlying structure, code, or functionality of the application itself does 
not change.

Our goal is to provide a quick, easy method for ITSO field support engineers to find the 
contact information associated with their trouble tickets. The end result will match 
Figure 12-13.

Figure 12-13   ITSO field support help desk composite application
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Creating a publisher component
Our first step is to create the component that publishes data. A consensus of how ITSO Corp 
field engineers perform their daily functions revealed that most engineers look in the Tickets 
by Status view on a regular basis. Using this knowledge it has been decided that we will use 
this view to make our publisher component. The goal is to create a component that publishes 
the user name associated with the selected trouble ticket. The published name will be used 
later in “Creating a consumer component” on page 431.

Create a new WSDL file
We begin the process by creating the wiring properties. This process automatically creates 
the WSDL file for the publisher component of the help desk application. 

1. We start by opening the help desk application in the Domino Designer 8 client.

2. We select the Composite Applications → Wiring Properties view, as shown in 
Figure 12-14.

Figure 12-14   Wiring properties view

Note: The following example is intended to provide an understanding of the component 
creation process. Other considerations such as window real estate, Eclipse components, 
or more advanced techniques are not discussed. For a full understanding of composite 
applications, refer to Building Composite Applications, SG24-7367:

http://www.redbooks.ibm.com/redpieces/abstracts/sg247367.html
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3. We click the New Wiring Properties button, as shown in Figure 12-15.

Figure 12-15   New Wiring Properties button

4. In the dialog we give the property the name HelpDeskContacts, as shown in Figure 12-16, 
and click OK.

Figure 12-16   Naming the wiring property

The WSDL file has now been created and is embedded in the HelpDeskContacts wiring 
properties design element.

Important: Because the WSDL file is embedded in the database itself, NSF-based 
composite applications do not require provisioning in order to become available to the 
user, but rather are accessible just as any other Notes database.
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Create the property
Now that the WSDL file has been created, we must assign some properties and actions to it. 
Without properties and actions, the WSDL file has no functionality.

1. We now select the new wiring property created in “Create a new WSDL file” on page 424 
and click the Open File button, as shown in Figure 12-17. This launches the property 
broker editor (PBE).

Figure 12-17   Open the wiring properties WSDL file
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2. Our WSDL file is now opened in the PBE. Our first task is to create a new property from 
within the Property tab. As you can see in Figure 12-18, our property has been named 
HelpDeskContacts and its type is string. We also gave it a title and description.

Figure 12-18   Property broker editor: new property
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3. We now create an action that will make use of our new property. This is handled in the 
Actions tab, as shown in Figure 12-19. We name our action PublishContactsAction with an 
action input parameter based on our HelpDeskContacts property that was created in step 
2 on page 427.

Figure 12-19   Property broker editor: new action

4. After saving our changes and exiting the PBE, we now have a WSDL file that we can use 
to create an NSF component.

Note: The action name, title, and description entered into the property broker editor 
also display in the composite application editor.
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Modifying the Notes database
You will notice that in Figure 12-19 on page 428 at the bottom of the window there is a 
Location field with a lengthy file path. At the end of the file path there is mention of the file 
~HelpDeskContacts.wsdl. When we launched the PBE in step 1 on page 426, our embedded 
WSDL file, HelpDeskContacts.wsdl, was detached from the wiring properties design element 
and placed in a temporary location on our local hard drive. It is this file that we were working 
within the PBE. We must now refresh the embedded file in the wiring properties design 
element with the modified WSDL file located on our hard drive.

1. With modifications to the WSDL file complete (refer to “Create the property” on page 426), 
we go back to the Composite Applications → Wiring Properties view in the Domino 
Designer 8 client so that we can refresh the embedded WSDL file with the modified file 
located on our hard drive.

2. We select our HelpDeskContact wiring property and click the Refresh button, as shown 
in Figure 12-20.

Figure 12-20   Refresh WSDL file in the wiring properties design element

Attention: Do not forget to refresh your wiring properties after modifying and saving the 
WSDL file in the property broker editor, otherwise the changes will not be available to your 
component.
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3. Clicking Refresh causes the Open dialogue box to display, as shown in Figure 12-21. 
Within the dialogue box we navigate to our WSDL file and click the Select button. With the 
embedded WSDL file in our wiring properties design element now updated, we are ready 
to modify our application to begin publishing data.

Figure 12-21   Refresh WSDL open dialogue box

4. We have decided that we want the Ticket By Status view to publish the customer name. 
Within the designer client, we open the Tickets By Status view.

Tip: Notice that in Figure 12-20 the wiring properties is aware that the detached WSDL 
file has been opened through the property broker editor and indicates that a refresh 
may be necessary by the display of the blue, rounded refresh arrow to the left of the 
wiring properties design element name.
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5. This view already contains a Customer column, but it displays the customer’s common 
name for better readability by the user. We know that in large environments, using the 
common name is not the best choice for programmatic usage due to the high possibility of 
ambiguous names. Therefore, we decide to add a hidden column to display the customer 
name in an abbreviated hierarchical format. You can see this new column in Figure 12-22.

Figure 12-22   Tickets by Status view with new hidden Customer column

With our WSDL file created and embedded in the database, and a column in place that will 
publish data that we have decided to be of value, we are now ready to create a consumer 
component to take advantage of this newly available data source.

Creating a consumer component
In “Creating a publisher component” on page 424 we created a component that publishes 
data. We now create a component that consumes that data and does something useful with it.

Note: Using a fully canonical name as opposed to abbreviated canonical name would 
work just as well.
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Importing the WSDL file
The first step to creating a consumer component is the creation of a WSDL file, just as it is the 
first step to creating a publisher component. In our example, we simply import the publisher 
component’s WSDL file rather than create a new one. This brings along with it the publisher 
component’s properties and actions.

1. We open the database that acts as the consuming component in the Domino Designer 8 
client. In our example, we modify the Domino directory to become the consumer because 
it contains the contact data for all of our domain’s users.

2. We start by selecting the Domino directory’s Composite Applications → Wiring 
Properties view, as shown in Figure 12-23.

Figure 12-23   Wiring Properties view in the ITSO Directory
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3. Click the Import WSDL button, as shown in Figure 12-24.

Figure 12-24   Import WSDL button

4. Within the Open dialogue box, we navigate to the HelpDeskContact.wsdl file, as shown in 
Figure 12-21 on page 430, and click the Open button.

With the WSDL file embedded in the Domino directory, we are now ready to begin creating 
our consumer component.

Tip: If you ever update the WSDL file by adding more properties, datatypes, or actions, be 
sure to refresh the wiring properties design element across all database templates that 
include this WSDL file and refresh the design of your application with the modified 
template. Keep in mind that this WSDL file is distributed and that your templates will not 
automatically refresh just because the WSDL file has been modified. This means that a 
frequently modified WSDL file can quickly become out of date, especially if it is distributed 
amongst a large number of applications.
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Creating the component’s front end
We now need to create a user interface for this component. It will consist of a view to display 
the contact data for each person document as well as a form with this new view embedded 
within it. These two elements will make up this component’s front end.

1. We begin by creating a new view. This view will display person documents categorized by 
the first entry of the FullName field. The categorized column will be hidden.

2. We create a column named Contact Data with a simple formula column value that will 
display the contact data for each document. The column value is shown in Example 12-1.

Example 12-1   Contact Data column value

CityStateZip := OfficeCity + ", " + OfficeState + " " + OfficeZip;

OfficeStreetAddress:
CityStateZip:
OfficeCountry

3. We also modify the visible column properties to display larger fonts for a more pleasing 
display within the component. The view is named “(CategorizedPeople)”, as shown in 
Figure 12-25.

Figure 12-25   CategorizedPeople view

Note: In this section we discuss only those concepts that are new to ND for the purpose of 
building composite applications. If you are new to Domino development, refer to the 
Domino Designer 8 Help for more information.
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4. We create a form named “(CustomerContactData)”.

5. In the form, we create a field named “Customer”. This is a hidden field.

6. An embedded view element is created to display the “(CategorizedPeople)” view created 
in step 1 on page 434. We populate the show single category object of the embedded 
view element with an entry of Category. Therefore, whenever the Category field of the form 
is populated, it will force the embedded view to display only those documents with a 
category that matches the entry in the Category field. This form is shown in Figure 12-26.

Figure 12-26   CustomerContactData form

At this point, we now have a form containing an embedded view. By modifying this form’s 
Category field, we can force the embedded view to display only the documents in the view 
that have a matching category. Because the view is categorized by the first entry of the 
FullName field, essentially we should have one category for every person, with each category 
containing a single person document for that user. For example, if we populate the Category 
field with Joe Admin, the embedded view should only display Joe Admin’s person document.

Of course, we do not want to manually populate the Category field, so we now need to create 
an automated process to populate this field with the data that is being published from the help 
desk application.

Note: Refer to the Domino Designer 8 Help for more information about how to create 
embedded view elements.
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Creating the consumer actions
In the (CustomerContactData) form that we created in “Creating the component’s front end” 
on page 434, we embedded a view that will only display one person document at a time. The 
person document to be displayed is controlled by the population of a hidden field named 
Category. We now need to create an action that consumes published data and populates the 
Category field. We accomplish this task with a form action.

1. In the (CustomerContactData) form, we create an action named 
“ConsumeContactAction”.

2. We tie this consumer action to the publisher action via the Advanced tab of the action’s 
properties window, as shown in Figure 12-27. In the Composite Settings section we select 
PublishContactsAction from the drop-down. This is the action that we created in “Create 
the property” on page 426.

Figure 12-27   CustomerContactData form

Important: If the composite application action name is not available, or if the 
drop-down is greyed out, then you most likely did not create the wiring property as 
outlined in “Importing the WSDL file” on page 432, or the WSDL has been modified and 
you have not refreshed it with the most recent WSDL file.
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3. We also need to add some code to this action in order for it to obtain the published data, 
and place it in the Customer field so that our embedded view displays the appropriate 
user’s contact data. We do this by adding the code, as shown in Example 12-2, to the Click 
subroutine of the action.

Example 12-2   ConsumeContactAction LotusScript code

Sub Click(Source As Button)
Dim s As New Notessession
Dim db As NotesDatabase
Set db = s.currentdatabase

'handle to the database where this form is located.
Dim ws As New NotesUIWorkspace
Dim uidb As NotesUIDatabase
Dim uidoc As NotesUIDocument

'handle error 4719, returned when the script is run without a property broker 
context

On Error 4719 Goto err4719
'new property broker code

Dim pb As NotesPropertyBroker
Set pb = s.getPropertyBroker()

'create ’new NotesPropertyBroker object
Dim pbInputProperty As NotesProperty
Dim pbcontext As Variant
pbContext = pb.InputPropertyContext 'array of NotesProperty objects
Set pbInputProperty = pbContext(0) 'handle to first ’NotesProperty object
Dim InputPropertyName As String
Dim Namespace As String
InputPropertyName = pbInputProperty.Name 

'name of the ’NotesProperty object
NameSpace = pbInputProperty.NameSpace 

'namespace of the 
'NotesProperty object 

Print "InputPropertyName = " & InputPropertyName ’&" NameSpace = " & 
NameSpace

Dim pbvalue As Variant
pbValue = pb.GetPropertyValue(InputPropertyName) 'array of values of 

NotesProperty
cName$ = pbValue(0) 'first value from array of values of NotesProperty 

object
SkipPropertyBroker:

If cName$ = "" Then
Exit Sub

End If
' Messagebox cName$

Set UIdoc = ws.CurrentDocument 
Call uidoc.FieldSetText("Customer",cName$)
Call uidoc.Refresh
Exit Sub

err4719:
Print "Error" & Str(Err) & ": " &Error$
Messagebox "error"
Resume skipPropertyBroker

End Sub
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We now have a consumer component that is ready to receive data, populate the Category 
field, and thus display the appropriate person document.

Putting it all together
At this point we have a publisher and consumer that are ready to be coupled together. As you 
can see, both still work as stand-alone Notes applications, and the component aspect has not 
affected the application in any significant way. In the Notes client we can now create a new 
composite application and bring all of our components together to work in harmony.

1. From within the Notes client, we created a new application based on the blank composite 
application template. The blank composite application is shown in Figure 12-28.

Figure 12-28   Blank composite application

2. We edit the application by selecting the Action → Edit Application menu. This launches 
the composite application editor.
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3. We begin by opening the component palette by selecting Tools → Component 
Palette → Open. See Figure 12-29.

Figure 12-29   Component palette

4. We add our NSF components to the palette. This is done by selecting Tools → 
Component Palette → Add Components → Add NSF Component menu.

5. In the New NSF Component dialogue, we enter a name for our first component in the 
Component Name field, and a description in the Component Description field, as shown in 
Figure 12-30.

Figure 12-30   New NSF Component dialog

Component Palette
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6. We add our view by selecting the Browse button next to the Notes URL field.

7. The browse button displays the Locate Object dialogue box, which we then use to find the 
Ticket By Status view as follows:

a. In the Application field we use the drop-down menu to find the help desk application.
b. We select View in the Kind of Object field.
c. We select Tickets by Status in the View field, as shown in Figure 12-31.

Figure 12-31   Locate Object dialogue

8. Because the help desk application has two views, but only one is designated as a 
component, we want restrict users to the Tickets By Status. To do this, we need to append 
&HideNavigator to the end of the Notes URL, as shown in Figure 12-32.

Figure 12-32   Adding &HideNavigator to the Notes URL

9. With the Tickets by Status component complete, we now need to add the ContactData 
component from the Domino directory. To do this, we repeat steps 4 through 7, but this 
time we select the Domino directory database and choose the (CustomerContactData) 
form.
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10.Now that we have our two NSF components, we need to add them to the blank application 
section of the window. This is done by simply dragging the components from the 
component palette onto to the blank application. The finished product is shown in 
Figure 12-33.

Figure 12-33   Composite application editor

11.Now that we are done with adding our components to the composite application, we select 
File → Finished Editing to save our changes.

Wiring the components
We now have a composite application with two components. The next step is to wire these 
components together in order to form an action/event relationship.

1. We re-open the composite application into the composite application editor by selecting 
the Action → Edit Application menu.
Chapter 12. New application development features 441



2. From the Navigator pane (left most pane), we right-click the Help Desk - Tickets 
component and select the Wiring menu option, as shown in Figure 12-34.

Figure 12-34   Wiring menu

3. The Wiring page is now displayed, as shown in Figure 12-35.

Figure 12-35   Wiring page
442 IBM Lotus Notes and Domino 8 Deployment Guide



4. We wire the two components together by clicking the HelpDeskContacts component and 
dragging it to the PublishContactsAction, HelpDeskContacts component. The result is 
shown in Figure 12-36.

Figure 12-36   Two wired components

5. We click the OK button to exit out of the Wiring page.

6. We can now save and close out of the CAE by selecting File → Finished Editing menu.

The finished product
In this example we have completed the following tasks:

� Built publisher and consumer components
� Added components to composite application
� Wired components
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With these tasks done, we now have a finished and fully functional application, as shown in 
Figure 12-37.

Figure 12-37   A composite application

For every trouble ticket we click, the user’s contact data displays in the bottom pane of the 
application.

12.6.3  Considerations when creating composite applications

From an application development standpoint, composite applications are likely to be 
considered the most important change in Notes 8. The ability to build business applications in 
Notes, combined with Notes superior collaboration capabilities, is likely to spur a new growth 
in demand for the ND developer.

NSF-based components and NSF-based composite applications are still in their infancy, 
therefore some restrictions apply. The following is a list of currently known limitations in 

Tip: For more information about composite applications, including IBM Lotus Component 
Designer, WebSphere Portal, and NSF-based composite applications, refer to the IBM 
developerWorks composite applications page at:

http://www.ibm.com/developerworks/lotus/composite-apps/

Also, refer to the IBM Redbooks Publication Building Composite Applications, SG24-7367:

http://www.redbooks.ibm.com/redpieces/abstracts/sg247367.html
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NSF-based composite applications in Notes and Domino 8. Some of these may be addressed 
in later releases of ND.

� No support for design locking

Design locking allows developers working in teams to lock other developers out of the 
design elements that they are currently working on. This prevents two or more developers 
from modifying the same element at the same time. Currently, the IBM Lotus composite 
application editor does not support design element locking.

� No browser support through Domino

Notes databases built on the blank composite application template are not accessible via 
a Web browser. Currently, NSF-based composite applications are intended for viewing 
through Notes 8 only. In order to create a composite application that is accessible via a 
Web browser, the application must reside on a WebSphere Portal Server.

� Replication

Although replication is fully supported with NSF-based composite applications, the ability 
for components to exist anywhere, including locally, can pose some challenges for 
replicating composite applications. Before doing so, you must take into consideration the 
components that make up your applications and whether they will be accessible if the 
application is replicated to another server.

12.7  DB2 integration

DB2 integration provides the ability to store Domino data in a DB2 database rather than the 
standard NSF database. Though the feature was available in ND7, it was not fully supported. 
Now, with Notes and Domino 8, DB2 integration is a fully supported feature of Domino.

The power of this feature can be realized through Domino applications that would benefit from 
a relational database back-end as opposed to the flat structure of the NSF. Furthermore, 
developers are not restricted DB2 or NSF and can build applications that bridge data between 
DB2 back ends and NSF databases.

Implementation of the DB2 integration feature requires a DB2 server to store a representation 
of the Domino data, but maintains full functionality as though the data were stored in an NSF. 
Accessing the DB2 Domino data requires a DB2 Access View (DAV) and Query view.

For more information about DB2 integration refer to 9.11, “Domino and DB2 deployment” on 
page 286.

Tip: An in-depth overview of DB2 integration from an application developers point-of-view 
is available in Chapter 2, “Using DB2 integration to enhance the ITSO Electronics 
application” on page 7, of the Lotus Domino 7 Application Development, REDP-4102:

http://www.redbooks.ibm.com/abstracts/redp4102.html
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Appendix A. Considerations for upgrading 
from Notes and Domino 6.5.x to 8

This appendix aims to summarize the information from this book and other sources of 
information that is specific to an upgrade from Notes and Domino 6.5.x to 8. While it is not 
possible to cover every scenario and every aspect of the upgrade process in this short 
summary, we aim to raise awareness of some of the main points of consideration. 

If you are planning to upgrade your Notes and Domino environment from 6.5.x to 8, it is 
important to remember that adequate planning and testing of the upgrade within your own 
unique Notes and Domino environment is an essential part of a successful upgrade.

Upgrading directly from Notes and Domino 6.5.x to 8 is supported, and has been tested as 
part of the development process for Notes and Domino 8. 

This appendix contains the following information:

� General Upgrade considerations for Notes and Domino 6.5.x to 8
� Upgrade considerations for the Domino server
� Upgrade considerations for the Notes client
� Coexistence considerations for Notes and Domino 6.5.x and 8
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Introduction

For the most part, upgrading from Notes and Domino 6.5.x to 8 follows the same process and 
has the same considerations as upgrading from Notes and Domino 7.x to 8. All the important 
tasks of planning and testing the upgrade remain the same, and most implementation steps 
also do not differ. Therefore, if you are planning to upgrade your Notes and Domino 
environment directly from 6.5.x to 8, it is important to understand the concepts and steps 
detailed throughout this book. In particular, review these chapters to assist with the actual 
upgrade process:

� Chapter 2, “Planning the Notes and Domino 8 Deployment” on page 15
� Chapter 3, “Deploying the Domino 8 server” on page 45
� Chapter 4, “Deploying the Notes 8 client” on page 63
� Chapter 5, “Coexistence: Domino/Domino and Domino/Microsoft Exchange” on page 93

This appendix chapter aims to provide a summary of information that is specific to a Notes 
and Domino 6.5.x to 8 upgrade, using the information presented in the above chapters and 
other known sources of best practice information.

Upgrade considerations for Notes and Domino 6.5.x to 8

This section highlights some of the known areas of change between Notes and Domino 6.5.x 
and 8 that may affect the overall Notes and Domino upgrade and environment.

Encryption key length and large key support

Many changes were made to encryption key length in Notes and Domino 7 and 8, to provide 
enhanced security. These changes are backward compatible, so older keys can be used on 
newer Notes clients, but they are not all forward compatible. Therefore, if you are upgrading 
to Notes and Domino 8 directly from ND6.5, you need to be aware of the changes in each 
version and the compatibility of the different key lengths, especially if you are planning to use 
the higher encryption strength keys but you still have 6.5.x Notes clients in the environment.

The following list provides information to assist with planning key upgrades in mixed release 
environments:

� Notes and Domino 6.0: 

– Can use 1024-bit RSA keys, but will not generate them
– Can use 128-bit RC4 keys, but cannot use 128-bit RC2 keys

� Notes and Domino 6.0.4/6.5.1: 

– Can use 1024-bit RSA keys, but will not generate them
– Can use 128-bit RC2 keys, but will not generate them

Tip: The use of larger keys will not impact performance or impact the users. It is 
worthwhile to consider upgrading your ID files after your Notes and Domino 8 environment 
is in place, as longer keys do add additional security.

Note that you can view the encryption strength of an ID file by looking at the ID properties.
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� Notes and Domino 7.0:

– Can generate and use 1024-bit RSA keys
– Can generate and use 128-bit RC2 keys
– Adds underlying support for 2048-bit RSA keys

� Notes and Domino 8.0:

– Can generate and use 2048-bit RSA keys for users and servers
– Can generate and use 4096-bit RSA keys for certifiers
– Adds underlying support for 4096-bit RSA keys for users and servers

For additional information about Notes and Domino encryption key length, large key support, 
and upgrade considerations for Notes and Domino 6.5 environments, refer to mino 
Administrator 8 Help.

Hierarchical certification for Notes IDs

When Lotus Notes was first released, it offered only flat certification for the purpose of naming 
users and servers within the Notes environment. Hierarchical certification was introduced with 
Release 3 of Lotus Notes. 

Support for flat certification was removed in Notes and Domino 7.0 due to its inherent lack of 
security and its inability to be used with the administration process.

If you are upgrading directly from Notes and Domino 6.5.x to 8 and are still using flat 
certification, you need to convert all flat names to hierarchical names as part of the upgrade 
project. 

To update a flat user name and ID to a hierarchical one, use the user rename process and 
select the option Upgrade to Hierarchical. To update a flat server name to hierarchical, use 
the administrator client, Server view (on the Configuration tab), and select Actions - 
Upgrade server to hierarchical from the menu.

For additional information and step-step instructions to upgrade your users and servers to 
hierarchical naming, refer to the following topics in Lotus Domino 8 Administrator Help:

� Upgrading a user name from flat to hierarchical
� Upgrading a server to hierarchical

Some encryption key history: Prior to 5.0.4, key lengths were restricted for the purposes 
of encrypting data, but not for authentication or signing. Anything over 512-bit RSA key and 
56-bit symmetric key was considered strong encryption and was not allowed for export by 
the U.S. Government. Customers were required to order and choose among kits of 
different cryptographic strengths.

After the relaxation of U.S. government regulations on the export of cryptography, the 
Domino server and the Domino Administrator, Domino Designer, and Lotus Notes client 
products consolidated all previous encryption strengths (North American, International, 
and France) into one strong encryption level resulting in a single global release of the 
products. The global release adopts the encryption characteristics previously known as 
North American. Strong encryption in global products can be used worldwide, except in 
countries whose import laws prohibit it, or except in those countries to which the export of 
goods and services is prohibited by the U.S. government. Customers are no longer 
required to order Notes software according to cryptographic strength.
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Upgrade considerations for the Domino server

This section highlights some of the known areas of change between Domino 6.5.x and 8 that 
may affect your Domino server upgrade.

Clustering

Upgrading your clustered servers at different times is supported, so you can have a mixed 
6.5.x and 8.x cluster during the coexistence period of your project. Keep in mind, however, 
that the cluster replication task does not restrict the replication of any design elements. 

While this is a consideration for Domino server upgrades both from 6.5.x and from 7.x, there 
is a higher likelihood of experiencing issues with an 8 design on a 6.5.x server or client.

The Domino directory 8 design is backward compatible with Notes and Domino 6.5.x. Other 
databases may, however, cause issues on earlier Domino servers and Notes clients. If you 
want to keep design elements at the same version as the server, do not put Domino 6.5.x or 
7.0 in the same cluster with Domino 8 servers.

For further information about design upgrades during coexistence, refer to the following 
sections:

� 5.1.2, “Templates and design elements” on page 96
� 5.1.3, “System databases” on page 99
� 5.1.4, “Clusters” on page 103

Resource reservations

Resource reservations has seen significant changes since Domino 6.5. Prior to Domino 7, the 
resource and reservation functionality was distributed amongst the resource template, the 
router task, and the schedule manager task. Beginning with Domino 7, this functionality was 
combined into a single server task: rooms and resource manager, or RnRMgr.

If you are upgrading directly from Domino 6.5.x or earlier be aware that these points apply to 
Domino 8 just as they did for Domino 7.

For additional information about how to configure the RnRMgr, refer to the following sources:

� The Rooms and Resources Manager topic in Lotus Domino Administrator 7 Help

� Technote #7002648 “What is and how to set up resource scheduling for Notes/Domino 6.x 
or 7.x Calendaring & Scheduling”: 

http://www.ibm.com/support/docview.wss?rs=203&uid=swg27002648

� Resource Reservations database in the Notes and Domino 7 Upgrade Best Practices 
Redpaper, REDP-4120-00

Note: Resource reservations databases (RRDB) based on a 6.x or earlier design do not 
function properly on Domino 8 servers. Overbooking of rooms and resources can easily 
occur if you attempt to use a pre-Domino 7 RRDB on a 7.0 or later server. Replace the 
design of the resource reservation template immediately. In Releases 7.0.2 and later, this 
is done automatically at server startup.
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Upgrade considerations for the Notes client

This section highlights some of the known areas of change between Notes 6.5.x and 8 that 
may affect your Notes client upgrade.

Client features and functionality

Changes in Notes client features and functionality can have a huge impact on user 
productivity and perception of the upgrade. It is therefore important to understand the major 
areas of change between the old and new client version. 

This requirement is even more pronounced if you are skipping a version of the Notes client 
when you upgrade, such as when moving from Notes 6.5.x to 8.x. 

We therefore highly recommend that you review the major feature and functionality changes 
between each of the releases to help plan the user training requirements for the upgrade 
project.

Some good resources to assist with this process are:

� Chapter 4, “Deploying the Notes 8 client” on page 63 

� Chapter 2, “Changes for the user,” in the Lotus Notes and Domino 8 Reviewers Guide:

ftp://ftp.software.ibm.com/software/lotus/lotusweb/product/domino/ND8_Reviewers
_Guide.pdf

� “New client features” in the Notes and Domino 7 Upgrade Best Practices, REDP-4120-00

� “What’s New in Lotus Notes 7: Features and benefits” in the Lotus Notes and Domino 7 
Reviewers Guide:

ftp://ftp.software.ibm.com/software/lotus/lotusweb/product/domino/ND7_Reviewers
_Guide.pdf

Smart Upgrade

Smart Upgrade was introduced in Notes and Domino 6.0 for the purpose of centrally 
managing and automating Notes client upgrades. Changes and enhancements to the Smart 
Upgrade functionality were made in various point releases of Notes and Domino 6.0 and 6.5. 

If you are planning to use Smart Upgrade to upgrade your Notes clients from 6.5.x to 8, it is 
worthwhile to understand the client, template, and server dependencies for the functions of 
Smart Upgrade. For example, if you are upgrading from 6.5.2 or earlier, Smart Upgrade kit 
download will not occur as a background task in the Notes client, so users will not be able to 
use their Notes client while kit download is occurring. 

For the full list of Smart Upgrade client, template, and server dependencies, refer to 5.1.7, 
“Smart Upgrade” on page 104.

For details on how Smart Upgrade works, its features, and steps to deploying the Notes client 
using Smart Upgrade, refer to the IBM Redpaper, Understanding Lotus Notes Smart 
Upgrade, REDP-4180: 

http://www.redbooks.ibm.com/abstracts/redp4180.html?Open
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Multi-lingual Notes interface support (MUI)

Notes 7.0 added support for easier multi-lingual support in the Notes client using multi-user 
interface (MUI) packs. Although it was possible in Notes 6.5.x to set up a multi-lingual Notes 
client, it was a little more difficult (and not quite as functional) than in Notes 7.x.

If you are upgrading multi-lingual Notes clients directly from 6.5.x to 8, or if you would like to 
implement the newer functionality after the client upgrade, refer to Technote #1239269 “Notes 
Client Multilingual User Interface (MUI) functionality changes between 6.x and 7.x” for more 
information:

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21239269

Coexistence considerations for Notes and Domino 6.5.x and 8

This section highlights some of the known areas of change between Notes and Domino 6.5.x 
and 8 that may affect the overall Notes and Domino upgrade and environment.

Automatic diagnostic data collection and fault analyzer

In Domino 6.5.x, automatic diagnostic data collection could be enabled to automatically send 
diagnostic files to a mail-in database on the Domino server. Fault analyzer was introduced in 
Domino 7 to provide diagnostic data analysis for troubleshooting Domino server issues. 

Fault analyzer analyzes the data collected by automatic diagnostic data collection so if you 
use automatic diagnostic data collection with Domino 6.5.x, and you plan to use fault analyzer 
after upgrading to Domino 8, be aware that fault analyzer will also analyze the existing fault 
report documents collected in your mail-in database. This analysis can be time-consuming. 
However, fault analyzer works well against Domino 6.5.x server failure reports, so as soon 
you have one server upgraded, you can take immediate advantage of fault analyzer.

For more information about automatic diagnostic data collection and fault analyzer, refer to 
the topic “Collecting diagnostic information after a server or client crash” in Lotus Domino 
Administrator 8 Help.

Background information: In Notes 6.5.x, to install multiple languages of the Notes client 
on a workstation, you would run through the setup.exe for each language separately. The 
Notes single-user setup did not support this, so the Notes client needed to be installed as a 
multi-user setup. By doing this, a MUI directory was created in the Notes program directory 
(for example, C:\Program Files\Lotus\Notes\MUI). The MUI directory contained the 
language files for the required language interface. To swap between languages, the user 
would need to change to the other user you had installed (with the multi-user installation). 
Using this method, the user would actually have a different local data directory for each 
language.

Starting with Notes 7.0, the limitations described above do not exist. A MUI Pack 
installation can be performed for the required language, then the user can swap between 
languages from within the Notes client just with a preference setting change.
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Domino directory design interoperability

A Domino directory based on the Domino 8 design can run on both Domino 6.5 and Domino 
7 servers. For more information about managing the Domino directory design during the 
coexistence phase, refer to “Domino directory” on page 99.

Mail design interoperability 

As discussed in “Client/template interoperability” on page 105, the mail template is usually 
upgraded after the Notes client upgrade. Table A-1 details the supported client and mail 
template versions for interoperability.

Table A-1   Supported client/template coexistence

If you are upgrading your Notes clients directly from Notes 6.5.x to 8, it is essential to upgrade 
the clients prior to the mail template upgrade, as the use of the 8 mail template is not 
supported and causes issues.

For additional information, refer to Technote #1264690 at: 

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21264690

Calendar and scheduling interoperability
The functionality of calendar and scheduling in the Notes client has been extensively 
enhanced since Notes 6.5. Many of the newer features do not function correctly on older 
Notes clients and older Domino servers. In some cases, functionality that was available to 
Notes users in the 6.5.x calendar and scheduling does no longer function if they use a newer 
(7.x or 8.x) mail template or are on an upgraded Domino server.

For example, Domino 7 introduced a new feature that enables you to specify what action 
should be performed on a user's meeting invitations. If a user is on a pre-Domino 7 server but 
has upgraded her Notes client and template to Notes 7 (or later), the “Automatically accept 
even if time is not available” option in calendar and scheduling does not work. The meeting 
invitation is either not processed or it is declined. In a mixed release clustered environment, if 
a user is on a Domino 7 or 8 server and Notes client, but fails over to a Domino 6.5.x server in 
the cluster, the user will encounter this issue.

For additional information, refer to “Calendar and Scheduling” in the Notes and Domino 7 
Upgrade Best Practices Redpaper, REDP-4120-00.

Lotus Notes 8.x Lotus Notes 7.x Lotus Notes 6.5.x

Notes 8 template Supported Supporteda

a. Although this configuration is supported, it is not considered a best practice because there
will be limited functionality available to the user.

Unsupported

Notes 7 template Supported Supported Supporteda

Notes 6 template Supported Supported Supported

Tip: Remember, if you have users who delegate mail access to others (such as a personal 
assistant) you need to upgrade both Notes clients to 8 before either of the mail templates is 
upgraded.
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Out of office
Domino 8 introduced the option to use the router to process out-of-office responses, using the 
Out of Office router service. If this option is configured on a Domino 8 server that has Notes 
6.5.x mail templates, the users with the 6.5.x template will not be able to utilize the new Out of 
Office router service. These users will still be able to continue using the out-of-office agent, 
but they will not be able to use the new features such as out-of-office start and end-time 
setting. 

For a summary of the differences between the functionality of the out-of-office agent and the 
router service, refer to Table 9-1 on page 242. For more information about the new Out of 
Office router service, refer to 9.2, “Out of Office router service” on page 242.

Domino Web Access interoperability

If you will be housing DWA6.5.x users on your Domino 8 server, you should also note that the 
instant messaging settings and local archive setting in the configuration document of the 
Domino directory are intended only for users using the DWA8 template. In order to configure 
these options for DWA6.5 users you need to utilize the appropriate INI parameters.

For more information about Domino Web Access 8, see Chapter 8, “Domino Web Access” on 
page 215.

In a mixed server environment, if you make a replica of a Domino Web Access database on a 
Domino 6.x server, this server loads the Release 6 design automatically whether you are 
using a Release 6.x design or later design. In this scenario, users get the functionality of the 
version of the Domino server they are on. They do not have the features available to them in 
newer DWA template versions on a Domino 6.x server.

Domino domain monitoring

Domino domain monitoring was introduced in Domino 7. To gain full functionality from 
Domino Domain Monitor, a Domino 7 or later server is required. However, a Domino 7 or 8 
server can monitor areas on pre-Domino 7 servers using three of the Domino domain monitor 
probes: the security, Web, and replication probes.

For additional information about Domino domain monitoring, refer to these sources:

� 9.9, “New Domino domain monitoring features” on page 265
� Lotus Domino Domain Monitoring, REDP-4089

Policies

Policies were introduced to Notes and Domino 6 to assist administrators with the task of 
implementing standardized Notes client configuration settings. With each new major release 
of Notes and Domino, policies have been enhanced to provide additional configuration 
options and more complete standardization.

Some of the major enhancements to policies since Notes and Domino 6 are:

� Mail policy settings documents, introduced in Domino 7

� Custom password settings, introduced in Domino 6.5.4

� Ability to lock down policy settings so that users cannot change them, introduced in 
Domino 7

� Productivity tools and activities policy settings documents, introduced in Domino 8
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� Enhancements to the ability to lock down policy settings, and additional options for 
choosing how and when settings are applied to users, introduced in Domino 8

Most of the new capabilities of policies in Domino 7 and 8 are ignored by Notes 6.5.x clients. 
For example, policy lock-down settings have no effect on 6.5.x clients, and the new types of 
Policy Settings (Mail, productivity tools, and activities) are also ignored. 

While these newer policy settings and options do not have any adverse effects on the Notes 
6.5.x client, it is worthwhile understanding that during the co-existence period users are not 
able to utilize these new settings and options until they are upgraded to Notes 8.

For additional information, refer to these sources:

� 9.8, “Policy enhancements” on page 262 

� “Policy document compatibility” in the Notes and Domino 7 Upgrade Best Practices, 
REDP-4120-00 

Further reading

While many new features have been added to Domino 8, it is Notes 8 that received most of 
the attention in this release. Though we tried to keep Domino 6.5 in mind throughout this 
book, we recommend that if you are considering upgrading to Domino 8 directly from Domino 
6.5 you also consult Notes and Domino 7 Upgrade Best Practices, REDP-4120-00, as much 
of the information in it applies to Domino 8 as well. The Redpaper can be found at:

http://www.redbooks.ibm.com/abstracts/redp4120.html

Tip: You can assign policies to users while they are still running 6.5x, so that when they 
upgrade to 8.0, the policies take effect. This provides greater timing flexibility during your 
upgrade, because the timing of policy creation and client upgrade do not have to be 
coordinated.
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Appendix B. Lotus Notes and Domino client 
feature comparison

This appendix contains a matrix comparing the features in Lotus Notes 8 with the Domino 
Web Access 8 Client, as well as previous releases of Domino Web Access.

We also provide you with information about the differences between Lotus Notes 8 client and 
Lotus Notes 8 basic configuration client.

While it is not possible to cover every feature in the clients, we hope that it helps you in 
making decisions on your upgrade process and deciding which client is best for your users.
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Lotus Notes 8 and Lotus Notes 8 Basic Configuration Client

A basic configuration of Notes 8 is available in case you do not have the system resources 
required to run the standard configuration. In the basic configuration of the Notes client, the 
following Lotus Notes 8 standard configuration features are not available:

� User interface

– Access to the Notes Getting Started page using Help → Getting Started Page from the 
main menu

– Side bar to provide access and mini-views of Sametime instant contacts, feed reader, 
calendar, and activities

– Consolidated user preferences

– Choice of preview pane location, below list or beside list

– Open button to open applications

– Ability to set how Window tabs display in user preferences

– Embedded Web browser, with the option to set default to your chosen browser

– Easier methods to find and work with location documents

– New user interface for help that lets you keep the help pane open as you work

� Mail

– Improved choices for reply to all, include history, and include attachments

– Thread layout display when applying to a mail thread.

– The ability to right-click operations for an entire mail thread, such as deleting a thread 
or moving a thread to a folder

– The ability to perform operations for an entire mail thread, such as deleting a thread or 
moving a thread to a folder

– Within the inbox, the ability to see all related messages in a thread

� Contacts

Recent Contacts view that shows users with whom you have recently interacted, such as 
e-mail correspondence or chats.

� Search

– New centralized search interface for queries and results (domain search, find people, 
find application, web/intranet searches available as search scopes)

– New search capability for help that searches across all books in the help system, such 
as Lotus Notes help and activities help

– Optional desktop search that can be launched by right-clicking live names, and is also 
available in the Search scope drop-down menu

� Composite applications

Composite applications that make it convenient for a user to access a collection of 
components (applications) to address a business need for a particular group of users
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� Other

– The home page includes buttons for the IBM Lotus Productivity tools (documents, 
spreadsheets, presentations). However, these tools are not included with the basic 
configuration of Notes, and the buttons are not active. To use these tools, you must 
install the standard configuration.

– Ability to view collaboration history with another user, such as e-mail correspondence, 
saved chat transcripts, or shared documents.

For the latest comparison on the two configuration of the client, refer to the following Lotus 
Software Knowledge Base Documents:

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21264877

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21256781

Lotus Notes and Domino Web Access client comparison

A comparison chart of the major mail, calendar, to do, and contacts features for the Lotus 
Notes 8 client and the Domino Web Access client is shown in next sections (Table B-2 on 
page 464, Table B-3 on page 468, Table B-4 on page 468, and Table B-5 on page 469).

For the latest version of this comparison chart, refer to the Lotus Domino Web Access 
product page at:

http://www-142.ibm.com/software/sw-lotus/products/product1.nsf/wdocs/webaccesshome

Or refer to the Lotus Notes product page at:

http://www-142.ibm.com/software/sw-lotus/products/product4.nsf/wdocs/noteslibrary

Mail features comparison

Table B-1 shows the major mail features between the Lotus Notes 8 client, Domino Web 
Access 8, Domino Web Access 7, and Domino Web Access 6.5.

Table B-1   Mail features

Feature Notes 8 DWA 8 DWA 7 DWA 6.5

Views and folders

File type used NSF (server, 
local)

NSF (server) NSF (server) NSF (server)

In-box view Yes Yes Yes Yes

Drafts view Yes Yes Yes Yes

All Documents view Yes Yes Yes Yes

Discussion Thread view Yes Yes Yes No

Folders Yes Yes Yes Yes

Nested folders Yes Yes Yes Yes

Create and delete folders Yes Yes Yes Yes
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Drag and drop messages into 
folders

Yes Yes Yes Yes

Copy and move to folder Yes Yes Yes Yes

Discover folder Yes No No No

Unread count within folders Yes No No No

Soft deletes Yes Yes Yes Yes

Restore a message Yes Yes Yes Yes

From the action bar, open mail 
into specific view (that is, inbox, 
sent, drafts, and so on)

No Yes Yes Yes

Support displaying columns 
defined in mail template

Yes Yes Yes Yes

Support resizing various column 
widths

Yes Yes Yes Yes

Forwarding multiple selected 
documents

Yes Yes Yes Yes

Printing multiple selected 
documents

Yes Yes Yes Yes

Displaying attention indicator Yes Yes Yes Yes

Color coding view lines based on 
sender

Yes No No No

Color coding view lines based on 
Recipients

Yes Yes No No

Allow individual users to 
show/hide various columns

Yes No No No

Message creation and addressing

Create new message Yes Yes Yes Yes

Customize header display for 
new messages

Yes Yes No No

Type-ahead addressing Yes Yes, automatic 
name resolution 
provides this 
function

Yes, automatic 
name resolution 
provides this 
function

Yes, automatic 
name resolution 
provides this 
function

Recent contacts Yes No No No

Support file attachments Yes Yes Yes Yes

View file attachments from within 
message

Yes No, third-party 
products are 
available for this

No, third-party 
products are 
available for this

No, third-party 
products are 
available for this

Spell checking Yes Yes Yes Yes

Alternate name support Yes Yes Yes Yes

Feature Notes 8 DWA 8 DWA 7 DWA 6.5
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Sametime integration Yes Yes Yes Yes

Perform name and address book 
lookup

Yes Yes Yes Yes

Display contacts sorted by 
organizational unit

Yes Yes Yes Yes

Perform integrated address book 
lookup when sending a message

Yes Yes Yes Yes

Name lookups to LDAP 
directories

Yes Yes Yes Yes

Personal contacts address book Yes Yes Yes Yes

Delivery options (importance, 
delivery priority, delivery report)

Yes Yes Yes Yes

Forward message Yes Yes Yes Yes

Save message draft Yes Yes Yes Yes

Create a serial route memo Yes Yes Yes Yes (new in 6.5.3)

Copy into - convert item to task, 
calendar entry or new memo

Yes Yes No No

Return receipt Yes Yes Yes Yes

Prevent copying Yes No No No

Apply mood stamps to messages Yes No No No

Create/use stationery Yes Yes Yes No

Choose a letterhead Yes No No No

Create a message containing a 
signature file 

Yes Yes Yes Yes

Type-ahead within Move to 
Folder dialog

Yes No No No

Specify outbound message with a 
reply by date

Yes No No No

Specify message expiration date Yes No No No

Utilize plain text or rich text editor No Yes Yes Yes

Internet Message format Yes Yes Yes Yes

Viewing and responding to message items

Preview pane Yes Yes No No

Support for read/unread marks Yes Yes Yes Yes

Navigate to next document 
without returning to view

Yes Yes Yes Yes

Delete current document and 
navigate to next document 
without returning to view

Yes Yes Yes No

Feature Notes 8 DWA 8 DWA 7 DWA 6.5
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Perform mail file delegation Yes Yes Yes Yes

Reply with history Yes Yes Yes Yes

Reply to memo Yes Yes Yes Yes

Reply to all Yes Yes Yes Yes

Reply without attachments Yes Yes Yes Yes

View rich text within a message Yes Yes Yes Yes

Support for doc links, view links, 
and database links 

Yes Yes Yes Yes

View tables within messages Yes Yes Yes Yes

Create tables within messages Yes Yes Yes Yes

Resend documents from within a 
delivery failure

Yes Yes Yes Yes

View sections Yes Yes Yes Yes

Action bar Yes Yes Yes Yes

Add Sender of message to 
personal contacts list from view

Yes Yes No No

Add sender of message to 
personal contacts list from 
message

Yes Yes Yes Yes

Modify/view the file's ACL from 
client

Yes No No No

Display of Importance/type icons 
in views

Yes Yes Yes Yes

Read encrypted mail and verify 
signature of signed mail 

Yes Yes Yes Yes

Verify signature of signed mail Yes Yes Yes Yes

Next/previous navigation within 
an open mail message

Yes Yes Yes Yes

Preference setting for new mail 
on top/bottom

No Yes Yes Yes

Automatically checking for new 
messages

Yes Yes Yes Yes

Follow up flags Yes Yes Yes Yes

Column sort in general Yes Yes Yes Yes

Sort by subject Yes Yes Yes No

Display mail thread for current 
message

Yes Yes Yes No

Advanced editing features in Rich Text field 

Feature Notes 8 DWA 8 DWA 7 DWA 6.5
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Left, right and center, indent, 
outdent text justification 

Yes Yes Yes Yes

Tables - simple tables, not all 
complex

Yes Yes Yes Yes

View sections Yes Yes Yes Yes

Support for embedded OLE 
objects

Yes No No No

Java applet support Yes No No No

Page break Yes Yes Yes Yes

Horizontal line Yes Yes Yes Yes

Hotspots Yes No No No

Insert image resources Yes Yes Yes Yes

Create sections Yes No No No

Ability to switch language 
dictionaries for spell checking

No Yes Yes Yes

Support for both bullets and 
number lists 

Yes Yes Yes Yes

Undo Yes Yes Yes Yes

User preferences     

New mail notification Yes Yes Yes Yes

Default mail send/save setting Yes Yes Yes Yes

Ability to archive mail and C&S 
documents

Yes Yes Yes Yes

Lookup across multiple address 
books

Yes Yes Yes Yes

Automatically create a reply 
message by clicking on the From 
field

No Yes Yes Yes

Security     

Send signed and/or encrypted 
mail 

Yes Yes Yes Yes

S/MIME Yes Yes Yes No

Read encrypted mail Yes Yes Yes Yes

Field, form, view, document, 
section level security

Yes No No No

User roles Yes No No No

Local encryption of mail database Yes Yes Yes Yes

Other features     

Feature Notes 8 DWA 8 DWA 7 DWA 6.5
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Calendar features comparison

Table B-2 shows the major calendar features between the Lotus Notes 8 client, Domino Web 
Access 8, Domino Web Access 7, and Domino Web Access 6.5.

Table B-2   Calendar features

Control of database 
properties/design (refresh, 
replace, and so on)

Yes No No No

Support for alternate editors for 
mail messages

Yes No No No

Built-in news reader, POP mail, 
IMAP mail

Yes No No No

Support for Notes/Domino 
database subscriptions

Yes No No No

Extended search (w/in 
databases, attachments, 
messages, and so on) control of 
search - refinement of search 
with form, and so on

Yes No No No

Drag and drop documents 
between frames

Yes Yes Yes Yes

User can change their own 
password from client

Yes Yes Yes Yes

Support for mail rules Yes Yes Yes Yes

Integrated instant messaging Yes Yes Yes Yes

Usage indicator (quota) No Yes Yes No

Out of office Yes Yes Yes Yes

Support for new out of office 
service

Yes Yes No No

Auto discover user configuration N/A Yes Yes Yes

Quick find Yes Yes Yes Yes

Support setting as default mail 
client on Win32® system

Yes Yes Yes Yes

Send current document from 
Microsoft Office applications

Yes Yes Yes Yes

Support for RSS Feeds/Atoms Yes Yes No No

Supported on Linux Yes Yes Yes (New in 7.0.1) No

Feature Notes 8 DWA 8 DWA 7 DWA 6.5

Feature Notes 8 DWA 8 DWA 7 DWA 6.5

Views 
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From the Action bar, open 
calendar into specific view (that 
is, 1-day, 1 week, 1-month, and 
so on)

No Yes Yes Yes

Calendar views 1 day, 2 day, 5 
day, 1 week, 2 
week, 1 month

1 day, 2 day, 5 
day, 1 week, 2 
week, 1 month, 1 
year

1 day, 2 day, 5 
day, 1 week, 2 
week, 1 month, 1 
year

1 day, 2 day, 5 
day, 1 week, 2 
week, 1 month, 1 
year

Summarized calendar views Yes Yes Yes Yes

Display unprocessed invites in 
calendar

Yes Yes Yes Yes

Unaccepted meetings displayed 
within calendar

Yes Yes Yes Yes

Meeting view Yes Yes Yes Yes

Calendar print preview Yes Yes Yes Yes

In-line calendar view editing Yes Yes Yes Yes

Work/non-work hour 
differentiation

Yes Yes Yes Yes

Calendar filtering Yes Yes No No

Ability for chairperson to see 
status of invitees from the view 
level

Yes Yes Yes Yes

Calendar entries and group scheduling 

Double-click within the calendar 
view to create an entry

Yes Yes Yes Yes

Create appointment Yes Yes Yes Yes

Create all day event Yes Yes Yes Yes

Create reminder Yes Yes Yes Yes

Create anniversary Yes Yes Yes Yes

Create meeting invitation Yes Yes Yes Yes

Save calendar entry as draft Yes Yes Yes No

Forward a calendar entry Yes Yes Yes No

Create rich text in detailed 
description field

Yes Yes Yes Yes

Automatic date (calendar picture) 
and time selector controls

Yes Yes Yes Yes

Centrally managed rooms and 
resources

Yes Yes Yes Yes

Create repeating entries Yes Yes Yes Yes
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Add alarms to entries Yes Yes Yes Yes

Attach a file to invitation forms Yes Yes Yes Yes

Pencil in a meeting/tentatively 
schedule 

Yes Yes Yes Yes

Mark an entry private/"not for 
public viewing"

Yes Yes Yes Yes

Delivery options on calendar 
entries

Yes Yes Yes Yes

Address lookup for inviting 
people

Yes Yes Yes Yes

Check freetime availability for 
invitees

Yes Yes Yes Yes

Support for counter-proposal Yes Yes Yes Yes

Freetime search within a 
counter-proposal

Yes Yes Yes No

Respond with comments within a 
counter-proposal

Yes Yes Yes Yes

Edit calendar entries Yes Yes Yes Yes

Send a reschedule notice Yes Yes Yes Yes

Add additional invitees after 
invitation is sent

Yes Yes Yes Yes

Send "broadcast" invitation (no 
RSVPs/responses)

Yes Yes Yes Yes

Send meeting confirmation Yes Yes Yes Yes

Display invitee responses in 
invitation

Yes Yes Yes Yes

Accept invitation Yes Yes Yes Yes

Decline invitation Yes Yes Yes Yes

Counter propose an alternative 
time

Yes Yes Yes Yes

Accept/decline with comments Yes Yes Yes Yes

Delegate an invitation Yes Yes Yes Yes

Check calendar from invitation 
page

Yes Yes Yes Yes

Create and maintain group 
calendar

Yes Yes Yes Yes

Create meeting invitation from 
group calendar view populating 
group members in invitation

No Yes Yes Yes

Accept counter proposal Yes Yes Yes Yes
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Support for meetings spanning 
midnight

Yes Yes Yes Yes

C&S entry support for online 
Sametime meetings

Yes Yes Yes Yes

Ability to specify time zones in 
C&S entries

Yes Yes Yes Yes

Users in different time zones can 
share the same server and still 
see meeting times with respect to 
their own zone 

Yes Yes Yes Yes

Generate PDF calendar printouts No Yes Yes Yes

Drag and drop to reschedule a 
calendar entry

Yes Yes Yes Yes

Import corporate holidays Yes Yes Yes No

User preferences

Default location for resources Yes Yes No No

Set global default appointment 
duration

Yes Yes Yes Yes

Set global default calendar entry 
type

Yes Yes Yes Yes

Option to make freetime available 
to only certain users

Yes Yes Yes Yes

Options to set allowable freetime Yes Yes Yes Yes

Enable conflict checking for 
calendar entries

Yes Yes Yes Yes

Allow another user to manage 
Calendar without allowing access 
to e-mail

Yes Yes Yes Yes

Mark default calendar entry as 
'not for public viewing'

Yes Yes Yes Yes

Autoprocessing of calendar information

Option to remove invitations from 
Inbox after processing

Yes Yes Yes Yes

Ability to autoprocess invitations Yes Yes Yes Yes
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To do features comparison

Table B-3 shows the major to do features between the Lotus Notes 8 client, Domino Web 
Access 8, Domino Web Access 7, and Domino Web Access 6.5.

Table B-3   To do

Contacts features comparison

Table B-4 shows the major contacts features between the Lotus Notes 8 client, Domino Web 
Access 8, Domino Web Access 7, and Domino Web Access 6.5.

Table B-4   Contacts

Feature Notes 8 DWA 8 DWA 7 DWA 6.5

To do's

To do's follow day-to-day in 
calendar view 

Yes Yes Yes Yes

Display To Do in Calendar view Yes Yes Yes Yes

Delegate a to do to another 
person

Yes Yes Yes Yes

Create to do's (with start and end 
dates)

Yes Yes Yes Yes

Categorize new to do entries Yes Yes Yes Yes

Alarm notification on to do's Yes Yes Yes Yes

Mark to do's complete or 
uncompleted 

Yes Yes Yes Yes

Create group to do's Yes Yes Yes Yes

Display to do's in gantt chart 
format

No Yes Yes Yes

Priorities for to do's (high, 
medium, and low) 

Yes Yes Yes Yes

Create personal to do's Yes Yes Yes Yes

Owner and participant actions Yes Yes Yes Yes

Forward a to do item Yes Yes (header info 
only)

Yes (header info 
only)

Yes (header info 
only)

Feature Notes 8 DWA 8 DWA 7 DWA 6.5

Personal contacts 

Sort contacts by last name, 
company, e-mail, address, and 
so on

Yes Yes Yes Yes

Add users in Domino directory to 
personal contact list

Yes Yes Yes Yes

Select multiple contacts and send 
message 

Yes Yes Yes Yes
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Other features comparison

Table B-5 shows the major mail features between the Lotus Notes 8 client, Domino Web 
Access 8, Domino Web Access 7, and Domino Web Access 6.5.

Table B-5   Attachment and miscellaneous

Select multiple contacts and 
schedule a meeting 

Yes Yes Yes Yes

Business Card Summary view Yes Yes Yes Yes

Categorization of contacts Yes Yes Yes Yes

Automatically add e-mail sender 
to personal contact list (from 
inbox)

Yes Yes Yes Yes

Forward a contact Yes Yes Yes No

Open contacts for another person Yes Yes No No

Feature Notes 8 DWA 8 DWA 7 DWA 6.5

Feature Notes 8 DWA 8 DWA 7 DWA 6.5

Attachments 

Unlimited attachments Yes Yes Yes Yes

Drag and drop attachments from 
desktop/file system

Yes Yes Yes Yes

Ability to rename attachments on 
download

Yes Yes Yes Yes

Miscellaneous

Browser support N/A IE 6 and IE 7 (Win 
XP/Vista), Mozilla 
1.7x (Linux; NLD 
10 and RHEL 
5.0), FireFox 2.0 
or later (Linux, 
Win XP/Vista, and 
MAC 10.4.x)

7IE 6.0+ (Win32), 
Mozilla 1.7x 
(Linux), FireFox 
1.0.x (Linux, 
Win32, and MAC)

IE 5.5/6.0 
(Win32), Mozilla 
1.3.1+ (Linux)

Advanced search (contextual by 
text, author, or date) 

Yes Yes Yes Yes

Journal integrated in mail file Yes Yes Yes Yes

Contacts integrated in mail file Yes Yes Yes Yes

Ability to snooze alarms across 
multiple sessions/logins

No Yes Yes Yes

Context sensitive help Yes Yes Yes Yes

Multilingual template support Yes Yes Yes Yes

Support for all Domino server 
platforms

Yes Yes Yes Yes
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Offline support for messaging, 
PIM, and collaborative 
applications

Yes Messaging, PIM 
(same DOLS 
code used for 
apps)

Messaging, PIM 
(same DOLS 
code used for 
apps)

Messaging, PIM 
(same DOLS 
code used for 
apps)

Home page support Yes Yes Yes Yes

Mail view filter for unread 
messages 

Yes Yes Yes Yes

Schedule replication Yes Yes Yes No

Secure Logoff Yes Yes Yes Yes

Cache cleaning N/A Yes Yes Yes

Auto save Yes No No No

Message disclaimers Yes Yes Yes Yes

Archiving Yes Yes Yes Yes

Log off instant messaging without 
getting out of the mail file or 
turning it off in the preference

Yes Yes No No

Feature Notes 8 DWA 8 DWA 7 DWA 6.5
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Related publications

The publications listed in this section are considered particularly suitable for a more detailed 
discussion of the topics covered in this book.

IBM Redbooks

For information about ordering these publications, see “How to get Redbooks” on page 472. 
Note that some of the documents referenced here may be available in softcopy only. 

� Lotus Domino 7 Application Development, REDP-4102

� Upgrading to Lotus Notes and Domino 6, SG24-6889

� Understanding Lotus Notes Smart Upgrade, REDP-4180

� Lotus Notes and Domino 7 Enterprise Upgrade Best Practices, REDP-4120

� Distributing Notes Clients Automatically, REDP-3693

� Migrating from Microsoft Exchange 2000/2003 to Lotus Notes and Domino 7, SG24-7777

� Domino 7 Server Consolidation: Best Practices to Get the Most Out of Your Domino 
Infrastructure, REDP-4181

� Lotus Domino Domain Monitoring, REDP-4089

� Building Composite Applications, SG24-7367

Online resources

These Web sites are also relevant as further information sources:

� IBM Software License Agreements

http://www-03.ibm.com/software/sla/sladb.nsf

� Best Practices for large Lotus Notes mail files

http://www.ibm.com/developerworks/lotus/library/notes-mail-files/

� Lotus Notes Mail: comparing Server-based mail and local replica mail

http://www.ibm.com/developerworks/lotus/library/serverlocalmail/

� Notes from Support: Domino Replication

http://www.ibm.com/developerworks/lotus/library/ls-Domino_Replication

� Lotus Notes and Domino Release Notes

http://www.ibm.com/developerworks/lotus/documentation/releasenotes/

� Lotus Connections

http://www.ibm.com/lotus/connections

� Lotus Notes/Domino Notes.ini settings

http://www.ibm.com/developerworks/lotus/documentation/notes-ini/index.html
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� How to perform a silent upgrade by mail

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21164125

� How to Synchronize Notes and Internet Password with Policy Documents in Notes Domino 6

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21110671

� Deploying Sametime 7.0 Connect for browsers on a Sametime 7.5 server

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21243158

� IBM developerWorks Composite Applications page

http://www.ibm.com/developerworks/lotus/composite-apps/

How to get Redbooks

You can search for, view, or download Redbooks, Redpapers, Technotes, draft publications 
and Additional materials, as well as order hardcopy Redbooks, at this Web site: 

ibm.com/redbooks

Help from IBM

IBM Support and downloads

ibm.com/support

IBM Global Services

ibm.com/services

IBM Support Assistant

http://www.ibm.com/software/support/isa/
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